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Printing procedurePrinting procedure
Printing Options Using Rolls and Sheets ...........................................................................................................16

Turning the Printer On and Off .......................................................................................................................... 17
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➔ Specifying Paper in the Printer Driver (Windows) ............................................................................ 144
➔ Specifying Paper in the Printer Driver (Mac OS) .............................................................................. 251
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Printing Options Using Rolls and SheetsPrinting Options Using Rolls and Sheets
The printer supports both rolls and sheets.
This section introduces the main features of each, as well as the main printing methods available. Select rolls or
sheets to suit your particular printing application.

Note
• For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Types of

Paper.") ➔P.328

• A variety of other ways to print are available besides those introduced here. Choose the printing method that suits
your particular printing application, referring to "Working with Various Print Jobs" and "Enhanced Printing Options"
from the table of contents.

Roll printing
Media in spooled rolls is generally called Roll Media. Rolls are loaded on the Roll Holder, which are in turn loaded
in the printer.
Rolls can be used to print large photos or create posters or banners that cannot be printed on regular sheets.

• Large-format printing
Easily print vertical or horizontal banners from familiar applications such as Microsoft Office applications.
 (See "Printing Vertical or Horizontal Banners (Large-Format Printing).") ➔P.88

• Borderless printing
Print without a margin (border) around posters or photos.
 (See "Borderless Printing on Paper of Equivalent Size.") ➔P.79
 (See "Borderless Printing by Resizing Originals to Fit the Roll Width.") ➔P.82
 (See "Borderless Printing at Actual Size.") ➔P.74

• Banner printing
You can print multiple pages as a single continuous image, without margins between pages.
 (See "Printing Multiple Pages Continuously.") ➔P.104

• 90-degree rotation before printing
Originals in portrait orientation are rotated 90 degrees when possible to use paper more efficiently.
 (See "Conserving Roll Paper by Rotating Originals 90 Degrees.") ➔P.123

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") ➔P.60
 (See "Resizing Originals to Fit the Roll Width.") ➔P.62
 (See "Resizing Originals by Entering a Scaling Value.") ➔P.65

• Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet pro-
grams, and so on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") ➔P.101

Sheet printing
Sheets refer to individual sheets of paper.
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Insert the sheet between the Platen and the Paper Retainer.

• Enlarged/reduced printing
You can freely adjust the size of originals by enlarging or reducing originals before printing.
 (See "Resizing Originals to Match the Paper Size.") ➔P.60
 (See "Resizing Originals by Entering a Scaling Value.") ➔P.65

• Free Layout function
Print multiple documents from multiple applications (such as word-processing programs, spreadsheet pro-
grams, and so on) next to each other.
 (See "Printing Multiple Originals Next to Each Other.") ➔P.101

Turning the Printer On and OffTurning the Printer On and Off

Turning the printer on

1
 

Press the Power button to turn on the printer.
The printer will now start up.
After the Display Screen shows the Canon logo, "Starting up...
Please wait." is displayed.

2
 

The Power Lamp is lit when the printer finishes starting up, and
the printer is now in Standby.

The printer will not go into Standby in the following situations.
Take the appropriate action.

• The Top Cover is open
Close the Top Cover.

• The Ink Tank Cover is open
Close the Ink Tank Cover.

• The Printhead is not installed
see "Replacing the Printhead." ➔P.546

• An Ink Tank is not installed
see "Replacing Ink Tanks." ➔P.536

• If "ERROR" is shown on the Display Screen
see "Error Messages." ➔P.600
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• The Power Lamp and Message Lamp are not lit (even once), and nothing appears on the
Display Screen
Make sure the printer is plugged in correctly. Check the connection at the plug and electrical outlet.

• No paper is loaded
Load paper.  (See "Loading and Printing on Rolls.") ➔P.18   (See "Loading and Printing on
Sheets.") ➔P.21

Turning the printer off

Important
• Never disconnect the printer's power supply or unplug it during a print job. This may damage the printer.

1
 

Make sure no print jobs are in progress.
If the Message Lamp is flashing, check the message on the Dis-
play Screen and take action as necessary.  (See "Error Messag-
es.") ➔P.600

If the Data Lamp is flashing, the printer is receiving a print job.
Turn off the printer only after printing is finished.

2
 

Hold down the Power button for more than a second.

After "Shut Down.. Please Wait.." is shown on the Display
Screen, the printer shuts off.

Loading and Printing on RollsLoading and Printing on Rolls
These are the basic steps for loading and printing on rolls.
Follow these steps to load and print on rolls.

Note
• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper

Sizes.") ➔P.328   (See "Types of Paper.") ➔P.328

• If you prefer to wait for the ink to dry after printing and simply eject the document, you can deactivate automatic
cutting and cut the paper manually.  (See "Specifying the Cutting Method for Rolls.") ➔P.351
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1
 

Turn the printer on.  (See "Turning the Printer On and Off.") ➔P.17

2
 

Load the roll on the Roll Holder.  (See "Attaching the
Roll Holder to Rolls.") ➔P.338

3
 

Load the roll in the printer.  (See "Loading Rolls in the
Printer.") ➔P.341
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4
 

Select the type of paper.  (See "Changing the Type of Pa-
per.") ➔P.343

Note
• If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll

length after the type of paper.  (See "Specifying the Paper Length.") ➔P.345

5 Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) ➔P.144
• Specifying Paper in the Printer Driver (Mac OS) ➔P.251

6 Send the print job.

• Printing in Windows ➔P.22
• Printing from Mac OS ➔P.23

The printer now starts printing the print job.
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Loading and Printing on SheetsLoading and Printing on Sheets
These are the basic steps for loading sheets and then printing.
Follow the steps below to load and print on sheets.

Note
• For details on supported types and sizes of paper, see Paper Sizes or the Paper Reference Guide.  (See "Paper

Sizes.") ➔P.328   (See "Types of Paper.") ➔P.328

1
 

Turn the printer on.  (See "Turning the Printer On and Off.") ➔P.17

2 Complete settings in the printer driver for the type of paper and other details.

• Specifying Paper in the Printer Driver (Windows) ➔P.144
• Specifying Paper in the Printer Driver (Mac OS) ➔P.251

3 Send the print job.

• Printing in Windows ➔P.22
• Printing from Mac OS ➔P.23
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4
 

Load the sheet.  (See "Loading Sheets in the Print-
er.") ➔P.358

The printer now starts printing the print job.

Printing in WindowsPrinting in Windows
Print from the application menu.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while printing may

interrupt the transfer of print data and affect printing quality.

1 In the source application, select Print from the File menu to display the dialog box for printing conditions.

2 After confirming that the printer is selected in the dialog box, click Print or OK to start printing.

Note
• The appearance of the dialog box varies depending

on the software application. In most cases, the dia-
log box includes basic printing options and enables
you to choose the printer, specify the range of pa-
ges, number of copies, and so on.
Example: Print dialog box displayed by the applica-
tion

• If another printer is selected, select the printer you want to use under Select Printer or in the dialog box
displayed after clicking Printer.

 

Settings for many printing methods (including enlarged or reduced printing, borderless printing, and so on) are dis-
played in the printer driver dialog box. There are two ways to access the printer driver dialog box, as follows.

• From the application
 (See "Accessing the Printer Driver Dialog Box from Applications .") ➔P.148

• From the operating system menu
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu .") ➔P.149
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Printing from Mac OSPrinting from Mac OS
Print from the application menu after registering the printer.

Important
• We recommend exiting unnecessary applications before printing. Running several applications while printing may

interrupt the transfer of print data and affect printing quality.

Registering the printer
The printer needs to be registered in Print & Scan (identified as Printers & Scanners or Print & Fax in other ver-
sions of Mac OS X) in System Preferences before printing.
For instructions on registering the printer, see "Configuring the Printer Driver Destination ." ➔P.453

Important
• During this setup process, the printer will not be listed among available printers if it is off or disconnected.

Printing from the application software

1 In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the range of

pages, number of copies, and so on.

2
 

Select the printer in the Printer list.

3
 

Click Print to start printing.
As shown in the following illustration, you can switch
to other panes in this dialog box to complete settings
for various methods of printing, including enlarged
and reduced printing, borderless printing, and so on.
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Canceling print jobsCanceling print jobs
Canceling Print Jobs from the Control Panel .................................................................................................... 24

Canceling Print Jobs from Windows ................................................................................................................. 25
Canceling Print Jobs from Mac OS ...................................................................................................................25

Canceling Print Jobs from the Control PanelCanceling Print Jobs from the Control Panel
To cancel printing or reception of print jobs, press the Stop button on the Control Panel.

When you press the Stop button during printing, printer operation varies depending on the current status.

• If you press the Stop button before printing starts
Pressing the Stop button before printing starts will display a confirmation message. To cancel the print job,
select Yes.

• If you press the Stop button during printing
Pressing the Stop button during printing will display a confirmation message. To cancel the print job immedi-
ately, select Yes.
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Canceling Print Jobs from WindowsCanceling Print Jobs from Windows
In the printer window, you can cancel jobs that are being sent to the printer.
Using imagePROGRAF Status Monitor, you can cancel print jobs that have already been received by the printer
or that are currently being printed.

1 Click the printer icon in the taskbar to display the printer window.

Note
• You can proceed from the folder for configuring the printer settings in the OS you are using.

For example, in Windows 7, open the Devices and Printers window from the start menu and double-
click the printer icon.

2
 

Right-click the job to cancel and select Cancel.

3 If the job to cancel is not shown in the printer window (that is, if the print data has already been received by
the printer), double-click the taskbar icon to display imagePROGRAF Status Monitor.

4
 

On the Printer Status sheet, click Cancel Job.

Note
• The screen may differ slightly depending on the model you are using.

Canceling Print Jobs from Mac OSCanceling Print Jobs from Mac OS
In the printer window, you can cancel jobs that are being sent to the printer.
Otherwise, you can cancel jobs from imagePROGRAF Printmonitor if they have been received by the printer or are
currently being printed.

Note
• Print jobs are shown in the printer window while they are being sent from the computer. After transmission, jobs are

not displayed even during printing.

• Print jobs are displayed in the imagePROGRAF Printmonitor window from the moment the printer starts receiving
the print data until the moment printing is finished. They are not displayed before print data is sent to the printer,
even if the computer has started preparing the print data.

1 Click the printer icon in the Dock to display the printer window.
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2
 

Either click × for the job to cancel printing or select
the job to cancel printing and then click Delete to de-
lete the job.

3
 

If there are no jobs to stop in the printer window (if
sending the print data to the printer has finished), ei-
ther click Settings, Utility, and then Open Printer
Utility, or click Utility to open the imagePROGRAF
Printmonitor.

4
 

Select the print job to cancel and click  to delete
the print job.

Note
• The screen may differ slightly depending on the model you are using.

The job sent to the printer is canceled.

5 Exit imagePROGRAF Printmonitor. In the printer window, click Resume or Resume Printer.

Important
• Always follow these steps if you cancel print jobs from imagePROGRAF Printmonitor. If you do not re-

start job processing, the next job cannot be printed.
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Pausing PrintingPausing Printing
Pausing PrintingPausing Printing

During printing, if you set Pause Print in the Control Panel menu to On, printing is stopped at that point and the
printer enters a state in which printing is paused.  (See "Control Panel Display.") ➔P.400
Printing from the job queue is not possible in this state.
To restore normal operation after this state, set Pause Print to Off.

Note
• In the following cases, the status is cleared even if you do not set Pause Print to Off, and printing from the job

queue resumes.

• When paper is advanced
• When you execute Chg. Paper Type in the Paper Menu

1
 

During printing, on the Tab Selection screen of the Control Panel,
press ◀ or ▶ to select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Pause Print, and then press the OK button.

4 Press ▲ or ▼ to select On or Off, and then press the OK button.
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Choosing Paper for PrintingChoosing Paper for Printing
Choosing a Paper for Printing ...........................................................................................................................30

➔ Changing the Type of Paper ................................................................................................................ 343

Specifying Paper in the Printer Driver ................................................................................................................30
➔ Specifying Paper in the Printer Driver (Windows) ................................................................................. 144
➔ Specifying Paper in the Printer Driver (Mac OS) ................................................................................... 251

Choosing a Paper for PrintingChoosing a Paper for Printing
Select the appropriate media type from the printer control panel or printer driver to match the paper loaded in the
printer. The appropriate media type differs between the case of genuine Canon paper or Canon feed confirmed pa-
per and the case of paper other than Canon feed confirmed paper. Select the media type by following the descrip-
tion below.
For information on how to select the media type in the printer control panel, see Changing the Type of Pa-
per ➔P.343 , and for information on how to select the media type in the printer driver, see Specifying Paper in the
Printer Driver (Windows) ➔P.144  or Specifying Paper in the Printer Driver (Mac OS) ➔P.251 .

Important
• If you use paper other than Canon feed confirmed paper, Canon provides absolutely no guarantees regarding

print quality or paper feed properties.

Note
• Genuine Canon paper and Canon feed confirmed paper are detailed in Paper Reference Guide.

• An error message is displayed on the printer Control Panel if the media type specified in the printer driver does not
match the media type specified in the printer. Although you can print under these conditions, the printing results
may not be suitable.

• Genuine Canon paper or Canon feed confirmed paper
For genuine Canon paper or Canon feed confirmed paper, select the settings that are optimized for that type of
paper. For more information on the settings for genuine Canon paper or Canon feed confirmed paper, see
"Displaying the Paper Reference Guide." ➔P.331

• Paper other than Canon feed confirmed paper
For paper other than Canon feed confirmed paper, printing can be performed easily by selecting the existing
settings provided by the printer control panel or printer driver. For details, see "Using Paper Other Than Genu-
ine Paper and feed confirmed Paper." ➔P.330

Specifying Paper in the Printer DriverSpecifying Paper in the Printer Driver
If you replace the paper, complete the printer driver settings for the paper type and size.
For instructions on configuring paper settings in the printer driver, refer to the following topics, as appropriate for
your computer and operating system.

• Specifying Paper in the Printer Driver (Windows) ➔P.144
• Specifying Paper in the Printer Driver (Mac OS) ➔P.251
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Printing Photos and Office DocumentsPrinting Photos and Office Documents
Printing Photos and Images ............................................................................................................................. 31

Printing Photos and Images (Windows) ....................................................................................................... 31
Printing Photos and Images (Mac OS) ......................................................................................................... 33

Printing Office Documents ................................................................................................................................ 35
Printing Office Documents (Windows) ..........................................................................................................35
Printing Office Documents (Mac OS) ........................................................................................................... 36

Using PosterArtist to Compose Originals .......................................................................................................... 38

Printing Photos and ImagesPrinting Photos and Images
By selecting the following Print Target from Easy Settings of the printer driver, you can easily configure the print-
ing of illustrations and photos.

Print Target Description
Photo (Color) Print photographic images from digital cameras with an optimal

setting.

Poster An optimal setting for posters. Print in vivid colors with impact
and high saturation.

Faithful Color Reproduction Print with minimum color difference. Suitable for printing scan-
ner images and when print results are too vivid.

Important
• Depending on the Media Type setting, some Print Target options may not be available.

Note
• You can check the settings values for each print target by clicking View Settings.

• You can also fine-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for Print-
ing." ➔P.54

For instructions on printing photos and images, refer to the following topics, as appropriate for your computer and
operating system.

• Printing Photos and Images (Windows) ➔P.31
• Printing Photos and Images (Mac OS) ➔P.33

Printing Photos and Images (Windows)Printing Photos and Images (Windows)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Premium Glossy Paper 2 280
• Roll paper width: 10 inches (254.0 mm)

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Premium Glos-
sy Paper 2 280.
In the AMedia Type, choose the type of paper used for printing, such as Glossy Paper, Canon Coated
Paper, and so on. Make sure the paper you select is loaded in the printer.

Note
• The paper type setting in the printer driver and related software (as well as on the Control Panel ) is upda-

ted when you install the Media Configuration Tool from the User Software CD-ROM or if you change pa-
per information by using the Media Configuration Tool. For details, see "Media Configuration Tool (Win-
dows)." ➔P.369

5 After confirming that DEasy Settings is selected, click Photo (Color) in the EPrint Target list.

Note
• You can check the settings values selected in the EPrint Target list by clicking GView Settings.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click
10"x12".

8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, 10-in. Roll (254.0mm).

10 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings ." ➔P.142
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11 Confirm the print settings and print as desired.

Note
• For instructions on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Photos and Images (Mac OS)Printing Photos and Images (Mac OS)
This topic describes how to print photos based on the following example.

• Document: Photo image from a digital camera
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll paper
• Paper type: Canon Premium Glossy Paper 2 280
• Roll paper width: 10 inches (254.0 mm)

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, click the size of the original. In this case, click 10"x12".

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.
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6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Premium Glos-
sy Paper 2 280.
Make sure the paper you select is loaded in the printer.

Note
• The types of paper indicated in the printer driver and related software (as well as on the Control Panel)

are updated when you install the Media Configuration Tool from the User Software CD-ROM or if you
change paper information by using the Media Configuration Tool. For details, see "Media Configuration
Tool (Mac OS)." ➔P.382

8 After confirming that DEasy Settings is selected, click Photo (Color) in the EPrint Target list.

Note
• For information on settings optimized for printing photos and images, see "Printing Photos and Im-

ages." ➔P.31

• You can check the settings values selected in the EPrint Target list by clicking GView set..

9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.
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12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, 10 in. (254.0mm) is
selected.

13 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings ." ➔P.250

14 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Printing Office DocumentsPrinting Office Documents
By selecting Office Document from Easy Settings of the printer driver, you can easily configure settings for print-
ing office documents.

Print Target Description
Office Document Setting optimized for printing general office documents such as

materials for distribution so that they can be viewed easily.

Note
• You can check the settings values for each print target by clicking View Settings.

• You can also fine-tune these values as needed. (Advanced Settings)
For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for Print-
ing." ➔P.54

Printing Office Documents (Windows)Printing Office Documents (Windows)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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5 After confirming that DEasy Settings is selected, click Office Document in the EPrint Target list.

Note
• You can check the settings values selected in the EPrint Target list by clicking GView Settings.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4.

8 Click Manual in the LPaper Source list.

9 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings ." ➔P.142

10 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Office Documents (Mac OS)Printing Office Documents (Mac OS)
This topic describes how to print office documents based on the following example.

• Document: Office document created using word-processing or spreadsheet programs
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large
Margins).

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 After confirming that DEasy Settings is selected, click Office Document in the EPrint Target list.

Note
• You can check the settings values selected in the EPrint Target list by clicking GView set..
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9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Click Manual in the APaper Source list.

12 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings ." ➔P.250

13 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Using PosterArtist to Compose OriginalsUsing PosterArtist to Compose Originals
You can print a variety of source documents from word-processing or spreadsheet programs or screen shots from
web browsers after composing an original with them using PosterArtist.
This topic describes how to use PosterArtist to compose originals from multiple applications, creating a poster lay-
out for printing.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box. (See "Accessing the Printer
Driver Dialog Box from Applications (Windows).") ➔P.148

3
 

Make sure the Main sheet is displayed.
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4
 

Click the Layout tab to display the Layout sheet.

5 Select the APage Layout check box.

6 Click in the Edit Using PosterArtist in the APage Layout list.

Note
• This function cannot be used with a 64-bit version OS.

7
 

When you attempt to print, PosterArtist starts up and
the PageCapture window is displayed. (At this point,
the document will not be printed yet.)

8 Choose the page to load in PosterArtist.

9 Edit and rearrange the image in the PosterArtist window as desired.
Without closing the PosterArtist window, repeat steps 1-8 to arrange originals from multiple applications on
the same page.

Note
• For details on how to edit and sort images, refer to the PosterArtist Manual.

10 Print from the PosterArtist menu.
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Printing CAD DrawingsPrinting CAD Drawings
Using this printer, you can print fine lines and text clearly and sharply. It's easy to produce highly precise drawings
from CAD applications.
For instructions on CAD printing, refer to the following topics, as appropriate for your computer and operating sys-
tem.

• Printing Line Drawings and Text (Windows) ➔P.41
• Printing Line Drawings and Text (Mac OS) ➔P.42

Printing Line Drawings and TextPrinting Line Drawings and Text
Printing is easy when you simply choose the type of original to print.

• Easy Settings
Simply choose the printing application in the list for optimal printing results.

• Print Target
Choose presets that match the type of document to be printed.

Print targets for line drawings and text
Print Target Description

CAD (Color Line Drawing) Settings optimized to print intricate lines in CAD drawings clear-
ly.

CAD (Monochrome Line
Drawing )

Settings optimized to print black lines in CAD drawings clearly.

Perspective, GIS Settings optimized for printing 3D CAD drawings, perspective
drawings, and maps, including GIS maps.

Note
• You can check the settings values for each print target by clicking View Settings.

• You can also fine-tune these values as needed. ( Advanced Settings )
For details on Advanced Settings, see "Giving Priority to Particular Graphic Elements and Colors for Print-
ing." ➔P.54

• Print Quality
Choose the print quality.
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The printing mode is determined by a combination of the print quality and resolution.
Print Quality Description

Highest A setting for printing at the highest resolution when quality is most important. Printing
takes longer and consumes more ink than in other modes, but this mode offers superior
printing quality.

High Choose this setting to print at high resolution when quality is most important.
Printing takes longer and consumes more ink than in Standard or Fast modes, but this
mode offers exceptional printing quality.

Standard Choose this setting to print at standard resolution when quality and speed are both impor-
tant.
Printing takes less time than in Highest or High mode.

Fast Choose this setting to print faster.
Printing in draft mode can help you work more efficiently when checking layouts.

For instructions on printing line drawings and text, refer to the following topics, as appropriate for your comput-
er and operating system.

• Printing Line Drawings and Text (Windows) ➔P.41
• Printing Line Drawings and Text (Mac OS) ➔P.42

Printing Line Drawings and Text (Windows)Printing Line Drawings and Text (Windows)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 After confirming that DEasy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome
Line Drawing ) in the EPrint Target list.

Note
• You can check the settings values selected in the EPrint Target list by clicking GView Settings.
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6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In APage Size, click the size of the original as specified in the application. In this case, click ISO A3.

8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).

10 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings ." ➔P.142

11 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Line Drawings and Text (Mac OS)Printing Line Drawings and Text (Mac OS)
This topic describes how to print line drawings based on the following example.

• Document: CAD drawing
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, click the size of the original. In this case, click ISO A3.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 After confirming that DEasy Settings is selected, click CAD (Color Line Drawing) or CAD (Monochrome
Line Drawing ) in the EPrint Target list.

Note
• You can check the settings values selected in the EPrint Target list by clicking GView set..
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9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A2/A3 (420.0mm)
is selected.

13 Specify additional printing conditions.
For details on available printing conditions, see "Printer Driver Settings ." ➔P.250

14 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

• You can conserve roll paper by configuring settings suitable for the document.
For details on how to conserve paper and print, see "Conserving Roll Paper by Rotating Originals 90 De-
grees ." ➔P.124

Printing from AutoCADPrinting from AutoCAD
Printer Driver Optimization Module for AutoCAD is software for printing optimally from AutoCAD with the printer
driver.
By optimally controlling the processing resolution of raster data and the memory to be used in image processing of
AutoCAD, printing superior in reliability and productivity is realized.
If you install Printer Driver Optimization Module for AutoCAD on a computer on which supported AutoCAD is instal-
led, it will be installed automatically.

Note
• Printer Driver Optimization Module for AutoCAD is applied automatically when you print from AutoCAD, and opti-

mal printing is performed.

• Printer Driver Optimization Module for AutoCAD can be used on Windows.

Confirming the Installation of Printer Driver Optimization Module for AutoCAD
You can confirm whether Printer Driver Optimization Module for AutoCAD is installed by the following method.

1 From the File menu of AutoCAD, select Print.
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2
 

The Printing dialog box is displayed.
Printer Driver Optimization Module for AutoCAD is in-
stalled if in Plotter of Printer/plotter this is dis-
played:iPFxxxx - Optimized driver - by Canon Inc..

Installation of Printer Driver Optimization Module for AutoCAD
If Printer Driver Optimization Module for AutoCAD is not installed, install it by the following method.

1 Insert User Software CD-ROM in the CD-ROM drive and start the installer.

2 In the Setup Menu window, click Install Individual Software.

3 Click Install of Printer Driver Optimization Module for AutoCAD.

4 Follow the instructions on the screen.

Specifying Colors and Printing CAD DrawingsSpecifying Colors and Printing CAD Drawings
You can complete color settings when Color (CAD) is selected in Color Mode.
Colors can be adjusted before printing as follows when Color Compatibility is selected.

Note
• Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print Priority to Line

Drawing/Text.

Color Compatibility
Color Setting Item

Color Setting Description
Color (CAD) 1 Print in standard colors.

Color (CAD) 2 Print with approximate colors emulating Canon iPF750, iPF755, iPF650, iPF655, iPF760,
iPF765.

Color (CAD) 3 Print with approximate colors emulating Canon iPF500, iPF600, iPF700, iPF510, iPF610,
iPF710, iPF605, iPF720, iPF810, iPF820, iPF815, iPF825.

Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors resembling colors produced by these
printers.

Color (CAD) 5 Print emulating the HP Designjet T1100, in colors resembling colors produced by this
printer.
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Important
• If you have selected Color (CAD) 2, Color (CAD) 3, Color (CAD) 4, or Color (CAD) 5, it is not possible to match

the colors and image quality produced by the specified printer exactly.

For instructions on configuring Color Compatibility, refer to the following topics.

• Specifying Colors and Printing CAD Drawings (Windows) ➔P.46

Specifying Colors and Printing CAD Drawings (Windows)Specifying Colors and Printing CAD Drawings (Windows)
You can complete color settings when Color (CAD) is selected in Color Mode.

Note
• Color (CAD) is displayed when you select Advanced Settings on the Main sheet and set Print Priority to Line

Drawing/Text.

1 Click start > Printers and Faxes (or Printers ).

2
 

Select the printer, and then display the printer proper-
ties dialog box.

3
 

Click the Device Settings tab to display the Device
Settings sheet.

4
 

ClickAColor Compatibility to display the Color Com-
patibility dialog box.

5 Select the desired color settings in theAColor Compatibility list.

Note
• For details on color settings, see "Specifying Colors and Printing CAD Drawings." ➔P.45

 

 

 

Specifying Colors and Printing CAD Drawings (Windows)                                                                                                                                        iPF785

                                                                                                                                                                                                                     User's Guide

  

Enhanced Printing O
ptions

Printing CAD Drawings

 46



For printing instructions, refer to the following topic.

• Choosing the Document Type and Printing Conditions ➔P.56

HP-GL/2 PrintingHP-GL/2 Printing
This printer supports printing using the original Canon GARO printer control language and printing using HP-GL/2
and HP RTL emulation to print in colors resembling the colors produced by printers from other companies.
The printer automatically switches to the corresponding processing depending on whether a GARO or HP-GL/2
and HP RTL emulation job is received.

Note
• GARO is an abbreviation of Graphic Arts Language with Raster Operations.

• HP-GL/2 is an abbreviation of Hewlett-Packard Graphics Language/2, and HP RTL is an abbreviation of Hewlett-
Packard Raster Transfer Language.

• Emulation is good for obtaining results similar to printing on other printers.

When printing from applications that support HP-GL/2 output, specify HP-GL/2 in the application's plotter output
settings.
HP-GL/2 and HP RTL emulation related settings such as the printer to emulate are configured from the printer Con-
trol Panel. (Refer to "Menu Structure ➔P.410 " and "Menu Settings ➔P.416 ")

Note
• For instructions on configuring these settings, refer to the software documentation.

It may not be possible to print jobs with excessively large amounts of data correctly.

• For information on CAD colors other than HP-GL/2 and HP RTL emulation, see "Menu Settings." ➔P.416
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Adjusting the Color in the Printer DriverAdjusting the Color in the Printer Driver
Color settings specified in the application for your documents are essentially given priority over other settings for
each print job, but further color adjustment is possible in the printer driver.

• Color Mode
Choose how the printer driver processes color, as desired.
The available options vary depending on the color mode.

Color Mode Description Color Adjustment
Color Print in color. You can select the color balance and color

matching functions.

Monochrome Print in grayscale. You can adjust the color balance.

Color (CAD) A color mode optimized for line drawings
(2D-CAD). Lines in red, yellow, and oth-
er colors are printed especially clearly.

You can adjust the color balance.

Monochrome (BK ink) A color mode for printing line drawings.
Only Black ink is used.

You can adjust the color balance.

Monochrome Bitmap Print in a color mode for CAD, using Col-
or Ink, with all non-white portions printed
in black.

No color adjustment is supported.

No color correction (*1) Prints without performing color-matching
in the printer driver.

You can adjust the color balance.

*1: If No color correction is selected, the Matching sheet / Matching pane is not displayed.

• Color Adjustment
You can adjust colors separately for images, graphics, and text documents.

Adjustment Item Description
Cyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

Magenta
Yellow
Gray Tone Adjust the grayscale, in a range from cool, blue tones to warm, red tones.

Brightness Adjust the brightness of printed images while keeping the darkest and lightest portions in-
tact.

Contrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color

adjustment target from Image, Graphics, and Text.

• Matching
You can choose the color-matching mode and method.
By adjusting the color-matching mode and method, you can make printed colors match the colors of on-screen
images more closely.
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Important
• If No color correction is selected under Color Mode, the Matching cannot be changed.

Matching Mode Description Remarks
Driver Matching Mode Enables printing of optimal color tones

using a driver specific color profile.
You should normally select this mode.

ICC Matching Mode Enables color matching using ICC pro-
files.
Select this if you want to print by specify-
ing the input profile, printer profile, and
matching method in detail.

This allows you to use ICC profiles for dig-
ital cameras and scanners, ICC profiles
created using the profile creation tool, etc.

Host ICM Mode Enables color matching by the host com-
puter using the ICM function of Win-
dows.
Select this if you want to print from an
application that supports the ICM func-
tion.

Available when using Windows.

ColorSync Enables color matching by using the
ColorSync function of Mac OS.
Select this if you want to perform soft
proofing using ColorSync before printing.

Available when using Mac OS.
To select ColorSync, choose ColorSync
on the Color Matching panel.

Matching Method Description Remarks
Auto Color-matching optimized for images,

graphics, or text.
The available options and their display or-
der vary depending on your selected col-
or-matching mode, as well as the operat-
ing system.

Perceptual Color-matching optimized for printing
typical photos attractively. Smooth gra-
dation is a feature. This is also an easy-
to-use mode when performing color ad-
justment using application software.

Colorimetric Color-matching optimized for printing im-
age data with accurate colors in input
color space. This is the easiest-to-use
mode when you want to adjust the color
and print. However, gradation may be
lost for colors of wider range than the
color reproduction range of the printer.
Generally, this is also called relative col-
orimetric.

Colorimetric (No Wht-pnt Corr) The processing method of color-match-
ing is identical to Colorimetric. Use this
when you want to further reproduce the
target paper material color of the image
data. Generally, this also is called abso-
lute colorimetric

Saturation Color-matching optimized for printing
posters, etc., vividly.

For instructions on color adjustment, refer to the following topics, as appropriate for your computer and operat-
ing system.

• Fine-Tuning Colors of Photos and Images (Windows) ➔P.49
• Fine-Tuning Colors of Photos and Images (Mac OS) ➔P.52

Fine-Tuning Colors of Photos and Images (Windows)Fine-Tuning Colors of Photos and Images (Windows)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-
tune the color tone of photos before printing.

1 Choose Print in the application menu.
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2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.

5
 

Click DAdvanced Settings to switch the print mode.

6 Click Color in the GColor Mode list.

7
 

Click HColor Settings to display the Color Settings dia-
log box.

8 On the Color Adjustment sheet, adjust the color tones, brightness, and so on as desired.
Adjustment Item Description

DCyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

EMagenta
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Adjustment Item Description

FYellow Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

GGray Tone Adjust the gray tone. Choose cool black (tinged with blue), pure black (neutral), warm
black (tinged with red), and so on.

HBrightness Adjust the brightness of printed images while keeping the darkest and lightest portions
intact.

IContrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

JSaturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color

adjustment target from Image, Graphics, and Text.

9 Close the Color Settings dialog box.

10
 

Click the Page Setup tab to display the Page Setup
sheet.

11 Confirm the settings of APage Size, LPaper Source, and so on.

12 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145
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Fine-Tuning Colors of Photos and Images (Mac OS)Fine-Tuning Colors of Photos and Images (Mac OS)
You can specify your own print settings instead of using the Print Target presets. This topic describes how to fine-
tune the color tone of photos before printing.

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 Choose the original size in the CPaper Size list.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded.
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8
 

Click DAdvanced Settings to switch the print
mode.

9 Click Color in the HColor Mode list.

10
 

Click ISet to display the Color Settings dialog box.

11 On the Color Adjustment pane, adjust the color tones, brightness, and so on as desired.
Adjustment Item Description

DCyan Fine-tune color tones by adjusting the levels of Cyan, Magenta, and Yellow.

EMagenta

FYellow

GGray Tone Adjust the gray tone. Choose cool black (tinged with blue), pure black (neutral), warm
black (tinged with red), and so on.

HBrightness Adjust the brightness of printed images while keeping the darkest and lightest portions
intact.

IContrast Adjust the contrast of the darkest and lightest portions relative to each other.
For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

JSaturation Adjust the level of color saturation, in a range from subdued to vivid.

Note
• Click Object Adjustment to open the Object Adjustment dialog box, which allows you to select the color

adjustment target from Images, Graphics, and Text.
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12 Click OK to close the Color Settings dialog box.

13
 

Access the Page Setup pane.

14 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Giving Priority to Particular Graphic Elements and Colors for PrintingGiving Priority to Particular Graphic Elements and Colors for Printing
You can specify detailed print settings as desired for the quality level, colors, and other criteria.

• Advanced Settings
For printing results that appear just as expected for your original, you can specify which graphic elements and
colors to prioritize for printing.

Note
• Easy Settings are also available, providing convenient presets. To use the presets, simply choose the print-

ing application.
For details on Easy Settings, refer to the following topics.

• Printing Photos and Images ➔P.31
• Printing Line Drawings and Text ➔P.40
• Printing Office Documents ➔P.35

• Print Priority
Choose the graphic elements that you want to emphasize for printing.

Print Priority (*1) Description
Image A setting for posters or other documents made up mainly of photos or images, or for em-

phasizing photos or images in printed documents.

Line Drawing/Text Choose this setting for CAD drawings made up mainly of intricate lines, or wall newspa-
pers and other notices with a large amount of text. Suitable for emphasizing detailed text
in printed documents.
However, the quality may not be sufficient when printing photos or images that require a
lot of color coverage. In this case, choose Image instead.

Office Document Choose this setting for better legibility of documents combining text and graphics, such as
documents and presentation material created with typical office applications.

*1: Options suitable for the selected type of paper are listed under Print Priority.

• Print Quality
Choose the print quality.
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The printing mode is determined by a combination of the print quality and resolution.
Print Quality (*1) Description Print Priority

Highest A setting for printing at the highest resolution
when quality is most important. Printing takes lon-
ger and consumes more ink than in other modes,
but this mode offers superior printing quality.

Image

High Choose this setting to print at high resolution
when quality is most important.
Printing takes longer and consumes more ink than
in Standard or Fast modes, but this mode offers
exceptional printing quality.

Image
Line Drawing/Text

Standard Choose this setting to print at standard resolution
when quality and speed are both important.
Printing takes less time than in Highest or High
mode.

Image
Line Drawing/Text
Office Document

Fast Choose this setting to print faster.
Printing in draft mode can help you work more effi-
ciently when checking layouts.

Image
Line Drawing/Text

*1: Options suitable for the selected Print Priority are listed under Print Quality.

• Color Settings
Setting Item Options Description

Color Mode (*1) Color
Monochrome
Color (CAD)
Monochrome (BK ink)
Monochrome Bitmap
No color correction

Choose whether to print in color or monochrome.
 (See "Adjusting the Color in the Printer Driv-
er.") ➔P.48

Color Adjustment Cyan
Magenta
Yellow
Gray Tone
Brightness
Contrast
Saturation

You can adjust the levels of cyan, magenta, and
yellow as well as the brightness, contrast, satura-
tion, and gray tones.
If you choose Monochrome or Monochrome (BK
ink) in Color Mode only Brightness and Con-
trast can be adjusted.
Image, Graphics, and Text are available as Ob-
ject Adjustment options.

Color-Matching Modes Driver Matching Mode
ICC Matching Mode
Host ICM Mode (Windows)
ColorSync (Mac OS)

Choose the color-matching mode.

Color-Matching Method (*2) Auto
Perceptual
Colorimetric
Saturation

Choose the color-matching method. The available
options vary depending on your selection in Col-
or-Matching Mode.

Gamma 2.2
1.8

You can adjust the gradation of intermediate tones
in an image.
You can select only after Driver Matching Mode
has been selected in Matching Mode.

*1: Options suitable for the selected Print Priority are listed under Color Mode.
*2: The order of options displayed varies depending on the operating system.

• Enhancing printing quality
Setting Item Description

Highest quality This prints at the highest resolution. Printing takes longer and consumes more ink than in
other modes, but this mode offers superior printing quality.

Thicken Fine Lines Prints making fine lines appear thicker.

Sharpen Text Choose this option to print intricate text more distinctly.
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Setting Item Description
Reduce Print Unevenness (*1) Choose this option to counteract uneven printing.

Unidirectional Printing Prints by suppressing color variations and misaligned ruled lines. However, this takes
more time than regular printing.

Economy Printing When this mode is selected, less ink is consumed than in regular printing, but the quality is
diminished.
Select this mode if you want to conserve ink when checking drawings, for example. De-
pending on the Media Type and Print Quality settings, this mode may not be available.

*1:Displayed in Mac OS.

Note
• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and select

the Unidirectional Printing check box.

For instructions on specifying the print quality and color settings before printing, refer to the following topics, as
appropriate for your computer and operating system.

• Choosing the Document Type and Printing Conditions (Windows) ➔P.56
• Choosing the Document Type and Printing Conditions (Mac OS) ➔P.58

Choosing the Document Type and Printing Conditions (Windows)Choosing the Document Type and Printing Conditions (Windows)
You can specify your own print settings instead of using the Print Target presets. As an example, this topic de-
scribes how to print CAD drawings as clearly as possible, with sharp lines and text.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.
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5
 

Click DAdvanced Settings to switch the print mode.

6 Click Line Drawing/Text in the EPrint Priority list.

7 Click High (1200dpi) in the FPrint Quality list.

Note
• Options displayed in the FPrint Quality list vary depending on the paper type.

8 Click Color (CAD) in the GColor Mode list.

9 To adjust the color, click HColor Settings.

Note
• For instructions on adjusting color, see "Adjusting the Color in the Printer Driver." ➔P.48

10 Select the KSharpen Text check box.

11
 

Click the Page Setup tab to display the Page Setup
sheet.

12 Confirm the settings of APage Size, LPaper Source, and so on.

13 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

 

 

iPF785                                                                                                                            Choosing the Document Type and Printing Conditions (Windows)

User's Guide                                                                                                                                                                                                                     

  

Enhanced Printing O
ptions

Adjusting Im
ages

57  



Choosing the Document Type and Printing Conditions (Mac OS)Choosing the Document Type and Printing Conditions (Mac OS)
You can specify your own print settings instead of using the Print Target presets. This topic describes how print
photographic images in monochrome.

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 Choose the original size in the CPaper Size list.

4 Click FOK to close the dialog box.

5 In the application menu, choose Print.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded.
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8
 

Click DAdvanced Settings to switch the print
mode.

9 Click Image in the EPrint Priority list.

10 Click High (600dpi) in the FPrint Quality list.

Note
• Options displayed in the FPrint Quality list vary depending on the paper type.

11 Click Monochrome in the HColor Mode list.

12 To adjust the brightness and contrast, click ISet.

Note
• For instructions on adjusting brightness and contrast, see "Adjusting the Color in the Printer Driv-

er." ➔P.48

13
 

Access the Page Setup pane.

14 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Printing enlargements or reductionsPrinting enlargements or reductions
Resizing Originals to Match the Paper Size .......................................................................................................60

Resizing Originals to Match the Paper Size (Windows) ................................................................................ 60

Resizing Originals to Fit the Roll Width ..............................................................................................................62
Resizing Originals to Fit the Roll Width (Windows) ....................................................................................... 62
Resizing Originals to Fit the Roll Width (Mac OS) ......................................................................................... 63

Resizing Originals by Entering a Scaling Value .................................................................................................. 65
Resizing Originals by Entering a Scaling Value (Windows) ............................................................................ 66
Resizing Originals by Entering a Scaling Value (Mac OS) ..............................................................................67

Resizing Originals to Match the Paper SizeResizing Originals to Match the Paper Size
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

For instructions on printing with resizing to fit the paper size, refer to the following topics.

• Resizing Originals to Match the Paper Size (Windows) ➔P.60

Note
• To print with resizing to fit the paper size on Mac OS, use Scale to fit paper size in the Paper Handling

panel provided by the OS.
For more information, see the Mac OS User Manual.

• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-
age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.

Resizing Originals to Match the Paper Size (Windows)Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before printing to match the paper size, based on the following exam-
ple.

• Document: Any Type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
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• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.  (See "Accessing the Print-
er Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the printing application in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).

9 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4.

10 Select the CEnlarged/Reduced Printing check box.

11 Select the DFit Paper Size check box.

12 Click ISO A3 in the GPaper Size list.
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13 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Resizing Originals to Fit the Roll WidthResizing Originals to Fit the Roll Width
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width, as desired.

Resizing Originals to Fit the Roll Width (Windows)Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before printing to match the roll width, based on the following exam-
ple.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.
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4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the printing application in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 Select and click a roll paper in the LPaper Source list.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4 or Letter (8.5"x11").

9 Select the CEnlarged/Reduced Printing check box.

Note
• If the CEnlarged/Reduced Printing check box is

not displayed on the Page Setup sheet, clear the
BBorderless Printing check box.

 

10 Click EFit Roll Paper Width.

Note
• After you click EFit Roll Paper Width, the Information dialog box is displayed. Select the width of the

loaded roll in the Roll Paper Width list and click OK.

• Make sure the roll paper width you specify matches the width of the loaded roll.

11 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Resizing Originals to Fit the Roll Width (Mac OS)Resizing Originals to Fit the Roll Width (Mac OS)
This topic describes how to enlarge originals before printing to match the roll width, based on the following exam-
ple.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
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• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 Make your selection in the EPrint Target list.

9 Make your selection in the FPrint Quality list.
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10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, 16 in. (406.4mm) is
selected.

13 Select the DEnlarged/Reduced Printing check box.

14 Click FFit Roll Paper Width.

15 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Resizing Originals by Entering a Scaling ValueResizing Originals by Entering a Scaling Value
You can freely adjust the size of originals by enlarging or reducing them as desired.

• Enlarged/Reduced Printing
Enlarge or reduce the original in the printer driver, as desired.

• Scaling
Enlarge or reduce originals by a particular amount, as desired.

For instructions on entering a scaling value to resize originals, refer to the following topics, as appropriate for
your computer and operating system.

• Resizing Originals by Entering a Scaling Value (Windows) ➔P.66
• Resizing Originals by Entering a Scaling Value (Mac OS) ➔P.67

Note
• For better printing results when enlarging photos from a digital camera in TIFF or JPEG format, use an im-

age-editing application software such as Adobe Photoshop to specify an image resolution of 150 dpi or more
at actual size.
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Resizing Originals by Entering a Scaling Value (Windows)Resizing Originals by Entering a Scaling Value (Windows)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

Important
• In borderless printing, you cannot resize originals by entering a scaling value.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the printing application in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).
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9 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4.

10 Select the CEnlarged/Reduced Printing check box.

11 Click ISO A4 in the GPaper Size list.

12 Click FScaling and enter 120.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portions off the bottom and

right edges of the paper will not be printed.

• If the original size after enlargement or reduction is
smaller than the paper size, the original is printed in
the upper-left corner. In this case, you can center
originals by selecting EPrint Centered on the Lay-
out sheet.

 

13 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Resizing Originals by Entering a Scaling Value (Mac OS)Resizing Originals by Entering a Scaling Value (Mac OS)
This topic describes how to enlarge originals before printing by entering a scaling value, based on the following
example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 Make your selection in the EPrint Target list.

9 Make your selection in the FPrint Quality list.
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10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A2/A3 (420.0mm)
is selected.

13 Select the DEnlarged/Reduced Printing check box.

14 Click GScaling and enter 120.

Note
• You can specify enlargement that exceeds the paper size, but in this case, the portion off the edge of the

paper will not be printed.

• If the original size after enlargement or reduction is smaller than the paper size, the original is printed in
the upper-left corner. In this case, you can center originals by selecting the JPrint Centered check box.

15 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Printing at full sizePrinting at full size
Printing on Oversize Paper ............................................................................................................................... 70

Printing at Full Size (Windows) .....................................................................................................................71
Printing at Full Size (Mac OS) ...................................................................................................................... 72

Borderless Printing at Actual Size ..................................................................................................................... 74
Borderless Printing at Actual Size (Windows) ............................................................................................... 75
Borderless Printing at Actual Size (Mac OS) ................................................................................................ 76

Printing on Oversize PaperPrinting on Oversize Paper
You can print all areas of the original at full scale by selecting the paper size from Oversize (sizes where the mar-
gins needed for printer operation have been added to the page size).
We recommend when printing with a focus on image.

Note
• If you prepare an original for printing without a margin and print it on paper of regular size, the image near the edge

will not be printed.

• Oversize
When printing on standard paper sizes, printing is performed by taking the margins necessary for printer oper-
ations inside the region of the original. (See "Print Area.") ➔P.623  For example, printing the A4 size (210 x 297
mm) original shown in Figure (b) gives the result as shown in Figure (a).
However, if Oversize paper is selected, printing is performed by taking the margins necessary for printer oper-
ations outside of the region of the original to give the result as shown in Figure (c).
The A4 size print as shown in Figure (b) can then be obtained by trimming the margins from the periphery after
printing.

Important
• When printing on Oversize paper, load paper larger than the page size—a size that includes the margin

required by the printer.

• Sheets: Load paper that is at least 10 mm (0.39 in) wider and 28 mm (1.10 in) higher than the page size

• Rolls:Load paper that is at least 10 mm (0.39 in) wider and 10 mm (0.39 in) higher than the page size

Note
• Paper larger than the maximum size supported by the printer cannot be used as paper for oversized printing.

 (See "Paper Sizes.") ➔P.328

• Oversized printing (selecting Oversize in Page Size) is only available in Windows.

• If you are performing oversized printing in Mac OS, you need to configure printing on non-standard paper
sizes.

• To specify a non-standard paper size in oversized printing, register the paper size as a Custom Paper Size.
Oversized printing is not available with Custom Size.  (See "Printing on Non-Standard Paper Sizes.") ➔P.95

For instructions on oversized printing, refer to the following topics, as appropriate for your computer and oper-
ating system.
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• Printing at Full Size (Windows) ➔P.71
• Printing at Full Size (Mac OS) ➔P.72

Printing at Full Size (Windows)Printing at Full Size (Windows)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 Click OSize Options to display the Paper Size Options dialog box.

7 In the Paper Size Options dialog box, select the Oversize check box in Display Series.

8 Click OK to close the Paper Size Options dialog box.

9 Click Oversize - ISO A4 in the APage Size list.

10 Select and click a roll paper in the LPaper Source list.
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11 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).

12 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing at Full Size (Mac OS)Printing at Full Size (Mac OS)
This topic describes how to print at full size based on the following example. (Oversized Printing)

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4 - Oversize.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.
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6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 Make your selection in the EPrint Target list.

9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A2/A3 (420.0mm)
is selected.

13 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Borderless Printing at Actual SizeBorderless Printing at Actual Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.
 

• Borderless printing is only available with rolls.

• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular widths.
 (See "Displaying the Paper Reference Guide.") ➔P.331

• Although it normally prints borderless on the top, bottom, left, and right (4-edge borderless), in the following
cases, it becomes borderless only on the left and right (2-edge borderless) because the top and bottom of the
printed image are not automatically cut.

• When paper where the borderless printing is described as two edges only in the Paper Reference Guide
(paper where printed image areas cannot be cut cleanly) is selected

• When the following settings are made in the printer control panel

• Cutting Mode is Manual
• CutDustReduct. is On

• When auto cut is configured as not performed in the printer driver
 

Important
• Borderless printing is not possible if details such as crop marks and margins are included as data on the periph-

ery of the original.

• If the length of the image to print is short, then since the roll paper is fed out to a prescribed length before cutting
in order to prevent cutting problems and ejection problems, the trailing edge of the roll paper might not be printed
borderless.

• These features cannot be used in combination with borderless printing: special page layouts, centering originals,
and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected while performing borderless print-
ing, Rotate Page 90 degrees (Conserve Paper) cannot be selected. Note that if borderless printing is possible,
then even if the original is rotated 90 degrees, it will be printed by automatically rotating the page by 90 degrees.

Choose the method of borderless printing that suits the original, as desired.

• Print Image with Actual Size
Prints originals at actual size, without enlarging or reducing them. We recommend when focusing on image
quality. You should create the original at a size larger by 3 mm on each side than the paper size.

Note
• Not all page sizes are available.

• When performing borderless printing without using Print Image with Actual Size, the image deteriorates
slightly because the image is automatically enlarged.

For instructions on borderless printing of photos and images at actual size, refer to the following topics, as ap-
propriate for your computer and operating system.

• Borderless Printing at Actual Size (Windows) ➔P.75
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• Borderless Printing at Actual Size (Mac OS) ➔P.76

Borderless Printing at Actual Size (Windows)Borderless Printing at Actual Size (Windows)
This topic describes how to print borderlessly at actual size based on the following example.

Important
• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at

the edges. If you require higher image quality, select No from the Automatic Cutting list in the Roll Paper Op-
tions dialog box. In this case, the paper can be printed without borders on the left and right sides only. Once
printed and cut, please cut the upper and lower bands with scissors.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 Create the original in the source application 3 mm (0.12 in) larger on each side than 254.0×304.8 mm (10 ×
12 in) —that is, 260.0×310.8 mm (10.2 × 12.2 in)

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on specifying

the margin, refer to the software documentation.

• The extra 3 mm (0.12 in) on each side will not be printed. Create the original so that it fits inside the paper
area to be printed on.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight
Coated Paper.

6 Select the print target in the EPrint Target list.

Important
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this kind of situation, change the ink drying time using the
following procedure.

• Click Advanced Settings in Media Type.

• Select an ink drying time in the list for the Between Pages setting of Drying Time.
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7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the source application. In this case, click
10"x12".

9 Select and click a roll paper in the LPaper Source list.

10
 

Select the BBorderless Printing check box to dis-
play the Information dialog box.

11 Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12 Click OK to close the Information dialog box.

13 In CBorderless Printing Method, click FPrint Image with Actual Size.

14 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Borderless Printing at Actual Size (Mac OS)Borderless Printing at Actual Size (Mac OS)
This topic describes how to print borderlessly at actual size based on the following example.

Important
• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at

the edges. If you require higher image quality, select No from the Automatic Cutting list in the Paper Detailed
Settings dialog box. In this case, the paper can be printed without borders on the left and right sides only. Once
printed and cut, please cut the upper and lower bands with scissors.

• Document: Any type
• Page size: 10 × 12 inches (254.0×304.8 mm)–Borderless
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• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, choose a paper size supported for borderless printing. Here, click 10"x12" - Bor-
derless.

Note
• Paper sizes supported for borderless printing are indicated by -Borderless.

4 Click FOK to close the dialog box.

5 In the application, create an original that takes up the entire space of the paper size.

6 Choose Print in the application menu.

7
 

Access the Main pane.
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8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight
Coated Paper.

9 Select the print target in the EPrint Target list.

Important
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this kind of situation, change the ink drying time in Between
Pages in the Paper Detailed Settings dialog box.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.
Select the paper width of the roll loaded in the printer for BRoll Width. In this case, 10 in. (254.0mm) is
selected.

12 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Borderless PrintingBorderless Printing
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Borderless Printing on Paper of Equivalent SizeBorderless Printing on Paper of Equivalent Size
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.
 

• Borderless printing is only available with rolls.

• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular widths.
 (See "Displaying the Paper Reference Guide.") ➔P.331

• Although it normally prints borderless on the top, bottom, left, and right (4-edge borderless), in the following
cases, it becomes borderless only on the left and right (2-edge borderless) because the top and bottom of the
printed image are not automatically cut.

• When paper where the borderless printing is described as two edges only in the Paper Reference Guide
(paper where printed image areas cannot be cut cleanly) is selected

• When the following settings are made in the printer control panel

• Cutting Mode is Manual
• CutDustReduct. is On

• When auto cut is configured as not performed in the printer driver
 

Important
• Borderless printing is not possible if details such as crop marks and margins are included as data on the periph-

ery of the original.

• If the length of the image to print is short, then since the roll paper is fed out to a prescribed length before cutting
in order to prevent cutting problems and ejection problems, the trailing edge of the roll paper might not be printed
borderless.

• These features cannot be used in combination with borderless printing: special page layouts, centering originals,
and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected while performing borderless print-
ing, Rotate Page 90 degrees (Conserve Paper) cannot be selected. Note that if borderless printing is possible,
then even if the original is rotated 90 degrees, it will be printed by automatically rotating the page by 90 degrees.

Choose the method of borderless printing that suits the original, as desired.
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• Fit Paper Size
Enlarge or reduce the original to match the size of the paper you are using.

Note
• The printer driver automatically enlarges originals 3 mm (0.12 in) past the dimensions of the paper on each

side. The 3 mm portion beyond the edge on each side is not printed.

For instructions on borderless printing of photos, images, and other documents to match the paper size, refer
to the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Match the Paper Size (Windows) ➔P.80

Note
• To perform borderless printing with resizing to fit the paper size on Mac OS, select borderless in Paper

Size and use Scale to fit paper size in the Paper Handling panel provided by the OS.
For more information, see the Mac OS User Manual.

Borderless Printing by Resizing Originals to Match the Paper Size (Windows)Borderless Printing by Resizing Originals to Match the Paper Size (Windows)
This topic describes how to enlarge originals before borderless printing to match the paper size, based on the fol-
lowing example.

Important
• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at

the edges. If you require higher image quality, select No from the Automatic Cutting list in the Roll Paper Op-
tions dialog box. In this case, the paper can be printed without borders on the left and right sides only. Once
printed and cut, please cut the upper and lower bands with scissors.

• Document: Any type
• Page size: 10×12 inches (254.0×304.8 mm)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on specifying

the margin, refer to the software documentation.

2 Choose Print in the application menu.
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3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight
Coated Paper.

6 Select the print target in the EPrint Target list.

Important
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this kind of situation, change the ink drying time using the
following procedure.

• Click Advanced Settings in Media Type.

• Select an ink drying time in the list for the Between Pages setting of Drying Time.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click
10"x12".

9 Select and click a roll paper in the LPaper Source list.
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10
 

Select the BBorderless Printing check box to dis-
play the Information dialog box.

11 Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12 Click OK to close the Information dialog box.

13 In CBorderless Printing Method, click DFit Paper Size.

14 Click Match Page Size in the GPaper Size list.

15 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Borderless Printing by Resizing Originals to Fit the Roll WidthBorderless Printing by Resizing Originals to Fit the Roll Width
Take advantage of borderless printing to print documents such as posters (made up mainly of photos or images)
without a surrounding margin, or border.
In regular printing, a margin required by the printer is added around the original. With borderless printing, you can
print documents without the margin, so that the printed image covers the entire surface of the paper.
 

• Borderless printing is only available with rolls.

• Paper you can use for borderless printing is restricted to particular types of paper and rolls of particular widths.
 (See "Displaying the Paper Reference Guide.") ➔P.331

• Although it normally prints borderless on the top, bottom, left, and right (4-edge borderless), in the following
cases, it becomes borderless only on the left and right (2-edge borderless) because the top and bottom of the
printed image are not automatically cut.

• When paper where the borderless printing is described as two edges only in the Paper Reference Guide
(paper where printed image areas cannot be cut cleanly) is selected

• When the following settings are made in the printer control panel

• Cutting Mode is Manual
• CutDustReduct. is On

• When auto cut is configured as not performed in the printer driver
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Important
• Borderless printing is not possible if details such as crop marks and margins are included as data on the periph-

ery of the original.

• If the length of the image to print is short, then since the roll paper is fed out to a prescribed length before cutting
in order to prevent cutting problems and ejection problems, the trailing edge of the roll paper might not be printed
borderless.

• These features cannot be used in combination with borderless printing: special page layouts, centering originals,
and printing cut lines on rolls.

• If Fit Paper Size or Print Image with Actual Size (Windows only) is selected while performing borderless print-
ing, Rotate Page 90 degrees (Conserve Paper) cannot be selected. Note that if borderless printing is possible,
then even if the original is rotated 90 degrees, it will be printed by automatically rotating the page by 90 degrees.

Choose the method of borderless printing that suits the original, as desired.

• Scale to fit Roll Paper Width
Enlarge or reduce the original as a whole to match the roll paper width.

Note
• You can combine this function with rotating pages 90 degrees before printing so that the original width (rela-

tive to portrait orientation) matches the roll paper width in borderless printing.

For instructions on borderless printing of photos, images, and other documents to match the roll paper width,
refer to the following topics, as appropriate for your computer and operating system.

• Borderless Printing by Resizing Originals to Fit the Roll Width (Windows) ➔P.83
• Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS) ➔P.85

Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)Borderless Printing by Resizing Originals to Fit the Roll Width (Windows)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the follow-
ing example.

Important
• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at

the edges. If you require higher image quality, select No from the Automatic Cutting list in the Roll Paper Op-
tions dialog box. In this case, the paper can be printed without borders on the left and right sides only. Once
printed and cut, please cut the upper and lower bands with scissors.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)

1 In the application, create an original that takes up the entire space of the paper size.

Note
• If you can specify the margin, as in Microsoft Word, set the margin at 0 mm. For instructions on specifying

the margin, refer to the software documentation.
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2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight
Coated Paper.

6 Select the print target in the EPrint Target list.

Important
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this kind of situation, change the ink drying time using the
following procedure.

• Click Advanced Settings in Media Type.

• Select an ink drying time in the list for the Between Pages setting of Drying Time.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4.

9 Select and click a roll paper in the LPaper Source list.
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10
 

Select the BBorderless Printing check box to dis-
play the Information dialog box.

11 Select the width of the loaded roll in the Roll Paper Width list—in this case, click 10-in. Roll (254.0mm).

12 Click OK to close the Information dialog box.

13 In CBorderless Printing Method, make sure EScale to fit Roll Paper Width is selected.

14 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS)Borderless Printing by Resizing Originals to Fit the Roll Width (Mac OS)
This topic describes how to enlarge originals before borderless printing to match the roll width, based on the follow-
ing example.

Important
• When borderless printing is used, the edge of the paper is cut during printing. Thus, ink density may be uneven at

the edges. If you require higher image quality, select No from the Automatic Cutting list in the Paper Detailed
Settings dialog box. In this case, the paper can be printed without borders on the left and right sides only. Once
printed and cut, please cut the upper and lower bands with scissors.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Canon Heavyweight Coated Paper
• Roll paper width: 10 inches (254.0 mm)
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

Note
• All sizes are available in borderless printing if you resize originals to fit the roll width.

4 Click FOK to close the dialog box.

5 In the application, create an original that takes up the entire space of the paper size.

6 Choose Print in the application menu.

7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Canon Heavyweight
Coated Paper.
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9 Select the print target in the EPrint Target list.

Important
• When you are using paper that takes longer for ink to adhere for borderless printing and the Cutter Unit

touches printing surfaces that are not dry yet, it may damage the paper or the edge of the document that
is cut, depending on frequency of use. In this kind of situation, change the ink drying time in Between
Pages in the Paper Detailed Settings dialog box.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, 10 in. (254.0mm) is
selected.

13 Select the DEnlarged/Reduced Printing check box.

14 Select the HBorderless Printing check box.
This ensures that FFit Roll Paper Width is automatically selected in DEnlarged/Reduced Printing.

15 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Printing banners or at other non-standard sizesPrinting banners or at other non-standard sizes
Printing Vertical or Horizontal Banners (Large-Format Printing) ......................................................................... 88
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Printing Vertical or Horizontal Banners (Large-Format Printing)Printing Vertical or Horizontal Banners (Large-Format Printing)
On this printer, large-format printing of up to 18.0 m is available using rolls.
If you use Print Plug-In for Office or PosterArtist, you can easily print maximum 18.0 m vertical or horizontal ban-
ners. (Refer to "Print Plug-In for Officefeatures (Windows)" ➔P.212  and "Using PosterArtist to Compose Origi-
nals" ➔P.38 .)
However, you may not be able to print 18.0 m due to restrictions in the settable document size according to the
application software.

Fit Roll Paper Width
To match the width of vertical and horizontal banners with the width of rolls, use the printer driver function for auto-
matically enlarging/reducing and printing.
For example, if you automatically enlarge a document created with application software such as Microsoft Word,
you can print the full width of the roll easily.

For instructions on printing vertical or horizontal banners, refer to the following topics, as appropriate for your com-
puter and operating system.

• Printing Vertical or Horizontal Banners (Large-Format Printing; Windows) ➔P.89
• Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS) ➔P.92

Important
• Before printing, check how much of the roll paper is left. If you have activated automatic detection of the remain-

ing roll paper, a warning message is displayed when there is not enough roll paper left.

• If not much ink is left, prepare replacement ink tanks.

• To print at a higher level of quality, in the printer driver, choose High or Highest in Print Quality, and choose
Unidirectional Printing as the direction of printing.
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Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)
By automatic enlargement of a document created with an application software by the printer driver, you can print
maximum 18.0 m vertical or horizontal banners.
However, you may not be able to print 18.0 m due to restrictions in the settable document size according to the
application software.
This topic describes how to print a banner about five times as long as the roll width based on the following exam-
ple.

• Document: A horizontal banner created in Microsoft Word
• Page size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 in (406.4 mm)

The print procedure is as follows.

1. Register a Custom Paper Size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Size.
Once you register Custom Paper Size, you then can select it repeatedly from the paper size list.
Custom Paper Size can be set up to 18.0 m.

2. In the application, create an original in the size you registered.

3. Print the banner, using the settings that correspond to banners.

Registering a Custom Paper Size
This example describes how to register a paper size that is horizontally elongated and suitable for banners in either
horizontal or vertical format.

1 Display the printer driver dialog box.  (See "Accessing the Printer Driver Dialog Box from the Operating
System Menu .") ➔P.149

2
 

Click the Page Setup tab to display the Page Setup
sheet.

3 Select and click a roll paper in the LPaper Source list.

4 Click OSize Options to display the Paper Size Options dialog box.

5 Enter a desired paper name in Custom Paper Size Name. My Horizontal Banner is used in this example.

6 In Units, click mm.

7 Under Paper Size, enter 100 in Width and 500 in Height.

8 Click Add to add the paper size of My Horizontal Banner.

9 Click OK to close the Paper Size Options dialog box.

 

iPF785                                                                                                                   Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)

User's Guide                                                                                                                                                                                                                     

  

Enhanced Printing O
ptions

Printing banners or at other non-standard sizes

89  



10 Close the printer driver dialog box.

Note
• Although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m. The setting of

Custom Size is disabled when you exit the application software.
For more information, see "Printing on Non-Standard Paper Sizes ." ➔P.95

Creating the banner in the application
Follow the steps below to create the banner in Microsoft Word using the Custom Paper Size you registered.

1 Start Microsoft Word.

2 Choose Page Setup from the File menu to display the Page Setup dialog box.

3 Under Paper Size, click the Custom Paper Size you registered—My Horizontal Banner in this example.

Important
• If My Horizontal Banner is not listed, make sure this printer is selected as the printer to use.

• In applications such as Microsoft PowerPoint that do not enable you to choose registered paper sizes,
use the custom paper size setting in Custom and specify 100×500 mm (3.9×19.7 in)

4 Set the printing orientation to horizontal.

5 Create the banner.

Printing the banner
Follow these steps to print the banner using the corresponding banner settings.

1 Choose Print in the Microsoft Word menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 After confirming that DEasy Settings is selected, click Poster in the EPrint Target list.
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6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size you registered, My Horizontal Banner.

8 Select the CEnlarged/Reduced Printing check box.

Note
• If the CEnlarged/Reduced Printing check box is

not displayed on the Page Setup sheet, clear the
BBorderless Printing check box.

 

9 Select and click a roll paper in the LPaper Source list.

10 After you click EFit Roll Paper Width, the Information dialog box is displayed.

11 Select the width of the loaded roll in the Roll Paper Width list. In this case, click 16-in. Roll (406.4mm),
and then click OK.

12 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

 

iPF785                                                                                                                   Printing Vertical or Horizontal Banners (Large-Format Printing; Windows)

User's Guide                                                                                                                                                                                                                     

  

Enhanced Printing O
ptions

Printing banners or at other non-standard sizes

91  



If printing is unsuccessful, you may be able to print after completing the following setting.

1
 

On the Layout sheet, click JSpecial Settings to
display the Special Settings dialog box.

2
 

In the FineZoom Settings list, click Yes.

Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS)Printing Vertical or Horizontal Banners (Large-Format Printing; Mac OS)
By automatic enlargement of a document created with an application software by the printer driver, you can print
maximum 18.0 m vertical or horizontal banners.
This topic describes how to print a banner about five times as long as the roll width based on the following exam-
ple.

• Document: An original designed for a horizontal banner
• Page Size: Non-standard (100×500 mm [3.9×19.7 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: 16 inches (406.4 mm)

The print procedure is as follows.

1. In the application, create an original in the format of a horizontal or vertical banner.

2. In Page Setup, register Custom Paper Sizes.
Once you register Custom Paper Sizes, you then can select it repeatedly from the paper size list.
Custom Paper Sizes can be set up to 18.0 m.

3. Print the banner, using the settings that correspond to banners.

Note
• The following instructions are for OS X v10.7. The method of setting up non-standard paper sizes varies depending

on the version and settings of Mac OS X.

Register a Custom Paper Sizes
This example describes how to register and print using a page size that is horizontally elongated and suitable for
banners in either horizontal or vertical format.

1 Create the document in the application.
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2
 

Choose Print in the application menu.

3 Select the printer in the APrinter list.

4
 

Click Manage Custom Sizes in the FPaper Size list
to display the Custom Paper Sizes dialog box.

5 Double-click Untitled in the list at left, and then enter a name for the page size you want to register. Here,
enter 100*500.
If the Untitled size is not listed at left, click + below the list.

6 Under Paper Size, enter 100 in Width and 500 in Height. Here, measurements are entered in millimeters.

7 Specify the margins by entering 3 in Non-Printable Area. Here, too, measurements are entered in millime-
ters.

8 Click OK to close the Custom Paper Sizes dialog box.

9 In the FPaper Size list, click the size of the original. In this case, click 100*500, the size you registered.

10 In GOrientation, click the icon of the document in landscape orientation.

11 If you configured the settings using the Page Attributes dialog box, click OK to close the dialog box.

Print the banner
Follow the steps below to print the banner using the corresponding banner settings.

1 Choose Print in the application menu.
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2
 

Access the Main pane.

3 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

4 Make your selection in the EPrint Target list.

5 Make your selection in the FPrint Quality list.

6
 

Access the Page Setup pane.

7 Select and click a roll paper in the APaper Source list.

8 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, 16 in. (406.4mm) is
selected.

9 Select the DEnlarged/Reduced Printing check box.

10 Click FFit Roll Paper Width.
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11 Confirm the print settings, and click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Printing on Non-Standard Paper SizesPrinting on Non-Standard Paper Sizes
For printing on non-standard size paper, first register the paper size in the printer driver.
Once you register a paper size, you then can select it repeatedly from the paper size list. The paper size can be set
up to 18.0 m.

Note
• In Windows, although you can even set Custom Size for the paper size, the maximum settable size is 3.2 m. The

setting of Custom Size is disabled when you exit the application software.

For instructions on specifying non-standard paper sizes for printing, refer to the following topics, as appropriate for
your computer and operating system.

• Printing on Non-Standard Paper Sizes (Windows) ➔P.95
• Printing on Non-Standard Paper Sizes (Mac OS) ➔P.98

Printing on Non-Standard Paper Sizes (Windows)Printing on Non-Standard Paper Sizes (Windows)
For printing on non-standard size paper, first register the paper size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Size.
Once you register Custom Paper Size, you then can select it repeatedly from the paper size list.
Custom Paper Size can be set up to 18.0 m.

Note
• Although you also can set Custom Size for the paper size temporarily, the maximum settable size is 3.2 m. Also,

the setting of Custom Size is disabled when you exit the application software.

Registering and Printing With a Custom Paper Size
This topic describes how to register a non-standard paper size by the name of 430 mm Square and print based on
the following example.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1 Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148
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4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded.

6 After confirming that DEasy Settings is selected, select from the EPrint Target list.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 Click OSize Options to display the Paper Size Options dialog box.

9 Enter a desired paper name in Custom Paper Size Name. 430 mm Square is used in this example.

10 Select mm in Units.

11 Enter 430 (16.9 in) in both Width and Height.

Note
• If you select the Fix the Ratio of the Width to Height check box, after you enter a value in either Width

or Height, the other value will be automatically applied based on the original aspect ratio.

12 Click Add to register 430 mm Square.

13 Click OK to close the Paper Size Options dialog box.

14 Click Manual in the LPaper Source list.

15 In the APage Size list, click the size you added,430 mm Square.
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16 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing by using Custom Size
This section describes how to print using Custom Size based on the following example.

• Document: Any Type
• Page size: Square of non-standard dimensions (430×430 mm [16.9×16.9 in])
• Paper: Sheets
• Paper type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

1 Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

2 Choose Print in the application menu.

3 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

4
 

Make sure the Main sheet is displayed.

5 In the AMedia Type list, select the type of paper that is loaded.

6 After confirming that DEasy Settings is selected, select from the EPrint Target list.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 Click Manual in the LPaper Source list.
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9 Click Custom Size in the APage Size list to display the Custom Size Settings dialog box.

10 Confirm that mm is selected in Units.

11 Enter 430 (16.9 in) in both Width and Height.

12 Click OK to close the Custom Size Settings dialog box.

13 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing on Non-Standard Paper Sizes (Mac OS)Printing on Non-Standard Paper Sizes (Mac OS)
For printing on non-standard size paper, first register the paper size in the printer driver.
Call a non-standard paper size registered in the printer driver with Custom Paper Sizes .
Once you register Custom Paper Sizes, you then can select it repeatedly from the paper size list.
Custom Paper Sizes can be set up to 18.0 m.
This topic describes how to register a non-standard paper size by the name of 430*430 and print based on the
following example.

• Document: Any Type
• Page Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])
• Paper: Sheets
• Media Type: Any type
• Paper Size: A square sheet (430 × 430 mm [16.9 × 16.9 in])

Note
• The following instructions are for OS X v10.7. The method of setting up non-standard paper sizes varies depending

on the version and settings of Mac OS X.

1 Create the document in the application.

2 Load the square paper (430 × 430 mm [16.9 × 16.9 in]) in the printer.

3
 

Choose Print in the application menu.

4 Select the printer in the APrinter list.

5
 

Click Manage Custom Sizes in the FPaper Size list
to display the Custom Paper Sizes dialog box.
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6 In Paper Size, enter the height and width of the original. Here, enter 430 mm in Height and Width.

7 In Non-Printable Area, enter 5 for the top and side margins and 23 for the bottom margin. Here, measure-
ments are entered in millimeters.

8 Double-click Untitled in the list at left in the Custom Paper Sizes dialog box and enter the paper name—in
this case, 430*430.

9 Click OK to close the Custom Paper Sizes dialog box.

10 In the FPaper Size list, click the size of the original. In this case, click 430*430, the size you registered.

11 If you configured the settings using the Page Attributes dialog box, click OK to close the dialog box, and
then select Print from the application software menu.

12
 

Access the Main pane.

13 In the AMedia Type list, select the type of paper that is loaded.

14 After confirming that DEasy Settings is selected, select from the EPrint Target list.

15 Make your selection in the FPrint Quality list.
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16
 

Access the Page Setup pane.

17 Click Manual in the APaper Source list.

18 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Tiling and multiple pages per sheetTiling and multiple pages per sheet
Printing Multiple Originals Next to Each Other ................................................................................................. 101

Printing Multiple Originals Next to Each Other (Windows) ...........................................................................102
Printing Multiple Originals Next to Each Other (Mac OS) ............................................................................ 103

Printing Multiple Pages Continuously .............................................................................................................. 104
Printing Multiple Pages Continuously (Windows) ........................................................................................ 105
Printing Multiple Pages Continuously (Mac OS) ..........................................................................................106

Printing Multiple Pages Per Sheet ................................................................................................................... 108
Printing Multiple Pages Per Sheet (Windows) .............................................................................................109
Printing Multiple Pages Per Sheet (Mac OS) .............................................................................................. 110

Printing Posters in Sections ............................................................................................................................ 113
Printing Large Posters (Windows) .............................................................................................................. 113

Printing Multiple Originals Next to Each OtherPrinting Multiple Originals Next to Each Other
By arranging originals from word-processing or spreadsheet programs or web browser screen shots next to each
other on single sheets, you can create highly expressive presentation materials, easy-to-understand meeting mate-
rials, and a variety of other printed documents.

• Free Layout (Windows)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even
multiple source applications—in a single-page layout.
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• Free Layout (Mac OS)
Besides combining multiple pages in a single-page layout, you can combine originals from multiple files—even
multiple source applications—in a single-page layout.

For instructions on arranging originals from multiple applications, refer to the following topics.

• Printing Multiple Originals Next to Each Other (Windows) ➔P.102
• Printing Multiple Originals Next to Each Other (Mac OS) ➔P.103

Printing Multiple Originals Next to Each Other (Windows)Printing Multiple Originals Next to Each Other (Windows)
This topic describes how to arrange multiple originals using the Free Layout function.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.
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4
 

Click the Layout tab to display the Layout sheet.

5 Select the APage Layout check box.

6 Click Free Layout in the APage Layout list.

7
 

When you attempt to print, the imagePROGRAF
Free Layout window is displayed. (At this point, the
document will not be printed yet.)

8 Edit and rearrange the image in the imagePROGRAF Free Layout window as desired.

Note
• Without closing the imagePROGRAF Free Layout window, repeat steps 1–7 to arrange originals from

multiple applications on the same page.

• For instructions on editing and rearranging images, refer to the imagePROGRAF Free Layout help topic.

9 Print from the imagePROGRAF Free Layout menu.

Note
• For details on imagePROGRAF Free Layout functions, see "Free Layout." ➔P.182

Printing Multiple Originals Next to Each Other (Mac OS)Printing Multiple Originals Next to Each Other (Mac OS)
This topic describes how to use the Free Layout function to arrange multiple originals next to each other before
printing.

1 Choose Print in the application menu.
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2
 

Access the Page Setup pane.

3 Select the NFree Layout check box.

4 Click MPrint.

5
 

The Canon imagePROGRAF Free Layout window
is displayed.

6 Edit and rearrange the image in the Canon imagePROGRAF Free Layout window as desired.

Note
• Without closing the Canon imagePROGRAF Free Layout window, repeat steps 1 to 4 to arrange origi-

nals from multiple applications on the same page.

• For instructions on editing and rearranging images, refer to the Canon imagePROGRAF Free Layout
help topic.

7 Print from the Canon imagePROGRAF Free Layout menu.

Note
• For details on Canon imagePROGRAF Free Layout functions, see "Free Layout." ➔P.289

Printing Multiple Pages ContinuouslyPrinting Multiple Pages Continuously
You can print multiple pages as a single continuous image, without margins between pages.
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• Banner Printing

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.

• When using Banner Printing, some of the settings are disabled, including Borderless Printing, Enlarge/
Reduce Printing, and Layout.

For instructions on printing multiple pages continuously, refer to the following topics, as appropriate for your
operating system.

• Printing Multiple Pages Continuously (Windows) ➔P.105
• Printing Multiple Pages Continuously (Mac OS) ➔P.106

Printing Multiple Pages Continuously (Windows)Printing Multiple Pages Continuously (Windows)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.

• When using Banner Printing, some of the settings are disabled, including Borderless Printing, Enlarge/Reduce
Printing, and Layout.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, click the type of paper that is loaded.
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5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 Select and click a roll paper in the LPaper Source list.

7
 

Click NRoll Paper Options to display the Roll Paper Op-
tions dialog box.

8 Select the BBanner Printing check box.

9 Click OK.

10 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Multiple Pages Continuously (Mac OS)Printing Multiple Pages Continuously (Mac OS)
This topic describes how to print multiple pages as a single continuous image, without margins between pages.

Important
• This feature is only available with rolls. It cannot be used when printing on sheets.

• When using Banner Printing, some of the settings are disabled, including Borderless Printing, Enlarge/Reduce
Printing, and Layout.
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 Choose the original size in the CPaper Size list.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, click the type of paper that is loaded.

8 Make your selection in the EPrint Target list.

9 Make your selection in the FPrint Quality list.
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10
 

Access the Page Setup pane.

11 Click Roll Paper (Banner) in the APaper Source list.

12 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Printing Multiple Pages Per SheetPrinting Multiple Pages Per Sheet
To conserve paper, you can print several pages of the original on a single sheet by reducing the original and divid-
ing the sheet into areas for each page.

• Page Layout
Specify a number of pages of the original to print on a single sheet, in a layout of multiple pages per sheet.

Important
• This function cannot be combined with the following options.

• Borderless Printing
• Scaling Originals (Windows)
• Banner Printing (Windows)

• When printing using this function, the Print Centered setting is disabled.

Note
• You can print up to 16 pages of the original on a single sheet.

• You can also change the page layout order and print page boundary lines, as desired.
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For instructions on printing multiple pages per sheet, refer to the following topics, as appropriate for your com-
puter and operating system.

• Printing Multiple Pages Per Sheet (Windows) ➔P.109
• Printing Multiple Pages Per Sheet (Mac OS) ➔P.110

Printing Multiple Pages Per Sheet (Windows)Printing Multiple Pages Per Sheet (Windows)
This topic describes how to print four pages of originals together on a single sheet based on the following example.

• Document: Any Type
• Page size: A3 (297.0×420.0 mm [11.7×16.5 in])
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.  (See "Accessing the Print-
er Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

6 Make your selection in the FPrint Quality list.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In APage Size, click the size of the original as specified in the application software. In this case, click ISO
A3.
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9 Select and click a roll paper in the LPaper Source list.

10 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).

11
 

Click the Layout tab to display the Layout sheet.

12 Select the APage Layout check box.

13 Click 4 Pages/Sheet in the APage Layout list.

Note
• You can select the layout order for placing four pages on a sheet and a frame border in the Page Layout

Printing dialog box by clicking BSet. If you select a pattern to print borders, the size of the images are
reduced about 5% to create space for the printed border. If None is selected, then the images are not
reduced for printing.

14 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Multiple Pages Per Sheet (Mac OS)Printing Multiple Pages Per Sheet (Mac OS)
This topic describes how to print four pages of an original on a single sheet, based on the following example.

• Document: Any Type
• Page size: A3 (297.0 × 420.0 mm [11.7 × 16.5 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, click the size of the original. In this case, click ISO A3.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Layout pane.

7 Click 4 in the APages per Sheet list.

Note
• You can choose the layout order and specify a boundary line for the four pages in BLayout Direction

and CBorder.
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8
 

Access the Main pane.

9 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

10 Make your selection in the EPrint Target list.

11 Make your selection in the FPrint Quality list.

12
 

Access the Page Setup pane.

13 Select and click a roll paper in the APaper Source list.

14 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A2/A3 (420.0mm)
is selected.

15 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Printing Posters in SectionsPrinting Posters in Sections
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can
create a poster larger than the maximum supported paper size of the printer.

• Page Layout
Choose poster printing.

Important
• When printing using this function, the Print Centered, Watermark, No Spaces at Top or Bottom (Con-

serve Paper), and Page Options settings are disabled.

For instructions on printing large posters, refer to the following topics, as appropriate for your computer and
operating system.

• Printing Large Posters (Windows) ➔P.113

Note
• This method of poster printing is supported in Windows.

Printing Large Posters (Windows)Printing Large Posters (Windows)
You can enlarge an original to print it in sections on several sheets. By assembling the printed sheets, you can
create a poster larger than the maximum supported paper size of the printer. This topic describes how to enlarge
an A2 original for printing it in sections on four sheets, based on the following example.

• Document: Poster
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Sheets
• Paper Size: A2 (420.0 × 594.0 mm [16.5 × 23.4 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.
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5 Click Poster in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In APage Size, click the size of the original as specified in the application. In this case, click ISO A2.

8 Click Manual in the LPaper Source list.

9
 

Click the Layout tab to display the Layout sheet.

10 Select the APage Layout check box.

11 Click Poster (2 x 2) in the APage Layout list.

Note
• Follow the steps below to print only a portion of the poster as divided for printing.

• Click BSet under APage Layout to display the Pages to Print dialog box.

• On the Pages to Print dialog box, clear the check boxes of the portion you do not want to print.
• Click OK to close the Pages to Print dialog box.

12 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145
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Centering originalsCentering originals
Printing Originals Centered on Rolls ................................................................................................................ 115

Printing Originals Centered on Rolls (Windows) ......................................................................................... 115
Printing Originals Centered on Rolls (Mac OS) ........................................................................................... 117

Printing Originals Centered on Sheets ............................................................................................................ 119
Printing Originals Centered on Sheets (Windows) ...................................................................................... 119
Printing Originals Centered on Sheets (Mac OS) ........................................................................................ 120

Printing Originals Centered on RollsPrinting Originals Centered on Rolls
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reduc-
ing the original.

• Print Centered
If you use originals smaller than the roll paper width, you can center them relative to the width when printing.

For instructions on centering originals when printing on rolls, refer to the following topics, as appropriate for
your computer and operating system.

• Printing Originals Centered on Rolls (Windows) ➔P.115
• Printing Originals Centered on Rolls (Mac OS) ➔P.117

Printing Originals Centered on Rolls (Windows)Printing Originals Centered on Rolls (Windows)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll width: A3/A4 roll (297.0 mm [11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Select the print target in the EPrint Target list.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4 or Letter (8.5"x11").

8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A3/A4 Roll
(297.0mm).

10
 

Click the Layout tab to display the Layout sheet.
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11 Select the EPrint Centered check box.

12 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Originals Centered on Rolls (Mac OS)Printing Originals Centered on Rolls (Mac OS)
This topic describes how to center originals before printing on rolls based on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

iPF785                                                                                                                                                         Printing Originals Centered on Rolls (Mac OS)

User's Guide                                                                                                                                                                                                                     

  

Enhanced Printing O
ptions

Centering originals

117  



6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 Make your selection in the EPrint Target list.

9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Select and click a roll paper in the APaper Source list.

12 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A3/A4 (297.0mm)
is selected.

13 Select the JPrint Centered check box.

14 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Printing Originals Centered on SheetsPrinting Originals Centered on Sheets
You can print originals centered on a page—for example, if the paper is larger than the original, or if you are reduc-
ing the original.

• Print Centered
If you use paper larger than the original size or print originals after reduction, the printed images may be
aligned in the upper-left corner of the paper. In this case, you can center originals on sheets when printing.

For instructions on centering originals when printing on sheets, refer to the following topics, as appropriate for
your computer and operating system.

• Printing Originals Centered on Sheets (Windows) ➔P.119
• Printing Originals Centered on Sheets (Mac OS) ➔P.120

Printing Originals Centered on Sheets (Windows)Printing Originals Centered on Sheets (Windows)
This topic describes how to reduce an original 50% for printing centered on a sheet.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Sheets
• Paper type: Plain Paper
• Paper size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.
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6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4.

8 Select the CEnlarged/Reduced Printing check box.

9 Click Match Page Size in the GPaper Size list.

10 Click FScaling and enter 50.

11 Click Manual in the LPaper Source list.

12
 

Click the Layout tab to display the Layout sheet.

13 Select the EPrint Centered check box.

14 Confirm the print settings and print as desired.

Important
• If you have selected Manual as the paper source, follow the instructions on the printer control panel to

enter the paper size.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Printing Originals Centered on Sheets (Mac OS)Printing Originals Centered on Sheets (Mac OS)
This topic describes how to center originals for printing on sheets, based on the following example.

• Document: Any Type
• Page size: A4
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• Paper: Sheets
• Paper type: Plain Paper
• Paper size: Non-standard

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In the CPaper Size list, click the size of the original. In this case, click ISO A4 - for Paper Tray (Large
Margins).

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8 Make your selection in the EPrint Target list.
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9 Make your selection in the FPrint Quality list.

10
 

Access the Page Setup pane.

11 Click Manual in the APaper Source list.

12 Select the JPrint Centered check box.

13 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Important
• If you have selected Manual as the paper source, follow the instructions on the printer control panel to enter the

paper size.
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Conserving roll paperConserving roll paper
Conserving Roll Paper by Rotating Originals 90 Degrees ................................................................................ 123

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) .......................................................... 123
Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS) ............................................................124

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins ................................................ 126
Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) ...........................................127
Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS) ............................................ 128

Conserving Roll Paper by Rotating Originals 90 DegreesConserving Roll Paper by Rotating Originals 90 Degrees
You can conserve roll paper by specifying particular settings as suitable for your original.

• Rotate Page 90 degrees (Conserve Paper)
When originals are printed in portrait orientation, the original is rotated 90 degrees before printing if it fits within
the roll width. This enables you to conserve paper.

Important
• If the page would exceed the roll paper width after rotation, use this function with Scale to fit Roll Paper

Width to print rotated pages.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating
system.

• Conserving Roll Paper by Rotating Originals 90 Degrees (Windows) ➔P.123
• Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS) ➔P.124

Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)Conserving Roll Paper by Rotating Originals 90 Degrees (Windows)
This topic describes how to conserve paper by rotating originals 90 degrees before printing, based on the following
example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3×11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3×11.7 in) original in portrait orientation 90
degrees to fit within the width of A3/A4 roll paper (297.0 mm [11.7 in]), which enables you to conserve paper.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.  (See "Accessing the Print-
er Driver Dialog Box from Applications .") ➔P.148
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3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4 or Letter (8.5"x11").

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A3/A4 Roll
(297.0mm).

9 Select the KRotate Page 90 degrees (Conserve Paper) check box.

10 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS)Conserving Roll Paper by Rotating Originals 90 Degrees (Mac OS)
This topic describes how to conserve roll paper by rotating originals 90 degrees before printing, based on the fol-
lowing example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])
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This example illustrates how to rotate an A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in) original in portrait orientation
90 degrees to fit within the width of A3/A4 roll (297.0 mm [11.7 in]), which enables you to conserve paper.
 

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.
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8
 

Access the Page Setup pane.

9 Select and click a roll paper in the APaper Source list.

10 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A3/A4 (297.0mm)
is selected.

11 Select the LRotate Page 90 degrees check box.

12 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252

Conserving Roll Paper by Printing Originals Without Top and Bottom MarginsConserving Roll Paper by Printing Originals Without Top and Bottom Margins
You can conserve roll paper by specifying particular settings as suitable for your original.

• No Spaces at Top or Bottom (Conserve Paper)
You can print without feeding the paper for blank portions of originals if there are top and bottom margins in
originals. This enables you to conserve as much paper as the size of the margins.

Important
• Printing without the top and bottom margins is not supported in the following cases.

• If you have chosen poster as the type of page layout

Note
• Even during borderless printing, you can print without the top and bottom margins.

• Printing without the top and bottom margins may cause inconsistency in the size of printed documents, de-
pending on the layout of images or text in your originals.

For tips on conserving roll paper, refer to the following topics, as appropriate for your computer and operating
system.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows) ➔P.127
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• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS) ➔P.128

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows)Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Windows)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based
on the following example.

• Document: Any type
• Page size: A4 (210.0×297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4 or Letter (8.5"x11").

7 Select and click a roll paper in the LPaper Source list.

8 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A3/A4 Roll
(297.0mm).
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9
 

Click the Layout tab to display the Layout sheet.

10 Select the GNo Spaces at Top or Bottom (Conserve Paper) check box.

11 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS)Conserving Roll Paper by Printing Originals Without Top and Bottom Margins (Mac OS)
This topic describes how to conserve roll paper when printing originals that have a top and bottom margin, based
on the following example.

• Document: Any Type
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A3/A4 roll (297.0 mm [11.7 in])

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

4 Click FOK to close the dialog box.
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5 Choose Print in the application menu.

6
 

Access the Main pane.

7 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

8
 

Access the Page Setup pane.

9 Select and click a roll paper in the APaper Source list.

10 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A3/A4 (297.0mm)
is selected.

11 Select the KNo Spaces at Top or Bottom check box.

12 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Checking Images Before PrintingChecking Images Before Printing
Checking the Layout in a Preview Before PrintingChecking the Layout in a Preview Before Printing

You can check the print layout on the preview screen.

• Open Preview When Print Job Starts (Windows)
While viewing the preview screen, you can also adjust orientation or other settings, and your changes will be
instantly applied on the preview screen.

Note
• Under some settings and in some environments, PageComposer may be started.

• Preview (Mac OS)
While viewing the preview screen, you can also adjust layout or size settings, and your changes will be instant-
ly applied on the preview screen.

For instructions on how to check the layout before printing, refer to the following topics:

• Checking the Layout in a Preview Before Printing (Windows) ➔P.145
• Checking the Layout in a Preview Before Printing (Mac OS) ➔P.253
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Other useful settingsOther useful settings
Printing With Watermarks ............................................................................................................................... 131

Printing with Watermarks—COPY, FILE COPY, and so on (Windows) ........................................................ 132

Making the Original Orientation Match the Paper Orientation .......................................................................... 133
Making the Original Orientation Match the Paper Orientation (Windows) .................................................... 134
Making the Original Orientation Match the Paper Orientation (Mac OS) ...................................................... 135

Using Favorites ...............................................................................................................................................137
➔ Using Favorites (Windows) .................................................................................................................. 146
➔ Using Favorites (Mac OS) .................................................................................................................... 253

Cutting Roll Paper After Printing ..................................................................................................................... 137
Cutting Roll Paper After Printing (Windows) ............................................................................................... 137
Cutting Roll Paper After Printing (Mac OS) ................................................................................................. 138

Printing With WatermarksPrinting With Watermarks
You can add watermarks (background images) to documents that require special handling.

• Watermark
Watermarks are applied to all pages of your document.

Important
• Watermarks are not printed if you select poster as the type of page layout.

The following watermarks are provided:

• CONFIDENTIAL
• COPY
• DRAFT
• FILE COPY
• FINAL
• PRELIMINARY
• PROOF
• TOP SECRET

You can also create your own watermarks. Specify the following options to customize your watermark.

• Watermark string: Specify the font, size, color, and so on. Surround the watermark with a frame, if de-
sired.

• Watermark position: Specify the position on the page, the angle, and so on.

• Watermark printing method: Specify whether to print the watermark superimposed or under the document
image. You can also print the watermark only on the first page, if desired.

Note
• Watermarks are supported in Windows.

• In addition to the provided watermarks, you can create up to 50 original watermarks.

For detailed instructions on printing with watermarks, refer to the following topics:
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• Printing with Watermarks—COPY, FILE COPY, and so on (Windows) ➔P.132

Printing with Watermarks—COPY, FILE COPY, and so on (Windows)Printing with Watermarks—COPY, FILE COPY, and so on (Windows)
This topic describes how to print with watermarks, based on the following example of printing with a FILE COPY
watermark.

• Document: Any type
• Page size: A2 (420.0×594.0 mm [16.5 × 23.4 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in[)

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

Note
• You can check the settings values selected in the EPrint Target list by clicking GView Settings.

6
 

Click the Page Setup tab to display the Page Setup
sheet.

7 In APage Size, click the size of the original as specified in the application software. In this case, click ISO
A2.
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8 Select and click a roll paper in the LPaper Source list.

9 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).

10
 

Click the Layout tab to display the Layout sheet.

11 Select the CWatermark check box.

12 Click FILE COPY in the Watermarks list.

Note
• Click DEdit Watermark to open the Edit Watermark dialog box. In the Edit Watermark dialog box, you

can create custom watermarks and change the position and angle of watermarks.

13 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Making the Original Orientation Match the Paper OrientationMaking the Original Orientation Match the Paper Orientation
You can specify the original orientation to match the orientation of the paper for printing.

• Orientation
Paper is usually loaded in the printer in portrait orientation. When you have an original in landscape orienta-
tion, you can specify the printing orientation so that the original is printed in landscape orientation.

• Rotate 180 degrees
The original is rotated 180 degrees to print it upside down.

• Mirror
A mirror image of the original is printed.
 

For instructions on specifying the original orientation before printing, refer to the following topics, as appropri-
ate for your computer and operating system.

• Making the Original Orientation Match the Paper Orientation (Windows) ➔P.134
• Making the Original Orientation Match the Paper Orientation (Mac OS) ➔P.135
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Making the Original Orientation Match the Paper Orientation (Windows)Making the Original Orientation Match the Paper Orientation (Windows)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on
the following example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm)/Letter (8.3 × 11.7 in)
• Paper: Roll
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then open the printer driver dialog box.  (See "Accessing the Print-
er Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

5 Make your selection in the EPrint Target list.

6 Make your selection in the FPrint Quality list.

7
 

Click the Page Setup tab to display the Page Setup
sheet.

8 In the APage Size list, click the size of the original as specified in the application. In this case, click ISO
A4 or Letter (8.5"x11").

9 In HOrientation, click JLandscape.

10 Select and click a roll paper in the LPaper Source list.
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11 Select the width of the loaded roll in the MRoll Paper Width list—in this case, ISO A2/A3 Roll
(420.0mm).

12 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Making the Original Orientation Match the Paper Orientation (Mac OS)Making the Original Orientation Match the Paper Orientation (Mac OS)
This topic describes how to print an original in landscape orientation after matching the paper orientation, based on
the following example.

• Document: An original in landscape orientation
• Page size: A4 (210.0 × 297.0 mm [8.3 × 11.7 in])
• Paper: Roll paper
• Paper type: Plain Paper
• Roll paper width: A2/A3 roll (420.0 mm [16.5 in])

1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 In CPaper Size, click the size of the original. In this case, click ISO A4.

4 In DOrientation, click the icon of the document in landscape orientation.

5 Click FOK to close the dialog box.

6 Choose Print in the application menu.

iPF785                                                                                                                     Making the Original Orientation Match the Paper Orientation (Mac OS)

User's Guide                                                                                                                                                                                                                     

  

Enhanced Printing O
ptions

O
ther useful settings

135  



7
 

Access the Main pane.

8 In the AMedia Type list, select the type of paper that is loaded. In this case, click Plain Paper.

9 Make your selection in the EPrint Target list.

10 Make your selection in the FPrint Quality list.

11
 

Access the Page Setup pane.

12 Select and click a roll paper in the APaper Source list.

13 Select the paper width of the roll loaded in the printer for BRoll Width. In this case, ISO A2/A3 (420.0mm)
is selected.

14 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Using FavoritesUsing Favorites
You can register print settings as Favorites to reuse settings from a particular job that met your expectations, or
settings for a particular page size that you will use repeatedly.

• Favorites
Registering a favorite for later use. You can choose the settings you have registered from a list before printing,
and you can check the settings details.

Note
• You can also save the favorite settings as files. Using these files is a convenient way to print under the same

conditions on another computer. (In Windows.)

For instructions on using favorites to print, refer to the following topics, as appropriate for your computer and
operating system.

• Using Favorites (Windows) ➔P.146
• Using Favorites (Mac OS) ➔P.253

Cutting Roll Paper After PrintingCutting Roll Paper After Printing
Roll paper can be automatically cut after printing.

Note
• It may not be possible to cut certain types of paper, such as adhesive paper. For details on types of paper that

cannot be used with the auto cut feature, see the Paper Reference Guide.  (See "Types of Paper.") ➔P.328

• Automatic Cutting
Roll paper is cut automatically after printing. If you prefer, you can print continuously without cutting the roll, or
you can print a cut line.
For instructions on cutting roll paper after printing, refer to the following topics, as appropriate for your comput-
er and operating system.

• Cutting Roll Paper After Printing (Windows) ➔P.137
• Cutting Roll Paper After Printing (Mac OS) ➔P.138

Cutting Roll Paper After Printing (Windows)Cutting Roll Paper After Printing (Windows)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to
print a cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the steps

below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148
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3
 

Click the Page Setup tab to display the Page Setup
sheet.

4 Select and click a roll paper in the LPaper Source list.

5
 

Click NRoll Paper Options to display the Roll Paper Op-
tions dialog box.

6 To enable automatic cutting, click Yes in the AAutomatic Cutting list. If you prefer to cut the paper later
yourself, click Print Cut Guideline.

7 Click OK to close the Roll Paper Options dialog box.

8 Confirm the print settings and print as desired.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.145

Roll paper will be automatically cut after printing.

Cutting Roll Paper After Printing (Mac OS)Cutting Roll Paper After Printing (Mac OS)
This topic describes how to cut roll paper automatically after printing (using the auto cut function), as well as how to
print a cut line for manual cutting.

Note
• The auto cut function is activated on the printer by default and when the printer driver is installed. Follow the steps

below to reactivate the function if it is disabled, or to select the setting for printing a cut line instead.
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1 Choose Page Setup from the application menu to display the Page Attributes dialog box.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the BFormat for list.

3 Choose the original size in the CPaper Size list.

4 Click FOK to close the dialog box.

5 Choose Print in the application menu.

6
 

Access the Page Setup pane.

7 Select and click a roll paper in the APaper Source list.
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8
 

Access the Main pane.

9 In the AMedia Type list, select the type of paper that is loaded.

10
 

Click CSet to display the Paper Detailed Settings
dialog box.

11 To enable automatic cutting, click Printer Default in the HAutomatic Cutting list. If you prefer to cut the
paper later yourself, click Print Cut Guideline.

Important
• If the automatic cut function has been deactivated on the printer, change the auto cut setting on the

printer Control Panel.

12 Click OK to close the Paper Detailed Settings dialog box.

13 Confirm the print settings, and then click MPrint to start printing.

Note
• For tips on confirming print settings, see "Confirming Print Settings ." ➔P.252
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Printer Driver SettingsPrinter Driver Settings
For instructions on accessing the Windows printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications ➔P.148

• Accessing the Printer Driver Dialog Box from the Operating System Menu ➔P.149

For information on the Windows printer driver settings, refer to the following topics.

• Main Sheet ➔P.150
You can specify the type of paper, color processing, print quality, print preview, and other settings. Choose
Easy Settings to specify basic print settings based on the printing application or Advanced Settings to com-
plete more detailed settings as desired.
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• Paper Detailed Settings Dialog Box ➔P.154
• View Settings Dialog Box for the Printing Application ➔P.155
• Color Adjustment Sheet: Color ➔P.156
• Object Adjustment Dialog box: Color ➔P.157
• Matching Sheet ➔P.157
• Color Adjustment Sheet: Monochrome ➔P.159
• Object Adjustment Dialog box: Monochrome ➔P.160

• Page Setup Sheet ➔P.161
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the
paper size and feed source, and automatic cutting.

• Output Method Dialog box ➔P.163
• Paper Size Options Dialog Box ➔P.164

• Layout Sheet ➔P.165
You can specify the page layout, watermarks, the orientation, the number of copies, and print processing op-
tions.

• Page Options Dialog Box ➔P.166
• Special Settings Dialog Box ➔P.167

• Favorites Sheet ➔P.168
Groups of print settings you select on each sheet can be saved as a favorite. Favorites you have added can
be edited or used at the time of printing as desired.

• Utility Sheet ➔P.169
You can specify settings related to maintenance for the Printhead and feed amount, as well as settings for
Color imageRUNNER Enlargement Copy.

• Support Sheet ➔P.170
You can view support information and the user manual.

• Device Settings Sheet ➔P.171
You can display settings for optional equipment installed on the printer and see the version information for the
printer driver.

imagePROGRAF Free Layout is a feature for freely arranging originals from various source applications on a sin-
gle page as desired before printing. For details, see "Free Layout." ➔P.182
Color imageRUNNER Enlargement Copy is a feature for automatic enlargement and printing of scanned originals
from a Color imageRUNNER. For details, see "Color imageRUNNER Enlargement Copy." ➔P.203

Note
• Color imageRUNNER Enlargement Copy is not displayed in 64-bit editions of Windows.
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Specifying Paper in the Printer DriverSpecifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

Important
• Always specify the same type and size of paper in the printer menu and printer driver.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3
 

Make sure the Main sheet is displayed.

4 In the AMedia Type list, select the type of paper that is loaded.

Note
• Click the BGet Information button to display the Paper Information on Printer dialog box. On the Pa-

per Information on Printer dialog box, you can obtain information on the paper in the printer and config-
ure printer driver settings for the feed source and type of paper.
This function requires that the Status Monitor be installed.

5
 

Click the Page Setup tab to display the Page Setup
sheet.

6 In the APage Size list, select the size of the original as specified in the application.

7 In the LPaper Source list, select how paper is supplied.

8 If you have selected roll paper in LPaper Source, select the width of the loaded roll in MRoll Paper
Width.
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Note
• A variety of settings are available in the printer driver to suit different printing applications.

For details on available printing conditions, see "Printer Driver Settings ." ➔P.142

Confirming Print SettingsConfirming Print Settings
There are two ways to confirm the print settings, as follows.

• Checking a preview of the settings
A preview of the settings is displayed on the left side of the Main, Page Setup, and Layout sheets. By check-
ing illustrations and numerical values in the preview, you can confirm current settings for the page size, orien-
tation, paper source, layout, and so on.

Display Area Information Displayed

PTop illustrations Illustrations indicate the orientation, page layout, borderless printing selection, color mode,
and other settings information.

QMiddle, bordered area The page size, paper size, and method and percentage of enlargement or reduction are
indicated.

RBottom illustrations Illustrations indicate the feed source, orientation, borderless printing selection, and other
settings information.

Note
• To confirm the Print Target specified in Easy Settings, click GView Settings on the Main sheet to display

the View Settings dialog box.

• Checking a print preview
You can check an image of the original just as it will be printed.
When you activate this feature, imagePROGRAF Preview or PageComposer is started before printing. Con-
firming how documents will be printed this way helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing." ➔P.130

Checking the Layout in a Preview Before PrintingChecking the Layout in a Preview Before Printing
This topic describes how to preview images of print jobs before actually printing them.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148
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3
 

Make sure the Main sheet is displayed.

4 Select the LOpen Preview When Print Job Starts check box.

5
 

After you click OK, when you print a job, the image-
PROGRAF Preview window will be displayed.

Note
• If PageComposer is running, access the Special Settings dialog box from the Layout sheet and clear

Preview Switching.

6 On the main window, you can check the layout and change settings as needed.

7 To print, click Print in the File menu.

Note
• For details on imagePROGRAF Preview functions, see "Preview." ➔P.172

Using FavoritesUsing Favorites
This topic describes how to register favorites and print using favorite settings.

Registering a favorite
This section describes the procedure for registering printing settings that have been changed in the driver as Fa-
vorites.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148

3 Perform normal printing settings.
The favorite is registered from here.
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4
 

Click the Favorites tab to display the Favorites
sheet.

5
 

Click HAdd to display the Add dialog box.

6 Enter a desired name in Name, such as Photos for Presentations or Monthly Report.

7 Choose a fitting icon for these print settings in the Icon list.

8 In Comment, enter a description of the favorite to be added, as desired.

9 Click OK to close the Add dialog box.
The favorite you have added is now displayed in AFavorites.

Note
• To save a favorite as a file, click JExport and specify the file to save.

Printing using the favorite
Follow the steps below to print using the favorite you have registered.

1 Choose Print in the application menu.

2 Select the printer in the dialog box, and then display the printer driver dialog box.  (See "Accessing the
Printer Driver Dialog Box from Applications .") ➔P.148
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3
 

Click the Favorites tab to display the Favorites
sheet.

4 In the AFavorites, choose the favorite you registered.

Note
• To import a favorite, click I Import and specify the favorite file.

5 Click DApply Favorite to replace the favorite settings with the current print settings.

6 Confirm the print settings and print as desired.

Note
• For instructions on confirming print settings, see "Confirming Print Settings ." ➔P.145

Accessing the Printer Driver Dialog Box from ApplicationsAccessing the Printer Driver Dialog Box from Applications

1 Choose Print from the File menu to display the dialog box for printing conditions.

2 Select the printer, and then display the printer driver dialog box.

Note
• The dialog box for specifying printing conditions varies depending on the source application. In some ca-

ses, when you select the printer, a sheet for configuring the printer driver is added to the dialog box.
In the following case, click Preferences.

• Example: Print dialog box displayed by the application software
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Six sheets of print settings are displayed by the print-
er driver: Main, Page Setup, Layout, Favorites,
Utility, and Support.

Note
• The titles of dialog boxes may vary depending on the application, and sheets other than these six sheets

may be displayed.

Important
• If you access the printer driver dialog box from the source application, changes you make to the settings will only

apply temporarily to that application. Because these are sizes you specify temporarily in the printer driver, the
sizes will not be available after you exit the application.

• You can also access the printer driver dialog box from the Windows system menu.
To use the settings continuously in all applications, open the printer driver from the system menu to make the
settings.
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu .") ➔P.149

Accessing the Printer Driver Dialog Box from the Operating System MenuAccessing the Printer Driver Dialog Box from the Operating System Menu

1 Click start > Printers and Faxes (or Printers ).

2
 

Select the printer, and then display the printer proper-
ties dialog box.

 

 

iPF785                                                                                                                Accessing the Printer Driver Dialog Box from the Operating System Menu

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Printer Driver

149  



3
 

Click Printing Preferences to display the Main(or
Printing Preferences) dialog box, titled with the
name of this printer.

Note
• The Device Settings sheet is also an extension of the printer driver.  (See "Device Settings

Sheet .") ➔P.171

Six sheets of print settings are displayed by the print-
er driver: Main, Page Setup, Layout, Favorites,
Utility, and Support.

Important
• If you access the printer driver dialog box from the operating system menu, changes you make to the settings will

apply to all applications you use for printing.

• You can also access the printer driver dialog box from applications.
 (See "Accessing the Printer Driver Dialog Box from Applications .") ➔P.148

Main SheetMain Sheet
The following settings are available on the Main sheet. For details on settings items, refer to the printer driver help
file.

Note
• On the Main sheet, choose Easy Settings to specify basic print settings based on the particular printing applica-

tion, or switch to Advanced Settings to complete more detailed settings as desired.
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Common Items

• AMedia Type
Select the type of paper.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Dis-
playing the Paper Reference Guide.") ➔P.331

• BGet Information
Displays Paper Information on Printer. You can update the printer driver settings for the feed source, media
type, and roll width by selecting the feed source.

• Paper Information on Printer Dialog Box ➔P.153

• CAdvanced Settings
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as
the ink drying time.

• Paper Detailed Settings Dialog Box ➔P.154

• LOpen Preview When Print Job Starts
When the check box is selected, imagePROGRAF Preview is launched before printing.
This allows you to check on-screen previews of documents before printing.

• Checking the Layout in a Preview Before Printing ➔P.130

• MStatus Monitor
Starts imagePROGRAF Status Monitor.
You can check the printer status, job status, and other conditions.
You can also set up email notification if printer errors occur by completing the Email Notice settings.
For details, refer to the Status Monitor help file.

• NAbout
Displays version information for the printer driver.

• SDefaults
Restores all settings on the sheet to the default values.
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Configuration using Easy Settings

• EPrint Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images ➔P.31
• Printing Line Drawings and Text ➔P.40
• Printing Office Documents ➔P.35

Depending on the AMedia Type setting, some EPrint Target options may not be available.

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54

• GView Settings
Displays the EPrint Target setting values.
You can view and change the order of EPrint Target setting values.

• View Settings Dialog Box for the Printing Application ➔P.155

Configuration using Advanced Settings

• EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54
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• THighest quality
When the check box is selected, printing is performing focusing on quality. Printing takes longer and consumes
more ink than in other modes, but this mode offers superior printing quality.

Note
• If you set FPrint Quality to High, you can select THighest quality. However, depending on AMedia Type

and EPrint Priority, you may not be able to select THighest quality.

• UEconomy Printing
If you select this option, you can print with less ink consumed. However, print quality is lower than in regular
printing.
Select this option to save ink, such as when printing to check drawings. Depending on the settings of AMedia
Type and FPrint Quality, you may not be able to select this option.

Note
• If you set FPrint Quality to Fast, you can select UEconomy Printing. However, depending on AMedia

Type and EPrint Priority, you may not be able to select UEconomy Printing.

• GColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54

Note
• Depending on the AMedia Type setting, some GColor Mode options may not be available.

• HColor Settings
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver ➔P.48

• IThicken Fine Lines
Select this option to print fine lines more distinctly.

• JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.

• KSharpen Text
Select this option to print text more sharply.

Paper Information on Printer Dialog BoxPaper Information on Printer Dialog Box
On the Paper Information on Printer dialog box, you can obtain information on the paper in the printer and config-
ure printer driver settings for the paper source and media type.

iPF785                                                                                                                                                                   Paper Information on Printer Dialog Box

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Printer Driver

153  



Note
• To display the Paper Information on Printer dialog box, on the Main sheet, click Get Information by Media Type.

 (See "Main Sheet .") ➔P.150

• APaper Source
Shows the paper source supported by the printer, as well as information about the loaded paper. To update the
paper source and media type settings in the printer driver, select the desired Paper Source option and click
OK.

Paper Detailed Settings Dialog BoxPaper Detailed Settings Dialog Box
In the Paper Detailed Settings dialog box, you can set Drying Time for the paper selected with Media Type of the
Main sheet, etc.
You can display this dialog box by clicking Advanced Settings of Media Type on the Main sheet.  (See "Main
Sheet .") ➔P.150
As for the items for which you can select Printer Default in this dialog box, you also can set them from the control
panel of the printer.  (See "Menu Settings.") ➔P.416

ADrying Time
Specify the time that the printer waits for ink to dry, as needed. The Between Pages setting is only valid for rolls.

• BBetween Pages
You can set the time to wait after printing 1 document page until ejecting the paper. Since waiting time is re-
quired for ink to dry before a roll is cut, you can deliver paper in the Output Stacker with the ink dried even if
Cutting Mode is set to Automatic.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

Off Paper is ejected immediately after printing completes.

30 sec. / 1 min. / 3 min. / 5 min. /
10 min. / 30 min. / 60 min.

Paper is ejected when the set time elapses after printing completes.

• CBetween Scans
You can set the time to wait after printing 1 line on a page until printing the next line. Set this to avoid bleeding
or color unevenness such as when bleeding occurs on a page or when color unevenness occurs during bor-
derless printing.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

Off The next line is printed immediately after a line is printed.

1 sec. / 3 sec. / 5 sec. / 7 sec. / 9
sec.

The next line is printed when the set time elapses after a line is printed.
 

* Increase the time according to the occurrence condition of bleeding or unevenness.
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DRoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is
held firmly against the Platen.

• ENear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

3 mm (0.12 in) The document is printed in the standard size.
 

* Select this when you do not have any problems in printing.

20 mm (0.8 in) Select this when rubbing against the printhead occurs such as when using paper that
tends to curl.

FCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic
cutting is used.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

High Speed When the Standard setting does not result in cutting the surface cleanly, select this.

Standard Select this when you do not have any problems in automatic cutting.

Low Speed This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if you
select it when using adhesive paper.

GMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image
with the left and right sides inverted.

View Settings Dialog Box for the Printing ApplicationView Settings Dialog Box for the Printing Application
In the View Settings dialog box, you can check details of the selected printing application.

Note
• To display the View Settings dialog box, on the Main sheet, click View Settings by Print Target.  (See "Main

Sheet .") ➔P.150

• APrint Target
Shows all Print Target options (settings items for the printing application).

• BName
Identifies the item selected in Print Target by its name and an icon.
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• CDetails
Here, you can confirm detailed settings values for each listed item for the selected Print Target.

Color Adjustment Sheet: ColorColor Adjustment Sheet: Color
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment sheet.
 

Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Advanced

Settings.  (See "Main Sheet .") ➔P.150

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan/EMagenta/FYellow
Fine-tune color tones by adjusting the levels of each color.

• GGray Tone
Adjust the color tone of grays as desired. Choose Cool Black (tinged with blue) or Warm Black (tinged with
red).

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter
or darker than the original image (that is, the original photo that was scanned or the original graphic as it ap-
pears on the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Con-
trast makes images sharper, and reducing the Contrast softens images.

• JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing
the Saturation makes colors more subdued.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

• Object Adjustment Dialog box: Color ➔P.157
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• SDefaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver." ➔P.48

Object Adjustment Dialog box: ColorObject Adjustment Dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an
original comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

• A Image
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.

Matching SheetMatching Sheet
On the Matching sheet, you can specify color matching to compensate for differences in the appearance of colors
on various devices.

Important
• If No color correction is selected under Color Mode, the Matching sheet is not displayed.

Note
• To display the Matching sheet, on the Main sheet, click Color Settings in Color Mode in Advanced Settings,

and then click the Matching sheet.  (See "Main Sheet .") ➔P.150

iPF785                                                                                                                                                                      Object Adjustment Dialog box: Color

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Printer Driver

157  



Driver Matching Mode
The following options are available when you select Driver Matching Mode in the AMatching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching
Mode or Host ICM Mode, depending on your color matching system.

• BMatching Method
Select the color matching method that suits the document to be printed. Various Matching Method options are
available depending on your selection in Matching Mode.

• EGamma
You can adjust the gradation of intermediate tones in an image.
2.2 is normally selected. If you want a softer impression than 2.2, select 1.8.

ICC Matching Mode and Host ICM Mode
The following options are available when you select ICC Matching Mode or Host ICM Mode in the AMatching
Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.

Matching Sheet                                                                                                                                                                                                     iPF785

                                                                                                                                                                                                                     User's Guide

  

W
indows Software

Printer Driver

 158



• B Input Profile Settings
You can select Image, Graphics, or Text. You can choose Matching Method and Input Profile.
Various options are available depending on your selected Matching Mode.
To apply the same input profile automatically for Graphics and Text, select Use the Same Profile for All Ob-
jects. To apply separate input profiles to Graphics and Text, clear Use the Same Profile for All Objects and
specify the individual settings.

• CPrinter Profile Settings
Specify the printer profile as desired. Normally, select Auto Settings.
We recommend that you select an ICC profile created using commercially available profile creation software in
order to perform color management accurately on paper other than genuine Canon paper and feed confirmed
paper.
The created ICC profile needs to be saved in the following folder on the computer you are using.
C:\Windows\system32\spool\drivers\color folder

Note
• C: may vary according to the user environment.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver." ➔P.48

Color Adjustment Sheet: MonochromeColor Adjustment Sheet: Monochrome
On the Color Adjustment sheet for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment sheet, on the Main sheet, click Color Settings by Color Mode in Advanced

Settings.  (See "Main Sheet .") ➔P.150

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan/EMagenta/FYellow
Not available.

• GGray Tone
Not available.
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• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter
or darker than the original image (that is, the original photo that was scanned or the original graphic as it ap-
pears on the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Con-
trast makes images sharper, and reducing the Contrast softens images.

• JSaturation
Not available.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

• Object Adjustment Dialog box: Monochrome ➔P.160

• SDefaults
Click to restore all settings on the sheet to the default values.

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver." ➔P.48

Object Adjustment Dialog box: MonochromeObject Adjustment Dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an
original comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment sheet.

• A Image
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Page Setup SheetPage Setup Sheet
The following settings are available on the Page Setup sheet. For details on settings items, refer to the printer driv-
er help file.

• APage Size
Select the page size as specified in the source application.
For details on available page sizes, see "Paper Sizes." ➔P.328

• BBorderless Printing

Borderless printing is available if roll paper is selected in the LPaper Source list. Choose from the following
options when this setting is activated.

• Borderless Printing on Paper of Equivalent Size ➔P.79
• Borderless Printing by Resizing Originals to Fit the Roll Width ➔P.82
• Borderless Printing at Actual Size ➔P.74

• DFit Paper Size
Scales the document image to match the paper size.

• EScale to fit Roll Paper Width
Scales the document image to match the roll width.

• FPrint Image with Actual Size
Prints documents at their actual size. This function is available when you have selected the size same as the
width of Roll Paper for either the length or width of the document from the APage Size list.

• GPaper Size
Available when DFit Paper Size is selected.
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes." ➔P.328
Paper sizes compatible with borderless printing are shown in the list.
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• CEnlarged/Reduced Printing

Choose from the following options when this setting is activated.

• Resizing Originals to Match the Paper Size ➔P.60
• Resizing Originals to Fit the Roll Width ➔P.62
• Resizing Originals by Entering a Scaling Value ➔P.65

• DFit Paper Size
Scales the document image to match the paper size.

• EFit Roll Paper Width
Scales the document image to match the roll width.

• FScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

• GPaper Size
Choose the size of the paper you will print on.
For details on available paper sizes, see "Paper Sizes." ➔P.328

• HOrientation
Choose the printing orientation.

• Making the Original Orientation Match the Paper Orientation ➔P.133

• KRotate Page 90 degrees (Conserve Paper)
Activate this setting to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees ➔P.123

• LPaper Source
Choose the feed source, as desired.
Options displayed in the list vary depending on the selection in Media Type on the Main sheet.

• MRoll Paper Width
Choose the roll width.
For details on available roll widths, see "Paper Sizes." ➔P.328

• NRoll Paper Options
Complete optional roll paper settings. Click to display the Roll Paper Options dialog box.

Under AAutomatic Cutting, you can specify Yes or No and Print Cut Guideline.

• Cutting Roll Paper After Printing ➔P.137

Select BBanner Printing when printing multiple pages continuously.

• Printing Multiple Pages Continuously ➔P.104
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• POutput Method
Click to display the Output Method dialog box, which enables you to complete the Output Method and Name
of data to be saved settings.

• Output Method Dialog box ➔P.163

• OSize Options
Click to display the Paper Size Options dialog box, which enables you to register additional paper sizes or
select the size system for use.

• Paper Size Options Dialog Box ➔P.164

• SDefaults
Restores all settings on the sheet to the default values.

Output Method Dialog boxOutput Method Dialog box
The Output Method dialog box allows you to select the Output Method and set the save settings when saving to
the box.

Note
• To display the Output Method dialog box, on the Page Setup sheet, click Output Method.  (See "Page Setup

Sheet .") ➔P.161

• AOutput Method
If Print is selected, the print job is saved to the printer hard disk after printing has finished.
If Save in mail box is selected, the print job is saved to the printer hard disk. If you choose Save in mail box,
also specify the destination personal box in the Mail box list.
If Print after reception is complete is checked, you can prevent degradation of print quality that occurs when
receiving a print job is interrupted and printing is aborted in the middle.
These can be selected as Print options.

• BName of data to be saved
To use the file name, choose Use file name.
Otherwise choose Enter name and enter a name in Name.

• CMail box
Displays a list of mail boxes. If you choose Save in mail box, also specify the destination personal box from
the list.

• DAcquire Mail Box Name
When this is clicked, the box name acquired from the printer main unit is displayed in Mail box.
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Paper Size Options Dialog BoxPaper Size Options Dialog Box
In the Paper Size Options dialog box, you can create and register your own Custom Paper Size. The sizes you
define are listed with standard paper sizes for selection later as needed.

Important
• You cannot create any arbitrary roll paper width as a Custom Paper Size.

• If you select a Paper Size from Paper Size Options, load paper of a size equal to or larger than the Paper Size
Options into the printer. If the size of the loaded paper is smaller than the Paper Size Options, an incomplete
output image may be printed.

Note
• To display the Paper Size Options dialog box, on the Page Setup sheet, click Paper Size Options. (See "Page

Setup Sheet .") ➔P.161

• APaper Size List
Shows the names and sizes of paper that can be used with the printer driver.

• BDelete
Custom paper sizes created by users can be deleted from the APaper Size List, as needed.
However, they cannot be deleted in the following situations.

• If a standard paper size of the printer driver is selected.
• If an oversized paper size is selected.
• If a paper size marked with a red circle is selected.

• CCustom Paper Size Name
You can name Custom Paper Size as desired.

• DUnits
Specify the desired unit of measure for the Custom Paper Size height and width.

• EPaper Size
Specify the desired Width and Height. You can make your selection from sizes that are compatible with Bor-
derless Printing by selecting Borderless Printing Size. To maintain the aspect ratio of the Width and Height
as you resize the paper, select Fix the Ratio of the Width to Height.

• FAdd
Enables you to register the custom paper size you have specified or overwrite an existing custom paper size.

• GDisplay Series
You can limit the number of options shown in Page Size, Paper Size, and Paper Size List.
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Layout SheetLayout Sheet
The following settings are available on the Layout sheet. For details on settings items, refer to the printer driver
help.

• APage Layout
Activate this setting to select a particular page layout.

• Printing Multiple Pages Per Sheet ➔P.108
• Printing Posters in Sections ➔P.113
• Printing Multiple Originals Next to Each Other ➔P.101
• Using PosterArtist to Compose Originals ➔P.38

• BSet
Click to display one of the following dialog boxes depending on the selection in APage Layout. In these dia-
log boxes, you can specify layout details and which pages to print, as well as other settings.

• Page Layout Printing
• Pages to Print
• Free Layout Settings

• CWatermark
Activating this option makes two settings available, Watermarks and DEdit Watermark.

• Printing With Watermarks ➔P.131

• Watermarks
Lists the provided watermarks. Choose the watermark to print.

• DEdit Watermark
Click to display the Edit Watermark dialog box for creating your own, original watermark.

• EPrint Centered
Activate this setting to print document images in the center of the paper.

• Printing Originals Centered on Rolls ➔P.115
• Printing Originals Centered on Sheets ➔P.119

• FRotate 180 degrees
Activate this option to rotate document images by 180 degrees before printing.

• GNo Spaces at Top or Bottom (Conserve Paper)
Activate this setting to print the next image skipping blank areas above and below printable data in documents,
which enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins ➔P.126

• HCopies
Enter the number of copies to print, in a range of 1–999.

• Reverse Order
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Activate this option to print pages in reverse order.

• IPage Options
Click to display the Page Options dialog box, which enables you to complete settings for printing the user
name, date, or page number in the header or footer.

• Page Options Dialog Box ➔P.166

• JSpecial Settings
If the printing results are not as you expected, click this option to display the Special Settings dialog box and
change how printing is processed.

• Special Settings Dialog Box ➔P.167

• SDefaults
Click to restore all settings on the sheet to the default values.

Page Options Dialog BoxPage Options Dialog Box
The Page Options dialog box offers the following settings.

Note
• To display the Page Options dialog box, on the Layout sheet, click Page Options.  (See "Layout Sheet .") ➔P.165

• APrint Date
Select where the date is printed, as desired. To print the time as well, select BPrint Time Also.

• CPrint User Name
Select where the user name is printed, as desired.

• DPrint Page Number
Select where the page number is printed, as desired.

• EFormat Settings
Click to display the Format Settings dialog box, which enables you to complete format-related settings.
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Note
• If you specify the same position for multiple items, the items are printed from left to right in this order: date,

user name, and page number.

• When you print multiple pages per sheet using Page Layout Printing or similar functions, these items will be
printed for each page.

Special Settings Dialog BoxSpecial Settings Dialog Box
If the printing results are not as you expected, you can change how printing is processed in the Special Settings
dialog box.

Note
• To display the Special Settings dialog box, on the Layout sheet, click Special Settings. (See "Layout

Sheet .") ➔P.165

• Click the processing method for Parameter within the Settings Summaries frame to display a list of the setting
details under the frame.

• ASpooling at Printer Driver
Sets whether or not print jobs are spooled in the printer driver and processed by PageComposer.
Printing results may be improved in some cases by setting this to No or No (EMF Spooling).

Note
• When set to No or No (EMF Spooling), functions such as Page Layout, Watermark, Reverse Order, Page

Options, FineZoom Settings, and Preview Switchingcan no longer be used.

• BFineZoom Settings
This function is used in large-format printing.
If it is set to Yes, problems in the printing may be improved.
If it is set to No, image distortions such as fine lines disappearing may be improved.

• CPreview Switching
When this setting is turned on, PageComposer starts when printing is performed with the Open Preview
When Print Job Starts check box selected in the Main sheet.

• DApplication Color Matching Priority
When this is on, you can give applications priority in color management.

• EFast Graphic Process
Turning this setting on may help produce the expected results if image colors are inconsistent in printed docu-
ments or if lines are printed in varying thicknesses.

Note
• This function cannot be used on 64-bit version of Windows.

• FReduce Print Unevenness
If you want to reduce unevenness of the printed image, turn this on to improve the print result. However, print-
ing may take longer for some images.
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• GAdjust faint lines
Turn this off to obtain expected results when fine lines have been printed in a color different from other dia-
grams and illustrations. However, lines in some colors may appear broken.

Favorites SheetFavorites Sheet
The following settings are available on the Favorites sheet. For details on settings items, refer to the printer driver
help.

• AFavorites
Printing favorites you have created are listed with Default Settings favorites.

• Using Favorites ➔P.137

• BSettings Details
Displays details of the favorite selected in the AFavorites.

• CComment
Displays notes registered in the favorite.

• DApply Favorite
Click to change the current print settings to those of the favorite selected in the AFavorites.

• EApplication Settings Priority
Activate this setting to use settings values specified in the source application in preference to favorite settings
selected in the AFavorites, when clicking DApply Favorite. For details on the settings items used in prefer-
ence, refer to the printer driver help.

• FDelete
Click to delete the selected favorite from the AFavorites list.

• GEdit
Click to display the Edit dialog box, which enables you to change the name and icon for the favorite selected
in the AFavorites list.
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• HAdd
Click to display the Add dialog box, which enables you to add the current print settings as a favorite.

• I Import
Click to display the Open dialog box, which enables you to import favorite settings saved as a file.

• JExport
Click to display the Save As dialog box, which enables you to save the favorite settings as a file.

• KUp
Click to move the selected favorite up in the AFavorites list.

• LDown
Click to move the selected favorite down in the AFavorites list.

Utility SheetUtility Sheet
The following items can be executed on the Utility sheet. For details on the utilities, refer to the relevant utility help.

• AMaintenance
Click to start the imagePROGRAF Status Monitor, which offers the following maintenance for the printer.

• Nozzle (ink ejecting outlet) check
• Nozzle (ink ejecting outlet) cleaning
• Head alignment adjustment
• Feed amount adjustment

• BColor imageRUNNER Enlargement Copy
Click to launch Color imageRUNNER Enlargement Copy (iR enlargement copy), which enables you to cre-
ate hot folders used for Color imageRUNNER Enlargement Copy and assign print settings to hot folders.

• Printing Enlargements of Scanned Originals from a Color imageRUNNER ➔P.211

For details, see "Color imageRUNNER Enlargement Copy." ➔P.203
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Note
• Color imageRUNNER Enlargement Copy is not displayed in 64-bit editions of Windows.

Support SheetSupport Sheet
On the Support sheet, you can view support information and the user's manual.

• ASupport Information
Click to access the Canon support webpage, where you can find the latest information on the printer and con-
sumables, check for printer driver updates, and browse other information.

• BUser Manual
Click to connect to the Internet and display the printer user's manual.

• CSettings Summaries
Click to display the View Settings dialog box, which enables you to confirm the settings for the Main, Page
Setup, Layout, and Favorites sheets.

Settings Summaries Dialog BoxSettings Summaries Dialog Box
The Settings Summaries dialog box enables you to confirm the settings for the Main, Page Setup, Layout, and
Favorites sheets.

• ACopy
Click to copy the settings information to the clipboard. You can paste the settings information into a file created
with a text editor or similar application.
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Device Settings SheetDevice Settings Sheet
Many settings items on the printer properties sheets are controlled by Windows applications. However, the Device
Settings sheet is for configuring the printer, and it is an extension of the printer driver.
The following settings are available on the Device Settings sheet.

• AColor Compatibility
Click to display the Color Compatibility dialog box, which enables you to adjust colors if you have selected
Color Mode > Color (CAD).

• For details on color settings, see "Specifying Colors and Printing CAD Drawings." ➔P.45

• BAbout
You can display version information for the printer driver.

iPF785                                                                                                                                                                                           Device Settings Sheet

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Printer Driver

171  



PreviewPreview
The Features of Preview ................................................................................................................................. 172
Starting Preview ............................................................................................................................................. 172

Preview Main Window .................................................................................................................................... 173
Dialog Area .....................................................................................................................................................175

Enlarge/Reduce the screen display .................................................................................................................176
Moving a Page ............................................................................................................................................... 176
Using the ruler ................................................................................................................................................ 176
Priority setting for rotating 90 degrees ............................................................................................................ 177
Printing with Selecting the Layout ................................................................................................................... 178
Print on the Center ......................................................................................................................................... 180
Not Print Spaces at the Top/Bottom ............................................................................................................... 181

The Features of PreviewThe Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.

• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen,
and you can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to

differ from the Preview settings.

Starting PreviewStarting Preview
Follow the procedure below to start the Preview.

1 Start the apllication software which you use.

2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3
 

On the Main sheet, click on the Open Preview
When Print Job Starts check box.
Click the OK button to save the settings.

Note
• Your printer is depicted in the lower-left area of this screen.
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4 On the Print dialog box in the apllication software, click the Print button.

5
 

Preview main window is displayed.

Preview Main WindowPreview Main Window
The Preview main window consists of the menu and tool bars, preview and dialog area and status bar.

Note
• You can use the View menu to show or hide the tool bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Preview Area
You can check the settings you made in this area.

• Dialog Area
This allows you to set the print conditions and perform a print job.
For more information about Dialog Area, see "Dialog Area." ➔P.175

• Status Bar
This shows the message, Pages and Output Size.
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Dialog AreaDialog Area
You can select the layout and print on the center.

• Media Type/Paper Source/Paper Size
You can confirm the information that is set.

• Layout Selection
You can print which conserves paper by selecting the layout.
For more information about Layout Selection, see "Printing with Selecting the Layout." ➔P.178

• Center Originals Across Roll
You can print on the center of the media loaded in the printer.
For more information about Center Originals Across Roll, see "Print on the Center." ➔P.180

Note
• Available only if rolls are selected in Paper Source.

• No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the
top or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." ➔P.181

Note
• Available only if rolls are selected in Paper Source.

• Print Button
Click the button to start printing.

• Cancel Button
Click the button to stop printing.

• Printer Information
You can confirm the information acquired from the printer.
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• Update Printer Information Button
Click the button to update the printer information with connecting to the printer.

• Status Monitor Button
Click the button to start Status Monitor.

Enlarge/Reduce the screen displayEnlarge/Reduce the screen display
You can enlarge or reduce the screen display when you select Zoom from the View menu.

Setting Details
Fit Screen Display all.

Fit to Width Display to the width of the paper.

Reduce Display at half of the standard size.

Standard Display at the standard size.

Enlarge Display with the double of the standard size.

Enlarge More Display with the triple of the standard size.

Note
• This item can be selected even if you have clicked the ▼ button in the toolbar Zoom.

Moving a PageMoving a Page
You can move a page to display when you select Go to Page from the View menu.

Setting Details
First Page Go to the first page.

Previous Page Go to the previous page.

Next Page Go to the next page.

Last Page Go to the last page.

Go To Page Go to the specified page.

Note
• You can also move a page by clicking  on the tool bar.

Using the rulerUsing the ruler
You can confirm the layout with using the ruler.

• Switching the ruler Show/Hide
In the View menu, select Ruler to switch the ruler Show/Hide.
 

• Changing the ruler unit
You can set the ruler unit when you select Units from the View menu.

Setting Details
mm Use mm as the ruler unit.

inch Use inches as the ruler unit.

Priority setting for rotating 90 degreesPriority setting for rotating 90 degrees
You can select Rotate 90 Degrees If Possible or Use Driver Settings from the Options menu.
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Setting Details
Rotate 90 Degrees If Possible Rotates pages in portrait orientation 90 degrees before printing. Pages are only rotated if

they can fit lengthwise across the roll.

Use Driver Settings Follows printer driver settings when determining whether to rotate pages.

Selecting Rotate 90 Degrees If Possible or Placing a checkmark for Rotate Page 90 degrees (Conserve Paper)
on the printer driver

Selecting Use Driver Settings
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Printing with Selecting the LayoutPrinting with Selecting the Layout
You can print which conserves paper by selecting the layout.

1
 

In Layout Selection, click the layout button to use.

Button Details
Upper Button

Turn at the position of .

Right Button

Turn at the position of .

Left Button

Turn at the position of .

Lower Button

Turn at the position of .
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Note
• Right Button or Left Button can be selected only when the rotated pages can fit lengthwise across the

roll.

• By clicking Right Button or Left Button, you can save paper by printing in landscape orientation on roll
paper.

• You can select only Upper Button or Lower Button
if Cut Sheet is selected.

 

Button Details
The button is selected currently.

The button can be selected.

The button can not be selected.

2 Click the Print button.
 

Printing on the selected layout begins.
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Print on the CenterPrint on the Center
You can print on the center of the media loaded in the printer.

1
 

Click the Center Originals Across Roll check box on.

2 Click the Print button.
 

Printing on the center begins.

Note
• Available only if rolls are selected in Paper Source.
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Not Print Spaces at the Top/BottomNot Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top
or bottom.

1
 

Click the No Spaces at Top or Bottom check box on.

2 Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.

 

iPF785                                                                                                                                                                       Not Print Spaces at the Top/Bottom

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Preview

181  



Free LayoutFree Layout
The Features of Free Layout ........................................................................................................................... 182
Starting Free Layout ....................................................................................................................................... 182

Free Layout Main Window .............................................................................................................................. 184
Detailed Settings ............................................................................................................................................ 185
Preferences Dialog Box .................................................................................................................................. 185
Page Options Dialog Box ............................................................................................................................... 186
Zoom Dialog Box ............................................................................................................................................187
Format Dialog Box ..........................................................................................................................................188

Laying out a Multiple-File Document on One Page ..........................................................................................189
Laying out a Document Created with Multiple Application Programs on One Page ......................................... 191
Selecting an Object ........................................................................................................................................ 193
Changing the Object Size ............................................................................................................................... 194
Moving an Object ........................................................................................................................................... 194
Rotating an Object ......................................................................................................................................... 195
Laying out Objects Automatically .................................................................................................................... 195
Aligning Objects ............................................................................................................................................. 195
Changing the Object Overlapping Order ......................................................................................................... 197
Pasting a Copied or Cut Object ...................................................................................................................... 198

Folded Duplex Window .................................................................................................................................. 199
Finished Size Settings Dialog Box ................................................................................................................... 200
Binding Settings Dialog Box ........................................................................................................................... 201
Prints using Folded Duplex ............................................................................................................................. 201

The Features of Free LayoutThe Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.

• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one
page, or lay out and print a document created with multiple application programs on one page.

• Any two pages can be arranged and printed in a layout that becomes duplex on folding.
This can be used such as for advertising posters that are suspended from the ceiling.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to

differ from the Free Layout settings.

Starting Free LayoutStarting Free Layout
Follow the procedure below to start the Free Layout.

1 Start the apllication software which you use.
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2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3
 

From the list, select the printer and select the Layout
sheet.

Note
• Your printer is depicted in the lower-left area of this screen.

4 In the Layout sheet, click on the Page Layout check box and select Free Layout from the list.
Click the OK button to save the settings.

Note
• When you select Free Layout, all other setting items will be disabled.

5
 

On the Print dialog box in the apllication software,
click the Print button.
Free Layout main window is displayed.
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Free Layout Main WindowFree Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and status bar.

Note
• You can use the View menu to show or hide the tool and status bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

• Layout Area
This allows you to lay out objects and edit the object size and orientation.
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• Status Bar
This shows the paper size, unit of length, and number of objects.

Detailed SettingsDetailed Settings
The printer driver opens when you select Detailed Settings from the File menu. The printer driver is used to con-
figure basic settings to match the type of media loaded in the printer.

Refer to "Printer Driver" ➔P.142  for details on the printer driver.

Note
• When you select the Detailed Settings, the only three sheets displayed are the Main sheet, the Page Setup

sheet, and theLayout sheet. Some of the printer driver settings may be disabled.

Preferences Dialog BoxPreferences Dialog Box
This dialog box appears when you select Preferences from the File menu. This allows you to configure the prefer-
ences of Free Layout.

• Units
Set the unit for paper length, margins, and so on.

• Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out ob-
jects.
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Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.88(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Grid Color
Select the grid line color.

• Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details
None You can print with no frame style.

Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

Crop Marks You can print with the crop marks.

Page Options Dialog BoxPage Options Dialog Box
This dialog box appears when you select Page Options from the File menu. This allows you to configure the roll
paper length, object layout order, and margins of Free Layout.

• Roll Paper Length
Set the length of one page to print on roll paper.
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The following settings are available for roll paper length.
Setting Details

Auto Settings The one-page length to be printed on roll paper is automatically set so that the laid-out
objects are printed on one page.

Manual Settings You can input the length of one page to print on roll paper in numerical characters.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Order
Set the object layout order.
The following settings are available for order.

Setting Details
Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Upper Right to Left The objects are laid out from upper right to left.

Lower Left to Top The objects are laid out from lower left to top.

Note
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can

choose Upper Left to Right or Upper Right to Left.

• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can
choose Upper Left to Bottom or Lower Left to Top.

• Margins
You can input the paper margins in numerical characters.

Note
• You can input between 0.0 and 50.0(mm) (between 0.00 and 1.97(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Zoom Dialog BoxZoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen dis-
play.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking ▼ button.
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Format Dialog BoxFormat Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object.

Size Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

• Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details
Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select Rotate.

• Enl./Red.
When you place a checkmark here, you can select Scaling, Fit Paper Size, or Fit Photo Size.

Setting Details
Scaling Allows you to input the value of the enlargement or reduction ratio of an object.

Fit Paper Size Prints by enlarging or reducing each object to match the paper size. If you are using roll
paper, objects are enlarged or reduced so that the width of each object matches the width
of the roll paper.

Fit Photo Size Prints all of the objects at the specified photo size.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.
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Position Sheet
You can rotate, enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

• Object Position
You can move the object position by changing the values.

Setting Details
Vertical Pos You can input the number of the vertical position in numerical characters.

Horizontal Pos You can input the number of the horizontal position in numerical characters.

Page Pos You can input the number of the page position in numerical characters.

• Object Size
You can confirm the object size.

Note
• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One PageLaying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.
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2
 

Click Properties to open the Properties dialog box.

3
 

In the Page Setup sheet, select Paper Source.

Note
• Your printer is depicted in the lower-left area of this screen.

4
 

In the Layout sheet, click on the Page Layout check
box and select Free Layout from the list.

Note
• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5 Click the OK button to save the settings.
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6
 

In the Print dialog box, select the pages to print and
the number of copies, and click the OK button.

Free Layout starts, laying out the document created
with application software in the layout area as an ob-
ject.

7 Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on OneLaying out a Document Created with Multiple Application Programs on One
PagePage

You can lay out and print a document created with multiple application programs on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.
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2
 

Click Properties to open the Properties dialog box.

3
 

In the Page Setup sheet, select Paper Source.

Note
• Your printer is depicted in the lower-left area of this screen.

4
 

In the Layout sheet, click on the Page Layout check
box and select Free Layout from the list.

Note
• Your printer is depicted in the lower-left area of this screen.
• When you select Free Layout, all other setting items will be disabled.

5 Click the OK button to save the settings.

 

 

 

Laying out a Document Created with Multiple Application Programs on One Page                                                                                                    iPF785

                                                                                                                                                                                                                     User's Guide

  

W
indows Software

Free Layout

 192



6
 

In the Print dialog box, select the pages to print and
the number of copies, and click the OK button.

Free Layout starts, laying out the document created
with application software in the layout area as an ob-
ject.

7 Leaving Free Layout running, open other files with other application software and repeat the above steps.

Selecting an ObjectSelecting an Object
When an object is selected, a select box (blue border) appears around the object.

 

 

iPF785                                                                                                                                                                                               Selecting an Object

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Free Layout

193  



Note
• To select an object, click that object.

• To select multiple successive objects, click them while holding down the Shift key.
• To select multiple arbitrary objects, click them while holding down the Ctrl key.
• To select all objects, select Select All from the Edit menu.

• When you specify the area with dragging the mouse, the object in the area is selected.

Changing the Object SizeChanging the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.

Resizing by means of mouse operation

1 Select an object.

2
 

Place the pointer at a corner of the selection box
around the object to show the arrow handle, and drag
this handle to change the object size.

Resizing by specifying a scaling value

1 Select an object.
Click on the Enl./Red. checkbox in the Format Dialog Box ➔P.188  and select Scaling.

2 You either enter numbers directly.

Note
• You can input between 25 and 600.
• You can change the numbers by clicking either ▲ button or ▼ button.

3 Click the OK button.

Moving an ObjectMoving an Object
You can move the object position.

1 Select an object.
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2
 

Place the pointer inside the selection box of the ob-
ject to show the crosshair handle, and drag it to move
the object.
Alternatively, you can move the Object Position by
changing the values in Vertical Pos, Horizontal Pos
and Page Pos in the Format Dialog Box ➔P.188 .

Rotating an ObjectRotating an Object
You can rotate the object.

1 Select an object.

2
 

Select Rotate Left 90 Degrees orRotate Right 90
Degrees from the toolbar.
Alternatively, you may click on the Rotate check box
in the Format Dialog Box ➔P.188  then select Rotate
Right or Rotate Left, and click the OK button.

Laying out Objects AutomaticallyLaying out Objects Automatically
Click Auto Arrange Object in the tool bar. This automatically lays out objects. Alternatively, you may select Auto
Arrange Object from the Object menu.

Note
• The object layout order varies depending on the Order setting in the Page Options Dialog Box ➔P.186  dialog box.

Aligning ObjectsAligning Objects
You can align objects systematically.

1 Select multiple objects.
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2 Click the align button from the toolbar.
Alternatively, you may select the align menu from the Object menu.

• Align Top
Lays out the objects, justifying them to the top.

• Center Vertically
Lays out the objects, justifying them to the verti-
cal center.

• Align Bottom
Lays out the objects, justifying them to the bot-
tom.

• Align Left
Lays out the objects, justifying them to the left.
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• Center Horizontally
Lays out the objects, justifying them to the hori-
zontal center.

• Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping OrderChanging the Object Overlapping Order
You can change the object overlapping order.

1 Select an object.

2 Select the Overlapping Order menu from the Object menu.

Note
• The order of overlapping affects the order of objects automatically laid out.
• You can also select by clicking the right button of the mouse on an object.

• Bring to Front
Moves the object to the frontmost position.
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• Send to Back
Moves the object to the backmost position.

• Bring Forward
Moves the object one position to the front.

• Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut ObjectPasting a Copied or Cut Object

1 Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2 Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.
• You can also select by clicking the right button of the mouse on an object.

• In order to paste an object on any position that you like, you can paste the object with Pointed Paste by clicking
the right button of the mouse on any position that you want.
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Folded Duplex WindowFolded Duplex Window
This window is displayed if you select Folded Duplex from the Edit menu after selecting an object. Using the Fol-
ded Duplex function allows you to print with fold lines added.
The Folded Duplex window consists of the menu and tool bars, layout area and status bar.

Note
• The toolbar and status bar can be toggled between hidden and displayed from the View menu.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.
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• Layout Area
This allows you to check the arrangement and orientation of objects.

• Status Bar
This shows the paper source, roll paper width, and output size.

Finished Size Settings Dialog BoxFinished Size Settings Dialog Box
This dialog box is displayed when you select Finished Size Settings from the Edit menu. This allows you to con-
figure finished size settings.

• Finished Size
Selects the method for setting the finished size.
The following settings are available for the finished size.

Setting Details
Fit Roll Paper Width Prints by automatically enlarging or reducing the entire document so that the width of the

document matches the roll paper width.

Specify Folded Size Prints by automatically enlarging or reducing the entire document to match the size of the
paper. Select the actual size of the paper you want to print on in Fit Paper Size.

Rotate Page 90 degrees (Con-
serve Paper)

Prints by rotating pages by 90 degrees. Pages are automatically rotated if they will fit with-
in the roll paper width when rotated, and are not rotated if they will not fit within the roll
paper width.
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Binding Settings Dialog BoxBinding Settings Dialog Box
This is displayed when you select Binding Settings from theEdit menu. This allows you to configure the binding
edge settings.

• Binding Edge
Configures the binding edge when folding paper.
The following settings are available for the binding edge.

Setting Details
Bottom Prints by placing the binding margin (gutter) at the bottom of the document.

Top Prints by placing the binding margin (gutter) at the top of the document.

• Binding
Configures the binding margin (gutter).
Prints by creating a binding margin (gutter) of the specified size. Enter the margin size as a number.

Note
• The values that can be entered are 0 to 50 (mm).

• Print Fold Lines
Configures the color and type of fold lines.

Note
• To not print fold lines, clear the Print Fold Lines checkbox.

• Fold Line Color
You can select the fold lines.

• Fold Line Type
You can select the fold lines.
The following settings are available for the fold line type.

Setting Details
Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

• Only Print Center and Edges
To print fold lines at the center and both edges, select the Only Print Center and Edges checkbox.

Prints using Folded DuplexPrints using Folded Duplex
This prints 2 pages consecutively. Folding back the paper at the fold lines of the center substitutes for duplex print-
ing.

1 Select two objects from the layout area of Free Layout.
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2 Select Folded Duplex from the Edit menu of Free Layout.
Open the Folded Duplex window and arrange the selected objects in the layout area.

3 Open the Finished Size Settings dialog box from the Edit menu.

4 Select Fit Roll Paper Width orSpecify Folded Size in Finished Size.

Note
• Rotate Page 90 degrees (Conserve Paper) is also available whenSpecify Folded Size is selected.

5 Click OK to save the settings.

6 Open the Binding Settings dialog box from the Edit menu.

7 Select Bottom or Top in Binding Edge.

8 Specify the Binding width in Binding.

9 Configure the Fold Line Color and Fold Line Type from Print Fold Lines.

Note
• When the Only Print Center and Edges checkbox is selected, fold lines are only printed at the three

locations of the center and both edges.

10 Click OK to save the settings.

11 Confirm the print setting and begin printing.
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The Features of Color imageRUNNER Enlargement CopyThe Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and
matching methods, in addition to borderless printing and enlargement/reduction process without growing
through the printer driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to

differ from the Color imageRUNNER Enlargement Copy settings.

Starting Color imageRUNNER Enlargement CopyStarting Color imageRUNNER Enlargement Copy
Follow the procedure below to start the Color imageRUNNER Enlargement Copy.

To start by selecting Printers and Faxes from the start button

1 Open the folder of the OS you are using for configuring printers.
For example, on Windows XP click the start button on the desktop, and then select Printers and Faxes.

2
 

Right-click the Printers icon and select Printing Pref-
erences to open the Printing Preferences dialog
box.
In the Utility sheet, click the Color imageRUNNER
Enlargement Copy button.
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3
 

The Color imageRUNNER Enlargement Copy dia-
log box displays.

Note
• If you click on the Add to Startup folder check box in the Color imageRUNNER Enlargement Copy dialog box,

the icon of Color imageRUNNER Enlargement Copy utility will appear on the task bar when starting Windows
thereafter.

To start by selecting Color imageRUNNER Enlargement Copy from the start button

1
 

From the Windows start button, select Color image-
RUNNER Enlargement Copy.

2
 

The Color imageRUNNER Enlargement Copy dia-
log box displays.

Color imageRUNNER Enlargement Copy Dialog BoxColor imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUN-

NER Enlargement Copy." ➔P.203
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• Hot Folder
The hot folder list appears.

• Add Button
Click the button to open the Easy Setup Wizard dialog box so that you can add a hot folder.

• Edit Button
From the Hot Folder list, select a hot folder and click the button to open the Add/Edit Hot Folder dialog box
that allows you to edit the hot folder.

• Delete Button
From the Hot Folder list, select a hot folder and click the button to delete the hot folder.

• Start Button
Clicking the button changes the status of the selected inactive Hot Folder to active.

• Stop Button
Clicking the button changes the status of the selected active Hot Folder to inactive.

• Add to Startup folder
Register the application in the Windows startup menu.

• Save Printed Data
Automatically saves printed data.

• About Button
Click the button to display the name and the version number of the utility.

• Operation Guide Button
Click the button to display the Color imageRUNNER Enlargement Copy Setup Manual.

Hot FolderHot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed
in enlarged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 20 hot folders.

Creating a New Hot FolderCreating a New Hot Folder

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box, and then click the Add button.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color im-

ageRUNNER Enlargement Copy." ➔P.203
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2
 

The Easy Setup Wizard dialog box displays.
Click the Next button.

3
 

Select the type of printer to use.
Click the Next button.

4 Select the media type to print.

Note
• If the Borderless Printing checkbox is checked, only media types that can be used for borderless print-

ing are displayed in the list.

Click the Next button.
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5
 

Select roll paper or cut sheet to print. Also, select the
media size to print.
Click the Next button.

6
 

Select the color matching method.
Click the Next button.

7 To receive a document scanned with the Color imageRUNNER, you need to share a folder. Enter the folder
shared name in Shared Name.
Click the Next button.

Note
• This shared name is used as the name of the hot folder.
• You cannot use the Back button, after clicking the Next button here.
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8
 

Click Finish button to close the Easy Setup Wizard
dialog box.
 

The hot folder you have created appears in the Hot
Folder list in the Color imageRUNNER Enlarge-
ment Copy dialog box.

Specifying an Existing Shared Folder as a Hot FolderSpecifying an Existing Shared Folder as a Hot Folder

1 Share the folder you want to specify as a hot folder.

2
 

Open the Color imageRUNNER Enlargement Copy
dialog box, and then click the Add button.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color im-

ageRUNNER Enlargement Copy." ➔P.203
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3
 

The Easy Setup Wizard dialog box displays.
Click the Manual Settings button.

4
 

The Add/Edit Hot Folder dialog box displays.
Enter the hot folder name in Name.
Click the Browse botton, with selecting Specify a
folder, to set the existing shared folder.

5
 

The location of the folders will appear.
Select the folder to specify a hot folder, and click the OK but-
ton.
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6
 

As necessary, set the print conditions in the hot fold-
er.  (See "Setting the Print Parameters.") ➔P.210
Click the OK button to close the Add/Edit Hot Fold-
er dialog box.
 

The hot folder you have created appears in the Hot
Folder list in the Color imageRUNNER Enlarge-
ment Copy dialog box.

Setting the Print ParametersSetting the Print Parameters
The printer driver opens when you click the Properties button in the Add/Edit Hot Folder dialog box. The printer
driver is used to configure basic settings to match the type of media loaded in the printer.

Refer to "Printer Driver" ➔P.142  for details on the printer driver.
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Note
• The only three sheets displayed are the Main sheet, the Page Setup sheet, and the Layout sheet. Some of the

printer driver settings may be disabled.

• Apply Sharpness
Place a checkmark here to set the sharpness.
Drag the slider bar to the left or right to adjust. You can also adjust by directly entering a number in the numer-
ic input field.

Note
• You can input between 0 and 500.
• You can change the numbers by clicking either ▲ button or ▼ button.
• You cannot be applied to PDF files.

Printing Enlargements of Scanned Originals from a Color imageRUNNERPrinting Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automati-
cally after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and com-
plete the settings for enlargement copy. For details, see "Creating a New Hot Folder." ➔P.205

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUN-
NER.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals
to the hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUN-
NER.
For instructions on assigning scanning settings and destinations to a Favorites button, refer to the setting manual,
displayed by clicking Color imageRUNNER Enlargement Copy Setup Manual button of Color imageRUNNER
Enlargement Copy utility, or refer to the Color imageRUNNER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For
detailed instructions, refer to the Color imageRUNNER manual.

1 Load the original on the platen glass or document feeder of the Color imageRUNNER.

2 Press Send to display the screen for transmission.

3 Press Favorites, and then press the Favorites button assigned to the hot folder.

4 Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press
Done on the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions
you specified for the folder.

iPF785                                                                                                                 Printing Enlargements of Scanned Originals from a Color imageRUNNER

User's Guide                                                                                                                                                                                                                     

  

W
indows Software

Color im
ageRUNNER Enlargem

ent Copy

211  



Print Plug-In for OfficePrint Plug-In for Office
Print Plug-In for Officefeatures ........................................................................................................................ 212
Steps to install ................................................................................................................................................ 212
Steps to uninstall ............................................................................................................................................ 215
When Print Plug-In for Office is not displayed ................................................................................................. 215

To start from Microsoft Word .......................................................................................................................... 218
Print Matching Roll Width(Word) ..................................................................................................................... 220
Borderless Printing(Word) ............................................................................................................................... 222
Multi-Page Printing(Word) ............................................................................................................................... 224
Register the settings (Word) ............................................................................................................................225
Print Using Registered Settings(Word) ............................................................................................................ 226
Portrait Orientation/Landscape Orientation(Word) ........................................................................................... 228

To start from Microsoft PowerPoint ................................................................................................................. 229
Print Matching Roll Width(PowerPoint) ............................................................................................................231
Borderless Printing(PowerPoint) ......................................................................................................................232
Multi-Page Printing(PowerPoint) ......................................................................................................................234
Register the settings (PowerPoint) .................................................................................................................. 236
Print Using Registered Settings(PowerPoint) ................................................................................................... 237
Portrait Orientation/Landscape Orientation(PowerPoint) ................................................................................. 238

To start from Microsoft Excel .......................................................................................................................... 240
Print Entire Sheet(Excel) ..................................................................................................................................241
Print Selected Area(Excel) ............................................................................................................................... 243
Configuring Binding (Excel) ............................................................................................................................. 246

Configuring Special Settings ........................................................................................................................... 247

Print Plug-In for OfficefeaturesPrint Plug-In for Officefeatures
Print Plug-In for Office is a Plug-In that enables easy printing from Microsoft Office.

• It is displayed on the toolbar/ribbon, so it is easily accessible.
• It can be set by just selecting from the Wizard.

• Large-Format Printing custom size can also be set in the Wizard from Microsoft Word or Microsoft Power-
Point.

• Custom size can be set automatically from Microsoft Excel.
• The layout can be checked before printing by starting the preview screen.

Note
• 64 bit edition Windows OS operates only on WOW64 (32 bit emulator).

Important
• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing image-

PROGRAF Print Plug-In for Office. For details, refer to "When Print Plug-In for Office is not dis-
played" ➔P.215 .

• If you opened the Office document from Internet Explorer, the software will not run correctly.

• If you are editing an embedded object or link object, the software will not run correctly.

• If you added the imagePROGRAF Print Plug-In ribbon to the Microsoft Office Quick Access toolbar, the soft-
ware will not run correctly.

Steps to installSteps to install
Below are the steps to install Print Plug-In for Office.

Note
• You must log into Windows as an Administrator before the installation.
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1 Insert "User Software CD-ROM" into the CD-ROM drive and start the installer.

Note
• If the installer screen does not appear automatically, open the CD-ROM drive icon of your computer and

double-click the iPFInst.exe icon.

2
 

Click the imagePROGRAF Print Plug-In button.

3
 

Click the Nextbutton.

4
 

Read the License Agreement, and click the Yes but-
ton.
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5
 

Click the Start button.

6
 

Click the Yes button.

Note
• The following message may be displayed in Windows 8

or a later OS. If this happens, install the .NET Frame-
work by following the procedure.

 

7
 

Click the Exit button.

The installation for Print Plug-In for Office is com-
plete.

Important
• When you install this software, the virtual printer Canon imagePROGRAF PrintPlugIn may be installed. If you

want to use this software, do not uninstall the virtual printer Canon imagePROGRAF PrintPlugIn.

• The Print Plug-In for Office toolbar/ribbon might not be displayed in Microsoft Office after installing image-
PROGRAF Print Plug-In for Office.
Refer to the following topic for details on how to display the imagePROGRAF Print Plug-In for Office toolbar/
ribbon.

• When Print Plug-In for Office is not displayed ➔P.215
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Steps to uninstallSteps to uninstall
Below are the steps to uninstall Print Plug-In for Office.

1 If Microsoft Office is open, close it.

2 Select Control Panel from the start menu.

3 Open Add or Remove Programs.

4
 

Select imagePROGRAF Print Plug-In, and click the
Remove button.

Note
• You cannot uninstall Print Plug-In for Office if an Office application is running. When a message appears, select

Cancel and close all Office applications that are running.

When Print Plug-In for Office is not displayedWhen Print Plug-In for Office is not displayed
Buttons such as Start imagePROGRAF Print Plug-In sometimes do not appear in the Word, PowerPoint and
Excel Office applications, and the Print Plug-In for Office functions are not available.
In this event, re-install Print Plug-In for Office.
If you are using Microsoft Office 2003 or later, you can also enable add-ins to display Print Plug-In for Office.
See below for the procedure for re-installing the plug-in or enabling add-ins.

Re-installing Print Plug-In for Office
If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.
In this event, you will need to re-install Print Plug-In for Office to display the imagePROGRAF Print Plug-In tool-
bar/ribbon.

Note
• You cannot re-install Print Plug-In for Office once an Office application is running. When the message appears,

select Cancel and close the active Office application.

Re-install Print Plug-In for Office as follows:

1 Close Microsoft Office if it is open.

2 Install Print Plug-In for Office.
For information about instsalling, see "Steps to install." ➔P.212

Enabling Print Plug-In for Office for items disabled in Office applications
If a problem occurs, such as the system or an application terminating abnormally, the Microsoft Office application
disables add-ins as a safety precaution.
In this event, you will need to restore the disabled add-ins in order to display the imagePROGRAF Print Plug-In
toolbar/ribbon.
Use the procedure below to restore the add-ins disabled by Microsoft Office.
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• For Microsoft Office 2010 or later

1
 

Select Options from the File menu.

2 From the list on the left side of the <application name> options dialog box, select Add-ins.

3
 

Select Disabled Items in the Manage combo box
and click the Go button.

4
 

If Addin imageprograf print plug-in (ipfaddinif.dll) is dis-
played in the Disabled Items dialog box, select it and click
the Enable button.

5 Close all the dialog boxes and restart the Office application.

• For Microsoft Office 2007
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1
 

Click the Office button and then click the <applica-
tion name> options button.

2 From the list on the left side of the <application name> options dialog box, select Add-ins.

3
 

Select Disabled Items in the Manage combo box
and click the Go button.

4
 

If Addin imageprograf print plug-in (ipfaddinif.dll) is dis-
played in the Disabled Items dialog box, select it and click
the Enable button.

5 Close all the dialog boxes and restart the Office application.

• For Microsoft Office 2003
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1
 

Click About <application name> in the Help menu of application.

2
 

Click the Disabled Items button in the About <appli-
cation name> dialog box.

3
 

If Addin imageprograf print plug-in (ipfaddinif.dll) is dis-
played in the Disabled Items dialog box, select it and click
the Enable button.

4 Close all the dialog boxes and restart the Office application.

To start from Microsoft WordTo start from Microsoft Word
Below are the steps to start Print Plug-In for Office from Microsoft Word.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed on the toolbar/
ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• "When Print Plug-In for Office is not displayed" ➔P.215
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3
 

Check that the imagePROGRAF Print Plug-In toolbar/
ribbon is displayed.

4 Click the buttons on the toolbar/ribbon according to the items you want to set.
Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.
You can change the settings using the Special Settings dialog box.
Refer to "Configuring Special Settings" ➔P.247  for details.

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed again.
Select this when you want to display all printer drivers or update the display.

PrintButton

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page Printing,
and Print Using Registered Settings can be set.

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.

  Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.
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  Large-Format Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard

is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to
change displays or operate the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data
again.

Print Matching Roll Width(Word)Print Matching Roll Width(Word)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape
orientations made in Large-Format Printing Wizard.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

 

 

Print Matching Roll Width(Word)                                                                                                                                                                              iPF785

                                                                                                                                                                                                                     User's Guide

  

W
indows Software

Print Plug-In for O
ffice

 220



4
 

Click Print Matching Roll Width.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.

8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

11 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• When you print to the edge of the roll width, the maximum length will be the lesser of 5.587 times the roll
paper width, or 18.0m.

12 Press Print to start printing.
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Borderless Printing(Word)Borderless Printing(Word)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

4
 

Click Borderless Printing.

5 A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-
in is selected in Choose how to proceed and press OK.

Note
• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and return to

the application.
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6 Select Roll Paper Width that is set in the printer.

7 Select layout.

8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

11 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the One-Touch Registration button to register the settings. This is useful for multiple printing using
the same settings.

• Press the Print Preview button to display the preview screen. You can confirm and make changes to the
layout in the preview screen.

• The maximum length for Borderless Printing is the lesser of 5.587 times the roll paper width, or 18.0m.

12 Press Print to start printing.
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Multi-Page Printing(Word)Multi-Page Printing(Word)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

4
 

Click Multi-Page Printing.

5 Select Roll Paper Width that is set in the printer.

6 Select layout from Layout Selection.
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7
 

Select Next.

8 Select Media Type.

9 Select Print Range from All Pages, Current Page, and Pages.
If Pages is selected, enter the number of pages.

10 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• The maximum length for Multi-Page Printing is the lesser of 5.587 times the roll paper width, or 18.0m.

11 Press Print to start printing.

Register the settings (Word)Register the settings (Word)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered
settings can be recalled from Print Using Registered Settings.

1 Set up to the Print screen from Print Matching Roll Width,Borderless Printing or Multi-Page Printing of
Printing Menu.

Note
• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width(Word) ➔P.220
• Borderless Printing(Word) ➔P.222
• Multi-Page Printing(Word) ➔P.224
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2
 

Click the One-Touch Registration button.

3 Enter name in Name.
Up to 31 characters can be entered.

4 Click . The name you entered is displayed in Registered Settings.

5 Click OK, and return to the Print screen.

6 Click Print to print, and click Cancel to cancel the print.

Note
• Clicking Cancel in the Print screen will not delete the registered settings.

Print Using Registered Settings(Word)Print Using Registered Settings(Word)
Prints using the registered settings.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.
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4
 

Click Print Using Registered Settings.

5
 

Click the Nextbutton.

6 Select Media Type.

7 Select Print Range from All Pages, Current Page, or Pages.
If Pages is selected, enter the number of pages.

8 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• The maximum print length when printing with the registered settings is the lesser of 5.587 times the roll
paper width, or 18.0m.

9 Press Print to start printing.
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Portrait Orientation/Landscape Orientation(Word)Portrait Orientation/Landscape Orientation(Word)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orien-
tation Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page
sizes for Landscape Orientation.

1 Start Microsoft Word.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3 Click Paper Settings from the imagePROGRAF Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is displayed.

Note
• If you want to change the display to another file or application while the Large-Format Printing Wizard is

open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to change
displays or operate the toolbar/ribbon.

4 Click Portrait Orientation or Landscape Orientation.

Note
• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.
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5 Adjust Length from the list-box or slide-bar.

6 Click the Create Page button.

7
 

ClickOK if the message is displayed.

8 Edit and create the document.

Note
• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Matching Roll

Width, see "Print Matching Roll Width(Word)." ➔P.220

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data again.

To start from Microsoft PowerPointTo start from Microsoft PowerPoint
Below are the steps to start Print Plug-In for Office from Microsoft PowerPoint.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed on the toolbar/
ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed ➔P.215

3
 

Check that the imagePROGRAF Print Plug-In toolbar/
ribbon is displayed.

4 Click the buttons on the toolbar/ribbon according to the items you want to set.
Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring Spe-
cial Settings.") ➔P.247

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed again.
Select this when you want to display all printer drivers or update the display.

PrintButton

The print Wizard is displayed.
The settings Print Matching Roll Width, Borderless Printing, Multi-Page Printing,
and Print Using Registered Settings can be set.
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Icon Contents

Paper Settings Button

Large-Format Wizard is displayed.
Settings for Portrait or Landscape Orientation can be set.

  Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

Note
• If you open a password protected document as read-only, the Printing Wizard cannot be run.

  Large-Format Printing Wizard dialog box

Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard

is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to
change displays or operate the toolbar/ribbon.

• The layout may collapse if you create a form using existing data. If that is the case, modify the data
again.

Note
• If you open a password protected document as read-only, the Large-Format Printing Wizard cannot be

run. Remove the password protection.
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Print Matching Roll Width(PowerPoint)Print Matching Roll Width(PowerPoint)
Prints to the edge of the roll width. You can print large exhibits and posters, and also print Portrait and Landscape
orientations made in Large-Format Printing Wizard.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

4
 

Click Print Matching Roll Width.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.
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8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• When you print to the edge of the roll width, the maximum length will be the lesser of 14.22 times the roll
paper width, or 18.0m.

12 Press Print to start printing.

Borderless Printing(PowerPoint)Borderless Printing(PowerPoint)
Prints up to the border of the media. Photos and posters can be printed without worrying about margins.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.
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3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

4
 

Click Borderless Printing.

5 A confirmation dialog box is displayed. If the data fills up the page, confirm that Continue using the plug-
in is selected in Choose how to proceed and press OK.

Note
• To adjust the data, select Return to application and press OK. Exit Print Plug-In for Office and return to

the application.
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6 Select Roll Paper Width that is set in the printer.

7 Select layout.

8
 

Select Next.

9 Select Media Type.

10 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

11 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the One-Touch Registration button to register the settings. This is useful for multiple printing using
the same settings.

• Press the Print Preview button to display the preview screen. You can confirm and make changes to the
layout in the preview screen.

• The maximum length for Borderless Printing is the lesser of 14.22 times the roll paper width, or 18.0m.

12 Press Print to start printing.

Multi-Page Printing(PowerPoint)Multi-Page Printing(PowerPoint)
Prints multiple pages as one page. You can print handouts into a single page, or print matter with many pages.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.
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3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

4
 

Click Multi-Page Printing.

5 Select Roll Paper Width that is set in the printer.

6 Select layout from Layout Selection.

7
 

Select Next.
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8 Select Media Type.

9 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

10 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• The settings are registered when the One-Touch Registration is pressed. This is convenient if you to
need print multiple times using the same setting.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• The maximum length for Multi-Page Printing is the lesser of 14.22 times the roll paper width, or 18.0m.

11 Press Print to start printing.

Register the settings (PowerPoint)Register the settings (PowerPoint)
If you are going to print multiple times using the same setting, you can select One-Touch Registration. Registered
settings can be recalled from Print Using Registered Settings.

1 Set up to the Print screen from Print Matching Roll Width,Borderless Printing or Multi-Page Printing of
Printing Menu.

Note
• Up to 20 items can be registered.
• The available settings are as follows.

• Print Matching Roll Width(PowerPoint) ➔P.231
• Borderless Printing(PowerPoint) ➔P.232
• Multi-Page Printing(PowerPoint) ➔P.234

2
 

Click the One-Touch Registration button.

3 Enter name in Name.
Up to 31 characters can be entered.

4 Click . The name you entered is displayed in Registered Settings.

5 Click OK, and return to the Print screen.

6 Click Print to print, and click Cancel to cancel the print.

Note
• Clicking Cancel in the Print screen will not delete the registered settings.
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Print Using Registered Settings(PowerPoint)Print Using Registered Settings(PowerPoint)
Prints using the registered settings.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3
 

Click Print from the imagePROGRAF Print Plug-In
toolbar/ribbon.
The Printing Wizard dialog box is displayed.

Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

4
 

Click Print Using Registered Settings.
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5
 

Click the Nextbutton.

6 Select Media Type.

7 Select Print Range from All Slides, Current Slide, and Slides.
If Slides is selected, enter the slide number.

8 Enter Copies.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• The maximum print length when printing with the registered settings is the lesser of 14.22 times the roll
paper width, or 18.0m.

9 Press Print to start printing.

Portrait Orientation/Landscape Orientation(PowerPoint)Portrait Orientation/Landscape Orientation(PowerPoint)
Print to the edge of the roll width. You can print large exhibits and posters, or print the Landscape or Portrait Orien-
tation Page Sizes made in the Large-Format Printing Wizard.

Create Page Size in Portrait or Landscape Orientation.
Use the Large-Format Printing Wizard to create portrait page sizes for Potrait Orientation, and landscape page
sizes for Landscape Orientation.

1 Start Microsoft PowerPoint.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.
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3
 

Click Paper Settings from the imagePROGRAF
Print Plug-In toolbar/ribbon.
The Large-Format Printing Wizard dialog box is
displayed.

Important
• If you want to change the display to another file or application while the Large-Format Printing Wizard

is open, close the Large-Format Printing Wizard dialog box. Otherwise, you may not be able to
change displays or operate the toolbar/ribbon.

4 Click Portrait Orientation or Landscape Orientation.

Note
• The steps taken to create a Portrait Page Size will be used as an example to explain the procedure.

5 Adjust Length from the list-box or slide-bar.

6 Click the Create Page button.

7
 

ClickOK if the message is displayed.
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8 Edit and create the document.

Important
• The layout may collapse if you create a form using existing data. If that is the case, modify the data

again.

Note
• Printing is done in Print Matching Roll Width of the Printing Wizard. For details on Print Matching Roll

Width, see "Print Matching Roll Width(PowerPoint)." ➔P.231

To start from Microsoft ExcelTo start from Microsoft Excel
Below are the steps to start Print Plug-In for Office from Microsoft Excel.

1 Start Microsoft Excel.

2
 

If Start imagePROGRAF Print Plug-In is displayed on the toolbar/
ribbon, click it.

Important
• If the imagePROGRAF Print Plug-In toolbar/ribbon is not displayed, refer to the following.

• When Print Plug-In for Office is not displayed ➔P.215

3
 

Check that the imagePROGRAF Print Plug-In toolbar/ribbon
is displayed.

4 Click the buttons on the toolbar/ribbon according to the items you want to set.
Icon Contents

Menu

Displays the About, Help, and Special Settings dialog boxes.  (See "Configuring Spe-
cial Settings.") ➔P.247

Printer list

Select Printer.
If you select Show All Printers, the imagePROGRAF printers will be displayed again.
Select this when you want to display all printer drivers or update the display.

PrintButton

The print Wizard is displayed.
The settings Print Entire Sheet and Print Selected Area can be set.

  Printing Wizard dialog box
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Important
• If you want to change the display to another file or application while the Printing Wizard is open, close

the Printing Wizard dialog box. Otherwise, you may not be able to change displays or operate the tool-
bar/ribbon.

• The Printing Wizard will not start if you click the Print button on the toolbar/ribbon while editing a cell.

• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one work-
sheet and click Print again.

• When an object is selected, the Printing Wizard is not started if you click the Print button on the tool-
bar/ribbon.

• If the paper size in Excel is blank, the Printing Wizard cannot be run. From the File menu in Excel,
select Page Setup and check Paper size.

Note
• If you click the Print button with a graph selected, a message dialog box will appear asking if you want to

continue printing. If you click No, you will return to the application.

• If you click the Print button with a page break set, a message dialog box will appear asking if you want to
continue printing. If you click No, you will return to the application. If you do not use the set page break,
check the page break preview and change the setting.

• If you click the Print button with a page range set, a message dialog box will appear asking if you want to
continue printing. If you click No, you will return to the application. If you do not use the set page range,
check the page break preview and change the setting.

• If you click the Print button with a worksheet or cell protected, a message dialog box will appear asking if
you want to continue printing. If you click No, you will return to the application. If you want to change the
setting, remove the protection from the worksheet or cell.

Print Entire Sheet(Excel)Print Entire Sheet(Excel)
For resizing the entire sheet to fit the roll width. Choose this option to enlarge the currently displayed sheet before
printing.

1 Start Microsoft Excel.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3 Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one work-

sheet and click Print again.

If a print area is set, a confirmation message dialog box will
appear.
To print the entire sheet, cancel the setting of the print area.
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The Printing Wizard dialog box is displayed.

4
 

Click Print Entire Sheet.
A message will appear informing you that analysis is
in progress.

The Layout menu will appear automatically.

Note
• If data analysis requires time, a message dialog will appear. If you select No, you will return to the applica-

tion.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.
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8 To configure Binding, click the Binding Settings button.
Refer to "Configuring Binding (Excel)" ➔P.246  for details on the procedure for configuring Binding.

9
 

Select Next.

10 Select Media Type.

11 Enter Copies.

12 If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• When you print to the edge of the roll width, the maximum print length is 18.0m.

13 Press Print to start printing.

Important
• If divided into plural pages, try reducing the data size or the range you select.

• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

Print Selected Area(Excel)Print Selected Area(Excel)
For resizing the selected range of cells to fit the roll width. Choose this option to enlarge a particular part of the
sheet before printing.

1 Start Microsoft Excel.

2
 

If Start imagePROGRAF Print Plug-In is displayed, click it.

3 Click Print from the imagePROGRAF Print Plug-In toolbar/ribbon.

Important
• When more than one worksheet is selected, the Printing Wizard cannot be run. Select only one work-

sheet and click Print again.
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If a print area is set, a confirmation message dialog box will
appear.
To print the selected area, cancel the setting of the print area.

The Printing Wizard dialog box is displayed.

4 Click Print Selected Area.

Important
• If only one cell is selected, Print Selected Area cannot be selected.

A message will appear informing you that analysis is
in progress.
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The Layout menu will appear automatically.

Important
• If the range selected in Excel 2007 or later is too large, it will not be possible to analyze the data. Select

a smaller range and then run the analysis.

Note
• If data analysis requires time, a message dialog will appear. If you select No, you will return to the applica-

tion.

5 Select Roll Paper Width that is set in the printer.

6 Select image size.

7 Select layout.

8 To configure Binding, click the Binding Settings button.
Refer to "Configuring Binding (Excel)" ➔P.246  for details on the procedure for configuring Binding.

9
 

Select Next.

10 Select Media Type.

11 Enter Copies.
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12 If the upper and lower margins are too wide, check No Spaces at Top or Bottom (Conserve Paper).
The upper and lower margins can be checked in Print Preview.

Note
• When Print in Draft mode is selected, printing is fast but the print quality is poor.

• When Saturation is selected, you can print posters, etc., vividly.

• Press the Print Preview button to display the preview screen. You can check and make changes to the
layout in the preview screen.

• When you print to the edge of the roll width, the maximum print length is 18.0m.

13 Press Print to start printing.

Important
• If divided into plural pages, try reducing the data size or the range you select.

• You cannot run Print or Print Preview if you select it for a worksheet with no data displayed.

Configuring Binding (Excel)Configuring Binding (Excel)
You can configure Binding margins for binding printouts.

1 Configure the settings up to Layout Selection in the Layout screen in Print Entire Sheet or Print Selec-
ted Area.
Refer to "Print Entire Sheet(Excel)" ➔P.241  and "Print Selected Area(Excel)" ➔P.243  for the configuration
methods.

2 Click the Binding Settings button.

Important
• You cannot click the Binding Settings button in the following situations.

• When the Image Size is set to a value smaller than 100%
• When a graph is selected
• When page breaks have been set
• When a sheet or cell is protected

Open the Binding Settings dialog box.

3 If the Binding checkbox is not checked, select it to turn binding on.

4 Select Binding Edge.

5 Select Binding Margin.

 

Configuring Binding (Excel)                                                                                                                                                                                     iPF785

                                                                                                                                                                                                                     User's Guide

  

W
indows Software

Print Plug-In for O
ffice

 246



6
 

Click the OK button.
Return to the Layout screen.

Check that the Binding settings are applied in the
preview screen.

7 Configure the settings in the Printing Wizard dialog box.

Configuring Special SettingsConfiguring Special Settings
You can configure Special Settings from the imagePROGRAF Print Plug-In toolbar.

1
 

Click imagePROGRAF in the toolbar, and select
Special Settings.

2 Turn the checkbox for the item you want to change on or off.
Item Details

Show progress indicator during plug-in start-
up

When this setting is off, hides the progress indicator that appears while the
plug-in is starting up.

Center sheets and print areas When this setting is off, printing is performed without changing the position.
When this setting is on, printing is performed with the top, bottom, left, and
right margins layed out equally. When this setting is off, printing is per-
formed without changing the position.
This function is only valid in Microsoft Excel.

Ensure image quality when creating page
sizes

When this setting is on, documents are created at the maximum size. This
reduces the enlargement ratio during actual printing, which minimizes deg-
radation of the quality of photos, etc.
This function is only valid in Microsoft PowerPoint.

Correct the print area when analyzing For data that cannot be processed with usual data analysis, the print area
is corrected and then the data is processed. When data analysis fails, you
may be able to print by turning on this checkbox.
This function is only valid in Microsoft Excel.

3 Click OK to close the Special Settings dialog box.
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Printer Driver SettingsPrinter Driver Settings
For instructions on accessing the Mac OS printer driver, refer to the following topics.

• Accessing the Printer Driver Dialog Box from Applications ➔P.254

For information on the Mac OS printer driver settings, refer to the following topics.

• Main Pane ➔P.254
You can specify the media type, color processing, print quality, print preview, and other settings. Choose Easy
Settings to specify basic print settings based on the printing application or Advanced Settings to complete
more detailed settings as desired.

• Paper Detailed Settings Dialog Box ➔P.258
• View set. Dialog Box for the Printing Application ➔P.260
• Color Settings Pane: Color ➔P.262
• Object Adjustment dialog box: Color ➔P.263
• Matching pane ➔P.260
• Color Settings Pane: Monochrome ➔P.264
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• Object Adjustment dialog box: Monochrome ➔P.265

• Page Setup Pane ➔P.265
You can specify the page size of the original, borderless printing, enlargement or reduction, the orientation, the
paper size and source, and automatic cutting.

• Additional Settings Pane ➔P.266
You can configure the method of outputting print jobs to the printer.

With the imagePROGRAF Free Layout feature, you can arrange originals from various source applications on a
single page before printing. For details, see "Free Layout." ➔P.289
With the imagePROGRAF Preview feature, you can check the layout before printing and adjust layout or size set-
tings while viewing a preview screen. For details, see "Preview." ➔P.268
With the Color imageRUNNER Enlargement Copy feature, you can automatically enlarge and print scanned origi-
nals from a Color imageRUNNER. For details, see "Color imageRUNNER Enlargement Copy." ➔P.312

Specifying Paper in the Printer DriverSpecifying Paper in the Printer Driver
If you have replaced the paper, you must complete the following settings in the printer driver.

1 This sets the BFormat for and CPaper Size.

Note
• The configuration method varies depending on the

OS and application software you are using.
If Page Setup is displayed in the application menu,
the settings are configured by opening the Page At-
tributes dialog box from Page Setup.

If it is not displayed, the settings are configured in the
upper part of the printer driver displayed when you se-
lect Print from the application software menu.

 

 

2 Select the printer in the APrinter list.

3 Choose the original size in the FPaper Size list.

4 If you configured the settings using the Page Attributes dialog box, click FOK to close the dialog box, and
then select Print from the application software menu.
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5
 

Access the Main pane.

6 In the AMedia Type list, select the type of paper that is loaded.

7
 

Access the Page Setup pane.

8 In the APaper Source list, select how paper is supplied.

9 If Roll Paper is selected in APaper Source, select the width of the roll paper that is loaded in BRoll
Width.

Note
• A variety of settings are available in the printer driver to suit different printing applications.

For details on available printing conditions, see "Printer Driver Settings ." ➔P.250

Confirming Print SettingsConfirming Print Settings
The ways to confirm what printing conditions have been specified are as follows.

Checking a print preview
You can check an image of the original just as it will be printed.
Confirming the image of print jobs beforehand helps prevent printing errors.
For details on print previews, see "Checking the Layout in a Preview Before Printing." ➔P.130
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Checking the Layout in a Preview Before PrintingChecking the Layout in a Preview Before Printing
This topic describes how to check the layout before printing using the Canon imagePROGRAF Preview function.

1 Choose Print in the application menu.

2
 

Access the Main pane.

3 Select the OPrint Preview check box.

4 Click MPrint.

5
 

The Canon imagePROGRAF Preview window is
displayed.

6 Check the layout and adjust settings in the Canon imagePROGRAF Preview window as desired.

7 Print from the Canon imagePROGRAF Preview menu.

Note
• For details on imagePROGRAF Preview functions, see "Preview." ➔P.268

Using FavoritesUsing Favorites
You can use the Presets function in Mac OS for favorite-based printing.
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Note
• In the printing dialog box, click Save As in the Presets list to save the current print settings. This is a standard

feature of the operating system. For details, refer to the Mac OS documentation.

Accessing the Printer Driver Dialog Box from ApplicationsAccessing the Printer Driver Dialog Box from Applications

1 In the application software, select Print from the File menu to display the dialog box for printing conditions.

Note
• This dialog box includes basic printing options and enables you to choose the printer, specify the range of

pages, number of copies, and so on.

2
 

Select the printer in the Printer list.

3
 

Click Print to start printing.
As shown in the following illustration, you can switch
to other panes in this dialog box to complete settings
for various methods of printing, including enlarged
and reduced printing, borderless printing, and so on.

Main PaneMain Pane
The following settings are available on the Main pane. For details on settings items, refer to the printer driver help.

Note
• On the Main pane, choose Easy Settings to specify basic print settings based on the print target, or switch to

Advanced Settings to complete more detailed settings as desired.
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Common Items

• AMedia Type
Select the paper type.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Dis-
playing the Paper Reference Guide.") ➔P.331

• CSet
Displays Paper Detailed Settings. You can configure the printing settings to match the type of media, such as
the ink drying time.

• Paper Detailed Settings Dialog Box ➔P.258

• OPrint Preview
When the check box is selected, imagePROGRAF Preview is launched before printing.
This allows you to check on-screen previews of documents before printing.

Important
• When Free Layout is selected on the Page Setup panel, Free Layout is disabled.

• Checking the Layout in a Preview Before Printing ➔P.130
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Configuration using Easy Settings

• EPrint Target
Choose presets that match the type of document to be printed.

• Printing Photos and Images ➔P.31
• Printing Office Documents ➔P.35

• FPrint Quality
Choose the level of print quality.

• GView set.
Click to display the View set. dialog box, which enables you to confirm the settings for the selected item from
the EPrint Target list or change the order of items listed in EPrint Target.

• View set. Dialog Box for the Printing Application ➔P.260

Configuration using Advanced Settings

Main Pane                                                                                                                                                                                                             iPF785

                                                                                                                                                                                                                     User's Guide

  

M
ac O

S Software
Printer Driver

 256



• EPrint Priority
Choose the graphic elements that you want to emphasize for printing.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54

• FPrint Quality
Choose the level of print quality.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54

• NHighest quality
When the check box is selected, printing is performing focusing on quality. Printing takes longer and consumes
more ink than in other modes, but this mode offers superior printing quality.

Note
• If you set FPrint Quality to High, you can select NHighest quality. However, depending on AMedia

Type, you may not be able to select NHighest quality.

• KEconomy Printing
When this mode is selected, you can print with less ink consumed. However, print quality is lower than in regu-
lar printing. Select this option to save ink, such as when printing to check drawings. Depending on the AMe-
dia Type and FPrint Quality settings, this mode may not be available.

Note
• If you set FPrint Quality to Fast, you can select KEconomy Printing. However, depending on AMedia

Type, you may not be able to select KEconomy Printing.

• RFast Graphic Process
Select this option to print faster than usual, when possible.

• HColor Mode
Choose the color mode.

• Giving Priority to Particular Graphic Elements and Colors for Printing ➔P.54

• ISet
Click to display the Color Settings dialog box for more advanced color settings.

• Adjusting the Color in the Printer Driver ➔P.48

• JUnidirectional Printing
Select this checkbox to prevent problems such as misaligned lines and improve the print quality. However, the
printing speed becomes slower.

• QThicken Fine Lines
Select this check box to print fine lines more distinctly.

• PSharpen Text
Select this check box to print text more sharply.

• SReduce Print Unevenness
Select this checkbox for two-pass printing to reduce color shading.
This option is displayed if you have selected Plain Paper in Media Type and Office Document in Print Priori-
ty.
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Paper Detailed Settings Dialog BoxPaper Detailed Settings Dialog Box
The Paper Detailed Settings dialog box offers the following settings. For details on settings items, refer to the
printer driver help.

Note
• To display the Paper Detailed Settings dialog box, on the Main pane, click Set by Media Type.  (See "Main

Pane .") ➔P.254

AMedia Type
The paper selected with Media Type of the Main panel is displayed.
For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Displaying
the Paper Reference Guide.") ➔P.331

BDrying Time
Specify the time that the printer waits for ink to dry, as needed. The Between Pages setting is only valid for rolls.

• CBetween Pages
You can set the time to wait after printing 1 document page until ejecting the paper. Since waiting time is re-
quired for ink to dry before a roll is cut, you can deliver paper in the Output Stacker with the ink dried even if
Cutting Mode is set to Automatic.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

None Paper is ejected immediately after printing completes.

30 sec. / 1 min. / 3 min. / 5 min. /
10 min. / 30 min. / 60 min.

Paper is ejected when the set time elapses after printing completes.

• DBetween Scans
You can set the time to wait after printing 1 line on a page until printing the next line. Set this to avoid bleeding
or color unevenness such as when bleeding occurs on a page or when color unevenness occurs during bor-
derless printing.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

None The next line is printed immediately after a line is printed.

1 sec. / 3 sec. / 5 sec. / 7 sec. / 9
sec.

The next line is printed when the set time elapses after a line is printed.
 

* Increase the time according to the occurrence condition of bleeding or unevenness.
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ERoll Paper Margin for Safety
You can specify the length of a margin on the leading edge of paper to ensure that paper susceptible to curling is
held firmly against the Platen.

• FNear End Margin
Specify the length of the Near End Margin (the leading edge margin) of the roll, as needed.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

3 mm (0.12 in) The document is printed in the standard size.
 

* Select this when you do not have any problems in printing.

20 mm (0.8 in) Select this when rubbing against the printhead occurs such as when using paper that
tends to curl.

GCut Speed
Select the speed of automatic cutting, as needed. You can adjust this setting if paper is not cut well when automatic
cutting is used.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

High Speed When the Standard setting does not result in a clean cut surface, select this.

Standard Select this when you do not have any problems in automatic cutting.

Low Speed This helps prevent adhesive from sticking to the cutter and keeps the cutter sharp if you
select it when using adhesive paper.

HAutomatic Cutting
Set whether to perform roll cutting automatically or print a cut line.
The following settings are available for automatic cutting.

Setting Item Details
Printer Default The setting of the control panel of the printer is applied.

None After printing completes, the roll is not cut per page, and the next page of data is printed
successively.

Print Cut Guideline After printing completes, a line is printed per page, and the next page of data is printed
successively.

JMirror
Specify whether to print a mirror image, as needed. Select this option to print a version of the document or image
with the left and right sides inverted.
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View set. Dialog Box for the Printing ApplicationView set. Dialog Box for the Printing Application
In the View set. dialog box, you can check details of the selected printing application.

Note
• To display the View set. dialog box, on the Main pane, click View set. by Print Target.  (See "Main

Pane .") ➔P.254

• APrint Target
Shows all Print Target options (settings items for the printing application).

• BName
Identifies the item selected in Print Target by its name and an icon.

• CDetails
Here, you can confirm detailed settings values for each item selected in the Print Target list.

Matching paneMatching pane
On the Matching pane, you can specify color matching to compensate for differences in the appearance of colors
on various devices.

Important
• The Matching pane is not displayed when No color correction or Monochrome is selected in Color Mode.

Note
• To display the Matching pane, on the Main pane click Color Settings by Color Mode in Advanced Settings, and

then click the Matching tab.  (See "Main Pane .") ➔P.254
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Driver Matching Mode
The following options are available when you select Driver Matching Mode in the AMatching Mode list.

• AMatching Mode
Select the color matching mode to use, as desired.
Normally, select Driver Matching Mode. For color matching based on ICC profiles, select ICC Matching
Mode depending on your color matching system.

• BMatching Method
Select the color matching method that suits the document to be printed. Various BMatching Method options
are available depending on your selection in AMatching Mode.

• EGamma
You can adjust the gradation of intermediate tones in an image.
2.2 is normally selected. If you want a softer impression than 2.2, select 1.8.

ICC Matching Mode
The following options are available when you select ICC Matching Mode, in the AMatching Mode list.

Note
• To display the Matching pane, on the Main pane, click Color Settings by Color Mode in Advanced Settings,

and then click the Matching tab.  (See "Main Pane .") ➔P.254
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• AMatching Mode
Select the color matching mode to use, as desired.

• B Input Profile Settings
You can choose Input Profile.
Various options are available depending on your selected AMatching Mode.

• CMatching Method
You can choose CMatching Method.
Various options are available depending on your selected AMatching Mode.

• DPrinter Profile Settings
Specify the printer profile as desired.
We recommend that you select an ICC profile created using commercially available profile creation software in
order to perform color management accurately on paper other than genuine Canon paper and feed confirmed
paper.
The created ICC profile needs to be saved in the following folder on the computer you are using.
/user/(user name)/library/ColorSync/Profiles folder

Note
• For details on settings items, see "Adjusting the Color in the Printer Driver." ➔P.48

Color Settings Pane: ColorColor Settings Pane: Color
In general, make any needed adjustments to the color of documents in the application used to create them. Howev-
er, if the color tone as printed is not as you expected, you can also adjust the color in the printer driver.
If the color tone as printed is not as you expected, you can adjust it on the Color Adjustment pane.

Note
• To display the Color Adjustment pane, on the Main pane click Color Settings by Color Mode in Advanced Set-

tings.  (See "Main Pane .") ➔P.254

• For details on settings items, see "Adjusting the Color in the Printer Driver." ➔P.48

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan/EMagenta/FYellow
Correct color tones by adjusting the levels of each color.
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• GGray Tone
Adjust the color tone of grays as desired. Choose Cool (tinged with blue) or Warm (tinged with red).

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter
or darker than the original image (that is, the original photo that was scanned or the original graphic as it ap-
pears on the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the Con-
trast makes images sharper, and reducing the Contrast softens images.

• JSaturation
Adjust the color intensity as desired. Increasing the Saturation setting makes colors more vivid, and reducing
the Saturation makes colors more subdued.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

• Object Adjustment dialog box: Color ➔P.263

Object Adjustment dialog box: ColorObject Adjustment dialog box: Color
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an
original comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

• A Images
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.
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Color Settings Pane: MonochromeColor Settings Pane: Monochrome
On the Color Adjustment pane for monochrome printing, you can adjust the brightness and contrast.

Note
• To display the Color Adjustment pane, on the Main pane, click Color Settings in Advanced Settings.  (See

"Main Pane .") ➔P.254

• For details on settings items, see "Adjusting the Color in the Printer Driver." ➔P.48

• ASample Type
Choose a sample image from Standard, Portrait, Landscape, or Graphics.

• BView Color Pattern
Select this checkbox to display the color pattern.

• CApply to Sample
Select this checkbox to apply the changed settings to the sample image.

• DCyan/EMagenta/FYellow
Not available.

• GGray Tone
Not available.

• HBrightness
Adjust the overall image brightness as desired. You can adjust the brightness if the printed document is lighter
or darker than the original image (that is, the original photo that was scanned or the original graphic as it ap-
pears on the computer screen).

• IContrast
Adjust the contrast of the darkest and lightest portions relative to each other, as desired. Increasing the ICon-
trast makes images sharper, and reducing the IContrast softens images.

• JSaturation
Not available.

• KObject Adjustment
Select this option to display the Object Adjustment dialog box, in which you can specify objects subject to
color adjustment.

• Object Adjustment dialog box: Monochrome ➔P.265
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Object Adjustment dialog box: MonochromeObject Adjustment dialog box: Monochrome
In the Object Adjustment dialog box, you can specify what type of print jobs to apply color adjustment to. If an
original comprises images, graphics, and text, you can specify which portion to apply color adjustment to.

Note
• To display the Object Adjustment dialog box, click Object Adjustment on the Color Adjustment panel.

• A Images
Select this option to apply color adjustment to image areas, such as photos.

• BGraphics
Select this option to apply color adjustment to graphics, such as lines and circles.

• CText
Select this option to apply color adjustment to text.

Page Setup PanePage Setup Pane
The following settings are available on the Page Setup pane. For details on settings items, refer to the printer driv-
er help.

• APaper Source
Choose how paper is supplied.
Options displayed in the list vary depending on the selection in AMedia Type in the Main pane.

• BRoll Width
Select the paper width of the roll loaded in the printer.
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• DEnlarged/Reduced Printing
Select this checkbox to choose the following options.

• Resizing Originals to Fit the Roll Width ➔P.62
• Resizing Originals by Entering a Scaling Value ➔P.65

• FFit Roll Paper Width
Resizes the document image to match the roll width.

• GScaling
Resizes the document image based on a specified scaling value. Enter a value in a range of 5–600.

• HBorderless Printing
Borderless printing is available if roll paper is selected in the APaper Source list.
Activate this setting for borderless printing to match the size and width of the paper.

• Borderless Printing by Resizing Originals to Fit the Roll Width ➔P.82
• Borderless Printing at Actual Size ➔P.74

• JPrint Centered
Select this checkbox to print document images in the center of the paper.

• Printing Originals Centered on Rolls ➔P.115
• Printing Originals Centered on Sheets ➔P.119

• KNo Spaces at Top or Bottom
Select this checkbox to print the next image skipping blank areas above and below printable data in docu-
ments, which enables you to conserve the paper.

• Conserving Roll Paper by Printing Originals Without Top and Bottom Margins ➔P.126

• LRotate Page 90 degrees
Select this checkbox to rotate the document image by 90 degrees before printing.

• Conserving Roll Paper by Rotating Originals 90 Degrees ➔P.123

• NFree Layout
Select this checkbox to start imagePROGRAF Free Layout before printing.
This allows you to print multiple documents next to each other.

Important
• When Print Preview is selected on the Main panel, Print Preview is disabled.

• Printing Multiple Originals Next to Each Other ➔P.101

Additional Settings PaneAdditional Settings Pane
The following settings are available on the Additional Settings pane.

• ASend job to
You can configure the method for saving print jobs to the printer hard disk.
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• BPrint after reception is complete
You can prevent degradation of print quality that occurs when receiving a print job is interrupted and printing is
aborted in the middle.
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The Features of PreviewThe Features of Preview
The main features of Preview are as follows.

• While viewing this screen, you can adjust layout settings of a document created with application software.

• You can not only adjust layout settings but also your changes will be instantly applied on the preview screen,
and you can print the preview screen as it is seen.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to

differ from the Preview settings.

Starting PreviewStarting Preview
Follow the procedure below to start the Preview.

1 Start the apllication software which you use.

2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3 Click Print Preview in the Main panel to attach a checkmark.
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4
 

Click the Print button in the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

5
 

Preview main window is displayed.

 

 

iPF785                                                                                                                                                                                                     Starting Preview

User's Guide                                                                                                                                                                                                                     

  

M
ac O

S Software
Preview

269  



Preview Main WindowPreview Main Window
The Preview main window consists of the menu and tool bars, and preview, dialog , drawer and status area.

Note
• You can use the View menu to show or hide the tool bar.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

• Preview Area
You can check the settings you made in this area.
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• Dialog Area
This allows you to set the print conditions and perform a print job.

• Drawer Area
This allows you to display the thumbnails of a document.

This area appears when you click  Drawer from the tool bar.
Alternatively, you may select Drawer from the View menu.

• Status Area
This shows Input Size and Output Size.
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Paper Settings PanelPaper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

• Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings ➔P.273
• Advanced Settings ➔P.274

• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details
Manual Select for manual paper feed printing.

Roll Paper Select to print on roll paper.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.
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• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Easy SettingsEasy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that match-
es the content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details
Default Settings Suitable for printing normal documents that contain a mixture of text, photographs, and

graphics.

Poster The best setting for posters.Prints using vivid and high impact colors.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and GIS draw-
ings including maps.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Office Document Suitable for printing handouts as well as general office documents for which print clarity is
key.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.
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Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest quality / Highest / High / Standard / Fast
Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.

• For Highest quality, the resolution is not displayed.

Advanced SettingsAdvanced Settings
Presents detailed settings for the print quality, the color mode, and other items so you can select the values for
these settings yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details
Image This mode achieves the best results for printing photographic images and illustrations.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or other
documents that contain large amounts of text. However, you may not achieve the quality
you expect with printing photographs or other images with many filled areas. For these
types of jobs, select Image.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so they
are easy to read.
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Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest quality / Highest / High / Standard / Fast
Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.

• For Highest quality, the resolution is not displayed.

Output Settings PanelOutput Settings Panel
This panel appears when you select Output Settings in the dialog area.

• Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details
Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for output.

Select the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper with the
page width.
 

*Make sure that the width of the roll paper in the printer is set correctly for Roll Paper
Width in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.
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Setting Details
Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling value

in numerical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part that
does not fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

• Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specif-
ic media type is used.
For more information about Borderless Printing, see "Print with No Borders." ➔P.284

Note
• Available only if rolls are selected in Paper Source.
• This is not displayed when a checkmark is placed in Print Centered.

• Paper Size
You can select the size of the print media.

Note
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Print Centered
You can print on the center of the media loaded in the printer.
For more information about Print Centered, see "Print on the Center." ➔P.285

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

• No Spaces at Top or Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the
top or bottom.
For more information about No Spaces at Top or Bottom, see "Not Print Spaces at the Top/Bottom." ➔P.285

Note
• Available only if rolls are selected in Paper Source.

• Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details
Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When the

rotated page can fit in the width of roll paper, the page is rotated automatically, and when it
can not fit in the width of roll paper, the page is not rotated.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When the ro-
tated page can fit in the width of roll paper, the page is rotated automatically, and when it
can not fit in the width of roll paper, the page is not rotated.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.
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Color Settings PanelColor Settings Panel
This panel appears when you select Color Settings in the dialog area.

• Color Mode
You can select a color mode to suit the print job.

Setting Details
Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled mono-
chrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome Bitmap Prints all colors other than white in black.

Monochrome (BK ink) Select to print all lines with black ink.

No color correction Prints without performing color matching in the printer driver. Select this when color match-
ing is performed by the application such as Adobe Photoshop or when you want to print
color charts using the profile creation tool.

Note
• The availability of settings depends on the print priority and media type selections.

• Color Adjustment / Gray Adjustment / Matching
You can set the color adjustment and matching.

• Color Adjustment ➔P.278
• Matching ➔P.279

Note
• Matching is not displayed if No color correction has been selected in Color Mode.

• Restore Defaults Button
Click the button to reset to the setting when starting Preview.
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• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color AdjustmentColor Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not
match colors on the screen, you can perform color adjustments.

1 Select Color on Color Mode in the Color Settings panel.

2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter
than the original images such as the original photo before scanning and graphics cre-
ated on the display, or when you want to print in different degrees of brightness, use this
feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).
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Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.

Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital
camera or other color images.

1 Select Monochrome on Color Mode in the Color Settings panel.

2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter
than the original images such as the original photo before scanning and graphics cre-
ated on the display, or when you want to print in different degrees of brightness, use this
feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.

MatchingMatching
You can set the matching.

Important
• If No color correction is selected under Color Mode, the Matching is not displayed.
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• Matching Mode
You can select a matching mode to suit the print job.

Setting Details
Driver Matching Mode ➔P.281 Enables printing of optimal color tones using a driver specific color profile. You should nor-

mally select this mode.

ICC Matching Mode ➔P.282 Enables color matching using ICC profiles. Select this if you want to print by specifying the
input profile, printer profile, and matching method in detail. This allows you to use ICC pro-
files for digital cameras and scanners, ICC profiles created using the profile creation tool,
etc.

ColorSync ➔P.283 Enables color matching by using the ColorSync function of OS X. Select this if you want to
perform soft proofing using ColorSync before printing.

Note
• You need to set each correction on the printer driver.

• ColorSync needs to be selected in the Color Matching panel of the driver in order to select ColorSync.

• Matching Method
You can select a matching method to suit the print job.

• Gamma
You can adjust the gradation of intermediate tones in an image. 2.2 is normally selected. If you want a softer
impression than 2.2, select 1.8.

Note
• You can select only after Driver Matching Mode has been selected in Matching Mode.

• Input Profile
Select the input profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Printer Profile
Select the printer profile.
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Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Soft Proof
When you place a checkmark here, ColorSync applies to the preview area.

Note
• You can select only after ColorSync has been selected in Matching Mode.

Driver Matching ModeDriver Matching Mode

1
 

Under Matching Mode, select Driver Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics, Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode when performing color adjustment using ap-
plication software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.
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ICC Matching ModeICC Matching Mode

1
 

Under Matching Mode, select ICC Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode when performing color adjustment using ap-
plication software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point Cor-
rection)

The processing method of color-matching is identical to Colorimetric. Use this when
you want to further reproduce the target paper material color of the image data. Gener-
ally, this also is called absolute colorimetric.

3 Click the Input Profile list and select an input profile.

4 Click the Printer Profile list and select a printer profile.
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ColorSyncColorSync

1
 

Check that ColorSync is selected in Matching Mode.

2 To apply ColorSync to previews, check the Soft Proof check box.

Preferences Dialog BoxPreferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You
can set the preferences for Preview.

• Units
Set the unit for paper length, margins, and so on.
 

Zoom Dialog BoxZoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen dis-
play.

• Scaling
Set the magnification for enlargement or reduction of the screen display.
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Note
• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.

Go to Page Dialog BoxGo to Page Dialog Box
This dialog box appears when you select Go to Page from the View menu.

Note
• You can not select Go to Page if the document is only one page.

• Page
Input the page number in numerical characters to display in the preview area.

Note
• You can change the numbers in the range of the page of the documents.

Print with No BordersPrint with No Borders
You can use the borderless printing function to print without margins surrounding the image.

Note
• With some media borderless printing can be performed only between two edges.

• To use the borderless printing function, the specified media must be set to the printer.

1 On the Paper Settings Panel ➔P.272 , select Roll Paper in Paper Source.

2 On the Output Settings Panel ➔P.275 , click the Enlarged/Reduced Printing check box on.

3 Select Fit Roll Paper Width.

4
 

Click the Borderless Printing check box on.

5 Click the Print button.
 

Borderless printing begins.
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Print on the CenterPrint on the Center
You can print on the center of the media loaded in the printer.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

1
 

On the Output Settings Panel ➔P.275 , click the Print
Centered check box on.

2 Click the Print button.
 

Printing on the center begins.

Not Print Spaces at the Top/BottomNot Print Spaces at the Top/Bottom
You can save paper on not to feed roll paper for the empty spaces when the print data contains spaces at the top
or bottom.

Note
• This is not displayed when a checkmark is placed in Borderless Printing.

1 On the Paper Settings Panel ➔P.272 , select Roll Paper in Paper Source.

2
 

On the Output Settings Panel ➔P.275 , click the No
Spaces at Top or Bottom check box on.

3 Click the Print button.
 

Printing on the settings with no spaces at top or bottom begins.
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Print Page Rotated 90 DegreesPrint Page Rotated 90 Degrees
You can save paper by printing in landscape orientation on roll paper.

1 On the Paper Settings Panel ➔P.272 , select Roll Paper in Paper Source.

2 On the Output Settings Panel ➔P.275 , click the Rotate Page check box on.

3
 

Select Rotate Right 90 Degrees or Rotate Left 90
Degrees.

4 Click the Print button.
 

Printing on rotating 90 degrees begins.

Display with Fitting to the Width of the PaperDisplay with Fitting to the Width of the Paper
In the preview area, you can display to the width of the paper.

1 Select  Fit to Width from the tool bar.

2
 

Fitting to the width of the paper, it is displayed.

Display with AllDisplay with All
In the preview area, you can display all.

1 Select  Fit Screen from the tool bar.
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2
 

All is displayed.

Display with Actual SizeDisplay with Actual Size
In the preview area, you can display the actual size.

1 Select  Actual Size from the tool bar.

2
 

Actual size is displayed.

Moving a PageMoving a Page
You can move a page to display in the preview area.

1 Select each button in Go to Page on the tool bar.
Setting Details

Go to the first page.

Go to the previous page.

Go to the next page.

Go to the last page.
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2
 

The target page appears.

Note
• You can also move a page by clicking the page on the thumbnails.
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The Features of Free LayoutThe Features of Free Layout
The main features of Free Layout are as follows.

• Allows you to lay out at will and print a document created with application software.

• You can not only lay out multiple pages on one page but also lay out and print a multiple-file document on one
page, or lay out and print a document created with multiple application programs on one page.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to

differ from the Free Layout settings.

Starting Free LayoutStarting Free Layout
Follow the procedure below to start the Free Layout.

1 Start the apllication software which you use.

2 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

3 Click on Free Layout in the Page Setup panel to attach a checkmark.
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4
 

Click the Print button in the Print dialog box.

Note
• Your printer is depicted in the lower-left area of this screen.

5
 

Free Layout main window is displayed.

Free Layout Main WindowFree Layout Main Window
The Free Layout main window consists of the menu and tool bars, layout area and dialog areas.
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Note
• You can use the View menu to show or hide the tool.

• Menu Bar
This allows you to select menus required for operations.

• Tool Bar
This allows you to select tool buttons required for major operations.

• Layout Area
This allows you to lay out objects and edit the object size and orientation.
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• Dialog Area
This allows you to set the print conditions and perform a print job.

Paper Settings PanelPaper Settings Panel
This panel appears when you select Paper Settings in the dialog area.

• Media Type
This allows you to select the media type.
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Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings ➔P.294
• Advanced Settings ➔P.295

• Paper Source
You can select the paper source.
The following settings are available for paper source.

Setting Details
Manual Select for manual paper feed printing.

Roll Paper Select to print on roll paper.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.
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Easy SettingsEasy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that match-
es the content of the document.

• Print Target
You can easily select the best settings for the print job simply.
If you select each Print Target item the corresponding comment for that item is displayed below the list.

Setting Details
Default Settings Suitable for printing normal documents that contain a mixture of text, photographs, and

graphics.

Poster The best setting for posters.Prints using vivid and high impact colors.

CAD (Color Line Drawing) Suitable for printing fine lines such as drawings clearly.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and GIS draw-
ings including maps.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Office Document Suitable for printing handouts as well as general office documents for which print clarity is
key.

Faithful Color Reproduction Prints by minimizing color differences. Suitable for when the printing results are too vivid
or when printing scanned images.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest quality / Highest / High / Standard / Fast
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Setting Details
Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.

• For Highest quality, the resolution is not displayed.

Advanced SettingsAdvanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for
these settings yourself.

• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details
Image This mode achieves the best results for printing photographic images and illustrations.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or other
documents that contain large amounts of text. However, you may not achieve the quality
you expect with printing photographs or other images with many filled areas. For these
types of jobs, select Image.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so they
are easy to read.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
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The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest quality / Highest / High / Standard / Fast
Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.

• For Highest quality, the resolution is not displayed.

Color Settings PanelColor Settings Panel
This panel appears when you select Color Settings in the dialog area.

• Color Mode
You can select a color mode to suit the print job.

Setting Details
Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled mono-
chrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome Bitmap Prints all colors other than white in black.

Monochrome (BK ink) Select to print all lines with black ink.

No color correction Prints without performing color matching in the printer driver. Select this when color match-
ing is performed by the application such as Adobe Photoshop or when you want to print
color charts using the profile creation tool.

Note
• The availability of settings depends on the print priority and media type selections.
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• Color Adjustment / Matching
You can set the color adjustment and matching.

• Color Adjustment ➔P.297
• Matching ➔P.299

Note
• Matching is not displayed if No color correction has been selected in Color Mode.

• Restore Defaults Button
Click the button to reset to the setting when starting Free Layout.

• Print Button
Click the button to begin printing.

• Update Printer Info. Button
Click the button to acquire printer information.

Color AdjustmentColor Adjustment
You can set the color adjustment.

Adjusting Color
Normally colors should be adjusted in the software application, but if you see colors in the printout that do not
match colors on the screen, you can perform color adjustments.

1 Select Color on Color Mode in the Color Settings panel.

2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Cyan Adjusts the strength of colors to compensate the hues.

Magenta Adjusts the strength of colors to compensate the hues.

Yellow Adjusts the strength of colors to compensate the hues.

 

iPF785                                                                                                                                                                                                   Color Adjustment

User's Guide                                                                                                                                                                                                                     

  

M
ac O

S Software
Free Layout

297  



Setting Details
Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter

than the original images such as the original photo before scanning and graphics cre-
ated on the display, or when you want to print in different degrees of brightness, use this
feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.

Saturation Adjusts the hues for vivid color or dark color.

Gray Tone Adjusts gray from cool black (bluish tones) to warm black (reddish tones).

Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.

Adjusting Monochrome
Use the monochrome setting to print monochrome images of color photographs captured with a scanner or digital
camera or other color images.

1 Select Monochrome on Color Mode in the Color Settings panel.

2
 

Select Color Adjustment.

3 Drag each slider to the left or right to adjust.
Setting Details

Brightness Adjusts the brightness of the entire image. When the results of the printout are brighter
than the original images such as the original photo before scanning and graphics cre-
ated on the display, or when you want to print in different degrees of brightness, use this
feature.

Contrast Adjusts the relative brightness between the brightest and darkest portions of the image.
 

*For soft gradation, decrease the contrast. For hard gradation, increase the contrast.
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Note
• You can also click the up or down arrow, or enter the number directly to increase or decrease the value.

MatchingMatching
You can set the matching.

Important
• If No color correction is selected under Color Mode, the Matching is not displayed.

• Matching Mode
You can select a matching mode to suit the print job.

Setting Details
Driver Matching Mode ➔P.300 Enables printing of optimal color tones using a driver specific color profile. You should nor-

mally select this mode.

ICC Matching Mode ➔P.301 Enables color matching using ICC profiles. Select this if you want to print by specifying the
input profile, printer profile, and matching method in detail. This allows you to use ICC pro-
files for digital cameras and scanners, ICC profiles created using the profile creation tool,
etc.

ColorSync ➔P.302 Enables color matching by using the ColorSync function of OS X. Select this if you want to
perform soft proofing using ColorSync before printing.

Note
• You need to set each correction on the printer driver.

• ColorSync needs to be selected in the Color Matching panel of the driver in order to select ColorSync.

• Matching Method
You can select a matching method to suit the print job.

• Gamma
You can adjust the gradation of intermediate tones in an image. 2.2 is normally selected. If you want a softer
impression than 2.2, select 1.8.
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Note
• You can select only after Driver Matching Mode has been selected in Matching Mode.

• Input Profile
Select the input profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Printer Profile
Select the printer profile.

Note
• You can select only after ICC Matching Mode has been selected in Matching Mode.

• Soft Proof
When you place a checkmark here, ColorSync applies to the layout area.

Note
• You can select only after ColorSync has been selected in Matching Mode.

Driver Matching ModeDriver Matching Mode

1
 

Under Matching Mode, select Driver Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics, Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode when performing color adjustment using ap-
plication software.

Saturation Color-matching optimized for printing posters, etc., vividly.
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Setting Details
Colorimetric Color-matching optimized for printing image data with accurate colors in input color

space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

ICC Matching ModeICC Matching Mode

1
 

Under Matching Mode, select ICC Matching Mode.

2 Click the Matching Method list, and then select a setting.
Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode when performing color adjustment using ap-
plication software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point Cor-
rection)

The processing method of color-matching is identical to Colorimetric. Use this when
you want to further reproduce the target paper material color of the image data. Gener-
ally, this also is called absolute colorimetric.

3 Click the Input Profile list and select an input profile.

4 Click the Printer Profile list and select a printer profile.
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ColorSyncColorSync

1
 

Check that ColorSync is selected in Matching Mode.

2 Place a checkmark on Soft Proof to simulate the output product in Layout Area.

Preferences Dialog BoxPreferences Dialog Box
This dialog box appears when you select Preferences from the imagePROGRAF Advanced Preview menu. You
can set the preferences for Free Layout.

• Units
Set the unit for paper length, margins, and so on.

• Gridlines
You can input a grid line width value in numerical characters so that they serve as a guide to laying out ob-
jects.

Note
• You can input between 10.0 and 200.0(mm) (between 0.39 and 7.87(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.
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• Divisions
You can change the number of divisions of grid lines so that they serve as a guide to laying out objects.

Note
• You can input between 1 and 10.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Grid Color
Select the grid line color.

• Print Object Frames
You can print the object border.

Note
• If you do not want to print the object border, deselect the Print Object Frames check box.

• Object Frame Style
You can select the object frame style for printing.
The following settings are available for the object frame style.

Setting Details
Solid Line You can print the solid line as the frame style.

Dotted Line You can print the dotted line as the frame style.

Dashed Line You can print the dashed line as the frame style.

• Auto Arrange Spacing
Change the object-to-object spacing to be applied in the operation of laying out objects automatically.

Note
• You can input between 0.0 and 100.0(mm) (between 0.00 and 3.94(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

Page Setup Dialog BoxPage Setup Dialog Box
This dialog box appears when you select Page Setup from the File menu.This dialog box provides selections for
setting the media size, orientation and other important features.

• Paper Orientation
This selects the paper orientation.
The following settings are available for orientation.

Setting Details
Vertical Prints the image and text created with the application software in the orientation as it is.

Horizontal Prints the image and text by rotating sideways 90 degrees from the orientation as speci-
fied in the application.

• Roll Paper Length
Set the length of one page to print on roll paper.
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When you place a checkmark on Auto Settings, the one-page length to be printed on roll paper is automati-
cally set so that the laid-out objects are printed on one page.

Note
• Available only if rolls are selected in Paper Source.
• You can input between 203.2 and 18000.0(mm) (between 8.00 and 708.66(inch)).
• You can change the numbers by clicking either ▲ button or ▼ button.

• Order
Set the object layout order.
The following settings are available for order.

Setting Details
Upper Left to Right The objects are laid out from upper left to right.

Upper Left to Bottom The objects are laid out from upper left to bottom.

Note
• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Vertical, you can

choose only Upper Left to Right.

• When you have selected Roll Paper Length > Auto Settings and Paper Orientation > Horizontal, you can
choose only Upper Left to Bottom.

• Paper Size
You can select the size of the print media.

Note
• You cannot display this if Roll Paper is selected in Paper Source.

Zoom Dialog BoxZoom Dialog Box
This dialog box appears when you select Zoom from the View menu. You can enlarge or reduce the screen dis-
play.

• Scaling
Set the magnification for enlargement or reduction of the screen display.

Note
• You can input between 10 and 400.
• You can change the numbers by clicking ▼ button.
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Format Dialog BoxFormat Dialog Box
This dialog box appears when you select Format from the Object menu after you select an object. You can rotate,
enlarge, or reduce an object.

Note
• When the objects are not selected, you can not select Format.

• Rotate
When you place a checkmark here, you can select Rotate Right or Rotate Left.

Setting Details
Rotate Right Rotates the object 90 degrees clockwise.

Rotate Left Rotates the object 90 degrees counterclockwise.

Note
• When several objects are selected, you cannot select Rotate.

• Scaling
You can input the value for enlargement or reduction of the obeject in numerical characters.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

• Object Size
You can confirm the object size.

Note
• When several objects are selected, you cannot display Object Size.

Laying out a Multiple-File Document on One PageLaying out a Multiple-File Document on One Page
You can lay out and print a multiple-file document on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2 Click on Free Layout in the Page Setup panel to attach a checkmark.

3 In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an ob-
ject.
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4 Leaving Free Layout running, open other files with the application software and repeat the above steps.

Laying out a Document Created with Multiple Application Programs on OneLaying out a Document Created with Multiple Application Programs on One
PagePage

You can lay out and print a document created with multiple application programs on one page.

1 From the application software's File menu, select the printer setup menu to open the Print dialog box.

Note
• Normally, select Print from the File menu.

2 Click on Free Layout in the Page Setup panel to attach a checkmark.

3 In the Print dialog box, select the pages to print and the number of copies, and click the Print button.
Free Layout starts, laying out the document created with application software in the layout area as an ob-
ject.

4 Leaving Free Layout running, open the files with other application software and repeat the above steps.

Selecting an ObjectSelecting an Object
When an object is selected, a select box (blue border) appears around the object.

Note
• To select an object, click that object.
• To select multiple successive objects, click them while holding down the shift key.

• To select multiple arbitrary objects, click them while holding down the command key.
• To select all objects, select Select All from the Edit menu.

Changing the Object SizeChanging the Object Size
You can change the object size by means of mouse operation or by specifying a scaling value.

Note
• The vertical-to-horizontal ratio remains unchanged when the object is enlarged or reduced.
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Resizing by means of mouse operation

1 Select an object.

2
 

Place the pointer at a corner of the selection box
around the object to show the arrow handle, and drag
this handle to change the object size.

Resizing by specifying a scaling value

1 Select an object.

2 Open the Format Dialog Box ➔P.305 .

3 Use Scaling to set the magnification for enlargement or reduction. You either enter numbers directly.

Note
• You can input between 25 and 400.
• You can change the numbers by clicking either ▲ button or ▼ button.

4 Click the OK button.

Moving an ObjectMoving an Object
You can move the object position.

1 Select an object.

2
 

Place the pointer inside the selection box of the ob-
ject to show the crosshair handle, and drag it to move
the object.

Rotating an ObjectRotating an Object
You can rotate the object.

1 Select an object.
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2
 

Select Rotate Left or Rotate Right from the toolbar.
Alternatively, you may click on the Rotate check box
in the Format Dialog Box ➔P.305  then select Rotate
Right or Rotate Left, and click the OK button.

Note
• When several objects are selected, you cannot select Rotate.

Laying out Objects AutomaticallyLaying out Objects Automatically
Click Auto Arrange in the tool bar. This automatically lays out objects. Alternatively, you may select Auto Arrange
Object from the Object menu.

Note
• The object layout order varies depending on the Order setting on the Page Setup Dialog Box ➔P.303 .

Aligning ObjectsAligning Objects
You can align objects systematically.

1 Select multiple objects.

2 Select the align menu from the Object menu.

• Align Top
Lays out the objects, justifying them to the top.
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• Center Vertically
Lays out the objects, justifying them to the verti-
cal center.

• Align Bottom
Lays out the objects, justifying them to the bot-
tom.

• Align Left
Lays out the objects, justifying them to the left.

• Center Horizontally
Lays out the objects, justifying them to the hori-
zontal center.
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• Align Right
Lays out the objects, justifying them to the right.

Changing the Object Overlapping OrderChanging the Object Overlapping Order
You can change the object overlapping order.

1 Select an object.

2 Select the overlapping order menu from the Object menu.

• Bring to Front
Moves the object to the frontmost position.

• Send to Back
Moves the object to the backmost position.

• Bring Forward
Moves the object one position to the front.
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• Send Backward
Moves the object one position to the back.

Pasting a Copied or Cut ObjectPasting a Copied or Cut Object

1 Click Copy or Cut from the toolbar.
Alternatively, you may select Copy or Cut from the Edit menu.

2 Click Paste from the toolbar.
Alternatively, you may select Paste from the Edit menu.

Note
• The copied or cut object is laid out at the end of the page.
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The Features of Color imageRUNNER Enlargement CopyThe Features of Color imageRUNNER Enlargement Copy
The main features of Color imageRUNNER Enlargement Copy are as follows.

• Allows the document scanned with the Color imageRUNNER to be automatically enlarged and printed.

• You can perform basic printer settings such as printer selection, media type and output profile selection, and
matching methods, in addition to borderless printing and enlargement/reduction process without growing
through the printer driver.

Note
• The media type, image size, detailed media settings, and the printer settings can cause the actual print output to

differ from the Color imageRUNNER Enlargement Copy settings.

Starting Color imageRUNNER Enlargement CopyStarting Color imageRUNNER Enlargement Copy
You can start the utility by clicking on the Color imageRUNNER Enlargement Copy.app icon in Applications >
Canon Utilities > iR Enlargement Copy.

Note
• If you are using OS X v10.7 and later, start it from Launchpad.
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Color imageRUNNER Enlargement Copy Dialog BoxColor imageRUNNER Enlargement Copy Dialog Box
The explanation below is on the Color imageRUNNER Enlargement Copy dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color imageRUN-

NER Enlargement Copy." ➔P.312

• Delete files in the folder
From the Hot Folder list, select a hot folder and click the Delete button to delete only files in the hot folder.

• Delete the entire folder, as well as items in the list above
From the Hot Folder list, select a hot folder and click the Delete button to delete the hot folder.

• Delete Button
Select Delete files in the folder or Delete the entire folder, as well as items in the list above and click this
button to delete the hot folder or only files in the hot folder.

• Add Button
Click the button to open the Destination Selection dialog box so that you can add a hot folder.

• Edit Button
From the Hot Folder list, select a hot folder and click this button to open the Add/Edit Hot Folder dialog box
that allows you to edit the hot folder.

• Monitor Hot Folder Constantly
If the check box is selected, the Hot Folder is monitored from after the next login.

Hot FolderHot Folder
Hot folder refers to a folder used for Color imageRUNNER Enlargement Copy.

• When transferred to the PC's hot folder, the document data scanned with the Color imageRUNNER is printed
in enlarged size from the printer according to the print conditions set in the hot folder.

• You can create a new hot folder, edit or delete an existing one, and set print conditions at will.

Note
• You can create up to 10 hot folders.
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Creating a New Hot FolderCreating a New Hot Folder

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box.

Note
• For the step to open the Color imageRUNNER Enlargement Copy dialog box, see "Starting Color im-

ageRUNNER Enlargement Copy." ➔P.312

2
 

Click the Add button in Enlarged Copy Settings to
open the Destination Selection dialog box.

3 From the printer list in Destination, select the printer of destination.

4
 

Click the OK button to open the Add/Edit Hot Folder
dialog box.

5 In Name, enter the name to display in the Hot Folder list.

6 In Hot Folder, enter the Hot Folder name.
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7
 

Click the OK button. The created Hot Folder is listed
in the Color imageRUNNER Enlargement Copy di-
alog box.

8 Click the Close button to close the Color imageRUNNER Enlargement Copy dialog box.

9 From the Apple Menu, open the Sharing dialog box for System Preferences.

10 For OS X v10.6:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using FTP and Share files and folders using SMB checkboxes to
configure the sharing.
For OS X v10.7 and later:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using SMB checkbox to configure the sharing.

Note
• You can create up to 10 hot folders.

Editing a Hot Folder (Setting Print Conditions)Editing a Hot Folder (Setting Print Conditions)

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box.

2 Select the Hot Folder from the Hot Folder list.

3 From Enlarged Copy Settings, click Edit button to open the Add/Edit Hot Folder dialog box.
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4
 

Make the necessary settings in the Paper Settings
Panel ➔P.318 .

5
 

Make the necessary settings in the Output Settings
Panel ➔P.321 .
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6
 

Make the necessary settings in the Color Settings
Panel ➔P.323 .

7 Click the OK button to close the Add/Edit Hot Folder dialog box.

8 From the Apple Menu, open the Sharing dialog box for System Preferences.

9 For OS X v10.6:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using FTP and Share files and folders using SMB checkboxes to
configure the sharing.
For OS X v10.7 and later:
Check the File Sharing checkbox and click the Options button.
Check the Share files and folders using SMB checkbox to configure the sharing.

Note
• If you've made shared settings when you created a new Hot Folder, you do not need to execute steps 8 to

9.

Deleting a Hot FolderDeleting a Hot Folder

1
 

Open the Color imageRUNNER Enlargement Copy
dialog box.

2 Select the Hot Folder you want to delete from the Hot Folder list.
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3
 

Select Delete the entire folder, as well as items in
the list above, and then click the Delete button.

4 Read the messag,e and then click the OK button.

Note
• Select Delete files in the folder to delete only files in the hot folder.

Setting the Print ParametersSetting the Print Parameters
You can set the print conditions in the setting panels within the Add/Edit Hot Folder dialog box.
The settings available on each panel are as follows.

• Paper Settings Panel ➔P.318
• Output Settings Panel ➔P.321
• Color Settings Panel ➔P.323

Paper Settings PanelPaper Settings Panel

• Easy Settings / Advanced Settings
Two modes are available to provide the optimum print settings for jobs.
The settings available on each mode are as follows.

• Easy Settings ➔P.319
• Advanced Settings ➔P.320

• Media Type
This allows you to select the media type.

Note
• Always select media type that is actually set in the printer. When the media you chose is different from the

media set in the printer, you may not receive the desired print results.

• Paper Source
You can select the paper source.
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The following settings are available for paper source.
Setting Details

Manual Select for manual paper feed printing.

Roll Paper Select to print on roll paper.

• Roll Paper Width
This selects the width of the roll media set to the printer.

Note
• Available only if rolls are selected in Paper Source.

• Automatic Cutting
You can set the printer to cut roll paper automatically or print a guideline for cutting.
The following settings are available for automatic cutting.

Setting Details
Printer Default The value set on the printer operation panel takes priority.

None Each page is not cut after it is printed and printing continues without interruption.

Print Cut Guideline A print cut guideline is printed after each page and printing continues without interruption.

Note
• Available only if rolls are selected in Paper Source.

• Copies
You can input the number of print copies in numerical characters.

Note
• The maximum value is 999.
• You can change the numbers by clicking either ▲ button or ▼ button.

Easy SettingsEasy Settings
You can easily select the best settings for the print job by just selecting an item from the print target list that match-
es the content of the document.

• Print Target
You can easily select the best settings for the print job simply.
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If you select each Print Target item the corresponding comment for that item is displayed below the list.
Setting Details

Default Settings Suitable for printing normal documents that contain a mixture of text, photographs, and
graphics.

Office Document Suitable for printing handouts as well as general office documents for which print clarity is
key.

Poster The best setting for posters.Prints using vivid and high impact colors.

CAD (Color Line Drawing) Prints the fine lines of CAD drawings and other such documents sharp and clear.

CAD (B/W Line Drawing) Suitable for printing CAD drawings with sharp, dark lines.

Perspective, GIS Suitable for attractive printing of 3D-CAD drawings, perspective drawings, and GIS draw-
ings including maps.

Photo (Color) Suitable for printing photographic images captured with a digital camera.

Faithful Color Reproduction Prints by faithfully reproducing the colors of the original image.

Custom Settings Suitable for printing documents for which Advanced Settings have been specified.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Fast
Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.

Advanced SettingsAdvanced Settings
Presents detailed settings for the print priority, the print quality, and other items so you can select the values for
these settings yourself.
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• Print Priority
Select a print quality mode that is appropriate for the print job.

Setting Details
Image This mode achieves the best results for printing photographic images and illustrations.

Line Drawing This mode is best for printing CAD drawings with fine lines or wall newssheet or other
documents that contain large amounts of text. However, you may not achieve the quality
you expect with printing photographs or other images with many filled areas. For these
types of jobs, select Image.

Office Document Prints common office documents, such as proposals, memos for distribution, etc., so they
are easy to read.

Note
• The number of settings available for selection depends on the media type.

• Print Quality
Selecting print quality strikes a balance between the quality of the printed image and printing speed.
 

The level of the print quality and resolution settings are displayed in the following combinations.
Setting Details

Print Quality Highest / High / Standard / Fast
Resolution 1200dpi / 600dpi / 300dpi

Note
• The availability of settings is determined by the media type and print priority selections.

• Printing time is longer and more ink is consumed with High than with Fast, however, print quality is higher.

• Printing time is shorter and less ink is consumed with Fast than with High, however, print quality is lower.

Output Settings PanelOutput Settings Panel

• Enlarged/Reduced Printing
Select the method for enlarged/reduced printing.
The following settings are available for enlarged/reduced printing.

Setting Details
Fit Paper Size Enlarges/reduces the whole page automatically to fit the media size selected for output.

Select the media size to print from Paper Size.

Fit Roll Paper Width Enlarges/reduces the whole page automatically to fit the width of the roll paper with the
page width.
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Setting Details
Fit Roll Paper Width  

*Make sure that the width of the roll paper in the printer is set correctly for Roll Paper
Width in the Paper Settings panel.
*Displayed only if rolls are selected in Paper Source.

Scaling Enlarges/reduces the whole page by the scaling rate as specified. Input the scaling value
in numerical characters. You can specify a range between 5 and 600%.
 

*You can change the numbers by clicking either ▲ button or ▼ button.
*Although Scaling can be set to make the image larger than the media size, the part that
does not fit in the media cannot be printed.
*This is not displayed when a checkmark is placed in Borderless Printing.

• Borderless Printing
You can print the media without margins on all sides when the roll paper with the specific width and the specif-
ic media type is used.

Note
• Available only if rolls are selected in Paper Source.

• Paper Size
You can select the size of the print media.

Note
• This is not displayed when Fit Roll Paper Width is set in Enlarged/Reduced Printing.

• Print Centered
Select this feature to print the image in the center of a cut sheet or to print left and right margins evenly from
the edges of roll paper.

Note
• This feature is useful when you print the document enlarged or reduced with Scaling as well. When an image

is scaled, it is always enlarged or reduced in reference to a starting point in the upper left corner of the page.
If the image is reduced, the bottom and right margins are enlarged and the top and left margins remain un-
changed. At that point, you can set all margins evenly with this feature.

• No Spaces at Top or Bottom
You can set the printer to print without any empty area when the print data contains empty area at the top or
bottom. Since the printer does not feed paper over the empty area, you can save paper.

Note
• Available only if rolls are selected in Paper Source.

• Rotate Page
Select the method for rotating page.
The following settings are available for rotating page.

Setting Details
Rotate Right 90 Degrees Rotates the portrait page right 90 degrees and print in landscape orientation. When the

rotated page can fit in the width of roll paper, the page is rotated automatically, and when it
can not fit in the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then the im-
age is enlarged or reduced after rotating to fit the width of the roll paper.

Rotate Left 90 Degrees Rotates the portrait page left 90 degrees and print in landscape orientation. When the ro-
tated page can fit in the width of roll paper, the page is rotated automatically, and when it
can not fit in the width of roll paper, the page is not rotated.
 

*When Fit Roll Paper Width is selected under Enlarged/Reduced Printing, then the im-
age is enlarged or reduced after rotating to fit the width of the roll paper.

Rotate 180 degrees Allows you to rotate the image 180 degrees from the vertical to the right.
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Note
• Available only if rolls are selected in Paper Source.

• Output Method Button
Click the button to open the Output Method dialog box.
In this dialog box, you can specify the object output method.

Color Settings PanelColor Settings Panel

• Color Mode
You can select a color mode to suit the print job.

Setting Details
Color Enables color printing.

Monochrome Disables color printing and converts image from continuous color to grayscaled mono-
chrome.

Color (CAD) Prints lines in the best color possible so they are easy to see.

Monochrome Bitmap Prints all colors other than white in black.

Monochrome (BK ink) Select to print all lines with black ink.

Note
• The availability of settings depends on the print priority and media type selections.

• Matching Mode
Under Matching Mode, select the matching mode.

Setting Details
Driver Matching Mode ➔P.324 Enables printing of optimal color tones using a driver specific color profile. You should nor-

mally select this mode.

ICC Matching Mode ➔P.324 Enables color matching using ICC profiles. Select this if you want to print by specifying the
input profile, printer profile, and matching method in detail. This allows you to use ICC pro-
files for digital cameras and scanners, ICC profiles created using the profile creation tool,
etc.

No Correction No color matching is performed. Select this option when you want to perform color match-
ing in the software application.
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Driver Matching ModeDriver Matching Mode

1
 

Under Matching Mode, select Driver Matching
Mode.

2 Click Matching Method list, and then select a setting.
Setting Details

Auto Automatically selects the best color matching method for each Image, Graphics, Text.

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode when performing color adjustment using ap-
plication software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

ICC Matching ModeICC Matching Mode

1
 

Under Matching Mode, select ICC Matching Mode.
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2 Click Matching Method list, and then select a setting.
Setting Details

Perceptual Color-matching optimized for printing typical photos attractively. Smooth gradation is a
feature. This is also an easy-to-use mode when performing color adjustment using ap-
plication software.

Saturation Color-matching optimized for printing posters, etc., vividly.

Colorimetric Color-matching optimized for printing image data with accurate colors in input color
space. This is the easiest-to-use mode when you want to adjust the color and print.
However, gradation may be lost for colors of wider range than the color reproduction
range of the printer. Generally, this is also called relative colorimetric.

Colorimetric (No White-Point Cor-
rection)

The processing method of color-matching is identical to Colorimetric. Use this when
you want to further reproduce the target paper material color of the image data. Gener-
ally, this also is called absolute colorimetric.

3 Click the Input Profile list, and then select an input profile.

Note
• To match the color on the printing, select the input profile for Color imageRUNNER Enlargement Copy of

the Color imageRUNNER type in use.

4 Click the Printer Profile list, and then select a printer profile.

Printing Enlargements of Scanned Originals from a Color imageRUNNERPrinting Enlargements of Scanned Originals from a Color imageRUNNER
Scanned originals from a Color imageRUNNER can be enlarged and printed automatically.
Originals you create by scanning with a Color imageRUNNER are transferred to a "hot folder" and printed automati-
cally after enlargement according to printing conditions you specify for that folder.
This processing sequence is called the Color imageRUNNER Enlargement Copy function.
To use Color imageRUNNER Enlargement Copy, first complete these settings in the following order.

1. Register a hot folder on your computer.
Register a hot folder on your computer for storing scanned originals from the Color imageRUNNER and com-
plete the settings for enlargement copy. For details, see "Creating a New Hot Folder." ➔P.314

2. Complete the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder.

After these settings are complete, you can print enlarged copies of scanned originals from the Color imageRUN-
NER.

Completing the scanning settings on the Color imageRUNNER.
Configure the Color imageRUNNER to send scanned originals to the hot folder. It is easy to send scanned originals
to the hot folder if you assign the scanning settings and destination to a Favorites button on the Color imageRUN-
NER.
For instructions on assigning scanning and sending settings to the Favorites button, refer to the Color imageRUN-
NER manual.

Scanning the original and print an enlargement
Follow the steps below to scan an original on the Color imageRUNNER for enlarged printing on the printer. For
detailed instructions, refer to the Color imageRUNNER manual.

1 Load the original on the platen glass or document feeder of the Color imageRUNNER.

2 Press Send to display the screen for transmission.

3 Press Favorites, and then press the Favorites button assigned to the hot folder.
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4 Press Start on the control panel. If you scan originals on the platen glass, after scanning all originals, press
Done on the touch-panel display.
Scanned originals are sent to the hot folder and automatically enlarged and printed following the conditions
you specified for the folder.
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Types of PaperTypes of Paper
The following types of paper are supported by the printer. For details on the paper supported by the printer, refer to
the Paper Reference Guide.  (See "Displaying the Paper Reference Guide.") ➔P.331

• Plain Paper
• Coated Paper
• Photo Paper
• Glossy Paper
• Proofing Paper
• CAD-dedicated Paper Etc.

The following content is described in the Paper Reference Guide.

• Types of paper
• Paper handling
• Paper product specifications
• Use precautions
• Setting of printer driver, control panel etc.

• Paper Reference Guide display method
You can display the Paper Reference Guide from [imagePROGRAF Support Information].  (See "Displaying
the Paper Reference Guide.") ➔P.331

1. Method of Updating Supported Paper
Photo Paper
To use newly released paper, register the latest paper information on the printer with the Media Configuration
Tool.  (See "Updating paper information.") ➔P.334

Important
• To install the Paper Reference Guide and register paper types applicable to your region on your printer

even when not using the printer driver, install the Media Configuration Tool.
 (See "Media Configuration Tool (Windows).") ➔P.369
 (See "Media Configuration Tool (Mac OS).") ➔P.382

Paper SizesPaper Sizes

Rolls
Rolls that meet the following conditions are supported.

• Outer diameter: Up to 150 mm (6 in)
• Inner diameter of paper core: 2 or 3 inches
• Printing side out

Roll Width Roll Paper Width Setting in Printer Driver Borderless Printing (*1)
914.4 mm (36.00 in) 36-in. Roll (914.4mm) Yes

841.0 mm (33.11 in) ISO A0/A1 Roll (841.0mm) Yes

762.0 mm (30.00 in) 30-in. Roll (762.0mm) No
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Roll Width Roll Paper Width Setting in Printer Driver Borderless Printing (*1)
728.0 mm (28.66 in) JIS B1/B2 Roll (728.0mm) Yes

609.6 mm (24.00 in) 24-in. Roll (609.6mm) Yes

594.0 mm (23.39 in) ISO A1/A2 Roll (594.0mm) Yes

515.0 mm (20.28 in) JIS B2/B3 Roll (515.0mm) Yes

431.8 mm (17.00 in) 17-in. Roll (431.8mm) Yes

420.0 mm (16.54 in) ISO A2/A3 Roll (420.0mm) Yes

406.4 mm (16.00 in) 16-in. Roll (406.4mm) No

355.6 mm (14.00 in) 14-in. Roll (355.6mm) Yes

300.0 mm (11.81 in) 300mm Roll (300.0mm) Yes

297.0 mm (11.69 in) ISO A3/A4 Roll (297.0mm) Yes

257.0 mm (10.12 in) JIS B4 Roll (257.0mm) Yes

254.0 mm (10.00 in) 10-in. Roll (254.0mm) Yes

*1:  For information on types of paper compatible with borderless printing, refer to the Paper Reference Guide.  (See "Types of
Paper.") ➔P.328

Sheets
Sheets of the following sizes are supported.

Paper Sizes Dimensions
ISO A0 841.0 × 1189.0 mm (33.11 × 46.81 in)

ISO A1 594.0 × 841.0 mm (23.39 × 33.11 in)

ISO A2+ 431.8 × 609.6 mm (17.00 × 24.00 in)

ISO A2 420.0 × 594.0 mm (16.54 × 23.39 in)

ISO A3+ 329.0 × 483.0 mm (12.95 × 19.02 in)

ISO A3 297.0 × 420.0 mm (11.69 × 16.54 in)

ISO A4 210.0 × 297.0 mm (8.27 × 11.69 in)

ISO B1 707.0 × 1000.0 mm (27.83 × 39.37 in)

ISO B2 500.0 × 707.0 mm (19.69 × 27.83 in)

ISO B3 353.0 × 500.0 mm (13.90 × 19.69 in)

ISO B4 250.0 × 353.0 mm (9.84 × 13.90 in)

JIS B1 728.0 × 1030.0 mm (28.66 × 40.55 in)

JIS B2 515.0 × 728.0 mm (20.28 × 28.66 in)

JIS B3 364.0 × 515.0 mm (14.33 × 20.28 in)

JIS B4 257.0 × 364.0 mm (10.12 × 14.33 in)

34"x44"(ANSI E) 863.6 × 1117.6 mm (34.00 × 44.00 in)

28"x40"(ANSI F) 711.2 × 1016.0 mm (28.00 × 40.00 in)

22"x34"(ANSI D) 558.8 × 863.6 mm (22.00 × 34.00 in)

17"x22"(ANSI C) 431.8 × 558.8 mm (17.00 × 22.00 in)

11"x17"(Ledger) 279.4 × 431.8 mm (11.00 × 17.00 in)

13"x19"(Super B) 330.2 × 482.6 mm (13.00 × 19.00 in)

Letter(8.5"x11") 215.9 × 279.4 mm (8.50 × 11.00 in)

Legal(8.5"x14") 215.9 × 355.6 mm (8.50 × 14.00 in)

36"x48"(ARCH E) 914.4 × 1219.2 mm (36.00 × 48.00 in)

30"x42"(ARCH E1) 762.0 × 1066.8 mm (30.00 × 42.00 in)

26"x38"(ARCH E2) 660.4 × 965.2 mm (26.00 × 38.00 in)

27"x39"(ARCH E3) 685.8 × 990.6 mm (27.00 × 39.00 in)

24"x36"(ARCH D) 609.6 × 914.4 mm (24.00 × 36.00 in)
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Paper Sizes Dimensions
18"x24"(ARCH C) 457.2 × 609.6 mm (18.00 × 24.00 in)

12"x18"(ARCH B) 304.8 × 457.2 mm (12.00 × 18.00 in)

9"x12"(ARCH A) 228.6 × 304.8 mm (9.00 × 12.00 in)

DIN C0 917.0 × 1296.0 mm (36.10 × 51.02 in)

DIN C1 648.0 × 917.0 mm (25.51 × 36.10 in)

DIN C2 458.0 × 648.0 mm (18.03 × 25.51 in)

DIN C3 324.0 × 458.0 mm (12.76 × 18.03 in)

DIN C4 229.0 × 324.0 mm (9.02 × 12.76 in)

20"x24" 508.0 × 609.6 mm (20.00 × 24.00 in)

18"x22" 457.2 × 558.8 mm (18.00 × 22.00 in)

14"x17" 355.6 × 431.8 mm (14.00 × 17.00 in)

12"x16" 304.8 × 406.4 mm (12.00 × 16.00 in)

10"x12" 254.0 × 304.8 mm (10.00 × 12.00 in)

10"x15" 254.0 × 381.0 mm (10.00 × 15.00 in)

US Photo 16"x20" 406.4 × 508.0 mm (16.00 × 20.00 in)

Poster 20"x30" 508.0 × 762.0 mm (20.00 × 30.00 in)

Poster 30"x40" 762.0 × 1016.0 mm (30.00 × 40.00 in)

13"x22" 329.0 × 558.0 mm (12.95 × 21.97 in)

Poster 300x900mm 300.0 × 900.0 mm (11.81 × 35.43 in)

Custom Paper Size 203.2 x 203.2 mm (8.00 x 8.00 in) to 917.0 x 1600.0 mm (36.10 x 62.99 in)

Note
• For details on non-standard paper sizes, see "Printing on Non-Standard Paper Sizes." ➔P.95
• Borderless printing is not supported on sheets.

Using Paper Other Than Genuine Paper and feed confirmed PaperUsing Paper Other Than Genuine Paper and feed confirmed Paper
When using this printer to print on paper other than genuine Canon paper and feed confirmed paper, use paper
that meets the following conditions.

Note
• Refer to Paper Reference Guide for details on genuine Canon paper and feed confirmed paper.  (See "Displaying

the Paper Reference Guide.") ➔P.331

• Paper where the size is described in "Paper Sizes"  (See "Paper Sizes.") ➔P.328

• Paper where the thickness is described in "Paper Thickness" in "Specifications"  (See "Specifica-
tions.") ➔P.622

• Paper where bleeding and ink overflow does not occur when printing
• Paper that does not warp severely when loading the paper or printing

Important
• If you use paper other than genuine Canon paper and feed confirmed paper, Canon provides absolutely no guar-

antees regarding print quality or paper feed properties. Refer to Paper Reference Guide for details on genuine
Canon paper and feed confirmed paper.  (See "Displaying the Paper Reference Guide.") ➔P.331

Load paper in the printer and then select the paper type in the control panel and printer driver and print.
You can print easily by selecting from existing settings provided in the printer control panel and printer driver.  (See
"Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing Settings.") ➔P.331
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Printing on Paper Other Than Genuine Paper and feed confirmed Paper Using ExistingPrinting on Paper Other Than Genuine Paper and feed confirmed Paper Using Existing
SettingsSettings

You can easily print on paper other than genuine Canon paper and feed confirmed paper without making complica-
ted settings by selecting existing settings provided in the printer control panel and printer driver depending on the
media type you are using. The existing settings consist of general-purpose paper settings provided for each media
type and special settings that allow you to select the amount of ink to use.

Important
• The genuine Canon paper settings provided in the printer control panel and printer driver are optimized for genu-

ine Canon paper. If these settings are selected for printing on paper other than genuine Canon paper, the ink may
bleed or the printhead may rub against the paper. In order to easily print on paper other than genuine Canon
paper and feed confirmed paper, we recommend that you select one of the following general-purpose paper set-
tings or special settings.

Note
• For an overview of the media types, see "Types of Paper." ➔P.328

• For details on how to select the media type in the control panel and printer driver, see "Types of Paper." ➔P.328

Choosing General-Purpose Paper Settings
Since these settings anticipate a wide variety of paper other than genuine Canon paper and feed confirmed paper,
these settings will make it difficult for bleeding ink and the printhead rubbing to occur. Refer to the following table
for the relationships between the conditions of the paper other than genuine Canon paper and feed confirmed pa-
per and the media type to select.

Type Approximate weight Approximate thickness Printer control panel Printer driver
Plain Paper 70 g/m² 0.09 mm (0.0035 in.) Plain Paper Plain Paper
Coated Paper 90 g/m² 0.13 mm (0.0051 in.) LW. Coated Paper Lightweight Coated Paper

170 g/m² 0.22 mm (0.0087 in.) HW. Coated Paper Heavyweight Coated Paper
Photo Paper 180 g/m² 0.18 mm (0.0071 in.) LW. Photo Paper Lightweight Photo Paper

LWPhotoPaper(LI)(*1) Lightweight Photo Paper (LowInk)(*1)

260 g/m² 0.26 mm (0.010 in.) HW. Photo Paper Heavyweight Photo Paper
HWPhotoPaper(LI)(*1) Heavyweight Photo Paper (LowInk)(*1)

Proof 80 g/m² 0.10 mm (0.0039 in.) News Proof (*2)

Sign/CAD Paper 150 g/m² 0.11 mm (0.0043 in.) CAD Clear Film CAD Clear Film
90 g/m² 0.08mm (0.0031 in.) CAD Trce(LowInk) CAD Tracing Paper (Low Ink)
100 g/m² 0.13 mm (0.0051 in.) Syn.Papr(LowInk) Synthetic Paper (LowInk)

  *1: Print using slightly less ink. Try this if you are concerned about rubbing of ink after printing.
  *2: Software RIP is required separately.

Selecting Special Settings
Special settings are provided that allow you to select the amount of ink used in steps. You can fix lackluster colors
or bleeding ink by selecting special settings where the amount of ink used is suitable for the paper you are using.
"Special 1" uses the least amount of ink, with the amount of ink used increasing through 5 steps as the number
increases up to "Special 5" which uses the greatest amount of ink. Although colors become more vivid as the
amount of ink used increases, bleeding also occurs more easily. We recommend that you try in order starting from
"Special 1" while checking the state of the printing.

Displaying the Paper Reference GuideDisplaying the Paper Reference Guide
The Paper Reference Guide are not included. To view, display the Paper Reference Guide on the website from
the links in the installed software. An Internet connection is required in order to view them.

• Windows
The basic instructions for displaying the Paper Reference Guide from the printer driver are as follows.

1. Open the printer driver.
 (See "Accessing the Printer Driver Dialog Box from Applications (Windows).") ➔P.148
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 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") ➔P.149

2.  

Select the Support sheet and click the User Man-
ual button.

3.  

Click Paper Reference Guide.

• Mac OS
The basic instructions for displaying the Paper Reference Guide from the imagePROGRAF Printmonitor are
as follows.

1.  

Click the System Preferences icon in the Dock.

2.  

Click Print & Scan. (This is identified as Printers &
Scanners or Print & Fax in other versions of Mac OS
X.)
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3.  

Select the printer from the list of printers and click Op-
tions & Supplies.

4.  

Click Utility.

5.  

Click Open Printer Utility.

6.  

Click Support.
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7.  

Click the User Manual button.

8.  

Click Paper Reference Guide.

Updating paper informationUpdating paper information
As for paper information of the printer Control Panel and printer driver, you can update it to the latest information by
downloading and installing the latest version of Media Information File from the imagePROGRAF website.
The latest Media Information File can be downloaded by accessing the imagePROGRAF website from the links in
the software installed on your computer. Contact your Canon dealer if you are unable to download it.
For details on Media Information File (Media Information File), refer as follows.

• Media Configuration Tool (Windows) ➔P.369
• Media Configuration Tool (Mac OS) ➔P.382

Important
• When your version of Media Configuration Tool is older than the version released on the imagePROGRAF

website, download and install the latest version of Media Configuration Tool before installing Media Infor-
mation File. If you do not install the latest version of Media Configuration Tool before installing Media Infor-
mation File, the latest paper information cannot be updated.

• Windows
The basic instructions for accessing the dedicated website from the printer driver are as follows.

1. Open the printer driver.
 (See "Accessing the Printer Driver Dialog Box from Applications (Windows).") ➔P.148
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") ➔P.149
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2.  

Select the Support sheet and click the Support In-
formation button.

The default browser on your computer is started
and the imagePROGRAF webpage is displayed.

• Mac OS
The basic instructions for accessing the dedicated website from the imagePROGRAF Printmonitor are as fol-
lows.

1.  

Click the System Preferences icon in the Dock.

2.  

Click Print & Scan. (This is identified as Printers &
Scanners or Print & Fax in other versions of Mac OS
X.)

3.  

Select the printer from the list of printers and click Op-
tions & Supplies.
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4.  

Click Utility.

5.  

Click Open Printer Utility.

6.  

Click Support.
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7.  

Click the Support Information button.

The default browser on your computer is started
and the imagePROGRAF webpage is displayed.
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Handling rollsHandling rolls
Attaching the Roll Holder to Rolls ................................................................................................................... 338
Loading Rolls in the Printer ............................................................................................................................. 341

Changing the Type of Paper ........................................................................................................................... 343
Specifying the Paper Length ...........................................................................................................................345

Removing the Roll from the Printer ................................................................................................................. 345
Removing the Roll Holder from Rolls ...............................................................................................................347

➔ Clearing Jammed Roll Paper .................................................................................................................... 573
➔ Clearing Jammed Paper (Paper Feed Slot) ............................................................................................... 578
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Keeping Track of the Amount of Roll Paper Left ..............................................................................................349
Specifying the Ink Drying Time for Rolls .......................................................................................................... 350

Specifying the Cutting Method for Rolls .......................................................................................................... 351
Cutting the Leading Edge of Roll Paper Automatically .................................................................................... 355
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Roll Holder Set ............................................................................................................................................... 444

Attaching the Roll Holder to RollsAttaching the Roll Holder to Rolls
When printing on rolls, attach the Roll Holder to the roll.
Rolls have a two- or three-inch paper core. Use the correct attachment for the paper core. The printer comes
equipped with the 2-Inch Paper Core Attachment installed.

Using Rolls with a 2-Inch Paper Core Using Rolls with a 3-Inch Paper Core
Holder Stopper (Left Side) Roll Holder (Right Side) Holder Stopper (Left Side) Roll Holder (Right Side)

2-Inch Paper Core Attachment No Attachment Needed 3-Inch Paper Core Attachment L 3-Inch Paper Core Attachment R

Caution
• Set the roll on a table or other flat surface so that it does not roll or fall. Rolls are heavy, and dropping a roll may

cause injury.

Important
• When handling the roll, be careful not to soil the printing surface. This may affect the printing quality. We recom-

mend wearing clean cloth gloves when handling rolls to protect the printing surface.

• Use scissors or a cutting tool to cut the edge of the roll paper if it is uneven, dirty, or has tape residue. Otherwise,
it may cause feeding problems and affect the printing quality. Be careful not to cut through any barcodes printed
on the roll.

• Align the edges of the paper on both ends of the roll. Misalignment may cause feeding problems.
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Note
• For details on supported sizes and types of rolls, see Paper Sizes or the Paper Reference Guide.  (See "Paper

Sizes.") ➔P.328   (See "Displaying the Paper Reference Guide.") ➔P.331

• To view instructions as you attach the Roll Holder, press the Navigate button.  (See "How to View Instructions with
Navigate.") ➔P.404

1
 

Lift the Holder Stopper lever (a) from the shaft side to
unlock it. Holding the Holder Stopper at the position
indicated (b), remove it from the Roll Holder.

2 Insert the respective attachments for the roll paper core on the Roll Holder and Holder Stopper.

• Using rolls with a 2-inch paper core

Holder Stopper (Left Side) Roll Holder (Right
Side)

Align the tips (a) of the 2-Inch Paper Core Attachment with the holes (b) of the Holder Stopper and
insert it firmly.

No attachment is
needed.
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• Using rolls with a 3-inch paper core
Holder Stopper (Left Side) Roll Holder (Right Side)

Align the tips (a) of the 3-Inch Paper Core Attachment L with
the holes (b) of the Holder Stopper and insert it firmly.

Align the tips (a) of 3-Inch Paper Core Attachment R with
the holes (b) of the Roll Holder and insert it firmly.

3
 

With the edge of the roll paper facing forward as
shown, insert the Roll Holder from the right of the roll.
Insert it firmly until the roll touches the flange (a) of the
Roll Holder, leaving no gap.

4
 

Insert the Holder Stopper from the left in the Roll
Holder as shown. Holding it at the position shown (b),
push it firmly in until the flange (a) of the Holder Stop-
per touches the roll. Lock the Holder Stopper lever (c)
by pushing it down toward the shaft side.
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Loading Rolls in the PrinterLoading Rolls in the Printer
Follow these steps to load rolls in the printer.

Note
• Before loading rolls, make sure the printer is clean inside the Top Cover and around the Ejection Guide. If these

areas are dirty, we recommend cleaning them in advance.  (See "Cleaning Inside the Top Cover.") ➔P.558

1
 

Press the Load button.

2 Press ▲ or ▼ to select "Load Roll Paper", and then press the OK button.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to remove it.

Press ▲ or ▼ to select Yes, and then press the OK button. Remove the paper and go to the next step.

3
 

Positioning your hands as shown, open the Roll Cov-
er.
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4
 

Holding the Roll Holder flange (a), rest the Roll Hold-
er shaft on the Roll Ledge (b).
At this time, position the holder so that the R label (c)
on the [W label (c) on the Roll Holder flange is
aligned with the R label (d) on the printer .

5
 

Holding the Roll Holder flange (a), guide the holder
along the Roll Loading Slots (b) on both ends, keep-
ing the holder level as you load it in the Roll Holder
Slot.

Caution
• Do not force the Roll Holder into the printer with the right and left ends reversed. This may damage the

printer and Roll Holder.

• Do not release the flanges until the holder is loaded in the Roll Holder Slot.

• Be careful not to pinch your fingers between the Roll Loading Slots (b) and the Roll Holder shaft (c) when
loading rolls.

6
 

Insert the edge of the roll in the Paper Feed Slot (a)
and advance the roll until you hear the feed tone.
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Important
• Be careful not to soil the printing surface of roll paper as you insert it in the slot. This may affect the

printing quality. We recommend wearing clean cloth gloves when handling rolls to protect the printing
surface.

• If the paper is wrinkled or warped, straighten it out before loading it.

• Load paper straight so it is not fed askew.

 

7 Once paper feeding starts, you will need to do the following, based on the ManageRemainRoll setting and
the barcode printed on rolls.  (See "Keeping Track of the Amount of Roll Paper Left.") ➔P.349
ManageR-
emainRoll Barcodes Printer Operation After the Paper is Fed

Off Printed A menu for selection of the type of paper is automatically shown on the Display Screen.
Press ▲ or ▼ to select the type of paper, and then press the OK button.Not prin-

ted

On Printed The type and amount of paper left is automatically detected based on the barcode printed on the roll.
There is no need to specify the type and length of the paper.

Not prin-
ted

A menu for selection of the paper type and length is automatically shown on the Display Screen.
Press ▲ or ▼ to select the type and length of paper loaded, and then press the OK button.

Note
• For details on types of paper to select, see the Paper Reference Guide.  (See "Displaying the Paper

Reference Guide.") ➔P.331

8
 

Holding it at the positions indicated, close the Roll Cov-
er.

Note
• Cut the edge of the roll after the paper is advanced if it is soiled or if there are cuts from scissors or the

blade after removing creased edges.  (See "Specifying the Cutting Method for Rolls.") ➔P.351

Changing the Type of PaperChanging the Type of Paper
Follow these steps to change the type of paper specified on the printer after you have loaded paper.
If you will continue using this type of paper later, selecting Keep Paper Type > On will save the time and effort of
configuring the media type setting when you load the paper again. The current media type settings before you se-
lect On will be automatically selected at that time.  (See "Using the Same Type of Paper Regularly.") ➔P.344
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Important
• For best printing results, the printer fine-tunes the print head height and the feed amount for each type of paper.

Be sure to select the type of paper to use correctly before printing.

• Because the printer fine-tunes the feed amount for each type of paper, the margins and the size of printed im-
ages may vary depending on the type of paper used. If margins and the size of images are not as you expected,
adjust the paper feed amount.
 (See "Adjusting the Feed Amount.") ➔P.527

• Rolls and sheets have different printing areas, and sheets having a larger bottom margin than rolls.
 (See "Print Area.") ➔P.623

Changing the Type of Paper

Note
• When you load a roll, a menu for selection of the type of paper is shown on the Display Screen. Select the type of

paper, and then press the OK button.
If no barcode has been printed on the roll and you have set ManageRemainRoll to On, specify the roll length after
the type of paper.  (See "Specifying the Paper Length.") ➔P.345

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Chg. Paper Type, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper loaded ( Roll Paper or Cut Sheet ), and then press the OK
button.

5 Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

Important
• Be sure to select the correct paper type. If this setting does not match the loaded paper, it may cause

feed errors and affect printing quality.

Note
• For details on types of paper, see the Paper Reference Guide.  (See "Types of Paper.") ➔P.328  By de-

fault, Plain Paper is selected.

• If you move the Release Lever, the setting automatically reverts to the previously selected paper.

Using the Same Type of Paper Regularly
Configure this setting so that current media type settings will be automatically selected when you load the same
type of paper later.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Keep Paper Type, and then press the OK button.

4 Press ▲ or ▼ to select On, and then press the OK button.

Note
• The specified media type setting is updated in the following situations.

• When using sheets, if you send a print job before loading a sheet, the media type setting is updated to match the
type of paper specified by the print job.

• When you have selected ManageRemainRoll > On on the Control Panel and a barcode is printed on the roll,
the media type setting is updated to match the type of paper specified by the barcode.

• To change the media type setting, see "Changing the Type of Paper." ➔P.344

Specifying the Paper LengthSpecifying the Paper Length
When changing the length of paper after the paper has been advanced, specify the length as follows.

Note
• Specify the paper length when you have set ManageRemainRoll to On.  (See "Keeping Track of the Amount of

Roll Paper Left.") ➔P.349

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Chg. Paper Size, and then press the OK button.

4 Press ▲ or ▼ to select Roll Length, and then press the OK button.

5 Press ▲ or ▼ to select the length of paper loaded in the printer, and then press the OK button.
Specify the roll length as follows.

1. Press the ◀ or ▶ button to move to the next field for input.

2. Press the ▲ or ▼ button to enter the value.

3. Repeat steps 1 and 2 to finish entering the value, and then press the OK button.

Removing the Roll from the PrinterRemoving the Roll from the Printer
Remove rolls from the printer as follows.

Note
• If you need to cut the roll, see "Specifying the Cutting Method for Rolls." ➔P.351
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1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4 Press ▲ or ▼ to select Yes, and then press the OK button.
The roll is now rewound and ejected.

Caution
• If you have selected ManageRemainRoll > On in

the Control Panel menu, a barcode is printed on
the leading edge of the roll.
Do not remove the roll before the barcode is prin-
ted. You will be unable to keep track of the amount
of roll paper left.  (See "Keeping Track of the Amount of Roll Paper Left.") ➔P.349

 

5
 

Positioning your hands as shown, open the Roll Cov-
er.

6
 

Using both hands, rotate the Roll Holder toward the back
to rewind the roll.
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7
 

Holding the Roll Holder flange (a), remove the holder
from the Roll Holder Slot.

Note
• For instructions on removing the Roll Holder from rolls, see "Removing the Roll Holder from

Rolls." ➔P.347

8
 

Holding it at the positions indicated, close the Roll Cov-
er.

Note
• To load new roll paper in the printer at this point, see "Loading Rolls in the Printer." ➔P.341

Removing the Roll Holder from RollsRemoving the Roll Holder from Rolls

1
 

Lift the Holder Stopper lever (a) from the shaft side to
unlock it. Holding the Holder Stopper at the position
indicated (b), remove it from the Roll Holder.
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2
 

Remove the Roll Holder from the roll.

3 When removing attachments, push the tips (a) in as you remove the attachment.

• 3-Inch Paper Core Attachment R (Roll Holder side)

• 3-Inch Paper Core Attachment L (Holder Stopper side)

• 2-Inch Paper Core Attachment

Important
• Store the roll in the original bag or box, away from high temperature, humidity, and direct sunlight. If paper is not

stored properly, the printing surface may become scratched, which may affect the printing quality when you use it
again.
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Feeding Roll Paper ManuallyFeeding Roll Paper Manually
After a roll has been advanced, you can press the Feed button to feed or retract the roll with the ▲ and ▼ buttons.

1 Press the Feed button.

2 Press the ▲ or ▼ button to advance or retract the roll.
Press ▲ to retract the roll manually.
Press ▼ to advance the roll manually.

Note
• If you hold down ▲ or ▼ for less than a second, the roll will move about 1 mm (0.04 in).

If you hold down ▲ or ▼ for more than a second, the roll will move until you release the button. Release the button
when the Display Screen indicates "End of paper feed. Cannot feed paper more.".

Keeping Track of the Amount of Roll Paper LeftKeeping Track of the Amount of Roll Paper Left
Setting ManageRemainRoll to On in the Paper Menu of the Control Panel will print a barcode with text on the roll
when the roll is removed that identifies the type of paper and amount left. When ManageRemainRoll is On and
you load rolls with printed barcodes, the type of paper and amount left are automatically detected after rolls are
loaded. The barcode will be cut off after it has been read.

Important
• If the barcode on the roll is not detected, enter the type and length of paper on the Control Panel.

Follow these steps to set ManageRemainRoll to On as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select ManageRemainRoll, and then press the OK button.

4 Press ▲ or ▼ to select On, and then press the OK button.
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Specifying the Ink Drying Time for RollsSpecifying the Ink Drying Time for Rolls
When you are using paper that takes longer for ink to adhere, ink may be transferred onto the paper surface during
ejection, soiling it. In that case, you may be able to improve the condition by setting the time to wait for the ink to
dry after printing.

Note
• If the Cutter touches the print surface on which the ink is not dry, the paper surface may become scratched or

soiled, or the paper surface may rub when the paper falls and the surface may become soiled.
To wait for the ink to dry without allowing printed documents to fall after printing, set Cutting Mode on the menu of
the printer to Eject.  (See "Specifying the Cutting Method for Rolls.") ➔P.351

• The settings can also be made from the Control Panel on the printer. Select the type of paper from Paper Details
in Paper Menu. (See "Menu Settings.") ➔P.416

Windows

1 Display the printer driver dialog box.
 (See "Accessing the Printer Driver Dialog Box from the Operating System Menu (Windows).") ➔P.149

2
 

Select the Main sheet and click CAdvanced Set-
tings in AMedia Type.

3
 

In the Paper Detailed Settings dialog box displayed
next, select the desired settings values in BBe-
tween Pages and CBetween Scans in ADrying
Time, and then click OK.
 (See "Paper Detailed Settings Dialog Box (Win-
dows).") ➔P.154

Mac OS

1 Choose Print in the application menu.
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2
 

Select the Main pane and click CSettings in AMe-
dia Type.

3
 

In the Paper Detailed Settings dialog box displayed
next, select the desired settings values in CBe-
tween Pages and DBetween Scans in BDrying
Time, and then click OK.
 (See "Paper Detailed Settings Dialog Box (Mac
OS).") ➔P.258

Specifying the Cutting Method for RollsSpecifying the Cutting Method for Rolls
How rolls are cut after ejection varies depending on printer settings.

Cutting Method Printer Setting Driver Setting
Automatic The roll is automatically cut by the Cutter Unit fol-

lowing printer driver settings.
Media
Menu >
Paper De-
tails >
(Various
Types of
Paper) >
Cutting
Mode

Automatic Automatic
Cutting

Yes

Eject (wait-
ing for ink
to dry after
printing)

Choose this setting if you prefer not to have docu-
ments dropped immediately after printing, as when
waiting for ink to dry.
To cut the roll with the Cutter Unit, press the Cut
button.

Eject Yes
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Cutting Method Printer Setting Driver Setting
Manual
(when us-
ing media
that cannot
be cut with
the Cutter
Unit )

Media
Menu >
Paper De-
tails >
(Various
Types of
Paper) >
Cutting
Mode

Automatic
Cutting

Choose this setting when using media that cannot
be cut using the Cutter Unit.
Cut each page from the roll using scissors. For con-
tinuous printing (if you will cut each page later), se-
lect Automatic Cutting > Yes or select Print Cut
Guideline.
 (See "Cutting Roll Paper After Printing.") ➔P.137

Manual No, Yes, Print
Cut Guideline

Paper cut-
ting (to
have the
roll cut at
your speci-
fied posi-
tion)

Choose this option if you want to cut pages by
pressing Cutter Unit buttons for manual cutting after
printing when Automatic Cutting > No is selected
or Print Cut Guideline is selected in the printer
driver.
Otherwise choose this option if you want to cut the
roll edge after loading a roll.

Cut button
pressed

Yes No, Print Cut
Guideline

Note
• Automatic and Eject are valid only when you have selected Automatic Cutting > Yes in the printer driver.

• With Eject, printing does not resume after a series of jobs have been printed continuously until the roll is cut.

• Eject is the preset selection in Cutting Mode for some types of paper. For this paper, we recommend keeping the
preset cutting mode.

Cut rolls manually in the following cases:

Eject (waiting for ink to dry after printing)

Important
• When cutting wide printed documents after ejection, have two people support the documents. If the paper drops,

printed documents may be damaged.

• Do not lift the paper when holding printed documents before cutting. If the paper rises, it may affect the printing
quality or cause rough cut edges.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button. The Paper Menu is displayed.
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3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6 Press ▲ or ▼ to select Eject, and then press the OK button.

7 Starts printing.
When printing is finished, the printer will stop without cutting.

8
 

Holding the printed document to prevent it from dropping, press
the Cut button to cut the roll.

Manual (when using media that cannot be cut with the Cutter Unit )

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button. The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Cutting Mode, and then press the OK button.

6 Press ▲ or ▼ to select Manual, and then press the OK button.

7 Starts printing.
The printer stops advancing the paper after printing.
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8
 

Press the Feed button.

Roll paper is fed to the specified cut position and then automati-
cally stopped.

9
 

Cut the roll paper manually with scissors or the like.

10
 

Press the OK button.

After the roll is rewound, it stops automatically.

Paper cutting (to have the roll cut at your specified position)

1 Press the Feed button.

2
 

Press the ▼ button to advance the roll to the position for cutting.
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3
 

Press the Cut button.

4 Press ▲ or ▼ to select Yes, and then press the OK button.
After the roll paper is cut, it is rewound automatically.

Caution
• If paper would be short when cut at a particular position, the roll may automatically be advanced in some

cases before cutting.

Cutting the Leading Edge of Roll Paper AutomaticallyCutting the Leading Edge of Roll Paper Automatically
If the leading edge of the paper is cut crooked or is not cut straight when roll paper is loaded, it will not print correct-
ly. If this happens, you can cut the leading edge of the paper straight when loading a paper roll by using Trim Edge
First in the Control Panel menu.
Trim Edge First offers the following options.

• Automatic
If the leading edge of the paper is cut crooked and is not cut straight when loading roll paper, cut the leading
edge straight and eject the fragment of paper to prevent printing on the platen and soiling the printer.

• On (Preset Len)
The amount to cut from the leading edge of the paper varies depending on the media type, and is cut to a
prescribed length. For more information on the prescribed length, see the leading edge precut length in the
Paper Reference Guide.  (See "Displaying the Paper Reference Guide.") ➔P.331

• On(Input Length)
The amount to cut from the leading edge of paper is specified in the control panel. The amount to cut from the
leading edge can be specified in the range of lengths displayed in the control panel. The range of lengths dif-
fers between each media type.

Note
• The amount to cut from the leading edge of paper cannot be set shorter than the length displayed in the con-

trol panel.

• Manual
The amount to cut from the leading edge of the paper can be adjusted by pressing the ▲ and ▼ buttons.
After making the adjustment, you can cut the paper by pressing the Paper Cutting button and selecting "Cut
paper".
After the paper has been cut, press "Finish paper set".

Note
• If you do not press "Finish paper set" after cutting the paper, you will not be able to print again.

• Off
The edge is not cut and scraps are not removed.
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Follow these steps to change the Trim Edge First setting.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Trim Edge First, and then press the OK button.

6 Press ▲ or ▼ to select the desired setting option, and then press the OK button.
This setting takes effect the next time you load a roll.

Reducing Dust from Cutting RollsReducing Dust from Cutting Rolls
For media such as Backlit Film that are more likely to generate debris when cut, select CutDustReduct. > On in
the Paper Menu of the Control Panel. This option reduces debris from cutting by printing black lines at the leading
and trailing edges of documents. It may help prevent Printhead damage. You can specify for CutDustReduct. to be
activated for particular types of paper.

Important
• Do not set CutDustReduct. to On for paper that wrinkles easily, such as Plain Paper or lightweight paper. This

may impair cutting and cause paper jams.

• Borderless printing is not available when CutDustReduct. is set to On. To use borderless printing, select Cut-
DustReduct. > Off.

Set CutDustReduct. to On as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper loaded in the printer, and then press the OK button.

5 Press ▲ or ▼ to select CutDustReduct., and then press the OK button.

6 Press ▲ or ▼ to select On, and then press the OK button.
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Handling sheetsHandling sheets
Loading Sheets in the Printer ..........................................................................................................................358

Changing the Type of Paper ........................................................................................................................... 343
Printing From a Desired Starting Point ............................................................................................................ 360

Removing Sheets ........................................................................................................................................... 362

➔ Clearing a Jammed Sheet ........................................................................................................................ 576
➔ Clearing Jammed Paper (Paper Feed Slot) ............................................................................................... 578

Loading Sheets in the PrinterLoading Sheets in the Printer
Follow these steps to load sheets in the printer.

Important
• One sheet of paper can be loaded in the Paper Feed Slot at a time. Do not load more than one sheet at a time.

This may cause paper jams.

• Before feeding paper or printing, make sure the sheet is flat against the Roll Cover. The sheet may jam if it curls
before feeding or printing and the trailing edge drops toward the front.

• Paper that is wrinkled or warped may jam. If necessary, straighten the paper and reload it.

• Load the paper straight. Loading paper askew will cause an error. (See "Paper is crooked..") ➔P.607

Note
• Store unused paper in the original package, away from high temperature, humidity, and direct sunlight.

1 Select sheets as the paper source.

• If a print job was received
Sheets are automatically selected, and the media type and size specified by the print job are shown on
the Display Screen. Go to the next step.

• If no print job was received

1.  

Press the Load button.

2. Press ▲ or ▼ to select "Load Cut Sheet", and then press the OK button.

Note
• If any paper has been advanced that will not be used, a message is shown requesting you to remove it.

Press ▲ or ▼ to select Yes, and then press the OK button. Remove the paper and go to the next step.
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2
 

Slide the Width Guide (a) to align it with the mark for the
size of paper you will load.

3
 

Load a single sheet printing-side up in the Paper
Feed Slot, with the right edge aligned with the Paper
Alignment Guide (a) to the right of the Roll Cover.
Insert the paper until the leading edge makes contact
and you hear a tone.
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4
 

Move the Width Guide (a) carefully to match the size of
paper loaded.
Set the Width Guide against the edge of the paper to
prevent the paper from becoming crooked or wrinkled.

5 Press the OK button.

• If a print job was received
The printer now starts printing the print job.

• If no print job was received
A menu for selection of the type of paper is automatically shown on the Display Screen.
Press ▲ or ▼ to select the type of paper, and then press the OK button.
The printer now starts feeding the paper.

Note
• Refer to Paper Reference Guide for details on type of paper to select.  (See "Displaying the Paper Refer-

ence Guide.") ➔P.331

Printing From a Desired Starting PointPrinting From a Desired Starting Point
When printing inside boundaries or in other situations when you want to specify a particular position to start printing
from, set Width Detection to Off in the printer menu for the type of paper used.

Set Width Detection to Off

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.
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4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

5 Press ▲ or ▼ to select Width Detection, and then press the OK button.

6 Press ▲ or ▼ to select Off, and then press the OK button.

Load paper in the desired position to start printing from
Follow these instructions to load paper at the desired starting position for printing when Width Detection is Off.

1 If you did not send a print job in advance, a menu for selection of the type of paper is displayed.
Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• If a print job was received before paper was advanced, the media type and size specified by the job are

shown on the Display Screen.
Thus, this screen is not displayed. Go to step 2.

2 "Width Detection OFF. OK to continue?" is now shown on the Display Screen. Press ▲ or ▼ to select
"Leave OFF", and then press the OK button.

3 After a menu for selection of the paper size is displayed, press ▲ or ▼ to select the paper size, and then
press the OK button.

4
 

Open the Top Cover and check the position where paper is
loaded.

To start printing from the current position, close the
Top Cover.
To reposition the paper, push the Release Lever
back.
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5
 

Keeping the right edge of the paper aligned with the ex-
tended line of the Paper Alignment Line (a) to the right of
the ejection guide and the leading edge aligned with the
groove (b) at the far end of the Platen, load the paper at
the position from which to start printing.

6
 

Pull the Release Lever forward and close the Top
Cover.

Removing SheetsRemoving Sheets
Remove sheets from the printer as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Eject Paper, and then press the OK button.

4 Press ▲ or ▼ to select Yes, and then press the OK button.
The paper is ejected from the front of the printer.

5
 

Holding the paper, push the Release Lever back and
remove the sheet.

6
 

Pull the Release Lever forward.
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Output StackerOutput Stacker
Using the Output StackerUsing the Output Stacker

This section describes how to use the Output Stacker.

• When storing printed documents on the Output Stacker
Use position (1). For details on how to use the Extended position which is a useful function for retrieving prin-
ted matter, refer to the note regarding the Extended position.  (See "Note regarding the Extended posi-
tion.") ➔P.364

• When the Output Stacker is not used, when loading paper, or when moving the printer
Use position (2).
When moving the printer, always lift the Support Rod to Extended position A before putting it in position (2),
otherwise the Basket Cloth may touch the floor and be soiled or damaged.  (See "Switching to Extended posi-
tion A.") ➔P.365

Important
• When storing printed documents on the Output Stacker, always use it in position (1). If you do not, printed docu-

ments may not be dropped into the Output Stacker, and the printed surface may become soiled.

• The Output Stacker can hold one sheet. When printing multiple pages, remove each sheet after it is printed.

• The Output Stacker can hold printed documents from paper up to 52.02 inches (1,296 mm) long.

Note regarding the Extended position
The Output Stacker has a regular position and a position for easy removal of printed documents. Use the best posi-
tion for the paper size and orientation that you are using.
For information on types and sizes of paper you can use with the stacker in extended position, refer to the follow-
ing.

• Printer Stand ST-34: Output stacker operation guide (Included with the Printer Stand ST-34)

Regular position
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Extended position A Extended position B

• Switching to Extended position A
Switch the stacker to Extended position A as follows.

1
 

Lift the Support Rod to the position shown (a) and
switch the stacker to Extended position A.
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2
 

When using 24-inch or A1 (portrait) roll paper, pull out
the Adjustable Stopper (a). This completes the proce-
dure for switching to Extended position A.

Once the printing has finished, use the following procedure to return to the regular position.

1
 

Lower the Support Rod to the position shown (a) to
return to the regular position. If the Adjustable Stop-
per (b) is extended, retract it.

2
 

Return to the regular position.

• Switching to Extended position B
Switch the stacker to Extended position B as follows.
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1
 

Grasp the Output stacker handle (a) and pull out the
Output Stacker so that it tilts towards you.

2
 

Open the Output Stacker Ejection Guides (a). This
completes the procedure of switching to Extended
position B.

Once the printing has finished, use the following procedure to return to the regular position.

1
 

Push the Output Stacker Ejection Guides (a) closed
until it clicks into place.
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2
 

Hold onto the Output stacker handle (a) and pull the
Output stacker release lever (b) towards you.

3
 

While continuing to hold the Output stacker handle
(a), slowly lower the Output Stacker.

4
 

Return to the regular position.
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The Features of Media Configuration ToolThe Features of Media Configuration Tool
In imagePROGRAF, the best printer settings for each paper are collected together in media information files in or-
der to give the highest quality printing results. Settings for Canon genuine paper and Canon feed confirmed paper
are provided by Canon in these media information files.

Note
• Canon genuine paper and Canon feed confirmed paper are detailed in the Paper Reference Guide.

The Media Configuration Tool allows you to perform the following tasks.

• When supported paper has been newly added to the printer, you can add that media type to the printer control
panel and printer driver by using the media information file provided by Canon.

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and
rename them, in addition to other functions.

Important
• Normally, the Media Configuration Tool is installed and the media information is configured when you install the

printer driver from the User Software CD-ROM. Use this software if you want to add new media information or
edit existing media information.

• Administration of paper information using the Media Configuration Tool should be performed by the printer admin-
istrator.

Drivers Applicable with Media Configuration Tool

• imagePROGRAF Printer Driver

Installation ProceduresInstallation Procedures
The Media Configuration Tool installation screen appears when you start the installation of a new version of the
Media Configuration Tool. The installation procedure started from this screen is described below.

Important
• When you install the printer driver from the User Software CD-ROM, the Media Configuration Tool is also instal-

led and the media information is also configured. The following procedure is therefore not normally needed. Per-
form the following procedure if you are installing the Media Configuration Tool without using the User Software
CD-ROM, such as by downloading the latest version of the Media Configuration Tool from the Canon website.

• You must be logged in as Administrator when installing software in Windows.
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1
 

Start the Media Configuration Tool installer.
Click the Next button.

2
 

The next screen presents selections for the country or
area where the printer is used.
Select a country or territory then click the Next button.

3
 

The License Agreement is displayed.
If you accept the agreement, click Yes.

4
 

The Change Installation Location screen appears.
Select the destination folder then click the Next button.
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5
 

The Installation Complete screen appears.
Click the Finish button.
 

This completes the installation of Media Configuration
Tool.

Starting MethodStarting Method
Follow the procedure below to start Media Configuration Tool.
From the start menu go to All Programs > iPFxxxx Media Configuration Tool > iPFxxxx Media Configuration
Tool.
Media Configuration Tool main window is displayed.

Note
• If you only start the Media Configuration Tool, the media information on the printer control panel and in the printer

driver is not updated. If this screen is displayed, select Add Genuine Paper in the main window, and click the
Update button in the Edit Media Types screen to update the media information.

Media Configuration Tool Main WindowMedia Configuration Tool Main Window
The explanation below is on the Media Configuration Tool main window.

Note
• For the step to open the Media Configuration Tool main window, see "Starting Method." ➔P.371
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• Add Genuine Paper button
When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media in-
formation files released by Canon to the printer control panel and printer driver. You can also change names,
toggle between displaying and hiding, and delete added media types.
You can also change the display order of the paper types.
Refer to "Editing Media Type Information for Genuine Paper and Feed Confirmed Paper" ➔P.372  for details
on Add Genuine Paper.

• Link to Support Information button
You can check information such as the latest information for the product and software version upgrade infor-
mation.

• Link to User Manual Button
Displays the printer user's manual

Editing Media Type Information for Genuine Paper and Feed Confirmed PaperEditing Media Type Information for Genuine Paper and Feed Confirmed Paper
To add genuine paper and feed confirmed paper to the printer control panel and printer driver and edit the media
type information, click the Add Genuine Paper button in the Media Configuration Tool main window.
Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Select Printer
dialog box, and then click the Next button.

Communication with the printer begins.

Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.

The Edit Media Types dialog box is displayed.

Note
• In the following screens, you cannot change the printer where media type information is to be updated.

Note
• Paper that is displayed grayed out does not appear in the printer driver or printer panel.
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• Add Button
To add genuine paper or feed confirmed paper to the printer control panel and printer driver, click this button.
For details on the procedure for adding media types, see "Adding Media Types." ➔P.373

Important
• To add media types, download the media information file (.amf file) in advance from the Canon website.

• Rename Button
To change the name on the printer control panel and the name in the printer driver for genuine paper and feed
confirmed paper, select the paper to change and click this button.
For details on the procedure for changing paper display names, see "Changing Media Names." ➔P.375

• Delete Button
To delete added genuine paper and feed confirmed paper from the printer control panel and printer driver, se-
lect the paper to delete and click this button.
For details on the procedure for deleting added media types, see "Deleting Media Types You Have Add-
ed." ➔P.377

• Show/Hide Button
To change whether or not genuine paper or feed confirmed paper is displayed in the printer control panel and
printer driver, select the paper to change and click this button.
For details on the procedure for changing whether or not to display media types, see "Switching Media Types
Display Show/Hide." ➔P.378

• Change Display Order button (  or )
To change the display order of a media type in the printer control panel and printer driver, select the paper to
change and click this button.
For details on the procedure for changing the display order of media types, see "Changing the Display Order
of Media Types." ➔P.380

Important
• When you update the media type information, perform the same update on all of the PCs that are using that

printer.

Note
• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.

Adding Media TypesAdding Media Types
Media information files (.amf files) released by Canon are registered in the printer control panel and printer driver.

Important
• Do not perform printing on the target printer while adding the media types.

• Reinstalling Media Configuration Tool after registering a media information file may delete the registered media
information file.In this case, first download and install latest Media Configuration Tool, then download and register
the required media information file.

1
 

Open the Edit Media Types dialog box, and then
click the Add button.
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Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.372

2
 

The Add Media Type dialog box displays.
Click the Browse button.

3
 

Open the folder that contains the media information files
(.amf files).

4
 

The names of the media information files contained in
the selected folder are displayed in Media Informa-
tion File in the Add Media Type dialog box. Select
the check box for the paper you want to add and click
the OK button.

Note
• If Master Media Information File is displayed as the Type of the Media Information File, the media type

display order and media type display/non-display settings are initialized. Reconfigure these after added
the master media information file.

5 Click OK when the confirmation message is displayed.

 

 

 

Adding Media Types                                                                                                                                                                                              iPF785

                                                                                                                                                                                                                     User's Guide

  

Handling and Use of Paper
M

edia Configuration Tool (W
indows)

 374



6
 

In the Edit Media Types dialog box, click the Update
button.

7
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

8
 

Click the OK button.

Changing Media NamesChanging Media Names

1
 

Open the Edit Media Types dialog box.
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Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.372

2
 

In the Media Type list, select the name to change.
Click the Rename button.

3
 

The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name
on Control Panel and click the OK button.

Note
• To restore the original names, click the Restore button.

• The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated
below.
alphanumeric, space, "-", ".", "_", "(", ")", "+", "%", ",", "/"

• For Name in Printer Driver up to 32 one Byte characters can be entered, and for Name on Control
Panel up to 16 one Byte characters can be entered.

4
 

In the Edit Media Types dialog box, click the Update
button.

5
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.
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Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

6
 

Click the OK button.

Deleting Media Types You Have AddedDeleting Media Types You Have Added

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.372

2
 

In the Media Type list, select the name of the media
to delete.
Click the Delete button.

Note
• Only paper for which Status in the Media Type is Add can be deleted.
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3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Click the Execute button.
Communication with the printer begins.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.

Switching Media Types Display Show/HideSwitching Media Types Display Show/Hide

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.372
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2
 

In the Media Type list, select the name of the media
to switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note
• You can select multiple paper.

• The names of media switched for non-display appear grayed out in the Media Type list.

• Each time you click the Show/Hide button, the display mode cycles from showing both the printer driver
and printer panel, to hiding both the printer driver and printer panel, and then to showing only the printer
panel.

3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.
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5
 

Click the OK button.

Changing the Display Order of Media TypesChanging the Display Order of Media Types

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.372

2
 

Select the paper in the Media Type list for which to
change the display order, and then click the buttons

to move the item (  or ).
The selected item moves one line up or down for ev-
ery button click.

3
 

In the Edit Media Types dialog box, click the Update
button.
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4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.

Checking the updateChecking the update
After updating the media information using the Media Configuration Tool, you can check whether the update has
been applied to the printer in the control panel of the printer.

1 Click the About button in the Media Configuration Tool main window to open the About dialog box.

2 Check the value xx.xx (xxxx) of MIT DB Version.

3 Check the value xx.xx (xxxx) of MIT in Set./Adj. Menu > Printer Info > System Info in the printer control
panel.
If the values in Steps 2 and 3 are the same, the update has been applied to the printer.
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The Features of Media Configuration ToolThe Features of Media Configuration Tool
In imagePROGRAF, the best printer settings for each paper are collected together in media information files in or-
der to give the highest quality printing results. Settings for Canon genuine paper and Canon feed confirmed paper
are provided by Canon in these media information files.

Note
• Canon genuine paper and Canon feed confirmed paper are detailed in the Paper Reference Guide.

The Media Configuration Tool allows you to perform the following tasks.

• When supported paper has been newly added to the printer, you can add that media type to the printer control
panel and printer driver by using the media information file provided by Canon.

• You can rearrange lists of the types of paper on the printer control panel and in printer driver dialog boxes and
rename them, in addition to other functions.

Important
• Normally, the Media Configuration Tool is installed and the media information is configured when you install the

printer driver from the User Software CD-ROM. Use this software if you want to add new media information or
edit existing media information.

• Administration of paper information using the Media Configuration Tool should be performed by the printer admin-
istrator.

Drivers Applicable with Media Configuration Tool

• imagePROGRAF Printer Driver

Procedures for InstallingProcedures for Installing
Start the installer in the new version of Media Configuration Tool, and follow procedures below to install the Media
Configuration Tool.

Important
• When you install the printer driver from the User Software CD-ROM, the Media Configuration Tool is also instal-

led and the media information is also configured. The following procedure is therefore not normally needed. Per-
form the following procedure if you are installing the Media Configuration Tool without using the User Software
CD-ROM, such as by downloading the latest version of the Media Configuration Tool from the Canon website.
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1
 

Double-click Canon iPFxxxx Series Media Configura-
tion Tool.pkg to start the Media Configuration Tool instal-
ler.

2
 

The Software License Agreement is displayed.
After you have read Canon Software License Agreement,
click the Continue button.

3
 

The next screen presents selections for the country or
area where the printer is used.
Select a country or territory then click the Continue but-
ton.

4
 

Click the Install button.
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5
 

Enter an administrator name/password and click the
Install Software button.

6
 

Click the Close button.

The installation of Media Configuration Tool is complete.

Note
• When the installation is completed properly, the Media Configuration Tool folder is saved in the following

folder.
Applications > Canon Utilities > iPFxxxx Media Configuration Tool

• The iPFxxxx in the folder above will be the printer name in use.

Starting MethodStarting Method
Follow the procedure below to start the Media Configuration Tool.
From the Applications menu > Canon Utilities >iPFxxxx Media Configuration Tool > MCTxxxx.app.
Media Configuration Tool main window is displayed.
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Note
• If a compatible printer driver is not installed, the Media Configuration Tool will not start. If you attempt to start the

Media Configuration Tool when a printer driver is not installed, the warning message below is displayed.

• If you only start the Media Configuration Tool, the media information on the printer control panel and in the printer
driver is not updated. If this screen is displayed, select Add Genuine Paper in the main window, and click the
Update button in the Edit Media Types screen to update the media information.

Media Configuration Tool Main WindowMedia Configuration Tool Main Window
The explanation below is on the Media Configuration Tool main window.

Note
• For the step to open the Media Configuration Tool main window, see "Starting Method." ➔P.384

• Add Genuine Paper button
When this button is clicked, the Edit Media Types dialog box is displayed, which allows you to add media in-
formation files released by Canon to the printer control panel and printer driver. You can also change names,
toggle between displaying and hiding, and delete added media types.
You can also change the display order of the paper types.
Refer to "Editing Media Type Information for Genuine Paper and Feed Confirmed Paper" ➔P.386  for details
on Add Genuine Paper.

• Link to Support Information button
You can check information such as the latest information for the product and software version upgrade infor-
mation.

• Link to User Manual Button
Displays the printer user's manual

iPF785                                                                                                                                                                  Media Configuration Tool Main Window

User's Guide                                                                                                                                                                                                                     

  

Handling and Use of Paper
M

edia Configuration Tool (M
ac O

S)

385  



Editing Media Type Information for Genuine Paper and Feed Confirmed PaperEditing Media Type Information for Genuine Paper and Feed Confirmed Paper
To add genuine paper and feed confirmed paper to the printer control panel and printer driver and edit the media
type information, click the Add Genuine Paper button in the Media Configuration Tool main window.
Confirm the printer, where media type information is to be updated, to be displayed in Printer in the Select Printer
dialog box, and then click the Next button.

Communication with the printer begins.

Important
• Do not attempt to print or turn the printer off while the program is communicating with the printer.

The Edit Media Types dialog box is displayed.

Note
• In the following screens, you cannot change the printer where media type information is to be updated.

Note
• Paper that is displayed grayed out does not appear in the printer driver or printer panel.

• Add Button
To add genuine paper or feed confirmed paper to the printer control panel and printer driver, click this button.
For details on the procedure for adding media types, see "Adding Media Types." ➔P.387

Important
• To add media types, download the media information file (.amf file) in advance from the Canon website.

• Rename Button
To change the name on the printer control panel and the name in the printer driver for genuine paper and feed
confirmed paper, select the paper to change and click this button.
For details on the procedure for changing paper display names, see "Changing Media Names." ➔P.390
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• Delete Button
To delete added genuine paper and feed confirmed paper from the printer control panel and printer driver, se-
lect the paper to delete and click this button.
For details on the procedure for deleting added media types, see "Deleting Media Types You Have Add-
ed." ➔P.392

• Show/Hide Button
To change whether or not genuine paper or feed confirmed paper is displayed in the printer control panel and
printer driver, select the paper to change and click this button.
For details on the procedure for changing whether or not to display media types, see "Switching Media Types
Display Show/Hide." ➔P.393

•
Change Display Order button (  or )
To change the display order of a media type in the printer control panel and printer driver, select the paper to
change and click this button.
For details on the procedure for changing the display order of media types, see "Changing the Display Order
of Media Types." ➔P.395

Important
• When you update the media type information, perform the same update on all of the PCs that are using that

printer.

Note
• It may not be possible to deleting, showing/hiding, and changing the display order under some conditions.

Adding Media TypesAdding Media Types
Media information files (.amf files) released by Canon are registered in the printer control panel and printer driver.

Important
• Do not perform printing on the target printer while adding the media types.

• Reinstalling Media Configuration Tool after registering a media information file may delete the registered media
information file.In this case, first download and install latest Media Configuration Tool, then download and register
the required media information file.

1
 

Open the Edit Media Types dialog box, and then
click the Add button.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.386
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2
 

The Add Media Type dialog box displays.
Click the Browse button.

3
 

Open the folder that contains the media information
files (.amf files).

4
 

The names of the media information files contained in
the selected folder are displayed in Media Informa-
tion File in the Add Media Type dialog box. Select
the check box for the paper you want to add and click
the OK button.

Note
• If Master Media Information File is displayed as the Type of the Media Information File, the media type

display order and media type display/non-display settings are initialized. Reconfigure these after added
the master media information file.

5 Click OK when the confirmation message is displayed.

 

 

 

Adding Media Types                                                                                                                                                                                              iPF785

                                                                                                                                                                                                                     User's Guide

  

Handling and Use of Paper
M

edia Configuration Tool (M
ac O

S)

 388



6
 

In the Edit Media Types dialog box, click the Update
button.

7
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

8
 

Click the OK button.
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Changing Media NamesChanging Media Names

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.386

2
 

In the Media Type list, select the name to change.
Click the Rename button.

3
 

The Rename Media dialog box is displayed.
Edit the names in Name in Printer Driver and Name
on Control Panel and click the OK button.

Note
• To restore the original names, click the Restore button.

• The characters that can be entered for Name in Printer Driver and Name on Control Panel are stated
below.
alphanumeric, space, "-", ".", "_", "(", ")", "+", "%", ",", "/"

• For Name in Printer Driver up to 32 one Byte characters can be entered, and for Name on Control
Panel up to 16 one Byte characters can be entered.
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4
 

In the Edit Media Types dialog box, click the Update
button.

5
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

6
 

Click the OK button.
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Deleting Media Types You Have AddedDeleting Media Types You Have Added

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.386

2
 

In the Media Type list, select the name of the media
to delete.
Click the Delete button.

Note
• Only paper for which Status in the Media Type is Add can be deleted.

3
 

In the Edit Media Types dialog box, click the Update
button.

 

 

 

Deleting Media Types You Have Added                                                                                                                                                                  iPF785

                                                                                                                                                                                                                     User's Guide

  

Handling and Use of Paper
M

edia Configuration Tool (M
ac O

S)

 392



4
 

The Confirm Update dialog box is displayed.
Click the Execute button.
Communication with the printer begins.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.

Switching Media Types Display Show/HideSwitching Media Types Display Show/Hide

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.386
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2
 

In the Media Type list, select the name of the media
to switch off or on for display.
Click the Show/Hide button.
The selected paper is alternately shown or hidden.

Note
• You can select multiple paper.

• The names of media switched for non-display appear grayed out in the Media Type list.

• Each time you click the Show/Hide button, the display mode cycles from showing both the printer driver
and printer panel, to hiding both the printer driver and printer panel, and then to showing only the printer
panel.

3
 

In the Edit Media Types dialog box, click the Update
button.

4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.
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5
 

Click the OK button.

Changing the Display Order of Media TypesChanging the Display Order of Media Types

1
 

Open the Edit Media Types dialog box.

Note
• For details on the procedure for opening the Edit Media Types dialog box, see "Editing Media Type Infor-

mation for Genuine Paper and Feed Confirmed Paper." ➔P.386

2
 

Select the paper in the Media Type list for which to
change the display order, and then click the buttons

to move the item (  or ).
The selected item moves one line up or down for ev-
ery button click.

3
 

In the Edit Media Types dialog box, click the Update
button.
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4
 

The Confirm Update dialog box is displayed.
Configure Update Target and click the Execute but-
ton.
Communication with the printer begins.

Note
• You should normally select Update the printer control panel and printer driver.

Important
• When setting a data to the printer that differs from the data to be updated, the selected media informa-

tion file is updated. When you would like to remain the data that is set to the printer, click the Cancel
button.

• Do not attempt to print or turn the printer off while the program is communicating with the printer.

5
 

Click the OK button.

Checking the updateChecking the update
After updating the media information using the Media Configuration Tool, you can check whether the update has
been applied to the printer in the control panel of the printer.

1 Click the About button in the Media Configuration Tool main window to open the About dialog box.

2 Check the value xx.xx (xxxx) of MIT DB Version.

3 Check the value xx.xx (xxxx) of MIT in Set./Adj. Menu > Printer Info > System Info in the printer control
panel.
If the values in Steps 2 and 3 are the same, the update has been applied to the printer.
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Control PanelControl Panel

a Display Screen
Shows printer menus, as well as the printer status and messages.

b Data Lamp (green)
• Flashing

During printing, the Data lamp flashes when the printer is receiving or processing print jobs. Otherwise,
this lamp flashes when the print job is paused or the printer is updating the firmware.

• Off
There are no active print jobs when the Data lamp is off.

c Message Lamp (orange)
• On

A warning message is displayed.

• Flashing
An error message is displayed.

• Off
The printer is off or is operating normally.

d Power button (green)
Turns the printer on and off.  (See "Turning the Printer On and Off.") ➔P.17
The Power button is lit when the printer is on or in Sleep mode.

e Stop button
Cancels print jobs in progress and ends the ink drying period.

f Navigate button
Enables you to check instructions for loading and removing paper or replacing ink tanks or printheads, as well
as other operations.  (See "How to View Instructions with Navigate.") ➔P.404

Control Panel                                                                                                                                                                                                         iPF785

                                                                                                                                                                                                                     User's Guide

  

Control Panel
O

perations and Display Screen

 398



g Arrow buttons
• ◀ button

Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▲ button
Press this button in the menu to move to another item.
In menu items requiring numerical input, press this button to increment the number.

• ▶ button
Press this button on the Tab Selection screen to move to another tab.
In menu items requiring numerical input, press this button to move to another digit.

• ▼ button
Press this button in the menu to move to another item.
In menu items requiring numerical input, press this button to decrement the number.

h OK button
Press this button on the Tab Selection screen to display the menu of the tab shown.
Pressing this button in menu items of each tab for which  is displayed at left will move to the lower level of
the menu item, enabling you to execute menu commands or set menu values.
Also press this button if the Display Screen indicates to press the OK button.

i Back button
Displays the screen before the current screen.

j Menu button
Displays the Tab Selection screen.  (See "Menu Settings.") ➔P.416

k Load button
Press this button when loading or replacing paper.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

l Feed button
Pressing this button when rolls are loaded enables you to reposition the paper.  (See "Feeding Roll Paper
Manually.") ➔P.349

m Cut button
Pressing this button when rolls are loaded cuts the paper, if you have specified Automatic or Eject in Cutting
Mode in the Control Panel menu.  (See "Specifying the Cutting Method for Rolls.") ➔P.351

n Cut Sheet lamp (green)
Lit when sheets are selected as the paper source.

o Roll Media lamp (green)
Lit when rolls are selected as the paper source.

Note
• To recover from Sleep mode, any button can be pressed except the Power button.
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Control Panel DisplayControl Panel Display
After the printer starts up, the Tab Selection screen is displayed.
Each of the four tabs presents status, menus, and error information related to the particular tab.

Types of tabs
The Tab Selection screen presents four tabs. Each tab is represented by an icon in the top row. Press the ◀ or ▶
button to access other tabs.

Paper tab A tab indicating status and showing menus related to paper. Pressing the OK button when this tab is
highlighted will display the Paper Menu.

• Top line displayed
The paper icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
The first and second lines display the paper type and size.

Ink tab A tab indicating status and showing menus related to ink. Pressing the OK button when this tab is
highlighted will display the Ink Menu.

• Top line displayed
The ink icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
Here, the remaining ink level is indicated.  (See "Checking Ink Tank Levels.") ➔P.541

Job tab A tab indicating status and showing menus related to print jobs. Pressing the OK button when this tab
is highlighted will display the Job Menu menu.

• Top line displayed
The job icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

Settings/Adj. tab A tab indicating status and showing menus related to settings and adjustment. Pressing the OK but-
ton when this tab is highlighted will display the Set./Adj. Menu.

• Top line displayed
The settings/adjustment icon is highlighted.

• Middle line displayed
Indicates the printer status and shows menu names.

• Bottom line displayed
The remaining Maintenance Cartridge capacity is shown on the first line and Tot.Print Area on the
second. The display unit for Tot.Print Area can be specified in the Length Unit menu.  (See
"Menu Settings.") ➔P.416
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Printer status and modes
The printer has the following status.

Standby The printer is ready to receive jobs sent from the computer. Jobs sent from the computer are printed
immediately.

Printing Paused Printing is paused on the printer. Any jobs sent from the computer are held without being printed.

Printing Printing is in progress on the printer. Jobs sent from the computer are printed after the current job.
The time left until printing is finished is indicated in the upper-right corner of the screen. (Values ex-
ceeding 10 hours are not shown.)

Sleep The printer is in power-saving mode. The printer automatically enters Sleep mode to conserve power
when idle for a specific period (by default, five minutes), that is, if no print jobs are received or buttons
are pressed while all covers are closed.
You can specify the period before the printer enters Sleep mode in the Sleep Timer menu.  (See
"Menu Settings.") ➔P.416
After entering Sleep mode from Standby mode, the printer automatically recovers if print jobs are re-
ceived, and the jobs are printed.

Off The printer is not on.
If no operations are performed on the printer for the duration of the time set in Shut Down Timer after
entering Sleep mode, the printer automatically turns off.  (See "Menu Settings.") ➔P.416

Error The printer requires your attention. Any jobs sent from the computer cannot be processed. The tab
related to the error is displayed.
For information about the display in the case of multiple errors, see "Display Transitions in Error Sta-
tus."
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Display Transitions in Normal Status
The display transitions while the printer is in the normal status (the status where no errors have occurred) are
shown below.

*1: The printer automatically enters Sleep mode when idle for a specific period (by default, five minutes), that is, if
no print jobs are received or buttons are pressed while all covers are closed. However, it does not enter Sleep
mode while error messages are displayed or when a roll can be manually advanced by pressing the Feed but-
ton.

*2: When the printer is in Sleep mode, you can press any button except the Power button to recover from Sleep
mode. Sleep mode is also terminated if a print job is received or a command is issued from RemoteUI.
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Display Transitions in Error Status
The display transitions while an error has occurred on the printer are shown below.
If multiple errors have occurred, the tabs for errors that have occurred other than the currently displayed error are
displayed flashing. You can move between the tabs to check the errors by pressing the ◀ and ▶ keys. If multiple
errors have occurred in the Job tab and Settings/Adj. tab, the error message switches every four seconds within
each tab.
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How to View Instructions with NavigateHow to View Instructions with Navigate
You can refer to instructions for loading paper, replacing ink tanks, and performing other operations on the printer
control panel.

1 Press the Navigate button.

2 Press ▲ or ▼ to select the desired navigation menu.

3 Press ▲ or ▼ to select View Op. Guide, and then press the OK button.
Instructions are now displayed.

  Example: Loading sheets

OKbutton

OKbutton

Navigate button

No Paper Loaded

Load the paper.

Load Roll Paper

Eject Paper
Roll Paper Feeding
Roll Paper Cutting

Load Cut Sheet

View Op. Guide

Back

Load Cut Sheet

Execute

display Menu screen.
Press Menu and

the paper menu, then
press OK.

Press to show

right guide with
print side up.

Align cut sheets to

then press OK.
Select Load Paper,

loading paper.
Press OK to start

select Cut Sheet
and press OK.

Press ,then

Input media type.

Can print when done
loading paper.

match paper width
and fully insert

Set width guide to

when fully inserted.
The buzzer sounds

OK: Paper Menu
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Checking Instructions During Printer OperationsChecking Instructions During Printer Operations
You can refer to instructions on the printer control panel when loading paper, replacing ink tanks, or performing oth-
er operations.

How to view instructions
Once you complete an action described in the instructions, the printer detects the action and switches to the next
instruction screen.
 

In the case of actions the printer cannot detect, instruction screens are switched every four seconds, and the se-
quence of operations is shown repeatedly.
When all actions in the sequence are finished, the instruction screen for the next step is displayed.

  Example: Ink tank replacement

Note
• During a continuous display of instructions, you can press the ◀ button to pause the instructions on the current

screen.
Press the ◀ or ▶ button to display the previous or next screens. If you do not press the ◀ or ▶ button within 30
seconds, continuous display is resumed.
Press the OK button to display the instruction screen for the next step.
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Printer MenuPrinter Menu
Printer Menu Operations .................................................................................................................................406

Menu Operations ............................................................................................................................................ 407
Menu Structure .............................................................................................................................................. 410
Menu Settings ................................................................................................................................................ 416

Status Print .................................................................................................................................................... 426
Printing Interface Setting Reports ................................................................................................................... 429

Printer Menu OperationsPrinter Menu Operations
The printer menu is classified into regular menu items available when no print job is in progress and menu during
printing items only available while printing is in progress.

• Regular menu operations ➔P.406
• Menu operations during printing ➔P.406

Regular menu operations
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK button.

Note
• If the Tab Selection screen is not displayed, pressing OK will not display menus.

Menus can be selected after you resolve the problem.

The following operations are available from the menu.

• Paper Menu
Paper menu settings

• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
Menu operations for printer adjustment and maintenance

For a description of specific menu items available, see "Menu Settings." ➔P.416
For instructions on selecting menu items, see "Menu Operations." ➔P.407

Note
• By default, menu settings apply to all print jobs. However, for settings that are also available in the printer driver,

the values specified in the printer driver take priority.

Menu operations during printing
During printing, only a limited set of menu items are displayed. Menu items that are not displayed during printing
should be operated after printing has finished.
To display menus during printing, select a tab on the Tab Selection screen on the Control Panel, and then press
the OK button.

Note
• If the Tab Selection screen is not displayed, pressing OK will not display menus.

Menus can be selected after you resolve the problem.

The following operations are available from the menu during printing.

• Ink Menu
Ink menu operations

• Job Menu
Menu operations to manage print jobs

• Set./Adj. Menu
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Fine-tuning paper feeding
Display of printer-related information

For a description of specific menu items available, see "Menu Settings." ➔P.416
For instructions on selecting menu items during printing, see "Menu Operations." ➔P.407

Menu OperationsMenu Operations
To view available menus organized on tabs, select a tab on the Tab Selection screen and press the OK button.
For details, see "Menu Settings." ➔P.416

• When the Ink tab is selected and the OK button is pressed

Note
• If the Tab Selection screen is not displayed, pressing OK will not display menus.

Menus can be selected after you resolve the problem.

Simply press buttons on the Control Panel to access menus on various tabs from the Tab Selection screen and
set or execute Menu items.
The following section describes menu operations and how they are presented in this User Manual.

• Accessing menus ➔P.407
• Specifying menu items ➔P.408
• Specifying numerical values ➔P.408
• Executing menu commands ➔P.409

Accessing menus
Printer menus are grouped by function.
Menus are displayed with the upper line selected. You can use the buttons on the Control Panel to access each
menu.

• Press Back button to access a higher menu in the menu list, and press OK button to access a lower one.
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• Press ▲ to access a higher menu in the menu list, and press ▼ to access a lower one. If items of the menu
list are more than the lines of the screen, press ▲ and ▼ to scroll the menu. Items you select are highlighted.
The scroll bar at right indicates the current position in the overall menu.

• Lower menus are available if  is displayed at left next to the second and subsequent rows. To access the
lower menus, select the menu and press the OK button.

Specifying menu items
Menu items can be set as follows.

1
 

Press ▲ or ▼ to select the desired setting, and then press the OK
button.
After two seconds, the display reverts to the upper level menu.

Note
• If a confirmation message is displayed regarding the setting you entered, follow the on-screen instruc-

tions.

• If you have changed the Interface Setup menu settings, a message confirming whether to register the
settings is displayed if you press Back button or Menu button. Follow the instructions shown on the
screen.

Specifying numerical values
Follow these steps to enter numbers. In this example, network settings items are entered.

1
 

Press the ◀ or ▶ button to move to the next field for input.

 

 

Menu Operations                                                                                                                                                                                                   iPF785

                                                                                                                                                                                                                     User's Guide

  

Control Panel
Printer M

enu

 408



2 Press the ▲ or ▼ button to enter the value.

Note
• Hold down ▲ or ▼ to increase or decrease the value continuously.

3 Repeat steps 1 and 2 to complete the settings, and then press the OK button.

Note
• If a confirmation message is displayed regarding the setting you entered, follow the on-screen instruc-

tions.

• If you have changed the Interface Setup menu settings, a message confirming whether to register the
settings is displayed if you press Back button or Menu button. Follow the instructions shown on the
screen.

Executing menu commands
Menu commands can be executed as follows.

1 Press ▲ or ▼ to select the action to execute, and then press the OK button.
The menu command is now executed.
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Menu StructureMenu Structure
The menu structure is shown categorized by tab. The * on the right side of an item indicates the default value.
The printer menu is classified into regular menu items available when no print job is in progress and menu during
printing items only available while printing is in progress. see "Printer Menu Operations." ➔P.406

Regular menu Menu during printing

Paper Menu Not displayed

Ink Menu The same Ink Menu as normal is displayed.

Job Menu The same Job Menu as normal is displayed.

Set./Adj. Menu A limited Set./Adj. Menu containing the following items is displayed.

• Adj. Fine Feed(*1)
• Printer Info

  *1: Only displayed in the menu during printing. Not displayed in the regular menu.

For instructions on menu operations, see "Menu Operations." ➔P.407
For details on menu items, see "Menu Settings." ➔P.416

Paper Menu
The Paper Menu is not displayed during printing.

 First Level  Second Level  Third Level  Fourth Level  Fifth Level

Load Paper Roll Paper | Cut Sheet
Eject Paper
Chg. Paper Type(*1) Roll Paper (The paper type is displayed here.) (*1)

  Cut Sheet (The paper type is displayed here.) (*1)
Chg. Paper Size Sheet Size (The size of paper is displayed here.) (*2)

    CustomPaperSize (Set the length and width)
  Roll Length(*3) (Set the length)
  Roll Width(*4) (Set the width)

ManageRemainRoll Off* | On
Paper Details (The paper type is dis-

played here.) (*1)
Head Height Automatic* | Highest | High | Standard | Low |

Lowest | Super Low
   Skew Check Lv. High Accuracy | Standard* | Loose | Off
   Cutting Mode(*6) Automatic | Eject | Manual
   Cut Speed Fast | Standard | Slow
   Trim Edge First Automatic | Off | On (Preset Len) | On(Input

Length) | Manual
   CutDustReduct. Off | On
   VacuumStrngth Automatic* | Strongest | Strong | Standard | Weak

| Weakest
   Scan Wait Time Dry time Off* | 1 sec. | 3 sec. |

5 sec. | 7 sec. | 9 sec.
     Area(*5) Entire area* | Leading

edge
   Roll DryingTime Off | 30 sec. | 1 min. | 3 min. | 5 min. | 10 min. | 30

min. | 60 min.
   NearEnd RollMrgn 3mm | 20mm
   NearEnd Sht Mrgn 3mm | 20mm
   BordlessOversize Standard* | Little
   Width Detection Off | On*
   Return Defaults

Paper Details
Keep Paper Type Off* | On
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  *1: For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Displaying the Paper
Reference Guide.") ➔P.331  Types of paper in the printer driver and related software (as well as on the Control Panel ) are
updated when you install the printer driver from the User Software CD-ROM or if you update paper information with the Me-
dia Configuration Tool.  (See "Updating paper information.") ➔P.334

  *2: For information on the sizes of paper the printer supports, see "Paper Sizes." ➔P.328
  *3: Available only if ManageRemainRoll is On.
  *4: Available only if Width Detection is Off.
  *5: Leading edge is not available as a setting option in the Paper Detailed Settings dialog box of the printer driver.
  *6: see "Specifying the Cutting Method for Rolls." ➔P.351

Ink Menu

 First Level

Rep. Ink Tank
Head Cleaning A

Job Menu

 First Level  Second Level  Third Level  Fourth Level  Fifth Level

Print Job Job List (Choose a print job.) Delete | Preempt Jobs(*1)
Stored Job Mailbox List (Enter a password if

one has been set.)
Job List Print | Delete

    Print Job List
Job Log(*2) (Choose from information

about the latest three print
jobs.)

Document Name
   User Name
   Page Count
   Job Status OK | CANCELED
   Print Start Time yyyy/mm/dd hh:mm:ss
   Print End Time yyyy/mm/dd hh:mm:ss
   Print Time xxxsec.
   Print Size xxxxxxxxsq.mm
   Media Type
   Interface USB | Network | HDD
   Ink Consumed Tot.Ink Consumed xxx.xxx ml
     (The ink color is dis-

played here.)
xxx.xxx ml

   Print settings
   Head Height
   Temp./Humidity
   Adjustment req.

Print Job Log
Pause Print Off* | On
HDD Information Total capacity | Box free space

  *1: If a pending job is selected, Print Anyway is displayed.
  *2: Restrictions apply if a password is configured using Change Password in the Admin. Menu.
        Viewing is possible for administrators only.

Set./Adj. Menu
Limited items are displayed during printing. The displayed items are indicated by annotations.

 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level  Eighth Level

Test Print Nozzle Check | Status Print | Interface Print | GL2 Set Print | Paper Details | Print Job Log | Menu Map | Color
Palette

Adjust
Printer

Head Posi.
Adj.

Auto(Standard) | Auto(Advanced) | Manual(*1)

  Head Inc. Adj.
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level  Eighth Level
  Feed Priori-

ty
Adj. Priority Automatic* | Print Quality | Print Length

   Adj. Quali-
ty(*2)

Auto(GenuinePpr) | Auto(OtherPaper) | Manual

   Adjust
Length(*3)

Adjust-
mentPrint

A:High | B:Standard/Draft

    Change
Settings

A:High | B:Standard/Draft

Mainte-
nance

Head
Cleaning

Head Cleaning A | Head Cleaning B

  Nozzle
Check

  Replace P.head
  Repl. maint cart
  Head Info

GL2 Set-
tings

Quality
Manager

Color Mode Monochrome | Color (CAD) 1* | Color (CAD) 2 | Color (CAD) 3 | Color (CAD) 4 |
Color (CAD) 5

    Print Quali-
ty

Fast | Standard* | High

    Input Reso-
lution

600dpi* |
300dpi

    Print (Econ-
omy)

Off* | On

  Paper Man-
ager

Paper
Source

Automatic* | Roll Paper | Cut Sheet

    Margin 3mm(Standard)* |
5mm

    Oversize Off | On*
    Conserve

Paper
Off* | On

    Auto Rotate Off* | On
    Enlarge/

Reduce
Off* | Specify scaling | Fit to paper

    Print cen-
tered

Off* | On

    Standard
cut

Off* | On

    Nesting Use Nest-
ing

Off* | On

     Nesting
Wait-
Time(*4)

xx min.

     Cut
Lines(*4)

Off* | On

  Line & Pen
Manager

Enable
merge

Off* | On

    Pen Setup Select Pa-
lette

Software* | Palette A | Palette B | Factory

      Define Pa-
lette

Palette A (Select the
pen number)

Width (Indicates
the value of
Width )

           Color 0～255
           Line Attrib-

utes
No Setting |
Circle Set-
ting
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level  Eighth Level
        Palette B (Select the

pen number)
(Indicates
Width, Color,
and Line At-
tributes )

(Specify the
values of
Width, Color,
and Line At-
tributes )

        Factory (Select the
pen number)

(Indicates Width, Color, and
Line Attributes )

      Reset Pa-
lette

All Palette | Palette A | Palette B

    Smoothing Software* | Smooth
    ThickenFi-

neLines
Off* | On

    Adjust-
FaintLines

Off | On*

    Ln wdth
correct

Black/gray | Color

  Processin-
gOption

Warning Off* | On
    On-the-Fly Off* | On
    Detect img

size
Off* | Command priority | Detected size

  GL2 Set Print
Interface
Setup(*8)

EOP Tim-
er(*8)

10 sec. | 30 sec. | 1 min. | 2 min. | 5 min. | 10 min.* | 30 min. | 60 min.

  TCP/IP(*8) IPv4(*8) IPv4
Mode(*8)

Automatic | Manual*

      Protocol(*5)
(*8)

DHCP(*8) On | Off*
        BOOTP(*8) On | Off*
        RARP(*8) On | Off*
      IPv4 Set-

tings(*9)
IP Ad-
dress(*9)

xxx.xxx.xxx.xx
x

        Subnet
Mask(*9)

xxx.xxx.xxx.xx
x

        Default G/
W(*9)

xxx.xxx.xxx.xx
x

      DNS Set-
tings(*9)

DNS Dync
update(*9)

On | Off*

       Pri. DNS SrvAddr(*9)
       Sec. DNS SrvAddr(*9)
       DNS Host Name(*9)
       DNS Domain Name(*9)
    IPv6(*8) IPv6 Sup-

port(*8)
On | Off*

     IPv6 Stles-
sAddrs(*8)
(*10)

On* | Off

     DHCPv6(*8
)(*10)

On | Off*

     DNS Set-
tings(*9)
(*10)

DNS Dync
update(*9)

Statefull
Addr(*9)

On | Off*

        Stateless
Addr(*9)

On | Off*

      Pri. DNS SrvAddr(*9)
      Sec. DNS SrvAddr(*9)
      DNS Host Name(*9)
      DNS Domain Name(*9)
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level  Eighth Level
  Ethernet

Driver(*8)
Auto De-
tect(*8)

On* | Off

    Comm.Mod
e(*6)(*8)

Half Duplex* | Full Duplex

    Ethernet
Type(*6)(*8)

10 Base-T* | 100 Base-TX | 1000 Base-T

    Spanning
Tree(*8)

Not Use* | Use

    MAC Ad-
dress(*8)

xxxxxxxxxx
xx

  Interface Print(*8)
  Return Defaults(*8)

System
Setup

Sleep Tim-
er(*11)

5 min.* | 10 min. | 15 min. | 20 min. | 30 min. | 40 min. | 50 min. | 60 min. | 210 min.

  Shut Down
Timer

Off | 5 min. | 10 min. | 30 min. | 1 hour | 4 hours | 8 hours* | 12 hours

  Buzzer Off | On*
  Contrast

Adj.
-4,-3,-2,-1,0*,+1,+2,+3,+4

  Date &
Time(*8)

Date
 

yyyy/mm/d
d(*7)(*8)

Time
 

hh:mm

  Date For-
mat(*8)

yyyy/mm/dd* | dd/mm/yyyy | mm/dd/yyyy

  Language English | 日本語 | Français | Italiano | Deutsch | Español | Português | Русский | 中文（简体字） | 한
국어

  Time
Zone(*8)

0:London (GMT) | +1:Paris,Rome | +2:Athens,Cairo | +3:Moscow | +4:Eerevan,Baku | +5:Islama-
bad | +6:Dacca | +7:Bangkok | +8:Hong Kong | +9:Tokyo,Seoul | +10:Canberra | +11:NewCaledo-
nia | +12:Wellington | -12:Eniwetok | -11:Midway is. | -10:Hawaii(AHST) | -9:Alaska(AKST) | -8:Or-
egon (PST) | -7:Arizona(MST) | -6:Texas (CST) | -5:NewYork(EST) | -4:Santiago | -3:Buenos Aires
| -2: | -1:Cape Verde

  Length Unit meter* | feet/inch
  Detect Mis-

match
Pause | Warning | None* | Hold Job

  Paper Size
Basis

Roll Selec-
tion 1

ISO A3 (297mm)* | 300mm Roll

    Roll Selec-
tion 2

10in. (254mm)* | JIS B4 (257mm)

  Keep Paper
Size

Off* | On

  TrimEdge
Reload

Automatic | Off* | On

  Rep.P.head
Print

Off | On*

  Nozzle
Check

Frequency Standard* | 1 page | 10 pages | Off
    Warning Off* | On
  Use

USB(*8)
On* | Off

  Use Ether-
net(*8)

On* | Off

  Use Remo-
teUI(*8)

On* | Off

  Reset PaprSetngs(*8)
  Erase HDD

Data
High Speed(*8) | Secure High Spd.(*8) | Secure(*8)
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 First Level  Second Level  Third Level  Fourth Level  Fifth Level  Sixth Level  Seventh Level  Eighth Level
  Output

Method
Print* | Print (Auto Del) | Save: Box XX

  Print After
Recv

Off* | On

  Save: Com-
mon Box

Off | On*

  Show Job
Log(*8)

Off | On*

Prep.Move-
Printer

Standard | Limited

Admin.
Menu(*8)

Change
Pass-
word(*9)

(The screen for setting the password is displayed)

  Init.Admin.Pswd(*9)
Adj. Fine Feed(*12)(*13)
Printer In-
fo(*12)

Paper Info
 Ink Info
 Head Info
 System Info
 Error Log
 Use Situa-

tion
Tot.Print Area | Duty Counter

  *1: Available after you have used Auto(Advanced) in Head Posi. Adj. once.
  *2: Available if Adj. Priority is Automatic or Print Quality.
  *3: Available if Adj. Priority is Automatic or Print Length.
  *4: Available only if Use Nesting is On.
  *5: Not displayed if IPv4 Mode is Manual.
  *6: Not displayed if Auto Detect is On.
  *7: Follows the setting in Date Format.
  *8: Restrictions apply if a password is configured using Change Password in the Admin. Menu.
        Viewing and configuration is possible for administrators, and only viewing for other users.
  *9: Restrictions apply if a password is configured using Change Password in the Admin. Menu.
        Viewing and configuration is possible for administrators only.
*10: Not displayed if IPv6 Support is Off.
*11: Default setting for the time to enter the power save mode/Sleep mode is recommended.
*12: Displayed as the menu during printing while printing is in progress.
*13: Not displayed in the regular menu.
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Menu SettingsMenu Settings
Menu items are as follows.
The printer menu is classified into regular menu items available when no print job is in progress and menu during
printing items only available while printing is in progress. see "Printer Menu Operations." ➔P.406

Regular menu Menu during printing
Paper Menu Not displayed

Ink Menu The same Ink Menu as normal is displayed.

Job Menu The same Job Menu as normal is displayed.

Set./Adj. Menu A limited Set./Adj. Menu containing the following items is displayed.

• Adj. Fine Feed (*1)
• Printer Info

  *1: Only displayed in the menu during printing. Not displayed in the regular menu.

For instructions on selecting menu items, see "Menu Operations." ➔P.407
For details on the displayed menu hierarchy, see "Menu Structure." ➔P.410

Paper Menu
The Paper Menu is not displayed during printing.

Setting Item Description, Instructions
Load Paper Select either sheets or rolls and load the paper.

Eject Paper Choose this item before removing loaded paper.

Chg. Paper Type (*1) Change the type of paper loaded.  (See "Changing the Type of
Paper.") ➔P.343

Chg. Paper Size Change the size of paper loaded.  (See "Specifying the Paper
Length.") ➔P.345  (See "Paper Sizes.") ➔P.328

ManageRemainRoll Choose On to print a barcode at the end of a roll before you re-
move it. The printed barcode can be used in managing the
amount of roll paper left. Choose Off if you prefer not to print the
barcode.
 (See "Keeping Track of the Amount of Roll Paper Left.") ➔P.349

Paper Details (The type of pa-
per is displayed
here.)(*1)

Head Height Adjust the Printhead height.  (See "Troubleshooting Paper Abra-
sion and Blurry Images.") ➔P.525

Skew Check Lv. If you print on Japanese paper (washi) or other handmade paper
that has an irregular width, choose Loose for a higher skew de-
tection threshold, or choose Off to disable skew detection. How-
ever, if paper is loaded askew when detection is Off, note that pa-
per jams or Platen soiling may occur.

Cutting Mode Specify whether or not to cut with the standard round-bladed cut-
ter.
If you choose Automatic, the roll will be cut automatically using
the Cutter Unit, depending on the printer driver settings.
Select Eject to prevent printed documents from falling immediate-
ly after printing such as when you wait for the ink to dry, etc. Man-
ual prints lines at the cut position instead of cutting after printing.
 (See "Specifying the Cutting Method for Rolls.") ➔P.351

Cut Speed Choose the cutting speed. The preset selection represents the op-
timal cutting speed for the type of paper. We recommend keeping
the preset cutting speed.
If you use adhesive paper, choosing Slow helps prevent adhesive
from sticking to the cutter and keeps the cutter sharp.

Trim Edge First Selects whether or not to automatically cut the leading edge of the
roll paper when roll paper is loaded.
 (See "Cutting the Leading Edge of Roll Paper Automatical-
ly.") ➔P.355

Menu Settings                                                                                                                                                                                                       iPF785

                                                                                                                                                                                                                     User's Guide

  

Control Panel
Printer M

enu

 416



Setting Item Description, Instructions
Paper Details (The type of pa-

per is displayed
here.)(*1)

CutDustReduct. If you choose On, a line will be printed at the cut position when
paper cutting is selected. This option reduces the amount of deb-
ris given off after cutting. It also helps prevent adhesive from stick-
ing to the cutter and keeps the cutter sharp if you use adhesive
paper.  (See "Reducing Dust from Cutting Rolls.") ➔P.356

VacuumStrngth Specify the level of suction that holds paper against the Platen.
 (See "Adjusting the Vacuum Strength.") ➔P.533

Scan Wait Time Specify the time to wait for the ink to dry between each scan (after
the printhead finishes moving in one direction), in consideration of
how quickly the ink dries. Also specify the applicable area for the
ink drying time. Select Entire area to apply the ink drying time af-
ter each scan until the document is fully printed. Select Leading
edge to apply the ink drying time after each scan only in the area
110–140 mm from the leading edge. (The applicable length varies
depending on the Print Quality setting.) Note that printing will
take longer if you specify the Scan Wait Time setting. In particu-
lar, when Leading edge is selected, colors may be uneven in the
boundary between the areas with and without a drying time.

Roll DryingTime Specify the time to wait for the ink to dry for each sheet.

NearEnd
RollMrgn

Specify the minimum margin at the leading edge of roll paper to
ensure better printing quality at the leading edge.
Note that if you choose 3mm, it may lower the printing quality at
the leading edge and affect feeding accuracy. The printed surface
may be scratched, and ink may adhere to the leading edge. It may
also cause the Platen to become soiled.

NearEnd Sht
Mrgn

Specify a margin at the leading edge of sheets to ensure better
printing quality at the leading edge.
Note that if you choose 3mm, it may lower the printing quality at
the leading edge and affect feeding accuracy. The printed surface
may be scratched, and ink may adhere to the leading edge.

BordlessOver-
size

Select the amount of oversize extension of the original during bor-
derless printing.
Normally, we recommend that you set this to Standard.
If it is set to Little, although it will reduce soiling on the back sur-
face, white patches may remain on the printed surface.

Width Detection Specify this option to print inside boundaries or in other cases
when specifying a particular starting position for printing.
Paper width and skew are not detected if you select Off. If paper
is loaded askew, paper jams or Platen soiling may occur.

Return Defaults Choose OK to restore Paper Details to the default values.

Paper Details Print the paper settings as specified in Paper Details.

Keep Paper Type Select On when printing on a particular type of paper regularly.
 (See "Changing the Type of Paper.") ➔P.343

  *1: For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Displaying the Paper
Reference Guide.") ➔P.331  Types of paper in the printer driver and related software (as well as on the Control Panel ) are
updated when you install the printer driver from the User Software CD-ROM or if you update paper information with the Me-
dia Configuration Tool.  (See "Updating paper information.") ➔P.334

Ink Menu
Setting Item Description, Instructions

Rep. Ink Tank Replace the Ink Tank at this point. Follow the instructions dis-
played to complete the required procedure.  (See "Replacing
Ink Tanks.") ➔P.536

Head Cleaning A Printhead cleaning options.  (See "Cleaning the Print-
head.") ➔P.545
Execute Head Cleaning A if printing is faint, oddly colored, or
contains foreign substances.
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Job Menu
Setting Item Description, Instructions

Print Job Job List (Choose a
print job)

Delete Delete the current job or queued jobs.  (See "Managing the Job
Queue (Deleting or Preempting Other Jobs).") ➔P.486

Preempt Jobs Print the job first after the current print job is finished.  (See
"Managing the Job Queue (Deleting or Preempting Other
Jobs).") ➔P.486

Stored
Job

Mailbox
List

(Enter a
password
if one has
been set.)

Job List Print Print the saved job.

Delete Delete the saved job.

Print Job List Print a list of saved print jobs.

Job Log (Choose
from infor-
mation
about the
last three
print
jobs.)

Document Name Indicates the document name of the selected print job.

User Name Indicates the name of the user who sent the print job.

Page Count Indicates the number of pages in the job.

Job Status Indicates the printing results.

Print Start Time Indicates when the print job was started.

Print End Time Indicates when the print job was finished.

Print Time Indicates the time required to print the job.

Print Size Indicates the paper size in the print job.

Media Type Indicates the type of paper in the print job.

Interface Indicates the interface used for the print job.

Ink Consumed Indicates a rough estimate of how much ink was consumed per
job.(*1)

Print settings A counter for maintenance purposes. Indicates job print set-
tings.

Head Height A counter for maintenance purposes. Indicates the head height
when jobs wereprinted.

Temp./Humidity A counter for maintenance purposes. Indicates the temperature
and humiditywhen jobs were printed.

Adjustment req. A counter for maintenance purposes. Indicates adjustment con-
ditions appliedto jobs.

Print Job Log Print a record of print jobs, including the paper type and size,
amount of ink consumed, and so on. Ink consumption indicates
a rough estimate of the amount of ink consumed per print job.
(*1)

Pause Print Choose On to stop printing.

HDD Information Indicates the total hard disk capacity and the mail box free
space.

  *1: A rough estimate of the amount of ink consumed per print job is displayed. Actual ink consumption may be different. The
average margin of error for estimates calculated according to Canon measurement conditions for ink costs is ±15%. Canon
does not guarantee the accuracy of these estimates. Estimates may vary depending on conditions of use. Calculation of
these estimates does not include ink consumed when cleaning printheads by forceful ejection of ink.

Set./Adj. Menu
Limited items are displayed during printing. The displayed items are indicated by annotations.

Setting Item Description, Instructions
Test
Print

Nozzle Check Print a test pattern to check the nozzles.

Status Print Print information about the setting values and condition of
the printer.

Interface Print Print interface settings information.

GL2 Set Print Print the settings as specified in GL2 Settings.

Paper Details Print the paper settings as specified in Paper Details.
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Setting Item Description, Instructions
Test
Print

Print Job Log Print a record of print jobs, including the paper type and
size, amount of ink consumed, and so on. Ink consump-
tion indicates a rough estimate of the amount of ink con-
sumed per print job.(*1)

Menu Map Print the menu structure.

Color Palette Print the GL2 color palette.

Adjust
Printer

Head
Posi.
Adj.

Auto(Standard) The printer prints and reads a test pattern for automatic
adjustment of Printhead alignment relative to the printing
direction.  (See "Automatic Adjustment to Straighten
Lines and Colors.") ➔P.520

Auto(Advanced) The printer prints and reads a test pattern for automatic
adjustment of Printhead alignment relative to the printing
direction and spacing between nozzles and colors.  (See
"Automatic Adjustment to Straighten Lines and Col-
ors.") ➔P.520

Manual Print a test pattern for adjustment of Printhead alignment
relative to the printing direction. Enter the adjustment val-
ue manually based on the resulting pattern.  (See "Manual
Adjustment to Straighten Lines and Colors.") ➔P.521

Head Inc. Adj. Print a test pattern for adjustment of the Printhead orienta-
tion.  (See "Adjusting Line Misalignment.") ➔P.523

Feed
Priority

Adj. Pri-
ority

Automatic Specify exact paper feeding, if desired. Normally, select
Automatic. Choose Print Quality for attractive printing.
Choosing Print Quality also makes banding less noticea-
ble. Choose Print Length if you prefer to feed the paper
an exact amount.

Print Quality
Print Length

Adj.
Quality

Auto(GenuinePpr) Specify this mode with paper identified in the Paper Ref-
erence Guide. (See "Displaying the Paper Reference
Guide.") ➔P.331
The printer prints and reads a test pattern for automatic
adjustment of the feed amount.  (See "Automatic Banding
Adjustment.") ➔P.528

Auto(OtherPaper) Specify this mode with paper not in the Paper Reference
Guide. (See "Displaying the Paper Reference
Guide.") ➔P.331
The printer prints and reads a test pattern for automatic
adjustment of the feed amount. Note that this function
takes more time and consumes more ink than Auto(Gen-
uinePpr).  (See "Automatic Banding Adjust-
ment.") ➔P.528

Manual Use this mode with highly transparent media or other pa-
per for which Auto(GenuinePpr) or Auto(OtherPaper)
cannot be used.
Print a test pattern for adjustment of the feed amount
based on the type of paper.  (See "Manual Banding Ad-
justment.") ➔P.529

Adjust
Length

Adjust-
ment-
Print

A:High Print a test pattern for particular types of paper to com-
pensate for paper stretching or shrinkage, after which you
enter the amount of adjustment.  (See "Adjusting Line
Length.") ➔P.531

B:Standard/Draft

Change
Settings

A:High Displayed when you have selected Feed Priority > Adj.
Priority > Print Length.
Adjustment relative to the amount of stretching or shrink-
age of the current paper.
Enter either the adjustment results from AdjustmentPrint
or the discrepancy that you measured (as a percentage).

B:Standard/Draft
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Setting Item Description, Instructions
Adjust
Printer

Feed
Priority

Adjust
Length

Change
Settings

B:Standard/Draft For paper that tends to stretch, increase the feed amount
by choosing a higher adjustment value. For paper that
tends to shrink, decrease the feed amount by choosing a
lower adjustment value. (See "Adjusting Line
Length.") ➔P.531

Mainte-
nance

Head Cleaning Clean the Printhead.  (See "Cleaning the Print-
head.") ➔P.545
Choose Head Cleaning A if printing is faint, oddly col-
ored, or contains foreign substances.
Choose Head Cleaning B if no ink is printed at all, or if
printing is not improved by Head Cleaning A.

Nozzle Check Print a test pattern to check the nozzles.

Replace P.head Execute when replacing the Printhead. Follow the instruc-
tions displayed to complete the required procedure.  (See
"Replacing the Printhead.") ➔P.546
Not displayed during a warning message that the remain-
ing Maintenance Cartridge capacity is low.

Repl. maint cart Execute when replacing the Maintenance Cartridge. Fol-
low the instructions displayed to complete the required
procedure.  (See "Replacing the Maintenance Car-
tridge.") ➔P.552

Head Info Indicates information about the printhead.

GL2
Settings

Quality
Manag-
er

Color
Mode

Monochrome Print in monochrome.

Color (CAD) 1 Print in standard colors.

Color (CAD) 2 Print with approximate colors emulating Canon iPF750,
iPF755, iPF650, iPF655, iPF760, iPF765.(*2)

Color (CAD) 3 Print with approximate colors emulating Canon iPF500,
iPF600, iPF700, iPF510, iPF610, iPF710, iPF605, iPF720,
iPF810, iPF820, iPF815, iPF825.(*2)

Color (CAD) 4 Print emulating the HP Designjet 500/800, in colors re-
sembling colors produced by these printers.(*2)

Color (CAD) 5 Print emulating the HP Designjet T1100, in colors resem-
bling colors produced by this printer.(*2)

Print Quality Choose the print quality.

Input Resolution Choose the printer input resolution, 600dpi or 300dpi.
Print (Economy) When On is selected, print using less ink.

However, the quality is lower than regular printing.
Select On to conserve ink such as the layout confirmation.
Note that although Print (Economy) is only available
when Fast is selected in Print Quality, it might not be
available depending on the paper type.

Paper
Manag-
er

Paper Source Choose the source of paper for HP-GL/2 printing.

Margin Specify the margin around paper. The margin for the trail-
ing edge of sheets is 23 mm (0.9 in).
However, if you have specified the leading margin in Pa-
per Details, the larger of the setting values has priority.

Oversize Set the position of the margin relative to the image range.
Choose Off to set the margin inside the image range.
The image may be missing depending on the layout.
Choose On to set the margin outside the image range.
Although the image will not be missing, you should print
on paper larger than the size of the image range plus the
margins.

Conserve Paper Conserves paper when printing.
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Setting Item Description, Instructions
GL2
Settings

Paper
Manag-
er

Auto Rotate If the long side of an original is shorter than the roll width,
the original is automatically rotated 90 degrees to con-
serve paper. Similarly, if the long side of an original in
landscape orientation is longer than the roll width and the
short side is shorter than the roll width, the original is re-
positioned to fit on the paper.
HP RTL print jobs are not rotated. Because HP RTL im-
ages are not rotated even if the paper is rotated 90 de-
grees, images may be cut off or the blank paper may be
ejected. In this case, set Auto Rotate to Off.

Enlarge/Reduce Enlarge or reduce the image.
Choose Specify scaling to print based on the specified
scaling value.
The specified range is 25 to 400 %.
Choose Fit to paper to print by resizing to fit the paper
loaded in the printer.
If Standard cut is On, the printing is resized to fit the
standard paper size.

Print centered Print in the center of the paper.

Standard cut Automatically selects the best standard paper size from
the width of the loaded roll paper and the image size and
cuts the roll paper.

Nesting Use Nesting Selecting On will store print jobs until multiple documents
can be arranged to fill up the roll width, instead of printing
each print job as it is received.

Nesting WaitTime Specify a time to wait until printing, as desired.

Cut Lines Select On to print cut lines between each document on
the roll.

Line &
Pen
Manag-
er

Enable merge Specify whether to merge or print over colors where lines
overlap.
Choose Off to print the second line over the first. Choose
On to merge all overlapping colors.

Pen Set-
up

Select Palette As pen values, choose Software, Palette A, Palette B, or
Factory.
Choose Software to print according to software settings.
Choose Palette A or Palette B to print using the value
specified in Define Palette.

Define Palette Specify the Width, Color, and Line Attributes in the pa-
lette Pen no.. Choose Factory to confirm the values
when Factory is selected in Select Palette.
In Line Attributes, choose No Setting or Circle Setting
as the processing for the ends and junctions of lines.

• If you choose No Setting

• If you choose Circle Setting

Reset Palette Restore Define Palette to the default palette settings.

Smoothing Choose whether to print arcs as smooth curved lines or as
multiple connected line segments.
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Setting Item Description, Instructions
GL2
Settings

Line &
Pen
Manag-
er

Smoothing • If you choose Software
Operation is determined by the application. If nothing
is specified by the application, the result is as shown in
the figure.

Note: By default, this is a 72-sided figure

• If you choose Smooth

ThickenFineLines Select On to print fine lines more distinctly.

AdjustFaintLines If fine lines are printed in colors that do not match the col-
ors of other shapes, selecting Off may help produce the
expected results. However, lines in some colors may ap-
pear broken.

Ln wdth correct Corrects by using a correction value that specifies the pen
width.
You can configure Black/gray and Color for each group.
The specified range is -20 to +20.

Proces-
singOp-
tion

Warning Select On to have any GL2-related warnings displayed.

On-the-Fly Selecting On will start printing jobs sooner if you are print-
ing only HP RTL print jobs and printing would not start un-
til later. However, images may be incomplete in some ca-
ses, so be sure to check the printing results.

Detect img size Sets the method of deciding the region to output in order
to print efficiently while avoiding missing images.
If Off is selected and the data contains image range infor-
mation, the image range information is followed.
If Off is selected and the data does not contain image
range information, a size with the maximum roll paper
width of the printer for the width and 1.5 times the maxi-
mum roll paper width for the length is used.
If Command priority is selected and the data contains
image range information, the image range information is
followed.
If Command priority is selected and the data does not
contain image range information, the detected minimum
image area is used.
If Detected size is selected, the detected minimum image
area is used.

GL2 Set Print Print GL2 settings information.

Inter-
face
Setup

EOP Timer Specify the timeout period before cancellation of print jobs
that cannot be received by the printer.

TCP/IP IPv4 IPv4 Mode Choose whether the printer IP address is configured auto-
matically or a static IP address is entered manually.

Proto-
col

DHCP Specify the protocol used to configure the IP address au-
tomatically.
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Setting Item Description, Instructions
Inter-
face
Setup

TCP/IP IPv4 Proto-
col

BOOTP Specify the protocol used to configure the IP address au-
tomatically.RARP

IPv4
Settings

IP Address Specify the printer network information when using a stat-
ic IP address.
Enter the IP address assigned to the printer, as well as
the network subnet mask and default gateway.
The value that was automatically configured is displayed if
you have set IPv4 Mode to Automatic.

Subnet Mask
Default G/W

DNS
Settings

DNS Dync update Specify whether DNS server registration is updated auto-
matically.

Pri. DNS SrvAddr Specify the DNS server address.

Sec. DNS SrvAddr
DNS Host Name Specify the DNS host name.

DNS Domain Name Specify the DNS domain name.

IPv6 IPv6 Support Specify whether to connect via IPv6.

IPv6 StlessAddrs Specify whether a IPv6 stateless address is used.

DHCPv6 Specify whether DHCPv6 settings are used.

DNS
Settings

DNS
Dync
update

Statefull
Addr

Specify whether DNS server registration is updated auto-
matically.

State-
less
Addr

Pri. DNS SrvAddr Specify the DNS server address.

Sec. DNS SrvAddr
DNS Host Name Specify the DNS host name.

DNS Domain Name Specify the DNS domain name.

Ether-
net
Driver

Auto Detect Specify the communication method. To apply your
changes, choose Register Setting.
Choose On for automatic configuration of the LAN com-
munication protocol. Choose Off to use settings values of
Comm.Mode and Ethernet Type.

Comm.Mode Choose the LAN communication method.

Ethernet Type Choose the LAN transfer rate.

Spanning Tree Choose whether spanning-tree packets are supported
over the LAN.

MAC Address Indicates the MAC address.

Interface Print Print interface settings information.

Return Defaults Choose OK to restore Interface Setup settings to the de-
fault values.

System
Setup

Sleep Timer Specify the period before the printer enters sleep mode.

Shut Down Timer Sets the time until the printer turns off automatically. If no
operations are performed on the printer for the duration of
the time set in Shut Down Timer after entering Sleep
mode, the printer automatically turns off.

Buzzer Choose On for the buzzer to sound once for warnings and
three times for errors.

Contrast Adj. Adjust the Display Screen contrast level.

Date &
Time

Date Set the current date.

Time Set the current time. Available only if the Date setting is
specified.

Date Format Specify the date format.
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Setting Item Description, Instructions
System
Setup

Language Specify the language used on the Display Screen.

Time Zone Specify the time zone. Time zone options indicate a main
city in this time zone and the difference from Greenwich
Mean Time.

Length Unit Choose the display unit for length. Change the unit dis-
played for the remaining amount of roll paper, Tot.Print
Area, and so on.

Detect Mismatch Specify printing behavior if the type and size of paper
specified in the printer menu does not match the type and
size in the printer driver.
Choose Pause to have printing paused under these cir-
cumstances. Choose Warning to continue printing after
notification. Choose None to continue printing without no-
tification. Choose Hold Job to store jobs with mismatched
types and sizes of paper on the printer hard disk, in a print
queue awaiting processing.  (See "Using the Printer Hard
Disk.") ➔P.482

Paper
Size Ba-
sis

Roll Selection 1 If roll size detection is activated, choose whether ISO A3
(297mm) or 300mm Roll is applied when a roll of an in-
termediate width is detected.

Roll Selection 2 If roll size detection is activated, choose whether 10in.
(254mm) or JIS B4 (257mm) is applied when a roll of an
intermediate width is detected.

Keep Paper Size Choose On to use the paper size setting as the basis for
printing instead of other settings. The margin setting of the
printer menu will be used instead of the margin setting of
the printer driver if the latter is smaller, which may prevent
text or images in the margin from being printed.

Choose Off to give priority to margin settings. The larger
value is used if the margin specified in the printer driver
does not match the margin in the printer menu.

TrimEdge Reload Specify whether to trim the leading edge of the currently
retracted roll when the roll is advanced. Cut the edge if
you are concerned about any marks left on the roll when
the roll is left in the retracted position.
Specify On to have rolls cut when printing begins after
Sleep mode or when the power is restored. Selecting Au-
tomatic will trim the edge when the roll has been in the
retracted position for two days or more.

Rep.P.head Print Choose On to have the printer automatically execute the
Advanced Adj. operations after you replace the Print-
head.  (See "Automatic Adjustment to Straighten Lines
and Colors.") ➔P.520
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Setting Item Description, Instructions
System
Setup

Nozzle Check In Frequency, specify the timing for automatic checks of
nozzle clogging. Choose Standard to have the printer ad-
just the timing for checks based on the frequency of noz-
zle use. Choose 1 page to check once per page. Choose
10 pages to check once per 10 pages. Choose Off to not
execute check.
If On is selected in Warning, a warning may be displayed
on the Control Panel depending on the result of the nozzle
check.

Use USB When Off is selected, the device can no longer be ac-
cessed via USB.

Use Ethernet When Off is selected, the device can no longer be ac-
cessed via Ethernet.

Use RemoteUI Choosing Off prohibits access from RemoteUI. Settings
can only be configured from the control panel.

Reset PaprSetngs Restores settings that you have changed with Media Con-
figuration Tool to the default values.

Erase
HDD
Data

High Speed Erases file management data for print job data stored on
the printer's hard disk.  (See "Erasing Data on the Print-
er's Hard Disk.") ➔P.442

Secure High Spd. Overwrites the entire hard disk with random data.  (See
"Erasing Data on the Printer's Hard Disk.") ➔P.442

Secure Overwrites the entire hard disk with 00, FF, and random
data (one time each). Verification is performed to check if
the data was correctly written.  (See "Erasing Data on the
Printer's Hard Disk.") ➔P.442

Output
Method

Print Select the printing method for jobs received from software
other than the printer driver. When using the printer driver,
configure settings on the printer.
To print as usual, select Print. Selecting Print (Auto Del)
will print the job and then delete the data from the printer's
hard disk. Selecting Save: Box 01 will only save the print
job in the box, without printing it.

Print (Auto Del)
Save: Box XX

Print After Recv A setting for jobs received from software other than the
printer driver. When using the printer driver, configure set-
tings on the printer. Select On to print the job after it has
been saved.

Save: Common Box Select Off to print without saving jobs in the common box.

Show Job Log Selecting Off prevents display of the log in Job Menu >
Job Log. Additionally, the log is not printed if you choose
Job Menu > Print Job Log. Note that because job logs
are not collected, the Status Monitor accounting functions
will not work correctly.

Prep.MovePrinter When transferring the printer to another location, choose
the level of transfer and follow the instructions on the
screen.  (See "Preparing to Transfer the Printer.") ➔P.562
Not displayed during a warning message that the remain-
ing Maintenance Cartridge capacity is low.

Admin.
Menu

Change Password The password that can be entered is a number from 0 to
9999999.
The restriction states and main items are shown below.
For more specific information on restricted items, see
"Menu Structure." ➔P.410

• Viewing and configuration by administrators only
Change Password
Init.Admin.Pswd
Etc.
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Setting Item Description, Instructions
Admin.
Menu

Change Password • Viewing and configuration by administrators, and
only viewing by other users
Date & Time
Time Zone
Use RemoteUI
Etc.

Init.Admin.Pswd Choose OK to restore the Admin. Menu password to the
default values.

Adj. Fine Feed (*2) (*3) Displayed when you have selected Feed Priority > Adj.
Priority > Automatic or Print Quality. Fine-tune the feed
amount manually.

Printer
Info (*2)

Paper Info Indicates the current paper size, type, and related printer
settings.

Ink Info Indicates ink levels and maintenance cartridge capacity.

Head Info Indicates information about the printhead.

System Info Indicates the firmware version, serial number, and inter-
face information.

Error Log Indicates the most recent error messages (up to five).

Use Situation A counter for maintenance purposes.
Displays printer usage related information.

  *1: A rough estimate of how much ink was consumed per job is displayed. Actual ink consumption may be different. The aver-
age margin of error for estimates calculated according to Canon measurement conditions for ink costs is ±15%. Canon does
not guarantee the accuracy of these estimates. Estimates may vary depending on conditions of use. Calculation of these
estimates does not include ink consumed when cleaning printheads by forceful ejection of ink.

  *2: Displayed as the menu during printing while printing is in progress.
  *3: Not displayed in the regular menu.

Status PrintStatus Print
You can print a Status Print report indicating the current status of the printer.
With Status Print, information is printed regarding the printer firmware version, various settings, and the status of
consumables.

Printing Status Print reports

1 Load paper.
If using cut sheets, load paper A4/Letter-sized, you will need three sheets.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Test Print, and then press the OK button.

5 Press ▲ or ▼ to select Status Print, and then press the OK button.
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Checking the information in Status Print reports
The following information is included in Status Print reports.

Canon imagePROGRAF iPFxxxx Status Print Printer model

Firm Firmware version

Boot Boot ROM version

MIT(DBF) MIT database format version

MIT(DB) MIT database version

S/N Printer serial number

Date Indicates when the status print report was prin-
ted.

Paper Menu Information on the loaded paper.

 Roll Media Type

Cut Sheet Type

ManageRemainRoll

Keep Paper Type

Job Menu Job-related information.

 Job Log A counter for maintenance purposes.
Various information about previous jobs.

HDD Information Indicates the total hard disk capacity and the mail box free
space. Total capacity

Box free space

Set./Adj. Menu Settings and adjustment informa-
tion.

 System Setup Printer system settings, as well
as settings regarding warnings
and errors.

 Sleep Timer

Shut Down Timer

Buzzer

Contrast Adj.

Date Format

Language

Time Zone

Length Unit

Detect Mismatch

Paper Size Basis Paper-related settings.

 Roll Selection 1

Roll Selection 2

Keep Paper Size

TrimEdge Reload

Rep.P.head Print Settings after a test pattern was
printed following head replace-
ment.

Nozzle Check Nozzle-check settings.

 Frequency

Warning
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  Use USB Use USB settings values.

Use Ethernet Use Ethernet settings values.

Use RemoteUI Settings used by RemoteUI.

Show Job Log Print job settings.

Output Method Print job settings.

Print After Recv

Save: Common Box Save: Common Box settings
values.

Adjust Printer Adjustment settings.

 Head Posi. Adj. A counter for maintenance pur-
poses.
Head position adjustment values
for previous jobs.

 Adjust Log

Printer Info Ink information, RAM usage, and
a record of errors.

 Ink Info Ink-related information.

 MC Maintenance Cartridge capacity
(%)

(The ink color is dis-
played here.)

Ink levels.
The remaining ink is displayed in
a five-level scale.

System Info Indicates the total amount of
RAM. RAM

Error Log The past five error codes.

HEAD LOT NUMBER/ DATE OF INSTALLATION The printhead lot number and date and time when the Print-
head was installed.HEAD INFxx

PARTS STATUS Utilization status of replacement parts that require servicing.

 COUNTER

COUNTER Utilization status of the cutter, media, and other items (indicat-
ing how much they have been used). CUTTER

MEDIA

 LIFE TTL

LIFE ROLL

LIFE CUTSHEET

MEDIA 1-7,OTHER

 NAME

TTL

ROLL

CUTSHEET

AFTER INSTALLATION

DUTY Counters for maintenance purposes. Needed when service is
requested. UNIT:m2

UNIT:sq.f

UNIT:A4 Sheet

UNIT:Letter Sheet
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Printing Interface Setting ReportsPrinting Interface Setting Reports
You can print an Interface Print report indicating the current interface settings values of the printer.

Printing Interface Print reports

1 Load the paper.
If using sheets, load paper A4/Letter-sized, you will need at least three sheets.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Test Print, and then press the OK button.

5 Press ▲ or ▼ to select Interface Print, and then press the OK button.

Confirming Interface Print information
The following information is included in the Interface Print report.

Canon imagePROGRAF iPFxxxx Interface Print Printer model

Firm Firmware Version

Boot Boot ROM Version

MIT(DBF) MIT Database Format Version

MIT(DB) MIT Database Version

S/N Printer serial number

Date The date when the interface setup print report
was printed.

EOP Timer Specify the timeout period before cancellation of
print jobs that cannot be received by the printer.

TCP/IPv4 Frame Type IPv4 settings values.

Use DHCP

Use BOOTP

Use RARP

Enable DNS Dynamic Update

Use Zeroconf Function

IP Address

Subnet Mask

Gateway Address

LPD Printing

IPP Printing
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TCP/IPv4 IPP Printer URI IPv4 settings values.

RAW Printing

Raw Mode Bi-direction

FTP Printing

WSD Printing

Use Discovery

Scope

Primary DNS Server Address

Secondary DNS Server Address

DNS Host Name

DNS Domain Name

MulticastDNS ServiceName

SNMPv1

SNMPv3

TCP/IPv6 Use IPv6 IPv6 settings values.

Use DHCPv6 Stateful Address

Prefix Length

Primary DNS Server Address

Secondary DNS Server Address

Use a stateless address Stateless Address 1

Prefix Length 1

Stateless Address 2

Prefix Length 2

Stateless Address 3

Prefix Length 3

Stateless Address 4

Prefix Length 4

Stateless Address 5

Prefix Length 5

Stateless Address 6

Prefix Length 6

Use a link-local Address Link-Local Address

Prefix Length

Use a manual address IP Address

Prefix Length

Default Router Address

Prefix Length

Primary DNS Server Address

Secondary DNS Server Address

Use the same host name and do-
main name as IPv4

DNS Host Name

DNS Domain Name

Perform dynamic updating of stateful addresses

Dynamically update the stateless address

Dynamically update the manual address
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Network Interface Physical Interface Network interface settings values.

Transmission Rate

MAC Address

Auto Detect

Communication

Ethernet Type

Spanning Tree

Use the Jumbo Frame Function

iPF785                                                                                                                                                                            Printing Interface Setting Reports

User's Guide                                                                                                                                                                                                                     

  

Control Panel
Printer M

enu

431  



                                                                                                                                                                                                                             iPF785

                                                                                                                                                                                                                     User's Guide

 432



iPF785
 

User's Guide

Basic Printing Workflow 15

Enhanced Printing Options 29

Windows Software 141

Mac OS Software 249

Handling and Use of Paper 327

Control Panel 397
 

Printer Parts
 

Printer parts ....................................................................................... 434
Hard Disk ........................................................................................... 440
Optional accessories ......................................................................... 444

Network Setting 445

Print Job Management 465

Adjustments for Better Print Quality 519

Maintenance and Consumables 535

Troubleshooting 571

Error Message 599

Specifications 621

Appendix 625

imagePROGRAF

  

Printer Parts

433  



Printer partsPrinter parts
Front .............................................................................................................................................................. 434
Side ................................................................................................................................................................435
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Carriage ......................................................................................................................................................... 437
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Stand ............................................................................................................................................................. 439

Control Panel ..................................................................................................................................................398

FrontFront

a Roll Cover
Open this cover to load rolls.  (See "Roll Cover (Inside).") ➔P.437

b Paper Feed Slot
When loading paper, insert it here.

c Roll Ledge
When loading rolls, rest the Roll Holder here before loading it in the Roll Holder Slot.

d Release Lever
When releasing the Paper Retainer, push this lever back.

e Control Panel
Use this panel to operate the printer and check the printer status.  (See "Control Panel.") ➔P.398

f Ink Tank Cover
Open this cover to replace an Ink Tank.  (See "Ink Tank Cover (Inside).") ➔P.438

g Paper Alignment Line
An orange line for alignment of paper.
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h Maintenance Cartridge Cover
Open this cover to replace the Maintenance Cartridge.

i Maintenance Cartridge
Absorbs ink used for maintenance purposes such as head cleaning. (Replace the cartridge when it is full.)

j Cutter Unit
A round-bladed cutter for automatic roll cutting.

k Cutter Rail
The Cutter Unit passes over this rail to cut paper.

l Output Tray
All printed documents are ejected from this slot.

m Ejection Guide
Supports output paper.

n Top Cover
Open this cover to install the Printhead and remove any jammed paper from inside the printer, as needed.
 (See "Top Cover (Inside).") ➔P.436

o Width Guide
When loading the sheets , move the guide to match the paper size.

p Stand
A stand that holds the printer. Equipped with casters to facilitate moving it.  (See "Stand.") ➔P.439

SideSide
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a Manual Pocket
Store printer manuals in this pocket.

b Ethernet Port
Connect an Ethernet cable to this port.

c USB Port
Connect a USB cable to this port. The printer is compatible with Hi-Speed USB connections.

d Carrying Handles
When carrying the printer, have three people hold it by these handles on the back at both ends.
Grasp these parts on the left and right sides also when moving the printer with the stand attached.

e Power Supply Connector
Connect the power cord to this connector.

Top Cover (Inside)Top Cover (Inside)

a Carriage
Moves the Printhead. The carriage serves a key role in printing.  (See "Carriage.") ➔P.437

b Carriage Shaft
The Carriage slides along this shaft.

c Paper Retainer
Important in supplying the paper. This retainer holds paper as it is fed.

d Platen
The Printhead moves across the platen to print. Vacuum holes on the platen hold paper in place.

e Borderless Printing Ink Grooves
For catching ink outside the edges of paper during borderless printing.

f Linear Scale
The linear scale serves a key role in detecting the Carriage position. Be careful not to touch this part when
cleaning inside the Top Cover or clearing paper jams.

Top Cover (Inside)                                                                                                                                                                                                  iPF785

                                                                                                                                                                                                                     User's Guide

  

Printer Parts
Printer parts

 436



g Cleaning Brush
When cleaning inside the printer under the Top Cover, use this brush to sweep away paper dust on the Platen.

Roll Cover (Inside)Roll Cover (Inside)

a Roll Holder
Load the roll on this holder.

b Holder Stopper
Secure rolls on the Roll Holder with this part.

c Roll Loading Slots
Slide the Roll Holder along these slots.

d Roll Holder Slot
Load the Roll Holder into this holder slot.

CarriageCarriage

a Angle Adjustment Lever
Use this lever to fine-tune the printer to correct misalignment of printed lines.
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b Printhead
The printhead is equipped with ink nozzles. The carriage serves a key role in printing.

c Printhead Fixer Lever
Locks the Printhead Fixer Cover.

d Printhead Fixer Cover
Holds the Printhead in place.

Ink Tank Cover (Inside)Ink Tank Cover (Inside)
Left Side Right Side

a Ink Tank Lock Lever
A lever that locks the Ink Tank in place and protects it. Lift and press down the lever when replacing an Ink
Tank.

b Ink Color Label
Load an Ink Tank that matches the color and name on this label.

c Ink Lamp (Red)
Indicates the state of the Ink Tank as follows when the Ink Tank Cover is opened.

• On
The Ink Tank is installed correctly.

• Off
No Ink Tank is installed, or the ink level detection function has been released.

• Flashing Slowly
Not much ink is left.

• Flashing Rapidly
There is no ink left.

d Ink Tank
Cartridges of ink in various colors.
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StandStand
• Printer Stand ST-34

a Accessory Pocket
Stores printer accessories.

b Output Stacker
Printed documents are ejected into the output tray.

c Locking Caster
Lock to immobilize the caster.
Before moving the printer, always unlock all four casters. Moving the printer while casters are locked may
scratch the casters or the floor.

d Adjustable Stopper
Pull out depending on the paper size when using the output stacker in the Extended position A.
For details on the extended position, see "Using the Output Stacker." ➔P.364

e Paper Guide
Guides printed documents into the output stacker.

f Output stacker handle
This handle is grasped and supports the sliding output stacker when putting the output stacker into Exten-
ded position B and returning it to the regular position.
For details on the extended position, see "Using the Output Stacker." ➔P.364

g Output stacker release lever
Pull this lever towards you to release Extended position B.
For details on the extended position, see "Using the Output Stacker." ➔P.364

h Output Stacker Ejection Guides
This guide supports the paper that is output when using the output stacker in Extended position B.
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Hard DiskHard Disk
Printer Hard Disk Operations .......................................................................................................................... 440

Checking the Free Hard Disk Space ............................................................................................................... 441
Erasing Data on the Printer's Hard Disk .......................................................................................................... 442

Printer Hard Disk OperationsPrinter Hard Disk Operations
Printer hard disk operations are available from the following programs and interfaces.

• Printer driver
• Free Layout
• Color imageRUNNER Enlargement Copy
• Preview
• imagePROGRAF Status Monitor
• imagePROGRAF Printmonitor
• RemoteUI
• Control Panel

The hard disk operations available through each interface are as follows.

Operation

• Printer driver
• Free Layout
• Color imageRUNNER

Enlargement Copy
• Preview

• imagePROGRAF Sta-
tus Monitor

• imagePROGRAF
Printmonitor

RemoteUI Control Pan-
el

Saving print jobs Save in mail box Yes No No No

Do Not Save Print Jobs
in the Common Box

No No No Yes

Save print jobs sent
from sources other
than the printer driver

No No No Yes

Operations with saved
jobs

Print saved jobs No Yes Yes Yes

Delete saved jobs No Yes Yes Yes

Job queue manage-
ment

Display job queue No Yes Yes Yes

Delete No Yes Yes Yes

Preempt Jobs No Yes Yes Yes

Operations with held
jobs

No Yes Yes Yes

Mail box management Move saved jobs No Yes Yes No

Modify saved jobs No Yes Yes No

Modify mail boxes No Yes Yes No

Print a list of saved
jobs

No No No Yes

Display a list of saved
jobs

No Yes Yes Yes

Other operations Display free hard disk
space

No Yes Yes Yes

Initialize hard disk No No No Yes

Display the time of
printing

No Yes Yes Yes

Display error messages No Yes Yes Yes
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Checking the Free Hard Disk SpaceChecking the Free Hard Disk Space
Check the space available on the printer's hard disk as follows.
This operation is available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select HDD Information, and then press the OK button.

Using RemoteUI
To view the box list, select Stored Job in Job Management. On the Stored Job page, the free hard disk space is
shown in the upper-right corner when boxes are listed.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor
The Hard Disk sheet shows the free hard disk space.

For details, refer to the imagePROGRAF Status Monitor help file.

Using imagePROGRAF Printmonitor
The Hard Disk pane shows the free hard disk space.

For details, refer to the imagePROGRAF Printmonitor help file.

Erasing Data on the Printer's Hard DiskErasing Data on the Printer's Hard Disk
When erasing all data on the hard disk, choose from the following three options.
This operation is only available from the Control Panel.

Erasure Method Details
High Speed Erases file management data for print job data stored on the printer's hard disk. Choose this method for

relatively fast erasure. Because only the file management data is erased, the print job data itself is not
erased. Note that it may be possible to read this data using commercial data recovery software.

Secure High Spd. Overwrites the entire hard disk with random data. No verification is performed to check if the data was
correctly written. Choose this method to erase highly confidential data. Note that it may be possible to
read the overwritten data using specialized data recovery tools.

Secure Overwrites the entire hard disk with 00, FF, and random data (one time each). Verification is performed
to check if the data was correctly written. Choose this method to erase especially confidential data. It is
virtually impossible to recover the overwritten data. Conforms to the DoD5220.22-M standard of the
U.S. Department of Defense.
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Important
• For a more secure method of preventing data recovery, we recommend physically or magnetically destroying the

hard disk. In this case, the hard disk can no longer be used.

• Erase HDD Data is not available if there is a job queue.
Additionally, print jobs are not processed during execution of Erase HDD Data.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Erase HDD Data, and then press the OK button.

5 Press ▲ or ▼ to select High Speed, Secure High Spd., or Secure, and then press the OK button to dis-
play the confirmation screen.

Note
• If a password has been set on the printer, the Admin.Pswd screen is displayed. In this case, enter the

password and press the OK button to go to the next step.

• As for the time required for deletion, confirm it on the Control Panel. However, when High Speed is selec-
ted, this finishes in several seconds.

6 Press ▲ or ▼ to select Yes, and then press the OK button to start erasure.
After the printer hard disk is erased, the printer automatically restarts.
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Optional accessoriesOptional accessories
Roll Holder SetRoll Holder Set

Load a roll on the roll holder and then load the holder in the printer. The Roll Holder in the Roll Holder Set RH2-33
is for use with both 2-inch and 3-inch paper cores. Use the correct attachment for the particular paper core.  (See
"Attaching the Roll Holder to Rolls.") ➔P.338

• Roll Holder Set RH2-33

• Roll Holder (for 2- and 3-inch paper cores)

• Attachments
Using the 2-Inch Paper Core Attachment Using the 3-Inch Paper Core Attachment
2-Inch Paper Core Attachment 3-Inch Paper Core Attachment L 3-Inch Paper Core Attachment R
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Network EnvironmentNetwork Environment
Network EnvironmentNetwork Environment

System requirements
The system requirements, which vary depending on your network, are as follows.

• Printing over a TCP/IP network (when using IPv4)
• Compatible operating systems

• Windows XP
• Windows Server 2003
• Windows Vista
• Windows Server 2008
• Windows 7
• Windows 8
• Windows Server 2003 x64
• Windows Vista x64
• Windows Server 2008 x64
• Windows Server 2012 x64
• Windows 7 x64
• Windows 8 x64
• OS X v10.6.8 or later
• Unix（Solaris 9）
• Unix（Red Hat 9）

• Printing over a TCP/IP network (when using IPv6)
• Compatible operating systems

• Windows Vista
• Windows Server 2008
• Windows 7
• Windows 8
• Windows Vista x64
• Windows Server 2008 x64
• Windows Server 2012 x64
• Windows 7 x64
• Windows 8 x64
• OS X v10.6.8 or later

Note
• When using IPv6, you must specify IPv6 on the Control Panel or in RemoteUI. For instructions, "Configuring

TCP/IPv6 Network Settings" ➔P.452  or see "Configuring the Printer's TCP/IP Network Settings With Remo-
teUI." ➔P.454

• The imagePROGRAF printer driver is not compatible with Unix.

Network Environment
After confirming what type of network environment you will connect the printer to, set up the printer and computers
as needed. For the specifications of the network interface, see "Specifications." ➔P.622
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• Example of a Windows network
In Windows networks, print over TCP/IP.

Note
• NetBIOS is not supported.

• Example of a Mac OS network
In Mac OS networks, print over TCP/IP using the Bonjour function.
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Using RemoteUIUsing RemoteUI
Using RemoteUIUsing RemoteUI

RemoteUI is software with which you can access the printer via the network from your Web browser to confirm the
printer status, operate jobs, and configure the settings. Since the software (Web server) for using RemoteUI is built
in the printer, preparing software other than a Web browser is unnecessary. You can use RemoteUI if an image-
PROGRAF printer on a network is connected to your computer. If you start your Web browser and specify the IP
address of the printer, the RemoteUI screen is displayed, and you can use RemoteUI.

Important
• To use RemoteUI, an IP address must be set on the printer in advance. For the method of setting an IP address,

see "Configuring the IP Address on the Printer." ➔P.450

What You Can Do With RemoteUI
With RemoteUI, you can access the printer via a network, configure network settings, and display the current status
of the printer, various types of information, the processing status of jobs, etc.

Starting RemoteUI
Start RemoteUI by the following operations.

1 Start your Web browser.

2 Enter the following URL in Address or Location.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

3
 

The RemoteUI screen is displayed.

Note
• The screen slightly differs depending on the model of printer.

Configuring the Network With RemoteUI
For details on configuring printer settings for networks, refer to the following topics.

• Configuring the Printer's TCP/IP Network Settings With RemoteUI ➔P.454
• Specifying Printer-Related Information ➔P.458
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Important
• For the Web browser, use Netscape Navigator 6.0 or later, Internet Explorer 5.01 or later, or Firefox 1.5 or later.

For Mac OS X, Safari 1.32 or later or 2.03 or later also is supported.

• This cannot be used connected via a proxy server. In environments where a proxy server is used, add the print-
er's IP address to Exceptions (addresses accessed without a proxy server) in the web browser proxy server
settings. (Settings may vary depending on the network environment.)

• Enable JavaScript and cookies in the web browser.

• If you access RemoteUI with the printer name instead of its IP address, make sure the DNS settings are correctly
configured.

• Depending on the network environment, you may not be able to start RemoteUI.

• Confirm whether System Setup > Use RemoteUI is set to On on the Control Panel of the printer.

Note
• RemoteUI also offers many other features. You can display the ink levels, check error messages and other status

information, and cancel print jobs.

• By factory default, the English screen is displayed. To change the display language, select the desired language
under Language before logging on in administrator mode.

• If you login in Administrator Mode, you can configure to use the Jumbo Frame function in the Network page. How-
ever, this function might not be able to be used depending on the network environment.
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Initial SettingsInitial Settings
Configuring the IP Address on the Printer ....................................................................................................... 450

Configuring the IP Address Using imagePROGRAF Device Setup Utility .................................................... 461
Configuring the IP Address Using the Printer Control Panel ....................................................................... 450
Configuring the IP Address Using ARP and PING Commands ................................................................... 451

Configuring TCP/IPv6 Network Settings ......................................................................................................... 452

Configuring the Printer Driver Destination (Windows) ...................................................................................... 453
Configuring the Printer Driver Destination (Mac OS) ........................................................................................ 453

Configuring the Printer's TCP/IP Network Settings With RemoteUI ................................................................. 454

Configuring the IP Address on the PrinterConfiguring the IP Address on the Printer
You must configure the printer's IP address before using the printer in a TCP/IP network.
The printer's IP address is configured automatically when you install the printer driver following the instructions in
the Setup Guide.
Configure the IP address by using imagePROGRAF Device Setup Utility, the printer Control Panel, or ARP or
PING commands, if the IP address is changed, or if you change the printer connection mode to a network connec-
tion. For details on configuring the IP address, refer to the following topics.

• Configuring the IP Address Using imagePROGRAF Device Setup Utility ➔P.461  (Windows)

• Configuring the IP Address Using the Printer Control Panel ➔P.450

• Configuring the IP Address Using ARP and PING Commands ➔P.451

Important
• If you use a DHCP server for automatic assignment of the printer's IP address, printing may no longer be possi-

ble after the printer is turned off and on. This is because an IP address different from before has been assigned.
Thus, when using DHCP server functions, consult your network administrator and configure the settings in one of
the following ways.

• Configure the setting for dynamic DNS updating
In the printer menu, either set DNS Dync update to On, or activate the setting Enable DNS Dynamic Update in
RemoteUI.
 (See "Menu Settings.") ➔P.416
 (See "Configuring the Printer's TCP/IP Network Settings With RemoteUI.") ➔P.454

• Configure the setting for assignment of the same IP address each time the printer starts up

Note
• We recommend configuring the printer's IP address even if you will use the printer in networks other than TCP/IP

networks. Configuring the printer's IP address enables you to use RemoteUI to configure the network settings and
manage the printer with a web browser.
For details on RemoteUI, see "Using RemoteUI." ➔P.448

Configuring the IP Address Using the Printer Control PanelConfiguring the IP Address Using the Printer Control Panel
This topic describes how to configure the printer's IP address on the Control Panel.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select TCP/IP, and then press the OK button.

5 Press ▲ or ▼ to select IPv4, and then press the OK button.

6 Press ▲ or ▼ to select IPv4 Settings, and then press the OK button.

7 Press ▲ or ▼ to select IP Address, and then press the OK button.

8 After you press ◀ or ▶ to select the input field, numerical input is possible.

9 Press the ▲ or ▼ button to enter the value.

Note
• Pressing the ▲ button increases the number by 1. The maximum value is 9, after which 0 is displayed.

• Pressing the ▼ button decreases the number by 1. The minimum value is 0, after which 9 is displayed.

• Hold down ▲ or ▼ to increase or decrease the value continuously.

• Make sure the IP address you enter for the printer is not the same as any computer IP address in your
network.

10 Repeat steps 8 and 9 to complete the settings, and then press the OK button.

11
 

Press the Menu button.
If you have changed the settings, a confirmation message is dis-
played. Press ▲ or ▼ to select Yes, and then press the OK but-
ton.

Important
• Be sure to complete step 11. This will activate the values you have entered.

• If an error message is displayed, check the settings and correct any invalid values.

Note
• You can also specify the subnet mask and default gateway on the Control Panel.

Configuring the IP Address Using ARP and PING CommandsConfiguring the IP Address Using ARP and PING Commands
This topic describes how to configure the IP address using ARP and PING commands.
To use the ARP and PING commands, you will need to know the printer's MAC address. You can confirm the MAC
address on the Control Panel.

1 Check the printer's MAC address.
You can confirm the MAC address on the Control Panel as follows:

1.  

On the Tab Selection screen of the Control Panel, press ◀ or
▶ to select the Settings/Adj. tab ( ).

2. Press the OK button.
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The Set./Adj. Menu is displayed.

3. Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4. Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.

5. Press ▲ or ▼ to select MAC Address, and then press the OK button.

Note
• If the Tab Selection screen is not displayed, press the Menu button.

• You can investigate the MAC address by printing an interface setting report.
 (See "Printing Interface Setting Reports.") ➔P.429

2 In Windows, open a command prompt, or in Mac OS, start Terminal.

3 Execute the following command to add entries to the ARP table for managing IP addresses and corre-
sponding MAC addresses.
arp -s [IP address] [the printer's MAC address you have verified]
Example: arp -s xxx.xxx.xxx.xxx 00-1E-8F-xx-xx-xx

Note
• In Mac OS when using Terminal, enter the arp command in the format arp -s xxx.xxx.xxx.xxx 00:1E:

8F:xx:xx:xx. For details, refer to the help file for the command line.

4 Execute the following command to send the IP address to the printer and configure it.
ping [IP address as specified in the ARP command] -l 479
Example: ping xxx.xxx.xxx.xxx -l 479

Note
• In -l, the l is the letter l.

• In Mac OS when using Terminal, enter the ping command in the format ping -s 479 xxx.xxx.xxx.xxx. For
details, refer to the help file for the command line.

Note
• The subnet mask and default gateway are set to 0.0.0.0. Use RemoteUI to change the subnet mask and default

gateway to match your network settings.
For details on RemoteUI, see "Using RemoteUI." ➔P.448

Configuring TCP/IPv6 Network SettingsConfiguring TCP/IPv6 Network Settings
When printing in a TCP/IPv6 network, you must configure the TCP/IPv6 settings on the Control Panel.
Follow the steps below to configure the TCP/IPv6 network settings.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select TCP/IP, and then press the OK button.

5 Press ▲ or ▼ to select IPv6, and then press the OK button.
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6 Press ▲ or ▼ to select IPv6 Support, and then press the OK button.

7 Press ▲ or ▼ to select On, and then press the OK button.

Important
• Once you set IPv6 Support to On, the IPv6 StlessAddrs setting takes effect.

Note
• You can also configure IPv6 StlessAddrs and DHCPv6 from the printer Control Panel.

Configuring the Printer Driver Destination (Windows)Configuring the Printer Driver Destination (Windows)
This topic describes how to specify the printer driver destination if the printer's IP address is changed, or if you will
use the printer over a network connection instead of via USB connection.
The procedure described below is the configuration based on the LPR or Raw protocol using the standard TCP/IP
port in Windows ( Standard TCP/IP Port ).

Important
• If you will use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.

• Configuring the IP Address on the Printer ➔P.450

Note
• This section describes the procedure in Windows 7.

1 Open the Devices and Printers window.

2 Right-click the icon of this printer and choose Printer Properties to open the printer properties window.

3 Click the Port tab to display the Port sheet.

4 Click Add Port to display the Printer Ports dialog box.

5 In the Available Port list, select Standard TCP/IP Port.

6 Click New Port.
After the wizard starts, a window is displayed for the Welcome to the Add Standard TCP/IP Printer Port
Wizard.

7 Click Next.

8 In Printer Name or IP Address, enter the printer's IP address. If the DNS is configured, you can also enter
the DNS Domain Name.

9 Follow the instructions on the screen to add a printer port.

10 Click Close to close the Printer Ports dialog box.

11 Make sure the printer port you added is displayed under Ports, and that the port is selected.

12 Click Close to close the printer properties window.

Configuring the Printer Driver Destination (Mac OS)Configuring the Printer Driver Destination (Mac OS)
Specify the printer driver destination as follows if the printer's IP address is changed, or if you will use the printer
over a network connection instead of via USB connection.

• If you switch to printing in a TCP/IP network, or if the printer's IP address is changed, see "Configuring the
Destination in TCP/IP Networks ." ➔P.457
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• If you switch to printing in a Bonjour network, see "Configuring the Destination for Bonjour Network ." ➔P.457

Configuring the Printer's TCP/IP Network Settings With RemoteUIConfiguring the Printer's TCP/IP Network Settings With RemoteUI
Follow the steps below to configure the TCP/IP network settings.

When using an IPv4 IP address

1 Start the web browser and enter the following URL in the Location (or Address ) box to display the Remo-
teUI page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

Note
• If a password has been set on the printer, enter the password.

3 Click Network in the Device Manager menu at left to display the Network page.

4 Click Edit in the upper-right corner of the TCP/IPv4 group to display the Edit TCP/IP Protocol Settings
page.

5 Refer to the TCP/IP Settings Items table to complete the settings.
TCP/IP Settings Items

Item Details Default Setting
Use DHCP Activate this setting to use DHCP for configuring the IP address. Off

Use BOOTP Activate this setting to use BOOTP for configuring the IP address. Off

Use RARP Activate this setting to use RARP for configuring the IP address. Off

Enable DNS Dynamic
Update

Activate this setting to perform DNS server registration automatically. Off

Use Zeroconf Func-
tion

Activate this setting to use Bonjour. On

IP Address Specify the printer's IP address. 0.0.0.0

Subnet Mask Specify the printer's subnet mask. 0.0.0.0

Gateway Address Specify the printer's default gateway. 0.0.0.0

LPD Printing Activate this setting to use LDP Printing. On

IPP Printing Activate this setting to use IPP Printing. On

IPP Printer URI Specify the URI of the printer used for IPP printing using up to 252 charac-
ters.

printer

RAW Printing Activate this setting to use Raw Printing. On

RAW Mode Bi-direc-
tion

Activate this setting to use Raw mode bidirectional communication. Off

FTP Printing Activate this setting to use FTP Printing. On

Use Discovery Activate this setting to use SLP Discovery function. On

Scope Enter the SLP search range. default

SMTP Server Ad-
dress

Specify the SMTP server's IP address.
You can also specify the SMTP server domain name, if desired.

0.0.0.0

Primary DNS Server
Address

Specify the IP address of the primary DNS server. 0.0.0.0

Secondary DNS
Server Address

Specify the IP address of the secondary DNS server. 0.0.0.0
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Item Details Default Setting
DNS Host Name Specify the printer host name, up to 63 characters (1–63 characters). Use

single-byte letters, numbers, and - (hyphens). Do not use numbers or - for
the first character or - for the last character.

NB-18GBipxxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters. Use single-byte let-
ters, numbers, - (hyphens), and . (periods). Do not use numbers, -, or . for
the first character, or - or . for the last character.

blank

Multicast DNS Serv-
ice Name

Specify the printer's Multicast DNS service name. (1–63 characters)
This name will be displayed when Bonjour functions are used.

Canon iPFxxxx
(xxxxxx)

6 Click OK to display the Network page.

Note
• If you specify to configure the IP address using DHCP, BOOTP, or RARP, there must be a server that supports

such protocol running in the network.

• If you specify to configure the IP address using DHCP, BOOTP, or RARP, the IP address obtained by this method is
used first. If you cannot obtain the IP address, the address specified in IP Address is used.

• It takes up to two minutes to determine whether DHCP, BOOTP, or RARP are available. We recommend clearing
check boxes of options you will not use.

• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS servers
and DNS domain name in Primary DNS Server Address, Secondary DNS Server Address and DNS Domain
Name, respectively.

When using an IPv6 IP address

1 Start the web browser and enter the following URL in the Location (or Address ) box to display the Remo-
teUI page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

Note
• If a password has been set on the printer, enter the password.

3 Click Network in the Device Manager menu at left to display the Network page.

4 Click Edit in the upper-right corner of the TCP/IPv6 group to display the Edit TCP/IPv6 Protocol Settings
page.

5 Refer to the TCP/IPv6 Settings Items table to complete the settings.
TCP/IPv6 Settings Items

Item Details Default Setting
Use IPv6 Activate to enable IPv6. Off

Use DHCPv6 Activate when using a DHCPv6 server to acquire the IP ad-
dress.

Off

Use a stateless address Activate when using an IPv6-compatible router to acquire the
IP address.

On

Use a manual address Activate when configuring the IP address manually. Off

IP Address Enter the printer's IP address. ::

Prefix Length Enter the IP address prefix length.

Default Router Ad-
dress

Enter the default router address. ::

Prefix Length Enter the prefix length of the default router address.

Primary DNS Server Address Specify the IP address of the primary DNS server. ::
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Item Details Default Setting
Secondary DNS Server Address Specify the IP address of the secondary DNS server. ::

Use the same host name and do-
main name as IPv4

Activate when using the same DNS host and domain names
as for IPv4.

Off

DNS Host Name Specify the printer host name, up to 63 characters (1–63
characters). Use single-byte letters, numbers, and - (hy-
phens). Do not use numbers or - for the first character or - for
the last character.

NB-18GBip6xxxxxx

DNS Domain Name Specify the printer domain name, up to 63 characters. Use
single-byte letters, numbers, - (hyphens), and . (periods). Do
not use numbers, -, or . for the first character, or - or . for the
last character.

blank

Perform dynamic updating of state-
ful addresses

Activate this setting to automatically register the stateful ad-
dress with the DNS server.

Off

Dynamically update the stateless
address

Activate this setting to automatically register the stateless ad-
dress with the DNS server.

Off

Dynamically update the manual ad-
dress

Activate this setting to automatically register the manual ad-
dress with the DNS server.

Off

6 Click OK to display the Network page.

Note
• If you are using a DNS server, select Enable DNS Dynamic Update and enter the IP Address for DNS servers

and DNS domain name in Primary DNS Server Address, Secondary DNS Server Address and DNS Domain
Name, respectively.
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Mac OS SettingsMac OS Settings
Configuring the Destination in TCP/IP Networks ............................................................................................ 457
Configuring the Destination for Bonjour Network ........................................................................................... 457

Configuring the Destination in TCP/IP NetworksConfiguring the Destination in TCP/IP Networks
If you use the printer in a TCP/IP network, register the printer in Print & Scan (This is identified as Printers &
Scanners or Print & Fax in other versions of Mac OS.) in the Mac OS System Preferences.

Note
• For details on how to register a printer using a TCP/IP network, see the OS User Manual.

Important
• If you use the printer in a TCP/IP network, make sure the printer's IP address is configured correctly.  (See

"Configuring the IP Address Using the Printer Control Panel.") ➔P.450

Configuring the Destination for Bonjour NetworkConfiguring the Destination for Bonjour Network
If you use the printer in a network that uses the Bonjour function, register the printer in Print & Scan (This is identi-
fied as Printers & Scanners or Print & Fax in other versions of Mac OS.) in the Mac OS System Preferences.

Note
• For details on how to register a printer using Bonjour, see the OS User Manual.

Important
• Bonjour and IP Print (Auto) do not support printing to a printer on other network groups that require a router for

connection. Make sure the computer and printer are on the same network. For information about network set-
tings, ask your network administrator.

• By default, Bonjour is activated on the printer. You can activate or deactivate the Bonjour function or change the
printer name by using RemoteUI. For instructions on changing it, see "Using RemoteUI." ➔P.448
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Other SettingsOther Settings
Specifying Printer-Related Information ............................................................................................................ 458
Configuring the Communication Mode Manually ............................................................................................. 459
Email Notification When Printing is Finished or Errors Occur ........................................................................... 460
Initializing the Network Settings ...................................................................................................................... 460

Specifying Printer-Related InformationSpecifying Printer-Related Information
Follow the steps below to specify device information and security settings.

1 Start the web browser and enter the following URL in the Location (or Address ) box to display the Remo-
teUI page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

Note
• If a password has been set on the printer, enter the password.

3 Click Information in the Device Manager menu at left to display the Information page.

4 To display the relevant settings page, click Edit in the upper-right corner of Device Information or Securi-
ty, depending on what information you want to specify.
To change the administrator password, click the Change Password button in the Security group.

5 Refer to the table of settings for device information and security as you complete these settings.
Security setting items are displayed when you click the Change Password button in the Security group.
Device Information Settings

Item Details Default Setting
Device Name Enter a device name.

(0–32 characters)
blank

Location Enter the location where the device is installed.
(0–32 characters)

blank

Administrator Enter the administrator's name.
(0–32 characters)

blank

Phone Enter the administrator's contact information.
(0–32 characters)

blank

Comments(E-mail) Enter any comments regarding the administrator.
(0–32 characters)

blank

Security Settings
Item Details Default Setting

New Password Enter the new password.
(0-9999999)

blank

Confirm Enter the new password again to confirm it.
(0-9999999)

blank

*1:On the Security settings screen, besides entering a password, you can specify other security-related information, such
as IP address-based SNMP or TCP usage restrictions, MAC address-based access restrictions, or IPP and FTP au-
thentication settings.

6 Click OK to activate the settings.
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Configuring the Communication Mode ManuallyConfiguring the Communication Mode Manually
This topic gives instructions for configuring the communication mode manually.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Interface Setup, and then press the OK button.

4 Press ▲ or ▼ to select Ethernet Driver, and then press the OK button.

5 Press ▲ or ▼ to select Auto Detect, and then press the OK button.

6 Press ▲ or ▼ to select Off, and then press the OK button.
The display reverts to the Ethernet Driver menu.

7 Press ▲ or ▼ to select Comm.Mode, and then press the OK button.

8 Press ▲ or ▼ to select the communication mode, and then press the OK button.
The display reverts to the Ethernet Driver menu.

9 Press ▲ or ▼ to select Ethernet Type, and then press the OK button.

10 Press ▲ or ▼ to select the Ethernet type, and then press the OK button.
The display reverts to the Ethernet Driver menu.

11 Press ▲ or ▼ to select Spanning Tree, and then press the OK button.

12 Press ▲ or ▼ to enable or disable spanning tree support, and then press the OK button.
The display reverts to the Ethernet Driver menu.

13
 

Press the Menu button.
After the confirmation message is displayed, press the OK button.
The new settings will take effect after the printer restarts.
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Email Notification When Printing is Finished or Errors OccurEmail Notification When Printing is Finished or Errors Occur
The printer can notify you of the printer status by email. Even when you are away from the printer, you can know
when printing is finished or if errors occur. Receive notification via email on your mobile phone or at your computer.

Use the imagePROGRAF Status Monitor (Windows) function to set up email recipients and message timing. Be-
sides being informed of finished print jobs or errors, you can also complete settings for email notification when
service is needed or it's time to replace consumables. For detailed instructions,see "Specifying Printer-Related In-
formation." ➔P.458

Note
• For details on email notification using imagePROGRAF Status Monitor (in Windows), refer to the imagePROG-

RAF Status Monitor help.

• Mail server authentication is only supported with imagePROGRAF Status Monitor.

Initializing the Network SettingsInitializing the Network Settings
Use RemoteUI to restore the network settings to the default values as follows.

Important
• Initializing the network settings will also restore the default value of the printer's IP address. As a result, the Re-

moteUI page cannot be displayed in the web browser after this procedure.

• For instructions on reconfiguring the IP address, see "Configuring the IP Address on the Printer." ➔P.450

• For details on RemoteUI, see "Using RemoteUI." ➔P.448

1 Start the web browser and enter the following URL in the Location (or Address ) box to display the Remo-
teUI page.
http://printer IP address or name/
Example: http://xxx.xxx.xxx.xxx/

2 Select Administrator Mode and click Logon.

Note
• If a password has been set on the printer, enter the password.

3 Click Network in the Device Manager menu at left to display the Network page.

4 Click Reset to Default settings in the lower-right corner of the Network Interface group.

5 After confirming the message, click OK to restore the network settings to the default values.

Note
• You can also use imagePROGRAF Device Setup Utility or the Control Panel to restore the default network set-

tings.
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Device Setup Utility (Windows)Device Setup Utility (Windows)
imagePROGRAF Device Setup Utility ..............................................................................................................461
Installing imagePROGRAF Device Setup Utility ............................................................................................... 461
Configuring the IP Address Using imagePROGRAF Device Setup Utility ......................................................... 461

imagePROGRAF Device Setup UtilityimagePROGRAF Device Setup Utility
imagePROGRAF Device Setup Utility is a utility to establish communication between the printer and your com-
puter by completing relevant settings. After the printer is installed, for example, you can use imagePROGRAF De-
vice Setup Utility to complete the network settings initially.

• Starting imagePROGRAF Device Setup Utility will show a list of printers found on the network. In this list,
select the printer (specifically, the printer's MAC address) that you want to set up, and then configure the basic
settings from your computer, such as the printer's IP address and the network frame type.

• You can see which printers are online in the network by checking the printer list. Communication between your
computer and these printers is possible.

Note
• We recommend that your network or printer administrator complete the setup work using imagePROGRAF Device

Setup Utility.

• For details, refer to the imagePROGRAF Device Setup Utility help.

Installing imagePROGRAF Device Setup UtilityInstalling imagePROGRAF Device Setup Utility
Install imagePROGRAF Device Setup Utility from the User Software CD-ROM provided with the printer as fol-
lows:

1 Insert the User Software CD-ROM in the CD-ROM drive.

2 On the Setup Menu window, click Install Individual Software.

3 Click Install in imagePROGRAF Device Setup Utility.

4 Follow the instructions on the screen to proceed with the installation.

Configuring the IP Address Using imagePROGRAF Device Setup UtilityConfiguring the IP Address Using imagePROGRAF Device Setup Utility
On a computer running Windows, you can use imagePROGRAF Device Setup Utility provided with the printer to
configure the printer's IP address. This topic describes how to configure the IP address using imagePROGRAF
Device Setup Utility.

Important
• To configure network settings, you must be logged in with administrative rights such as Administrator account.

We recommend that your network administrator configure the network settings.

Note
• For instructions on installing imagePROGRAF Device Setup Utility, see "Installing imagePROGRAF Device Setup

Utility." ➔P.461
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When specifying an IPv4 IP address

1
 

Start imagePROGRAF Device Setup Utility from
the start menu.

2 In the Device Name list displayed, select the printer to configure.

3 Choose Protocol Settings from the Printer menu.

4
 

Select the IPv4 tab.

5 In the Setting IP Address list, choose Manual.

6 Enter the IP address assigned to the printer and click the Set button.

7 Click OK after the Confirmation message is displayed.

8 Exit imagePROGRAF Device Setup Utility.

Note
• To configure the IP address automatically, choose Auto in the Setting IP Address list and select DHCP, BOOTP,

or RARP.

• You can also specify the subnet mask and default gateway.
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When specifying an IPv6 IP address

1
 

Start imagePROGRAF Device Setup Utility from
the start menu.

2 In the Device Name list displayed, select the printer to configure.

3 Choose Protocol Settings from the Printer menu.

4
 

Select the IPv6 tab.

5 In IPv6, select On.

6 When there is an IPv6-compatible router in the network environment, select On in Stateless Address.
Additionally, when there is an DHCPv6-compatible server in the network environment, select On in
DHCPv6.

Note
• When there is no IPv6-compatible router or DHCPv6-compatible server, select On in Manual and enter

the IPv6 Address and Prefix Length.

7 Click Set.

8 Click OK after the Confirmation message is displayed.

9 Exit imagePROGRAF Device Setup Utility.
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Status Monitor (Windows)Status Monitor (Windows)
The Features of imagePROGRAF Status Monitor ............................................................................................466
Job Management Using imagePROGRAF Status Monitor ............................................................................... 467

The Features of imagePROGRAF Status MonitorThe Features of imagePROGRAF Status Monitor
imagePROGRAF Status Monitor is a utility for checking the printer status and managing print jobs.
Two screens are available in imagePROGRAF Status Monitor : Printer List shows a list of printers, and Status
Monitor shows details for each printer.

• You can view a list of the printers for which printer drivers have been installed on your computer, printers con-
nected to your computer, and printers found on the network.

• If a printer error occurs, you can investigate the corrective action immediately.

• Printer status can be checked in real time on a computer monitor.

• Displays the ink level of every color in the printer. An icon and warning message will notify you when ink levels
are low.

• The type of paper loaded in each media source is identified. You can also check to see if paper has run out.

• This way, the utility enables you to check printer information and take care of printer maintenance for optimal
printing results.

• You can also set up automatic email notification of any printer problems or errors to email addresses you des-
ignate in advance.

• You can check the status of the hard disk and the documents saved on the hard disk.

• You can use the Accounting Manager to collect the print job logs for the printers and check information such
as the printing costs.
For details of the Accounting Manager, see "Accounting Manager." ➔P.470
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Note
• For details, refer to the imagePROGRAF Status Monitor help.

Job Management Using imagePROGRAF Status MonitorJob Management Using imagePROGRAF Status Monitor
You can use the Job sheet in imagePROGRAF Status Monitor for operations such as pausing and canceling print
jobs.

• Preempting Other Jobs
If you select a print job and click the Preempt Other Jobs button, the selected job is printed ahead of the job
that currently precedes it in the print queue.

• Pausing/Resuming Print Jobs
Selecting a print job and clicking the Pause button pauses printing of the selected job.
To resume printing of a paused print job, select the print job and click the Resume button.

Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/resumed.

• Canceling Print Jobs
Selecting a print job and clicking the Cancel Job button cancels printing of the selected job.

Note
• You cannot cancel other users' print jobs.

• Printing Held Jobs
Printing of the job with a Status of Holding is paused because the paper specified by the driver does not
match the paper currently loaded in the printer.
Use the procedure below to print the held job.

1 Select the held job and click the Replace Paper button.

2 Replace the paper in the printer with the correct paper.

Note
• To continue printing without changing the paper in the printer, select the held job and click Continue to print but-

ton.

• The printing behavior when the paper specified by the driver does not match the paper currently loaded in the print-
er can be changed by using Detect Mismatch in the operation panel menu. Refer to "Menu Settings" ➔P.416  for
details.
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Printmonitor (Mac OS)Printmonitor (Mac OS)
The Features of imagePROGRAF Printmonitor ............................................................................................... 468
Job Management Using imagePROGRAF Printmonitor ...................................................................................469

The Features of imagePROGRAF PrintmonitorThe Features of imagePROGRAF Printmonitor
imagePROGRAF Printmonitor is a utility for checking the printer status and managing print jobs.

• Printer status can be checked in real time on a computer monitor.
• You can check the status of print jobs, cancel jobs, and manage them as needed.
• If a printer error occurs, you can investigate the corrective action immediately.

• You can also set up automatic email notification of any printer problems or errors to email addresses you des-
ignate in advance.

• You can check the status of the hard disk and the documents saved on the hard disk.

Note
• If the status of the desired printer is not shown in imagePROGRAF Printmonitor, select the printer again as follows.

1. Make sure the printer is on and connected to the network or to a local port.

2. In the Printer menu, select the name of the desired printer. After the printer is detected, the printer status is
shown.

3. If information about the printer is not shown in step 2, choose Search Printer in the Printer menu. Printer
names listed in the Printer menu are updated with the printers that are now detected.

4. In the Printer menu, select the name of the desired printer. After the printer is detected, the printer status is
shown.
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Job Management Using imagePROGRAF PrintmonitorJob Management Using imagePROGRAF Printmonitor
You can use the Driver Panel in imagePROGRAF Printmonitor for operations such as pausing and canceling print
jobs.

• Pausing/Resuming Print Jobs

Selecting a print job and clicking the  button pauses printing of the selected job.

To resume printing of a paused print job, select the print job and click the  button.

Note
• Once all the print data for a print job has been sent to the printer, the job can no longer be paused/resumed.

• Canceling Print Jobs

Selecting a print job and clicking the  button cancels printing of the selected job.

Note
• You cannot cancel other users' print jobs.

• Preempting Other Jobs

If you select a print job and click the  button, the selected job is printed ahead of the job that currently
precedes it in the print queue.

• Printing Held Jobs
Printing of the job with a Status of Holding is paused because the paper specified by the driver does not
match the paper currently loaded in the printer.
Use the procedure below to print the held job.

1 Select the held job and click the Replace Paper button.

2 Replace the paper in the printer with the correct paper.

Note
• To continue printing without changing the paper in the printer, select the held job and click Continue to print but-

ton.
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Accounting (Windows)Accounting (Windows)
Accounting Manager ...................................................................................................................................... 470
Launching the Accounting Manager ............................................................................................................... 470
Accounting Manager Main Window ................................................................................................................ 471

Job List Area ........................................................................................................................................ 473

Accounting Manager Basic Procedures .......................................................................................................... 474
Configuring Unit Costs in Accounting Manager ............................................................................................... 474

Setting the Unit Cost for Ink ...................................................................................................................... 475
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Setting the Unit Cost for Items Other Than Ink and Paper ..........................................................................477

Configuring Units and Display Settings in Accounting Manager ...................................................................... 478

Automatically Acquiring Print Job Logs at Regular Intervals ............................................................................ 478
Canceling Regular Print Job Log Acquisition .................................................................................................. 479
Switching Between Displaying Jobs on Printer and Regularly Acquired Jobs .................................................. 479

Exporting Print Job Data as a CSV File ........................................................................................................... 479
Displaying Job Properties or Period Properties ............................................................................................... 480
Showing, Saving and Loading Selected Unit Cost Data .................................................................................. 481
Showing the Total Amount of Ink and Paper Consumed ................................................................................. 481

Accounting ManagerAccounting Manager
The Accounting Manager stores the printer's print job logs so that you can use the information for checking printing
costs, etc.
The benefits of using the Accounting Manager are outlined below.

• Print Job Log Collection
This allows you to check which documents were printed from each printer, who printed them and when.

• Calculation of the Total Pages Used and the Total Cost
This allows you to use the collected print job logs to calculate totals for items such as the number of pages
printed, the amount of paper used and the printing costs incurred.

• Regular Data Acquisition for Print Jobs
Job logs can be automatically collected periodically.

• Exporting Print Job Data
This allows you to export collected print job data as a CSV file.

Important
• The Accounting Manager in Status Monitor displays approximate estimates of the amount of paper consumed

and the ink consumed per job. Canon cannot guarantee the accuracy of these estimates. These estimates will
also vary depending on the conditions of printer use.

• Print job log collection is not performed when Set./Adj. Menu -> System Setup -> Show Job Log of the control
panel is Off. However,

• even if Show Job Log is set to Off, regularly acquired jobs that already have been retrieved at that time are
displayed.

• When Show Job Log has been set to On again, all jobs within the printer at that time are displayed.

Launching the Accounting ManagerLaunching the Accounting Manager
The procedure for launching the Accounting Manager is shown below.

1 Open the imagePROGRAF Status Monitor window.

Accounting Manager                                                                                                                                                                                              iPF785

                                                                                                                                                                                                                     User's Guide

  

Print Job M
anagem

ent
Accounting (W

indows)

 470



2
 

Select Accounting in the Accounting menu.
Or, open the Accounting sheet and click the Ac-
counting button.

Note
• If Show Job Log is set to off and an administrator password is configured in the printer, the administrator password

needs to be entered on startup.
If the password is correct, you are logged on as administrator and Accounting starts.
Furthermore, when you exit from Accounting, you can choose to log off as administrator.

• If you log off as administrator, you need to enter the password again the next time it starts.

• The administrator password can be set or cleared using Chg.Admin.Pswd/Init.Admin.Pswd in the Admin. Menu in
the Set./Adj. Menu in the printer.
The administrator menu can only be displayed and configured by the administrator.

Accounting Manager Main WindowAccounting Manager Main Window
The Accounting Manager main window consists of a title bar, menu bar, toolbars, listed job selection area, job list
area, totals area and status bar.

• Title Bar
This displays the printer model, its serial number and the port number it is using.

• Menu Bar
Allows you to select the menu options required for operation.

• Toolbars
Provide tool buttons and pull-down menus for the main operations.
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Note
• You can opt to either show or hide the toolbars in the View menu.

• Listed Job Selection Area
You can use this area to select which job log is displayed.
If you are using regular data acquisition, this area allows you to view the collective job logs for each specified
period.

For more information on how to select the job logs displayed, see "Switching Between Displaying Jobs on
Printer and Regularly Acquired Jobs." ➔P.479

• Job List Area
This area lists the details of acquired jobs.
Displays a list of the jobs in the printers or periodically acquired jobs.  (See "Job List Area.") ➔P.473

Note
• You can change the items that are displayed and the display order using the Advanced Display Settings

dialog box. The Advanced Display Settings dialog box can be displayed by selecting Advanced Display
Settings from the Show menu.

• Totals Area
Displays the total costs for the selected job and the amounts of paper and ink consumed.

Note
• If you are viewing regularly acquired print jobs, selecting a period on the left side of the window displays the

total costs for that period and the amounts of paper and ink consumed.
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• Status Bar
Displays messages and other information.

Job List AreaJob List Area
The job items and details that can be displayed in the job list area are as follows.

• No.
The job serial number.

• Job Cost
The cost of printing.

Note
• If the ink and paper unit costs are not set, **** is displayed.

• Document Name
This is the name of the printed document.

• Printing Results
OK is displayed when the print process was executed, and Cancel is displayed if the print process was not
executed.

• Media Type
This is the type of paper used in printing.

• Output Image Size
The size of the image used for printing.

Note
• If the job has multiple pages, the size of the last page is displayed.

• Paper Consumed
The area of paper used for printing.

Note
• The Paper Consumed may differ from the product of Paper Width and Paper Length.

• Paper Width
The width of paper used for printing.

Note
• If the job has multiple pages, the width of the last page is displayed.

• Paper Length
The length of paper used for printing.

• Ink Consumed
The amount of ink used for printing.
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• Owner
The sender of the job.

• Print Job Start Time/Print Time
The time when printing started and the time taken to print.

• Number of Pages
The number of pages printed.

• Roll Paper Width
The width of roll paper used for printing.

• Paper Cost
The cost of paper used for printing.

Note
• If the paper unit cost is not set, **** is displayed.

• Total Ink Cost
The total value of the cost of ink used for printing.

Note
• If the ink unit cost is not set, **** is displayed.

• Total of Other Costs
The total value of costs other than paper and ink.

• Ink Cost Details
The cost of each ink color.

• Ink Consumption Details
The amount of each color of ink used.

Accounting Manager Basic ProceduresAccounting Manager Basic Procedures
The first time you use the Accounting Manager, use the following procedures to configure the settings.

1 Configure unit costs, including the costs of ink and paper.
For details of the unit cost settings, see "Configuring Unit Costs in Accounting Manager." ➔P.474

2 Set options such as the units displayed.
For details of the unit settings, see "Configuring Units and Display Settings in Accounting Manag-
er." ➔P.478

3 If you are using Regular Data Acquisition, configure the Regular Data Acquisition settings.
For details of the Regular Data Acquisition settings, see "Automatically Acquiring Print Job Logs at Regular
Intervals." ➔P.478

4 Specify the jobs to be listed.
For details of how to select the job logs displayed, see "Switching Between Displaying Jobs on Printer and
Regularly Acquired Jobs." ➔P.479

This displays the required print job logs and lists the details.

Configuring Unit Costs in Accounting ManagerConfiguring Unit Costs in Accounting Manager
Select Unit Costs in the Settings menu to open the Unit Costs dialog box. Configure the unit cost settings in this
dialog box.

Note
• When you select a job and then open the Unit Costs dialog box, items with unit costs that have not yet been

configured for that job are shown highlighted.
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• Setting the Unit Cost for Ink ➔P.475
• Setting the Unit Cost for Paper ➔P.476
• Setting the Unit Cost for Items Other Than Ink and Paper ➔P.477

Setting the Unit Cost for InkSetting the Unit Cost for Ink
Open the Ink sheet. Set the unit cost for ink in this sheet.

To set the same unit cost for all the inks

1 Select the Use same price for all ink checkbox.

2 Enter the Tank Capacity and corresponding Price.

3 Click the OK button.

Important
• Your settings are not applied until you click the OK button.

To set different unit costs for each ink color

1 Select the ink color to be costed.

2 Enter the Tank Capacity and corresponding Price.

3 Click the Overwrite button.

4 Repeat steps 1 to 3 for all the inks.

5 Click the OK button.

Important
• Your settings are not applied until you click the OK button.
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Setting the Unit Cost for PaperSetting the Unit Cost for Paper
Opens the Paper sheet. This sheet is used to configure the unit cost of paper.

Setting Standard Prices

1 Select the media type in Media Type.

2 Enter the Width and Length of the paper, as well as the Price for the area of the configured width x height.

3 Click the Add button. To change the unit cost of a media type that has already been configured, click the
Overwrite button.

4 Click the OK button.

Important
• The settings are not applied until you click the OK button.

Specifying Price by Roll Paper

1 Select the media type in Media Type.

2
 

Click the Roll Paper Width Settings button to display the
Roll Paper Width Settings dialog box.
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3 Enter the Roll Paper Width and Length of the paper, as well as the Price for the configured length.

4 Click the Add button to return to the Paper sheet.

5 To change the unit cost of a media type that has already been configured, click the Overwrite button.

6 Click the OK button.

Important
• If you do not set the standard prices, you cannot set the price for each roll paper.

• If the Roll Paper Width is set to the same value as the Width of the paper configured in the standard prices, the
cost is calculated using the price configured in the Roll Paper Width Settings dialog box.

• The settings are not applied until you click the OK button.

Setting the Unit Cost for Items Other Than Ink and PaperSetting the Unit Cost for Items Other Than Ink and Paper
Open the Other sheet. Use this sheet to set any price for items other than inks and paper.

1 Enter any name in the Name field.

2 Enter a value in Unit Cost.

3 Use Allocated to specify whether the costs are allocated as being incurred by the print job.

4 Click the Add button. To change the unit cost for a media type you have already set, click the Overwrite
button.

5 Click the OK button.

Important
• Your settings are not applied until you click the OK button.
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Note
• You can set unit costs for up to 5 items.

Configuring Units and Display Settings in Accounting ManagerConfiguring Units and Display Settings in Accounting Manager
Select Units and Display in the Settings menu to open the Units and Display dialog box. Use this dialog box to
configure the display settings.

• Date Display Format
Use this option to select the display format for dates. "YYYY" indicates the year, "MM" the month and "DD" the
day.

• Currency Unit
Enter the currency unit. Enter a text string up to 3 characters long.

• 1000 Separator
Use this option to select the symbol used as a separator in numbers. The symbol is inserted every 3 digits.

• Decimal Symbol
Use this option to select the symbol used as a decimal point.

• Ink Consumed
Use this option to select the unit used for ink consumption.

• Paper Width
Use this to select the unit used for paper width.

• Paper Length
Use this to select the unit used for paper length.

• Area Display Format
Use this to select the unit used for paper area.

Automatically Acquiring Print Job Logs at Regular IntervalsAutomatically Acquiring Print Job Logs at Regular Intervals
This feature collects print job logs from the printer at regular intervals and saves the logs on your computer.

1 Select Regular Data Acquisition in the Settings menu.

2 Select Acquire print job logs regularly.

3 Click the OK button to close the dialog box.

Important
• Print job log collection is not performed when Set./Adj. Menu -> System Setup -> Show Job Log of the control

panel is Off. However, even if Show Job Log is set to Off, regularly acquired jobs that already have been re-
trieved at that time are displayed.
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Note
• Immediately after you configure Regular Data Acquisition, no print jobs are displayed. Wait a few moments and

then select Refresh in the View menu to display the print jobs.

• A maximum of 10,000 records are saved in a print job log. If this number is exceeded, jobs are deleted from the log
starting from the oldest record. To save old data, it is recommended that you export the data as a CSV file.
For details of how to export print job logs as CSV files, see "Exporting Print Job Data as a CSV File." ➔P.479

Canceling Regular Print Job Log AcquisitionCanceling Regular Print Job Log Acquisition
You can use this procedure to cancel the regular acquisition of print job logs from printers.

1 Select Regular Data Acquisition in the Settings menu.

2 Uncheck the Acquire print job logs regularly option.

3 Click the OK button to close the dialog box.

Switching Between Displaying Jobs on Printer and Regularly Acquired JobsSwitching Between Displaying Jobs on Printer and Regularly Acquired Jobs
The print job logs displayed by the Status Monitor Accounting Manager contain two types of job: Jobs on Printer
and Regularly Acquired Jobs.
You can select whether to display Jobs on Printer or Regularly Acquired Jobs in the Listed Job Selection Area on
the left side of the window.

• Jobs on Printer
This shows a list of the print jobs currently held on printers.
You can change the number of jobs displayed per page using the Print Jobs Shown Per Page setting in the
View menu or the toolbar.
You can skip to a particular page using the Go to option in the View menu or the toolbar.

Note
• For printers with built-in hard disks, you can view up to 500 print jobs per printer.

• For printers without built-in hard disks, you can view up to 32 print jobs per printer. However, only 10 jobs can
be displayed if the printer is switched off.

• Regularly Acquired Jobs
This shows a list of regularly acquired print jobs.
To view all the jobs in a set period, specify the period using Calculate Total for Period and then Starting
Date (or Starting Day of Week or Starting Month) in the View menu or the toolbar.
For example, to view monthly job logs starting on the 1st of each month, set Calculate Total for Period to
Monthly and set Starting Date to 1.

Note
• Up to 10,000 regularly acquired jobs are displayed for each printer.

Exporting Print Job Data as a CSV FileExporting Print Job Data as a CSV File
You can export the collected print job data in the form of a CSV file by selecting Export Job Cost Data in the File
menu.

Note
• You can also select Export Job Cost Data using the icon in the toolbar.

• Selected Jobs
Exports the data for the selected print jobs in the job list as a CSV file.

Note
• You can select multiple jobs by holding down the Shift key or Ctrl key as you click the job names.
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• Listed Jobs
Exports the data for the print jobs currently displayed in the list as a CSV file.

Displaying Job Properties or Period PropertiesDisplaying Job Properties or Period Properties
You can display the Job properties dialog box or Period Properties dialog box to check detailed cost information
and other items.
The Job properties dialog box displays detailed information about the selected job.
The Period Properties dialog box displays detailed information within the Regularly Acquired Jobs period.

• Displaying the Job properties Dialog Box
Select a job from the job list, and then select Show Job Properties from Job properties in the File menu.
You can also select multiple jobs at once.

Note
• You can also display the dialog box by selecting a job, right-clicking it, and then selecting Show Job Proper-

ties, or by using the icon in the toolbar.

• Displaying the Period Properties Dialog Box
Select a period from the Regularly Acquired Jobs list, and then select Show Period Properties from Job
properties in the File menu. You can also select multiple periods at once.

Note
• You can also display the dialog box by selecting and right-clicking a period and then selecting Show Period

Properties, or by using the icon in the toolbar.

• Components of the Job properties Dialog Box/Period Properties Dialog Box

• Job tab
Displays detailed information about the selected job. You can display detailed information about each job
by selecting the corresponding Document Name.

• Owner tab
You can display detailed information about each owner by selecting the corresponding Owner.

• Copy button
Click this button to copy the displayed text information to the clipboard.
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Showing, Saving and Loading Selected Unit Cost DataShowing, Saving and Loading Selected Unit Cost Data
• Show Unit Cost Data

Select Show Unit Cost Data in the File menu to open the Unit Cost Data dialog box. This lists the unit costs
for items such as the selected ink and paper.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

• Save Unit Cost Data
Select a destination folder using Save Unit Cost Data in the File menu. The unit cost data for items such as
the selected ink and paper is saved as a file.

• Load Unit Cost Data
Selecting Load Unit Cost Data in the File menu loads saved unit cost data.

Showing the Total Amount of Ink and Paper ConsumedShowing the Total Amount of Ink and Paper Consumed
Select Show Ink and Paper Consumed in the File menu to open the Show Ink and Paper Consumed dialog
box.
This lists the total amounts of ink and paper consumed by the printer so far.
You can copy text-based information in this dialog box to the clipboard by clicking the Copy button.

Note
• Up to 7 types of media are listed in order of the amount consumed. The total consumption for other media types is

shown as Other.
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Using the Printer Hard DiskUsing the Printer Hard Disk
The printer can save print jobs on the built-in hard disk.
Using print jobs stored on the printer enables you to print the jobs again as needed without using a computer.

Saving print jobs offers the following benefits.

• Save the time spent using a computer
When you send a print job to the printer, you can save it on the printer after printing or simply save it on the
printer without printing it yet. Saved print jobs can be printed in the required quantity later without the need to
use a computer again.

• Simplify reprinting, if any errors occur
If errors occur in the middle of printing (as when paper runs out), you can resume printing after clearing the
error without resending the print job from a computer.

• Streamline printing work
Without using a computer, you can select print jobs and print in the desired quantity. You can also select multi-
ple print jobs to print during the same period. This enables unattended operation at night, for example.

Output Method
To save print jobs on the printer's hard disk, configure the printer driver.
In Windows, this is set using the Output Method dialog box.
In Mac OS, this is set using the Additional Settings pane.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.

• Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that occurs
when receiving a print job is interrupted and printing is aborted in the middle.
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Storage destination
The storage area on the printer's hard disk is divided into a temporary storage area and a permanent storage area.
The temporary storage area stores print jobs in the job queue or shared mailbox. The permanent storage area
stores jobs in personal boxes.

• Job queue
The job queue refers to print jobs that are being processed by the printer (saved, received, prepared for pro-
cessing, printed, deleted, or held). Up to 64 jobs can be stored in the temporary storage area.
When the job queue is full, additional jobs sent from a computer are treated as "standby" jobs, to be processed
when possible.
However, if all queued jobs are simply being held, the oldest job is deleted and the print job sent from the com-
puter is processed.

• Shared mailbox
Jobs for which you have specified Print in Output Method (in Windows) or Send job to (in Mac OS) are
saved in the shared mailbox and classified as saved jobs.
There is one shared mailbox, numbered 00. A password cannot be set for the shared mailbox.
Up to 100 print jobs can be saved here, but they will be deleted one after another starting with the oldest job in
the following situations.

• If there are more than 100 jobs queued and saved in the shared mailbox combined

• If no more temporary storage space is available when jobs for which you have selected Print in Output
Method (in Windows) or Send job to (in Mac OS) are received

• If there is not enough space in the temporary or permanent storage area when jobs for which you have
selected Save in mail box in Output Method (in Windows) or Send job to (in Mac OS) are received

• Personal boxes
Jobs are classified as saved jobs and saved in personal boxes in the following situations.

• When a saved job stored in the shared mailbox is moved to a personal box

• When you have selected Save in mail box as the option in Output Method (in Windows) or Send job to
(in Mac OS)

There are 29 personal boxes, numbered 01 to 29. You can specify a name and password for each personal
box.
Up to 100 print jobs can be saved in all personal boxes combined.

Saving Print Jobs on the Printer Hard DiskSaving Print Jobs on the Printer Hard Disk
To save print jobs on the printer's hard disk, configure the printer driver.
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Note
• Printing from the following software also enables you to save print jobs on the printer's hard disk.

Windows

• Free Layout ➔P.182
• Color imageRUNNER Enlargement Copy ➔P.203
• Preview ➔P.172

Mac OS

• Free Layout ➔P.289
• Color imageRUNNER Enlargement Copy ➔P.312
• Preview ➔P.172

Configuring the Printer Driver in Windows

1
 

Access the Page Setup sheet.

2
 

Click Output Method to display the Output Method
dialog box.

3 Make your selection in Output Method.

• Print
Save print jobs on the printer's hard disk after printing.
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• Save in mail box
Save print jobs on the printer's hard disk.
If you choose Save in mail box, also specify the destination personal box in the Mail box list.

• Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that oc-
curs when receiving a print job is interrupted and printing is aborted in the middle.

Note
• Click Acquire Mail Box Name to display personal box names in the Mail box list, as acquired from the

printer.

4 In Name of data to be saved, specify how to name saved print jobs.

• To use the file name, choose Use file name.
• Otherwise choose Enter name and enter a name in Name.

5 Click OK to close the Output Method dialog box.

Configuring the printer driver in Mac OS

1
 

Access the Additional Settings pane.

2 Make your selection in Send job to.

• Print
Save print jobs on the printer's hard disk after printing.

• Save in mail box
Save print jobs on the printer's hard disk.
The Destination dialog box is displayed if you
select Save in mail box. Here, specify the name
and personal box number for saved print jobs.

1. In Document title, enter a name to identify saved print jobs.

Note
• If printed from Free Layout or Preview, the Document title is saved under the name image-

PROGRAF.
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2. Select the personal box number in the Mail box list.

3. Click OK to close the Destination dialog box.

• Print after reception is complete
This option is available in combination with Print. You can prevent degradation of print quality that oc-
curs when receiving a print job is interrupted and printing is aborted in the middle.

Managing the Job Queue (Deleting or Preempting Other Jobs)Managing the Job Queue (Deleting or Preempting Other Jobs)
Print jobs being processed by the printer are collectively called the job queue. You can delete or preempt jobs in
the job queue as needed.
These operations are available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

• Delete
Note that only jobs that are not currently being deleted can be deleted from the job queue.

• Preempting other jobs
You can preempt other jobs by printing jobs that are currently being received or prepared for processing first.

Note
• For information on managing jobs being held, see "Managing Pending Jobs (Printing or Deleting Jobs on

Hold)." ➔P.488

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).
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Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Manage the job queue as needed.

• Deleting jobs

1. Press ▲ or ▼ to select Print Job, and then press the OK button.

2. Press ▲ or ▼ to select the print job to delete, and then press the OK button.

3. Press ▲ or ▼ to select Delete, and then press the OK button.

• Preempting other jobs

1. Press ▲ or ▼ to select Print Job, and then press the OK button.

2. Press ▲ or ▼ to select the job to print first, and then press the OK button.

3. Press ▲ or ▼ to select Preempt Jobs, and then press the OK button.

Using RemoteUI
Manage jobs as needed on the Print Job page. For details, refer to the RemoteUI help file.

Using imagePROGRAF Status Monitor (Windows)
Manage jobs as needed on the Job sheet. For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)
Manage jobs as needed on the Driver sheet. For details, refer to the imagePROGRAF Printmonitor help file.

Managing Pending Jobs (Printing or Deleting Jobs on Hold)Managing Pending Jobs (Printing or Deleting Jobs on Hold)
If the type or size of paper loaded does not match the settings in the print job received when you have set Detect
Mismatch to Hold Job in the Control Panel menu, the print job is held on the printer as a pending job in the job
queue.
Manage held jobs such as these as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and im-
agePROGRAF Printmonitor.

Note
• As long as you do not manage held jobs from the Control Panel, imagePROGRAF Status Monitor, or imagePROG-

RAF Printmonitor, they will remain in the job queue. In this case, the printer processes the next job in the queue
without pausing.

• To print held jobs, replace the loaded paper with the paper specified in the print job.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).
"There are held jobs." is displayed if jobs are being held.

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu menu is displayed.

3 Press ▲ or ▼ to select Print Job, and then press the OK button.
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4
 

Press ▲ or ▼ to select the print job to manage, and then press the
OK button.
Held jobs are labeled with an icon.

5 Press ▲ or ▼ to select Print Anyway or Delete, and then press the OK button.

• If you choose Print Anyway
Press ▲ or ▼ to select Yes or No, and then press the OK button.

• If you choose Delete
Press ▲ or ▼ to select Yes or No, and then press the OK button.

Using RemoteUI
Manage jobs as needed on the Print Job page. For details, refer to the RemoteUI help file.

Using imagePROGRAF Status Monitor
Manage jobs as needed on the Job sheet. For details, see "Job Management Using imagePROGRAF Status Moni-
tor." ➔P.467
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Using imagePROGRAF Printmonitor
Manage jobs as needed on the Driver sheet. For details, see "Job Management Using imagePROGRAF Printmoni-
tor." ➔P.469

Printing Saved JobsPrinting Saved Jobs
Print saved print jobs stored on the printer's hard disk as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and im-
agePROGRAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.

4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.
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5 Press ▲ or ▼ to select Job List, and then press the OK button.

6 Press ▲ or ▼ to select the saved job, and then press the OK button.

7 Press ▲ or ▼ to select Print, and then press the OK button.

8 Specify the number of copies and press the OK button.

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.

 

2
 

Select the print job and click Resume.

3
 

On the Print Saved Document page, enter the
quantity to print in Copies and click OK.

For details, refer to the RemoteUI help.
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Using imagePROGRAF Status Monitor

1
 

On the Hard Disk sheet, select a box and click
Open.

Note
• Enter a password if one has been set.

 

2
 

In the Documents dialog box, select the print job and
click Print.

3
 

In the Print dialog box, enter the quantity to print in
Copies and click OK.
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Note
• The printing time initially indicates how long it took to finish printing one copy during the previous print job.

If you change the value in Copies, the printing time indicates the time it took to print one copy during the
previous print job multiplied by the number of copies.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor

1
 

On the Hard Disk pane, click ▶ by Inbox No./Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.

 

2
 

Select the saved job and click Resume Printing.
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3
 

In the Resume Printing dialog box, enter the quanti-
ty to print and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.

Deleting Saved JobsDeleting Saved Jobs
Delete saved print jobs stored on the printer's hard disk as follows.
This operation is available from the Control Panel, in RemoteUI, imagePROGRAF Status Monitor, and image-
PROGRAF Printmonitor.

Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.

4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Job List, and then press the OK button.

6 Press ▲ or ▼ to select the saved job, and then press the OK button.

7 Press ▲ or ▼ to select Delete, and then press the OK button.

8 Press ▲ or ▼ to select Yes, and then press the OK button.
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Using RemoteUI

1
 

On the Stored Job page, choose the mail box.

Note
• Enter a password if one has been set.

 

2
 

Select the print job and click Delete.

For details, refer to the RemoteUI help file.

Using imagePROGRAF Status Monitor

1
 

On the Hard Disk sheet, select a box and click
Open.
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Note
• Enter a password if one has been set.

 

2
 

In the Documents dialog box, select the print job and
click Delete.

For details, refer to the imagePROGRAF Status Monitor help file.

Using imagePROGRAF Printmonitor

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.
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2
 

Select the print job and click the Delete button.

For details, refer to the imagePROGRAF Printmonitor help file.

Moving Saved JobsMoving Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be moved from the current box to another box as fol-
lows.
However, jobs saved in personal boxes cannot be moved to the shared mailbox.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Important
• Jobs stored in the shared mailbox may be automatically deleted under some conditions. To prevent jobs from

being deleted, move them from the shared mailbox to personal boxes.  (See "Using the Printer Hard
Disk.") ➔P.482

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.
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2
 

Select the print job and click Move Document.

3
 

On the Move Document page, select the name or
number of the destination personal box in the Desti-
nation mail box list and click OK.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select a box and click
Open.

Note
• Enter a password if one has been set.
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2
 

In the Documents dialog box, select the print job and
click Move.

3
 

In the Move dialog box, select the destination per-
sonal box and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Mac OS)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.
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Note
• Enter a password if one has been set.

The password is a four-digit number.

 

2
 

Select the print job and click Move.

3
 

In the Move Document dialog box, select the desti-
nation personal box and click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Saving Print Jobs Sent from Sources Other than the Printer DriverSaving Print Jobs Sent from Sources Other than the Printer Driver
To save print jobs sent from software or systems other than the printer driver or applications provided with the print-
er, complete the Output Method and Print After Recv settings in the Control Panel menu.

Note
• Contact the software or system developer for information about support for this printer function.

Specifying Output Method
In Output Method, specify how to manage jobs, regarding printing and saving them.

• Print
Save print jobs automatically at the same time they are printed. (This is the default format.)

• Print (Auto Del)
Save print jobs temporarily at the same time they are printed and delete them after printing.

• Save: Box 01 (Here, the number represents a box number)
Save print jobs on the printer.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select System Setup, and then press the OK button.

 

iPF785                                                                                                                           Saving Print Jobs Sent from Sources Other than the Printer Driver

User's Guide                                                                                                                                                                                                                     

  

Print Job M
anagem

ent
Advanced Print Job O

perations

501  



4 Press ▲ or ▼ to select Output Method, and then press the OK button.

Note
• If a password has been set on the printer, the Logon screen is displayed.

To change the settings, select Administrator and press the OK button. When the Admin.Pswd screen is
displayed, enter the password and press the OK button to proceed to the next step.
If you select User and press the OK button, you can check settings values but cannot change them.

5 Press ▲ or ▼ to select Print, Print (Auto Del), or Save: Box 01.
Follow these steps only when you select Save: Box 01.

6 Press ▲ or ▼ to select the box, and then press the OK button.

Specify Print After Recv
To save print jobs on the hard disk before printing, specify Print After Recv.
Printing will start when Print After Recv is set to On, even if you have selected Save: Box 01 in Output Method.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Print After Recv, and then press the OK button.

5 Press ▲ or ▼ to select On or Off, and then press the OK button.

Printing Without Saving Jobs in the Common BoxPrinting Without Saving Jobs in the Common Box
Jobs sent from a computer for which you have selected Print in Output Method (in Windows) or Send job to (in
Mac OS) in the printer driver are saved in the shared mailbox.  (See "Using the Printer Hard Disk.") ➔P.482
When Save: Common Box is Off in the Control Panel menu, print jobs for which you have selected Print in the
Output Method dialog box of the printer driver are deleted from the shared mailbox after printing.
Use this function when printing highly confidential documents.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.
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3 Press ▲ or ▼ to select System Setup, and then press the OK button.

4 Press ▲ or ▼ to select Save: Common Box, and then press the OK button.

Note
• If a password has been set on the printer, the Logon screen is displayed.

To change the settings, select Administrator and press the OK button.
When the Admin.Pswd screen is displayed, enter the password and press the OK button to proceed to
the next step.
If you select User and press the OK button, you can check settings values but cannot change them.

5 Press ▲ or ▼ to select Off, and then press the OK button.

Setting Passwords for Personal BoxesSetting Passwords for Personal Boxes
For greater security, you can specify a password for personal boxes. After you set a password, it will be required to
modify the personal box settings, as well as to display, print, delete, move, and modify jobs saved in the personal
box.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Note
• By default, no passwords are set for personal boxes.
• A password cannot be set for the shared mailbox.
• Enter a four-digit number as the password, in the range 0001–9999.

• Even if you have set passwords, they are not required to access personal boxes in Administrator Mode in Remo-
teUI.

Using RemoteUI

1 On the Stored Job page, choose the personal box.

2
 

Click Edit.

3 In the Set/Register User's Inbox dialog box, specify the password and click OK.

• Set Password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Confirmation Number
Re-enter the password to confirm it.
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For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select the personal box and
click Open.

2
 

In the Documents dialog box, click Settings.

3 In the Settings dialog box, specify the password and click OK.

• Set password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Re-enter to confirm
Re-enter the password to confirm it.
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For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Mac OS)

1
 

On the Hard Disk pane, click ▶ by Inbox No./Name.
Select a saved job in the list and click Set.

2 In the Settings dialog box, specify the password and click OK.

• Set password
Select the check box.

• Password
Enter the password. (This field is limited to four digits in the range 0001–9999.)

• Verify
Re-enter the password to confirm it.

For details, refer to the imagePROGRAF Printmonitor help file.
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Naming Personal BoxesNaming Personal Boxes
For easier identification, you can assign names to personal boxes.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1
 

On the Stored Job page, choose the personal box.

Note
• Enter a password if one has been set for the per-

sonal box.

 

2
 

Click Edit.

3
 

In the Set/Register User's Inbox dialog box, enter
the name in Inbox Name and click OK.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select the personal box and
click Open.

Note
• Enter a password if one has been set for the per-

sonal box.

 

2
 

In the Documents dialog box, click Settings.

3
 

In the Settings dialog box, enter the name and click
OK.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name. Select a saved job in the list and click Set.

Note
• Enter a password if one has been set.

The password is a four-digit number.

 

2
 

In the Settings dialog box, enter the name and click
OK.

For details, refer to the imagePROGRAF Printmonitor help file.

Displaying a List of Saved JobsDisplaying a List of Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be listed by box as follows.
These operations are available from the Control Panel or in RemoteUI, imagePROGRAF Status Monitor, and im-
agePROGRAF Printmonitor.
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Using the Control Panel

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.

4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Job List, and then press the OK button.

Using RemoteUI
On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.
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Jobs saved in the box are listed.

For details, refer to the RemoteUI help.
 

Using imagePROGRAF Status Monitor (Windows)
On the Hard Disk sheet, select a box and click Open.

Note
• Enter a password if one has been set.

Jobs saved in that box are displayed in the Documents dialog box.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)
On the Hard Disk pane, click ▶ by Inbox No./Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.

For details, refer to the imagePROGRAF Printmonitor help file.

Printing a List of Saved JobsPrinting a List of Saved Jobs
The list of print jobs stored on the printer's hard disk (saved jobs) can be printed by box as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Job tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Job Menu is displayed.

3 Press ▲ or ▼ to select Stored Job, and then press the OK button.
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4 Press ▲ or ▼ to select the box number (in the range 00–29), and then press the OK button.

Note
• Enter a password if one has been set, and then press the OK button.

5 Press ▲ or ▼ to select Print Job List, and then press the OK button.

Displaying Details of Saved JobsDisplaying Details of Saved Jobs
Details of print jobs stored on the printer's hard disk (saved jobs) can be displayed as follows.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.

 

2
 

Select the print job and click Details.

The Details of the saved document page is dis-
played.

For details, refer to the RemoteUI help file.
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Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select a box and click
Open.

Note
• Enter a password if one has been set.

 

2
 

In the Documents dialog box, select the print job and
click Properties.

The Properties dialog box is displayed.

For details, refer to the imagePROGRAF Status Monitor help file.
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Using imagePROGRAF Printmonitor (Mac OS)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.

Note
• Enter a password if one has been set.

The password is a four-digit number.

 

For details, refer to the imagePROGRAF Printmonitor help file.

Renaming Saved JobsRenaming Saved Jobs
Print jobs stored on the printer's hard disk (saved jobs) can be renamed as follows.
This operation is available in RemoteUI, imagePROGRAF Status Monitor, and imagePROGRAF Printmonitor.

Using RemoteUI

1
 

On the Stored Job page, choose the box.

Note
• Enter a password if one has been set.
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2
 

Select the print job and click Details.

3
 

On the Details of the saved document page, click
Change Document.

4
 

In the Rename Saved Document dialog box, enter
the name and click OK.

For details, refer to the RemoteUI help file.
 

Using imagePROGRAF Status Monitor (Windows)

1
 

On the Hard Disk sheet, select a box and click
Open.
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Note
• Enter a password if one has been set.

 

2
 

In the Documents dialog box, select the print job and
click Properties.

3
 

In the Properties dialog box, enter the new name
and click OK.

For details, refer to the imagePROGRAF Status Monitor help file.
 

Using imagePROGRAF Printmonitor (Mac OS)

1
 

In the Hard Disk pane, click ▶ next to Inbox No./
Name.
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Note
• Enter a password if one has been set.

The password is a four-digit number.

 

2
 

Select the print job and click Set.

3
 

In the Settings dialog box, enter the new name and
click OK.

For details, refer to the imagePROGRAF Printmonitor help file.
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Adjusting the PrintheadAdjusting the Printhead
Adjusting the Printhead .................................................................................................................................. 520

Automatic Adjustment to Straighten Lines and Colors ............................................................................... 520
Manual Adjustment to Straighten Lines and Colors ....................................................................................521
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Troubleshooting Paper Abrasion and Blurry Images ........................................................................................ 525

Adjusting the PrintheadAdjusting the Printhead
If printed documents are affected by the following problems, try adjusting the printhead.

• Printing is faint or affected by banding in different colors
Execute Nozzle Check to check for printhead nozzle clogging.
For instructions, see "Checking for Nozzle Clogging." ➔P.544

• Printed vertical lines are warped or colors are out of alignment
Execute Head Posi. Adj. to adjust the printhead position.
Normally, execute Auto(Standard) or Auto(Advanced). However, when using special paper or if printing is
not improved after executing Auto(Advanced), try Manual.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520
 (See "Manual Adjustment to Straighten Lines and Colors.") ➔P.521

• Printed lines are misaligned
Execute Head Inc. Adj. to adjust the angle of inclination of the printhead.
Even slight misalignment can be corrected.
 (See "Adjusting Line Misalignment.") ➔P.523

• Paper rubs against the printhead, or image edges are blurred
Executing Head Height to adjust the printhead height may improve printing results.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

Automatic Adjustment to Straighten Lines and ColorsAutomatic Adjustment to Straighten Lines and Colors
If printed vertical lines are warped or colors are out of alignment, execute Head Posi. Adj. to adjust the Printhead
alignment.
There are two modes for automatic Printhead adjustment: Auto(Standard) and Auto(Advanced).
Auto(Standard) will fix most slight image distortion or color misalignment, but if not, try Auto(Advanced).
Use Auto(Standard) or Auto(Advanced) to have the printer print and read a test pattern for automatic adjustment
of the Printhead.

Important
• This function is not available with Tracing Paper, Translucent Matte Film, or Clear Film.

• If adjustment is not possible as expected using special media, try another type of paper, or try Manual adjust-
ment.
 (See "Manual Adjustment to Straighten Lines and Colors.") ➔P.521

Note
• Because the results of adjustment vary depending on the type of paper used for adjustment, use the same type of

paper as you will use for printing.

• Use Auto(Standard) if you have switched to another type of paper or if you want the boundaries between colors to
appear as clear as possible.

• Use Auto(Advanced) to fine-tune the space between nozzles or colors if you have switched the printhead or if
clearer printing is required. We recommend Auto(Advanced) for printing at the highest level of quality.
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Paper to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Auto(Standard) : One sheet of unused paper of at least A4/Letter size
Auto(Advanced): Six sheets of unused paper of at least A4/Letter size (or one sheet when using A2 or larg-
er)

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

Important
• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment

cannot be completed correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6 Press ▲ or ▼ to select Auto(Standard) or Auto(Advanced), and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll or a sheet of A2 size or larger.

7 If you are printing on sheets smaller than A2 size for Auto(Advanced), a confirmation message is dis-
played requesting you to continue printing. Press the OK button and follow the instructions displayed.

Manual Adjustment to Straighten Lines and ColorsManual Adjustment to Straighten Lines and Colors
If printed vertical lines are warped or colors are out of alignment, execute Head Posi. Adj. to adjust the Printhead
alignment.
Normally, execute Standard.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520
However, when printing on special paper, or if printing is not improved after Standard, try Manual.
Manual adjustment requires you to examine the printed test pattern and enter an adjustment value.
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Note
• We recommend using the type of paper you use most often for adjustment.

Items to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets Two sheets of unused paper, A4/Letter size (or one sheet when using A2)

Perform adjustment as follows.

1 Load paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

Important
• Always make sure the loaded paper matches the type of paper specified on the printer. Adjustment

cannot be completed correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Posi. Adj., and then press the OK button.

6 Press ▲ or ▼ to select Manual, and then press the OK button.
A test pattern is printed for adjustment.

Note
• Manual may be unavailable in some cases, even if it is displayed in the menu.

If so, execute Standard once.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520

• If you printed on cut sheets, follow the instructions on the Display Screen and use another sheet of the
same type of paper.

7 Press ▲ or ▼ to select D, and then press the OK button.

8 Press ▲ or ▼ to select D-1, and then press the OK button.
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9
 

Examine adjustment test pattern D-1 and determine the number
with straight lines.

Note
• If two patterns seem equally good and you cannot decide which one is better, choose an intermediate

value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.

10 Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.

11 Repeat steps 8–10 to specify the adjustment value for D-2 to D-17.
Note that D-6 and D-12 cannot be configured.

12 Press the Back button.

13 Press ▲ or ▼ to select Register Setting, and then press the OK button.

14 Press ▲ or ▼ to select Yes, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Adjusting Line MisalignmentAdjusting Line Misalignment
If printed lines are misaligned, execute Head Inc. Adj. to adjust the angle of inclination of the Printhead. Executing
Head Inc. Adj. requires you to examine a printed test pattern and enter an adjustment value.

Paper to Prepare
Rolls An unused roll at least 10 inches wide

Sheets One sheet of unused paper of at least A4/Letter size

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

Note
• When loading paper, specify the type of paper correctly. Using paper that you have not specified on the

printer may cause feeding problems and affect the printing quality.

• We recommend loading a type of paper that you use often.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Head Inc. Adj., and then press the OK button.
After the Carriage is moved, a message is displayed requesting you to open the Top Cover.

6
 

Open the Top Cover.

Important
• If you accidentally move the Carriage, you will hear a warning tone. In this case, close the Top Cover.

7
 

Align the Angle Adjustment Lever with the red square and
close the Top Cover.

A test pattern is printed for adjustment.

Important
• Do not touch the Linear Scale (a) or Carriage Shaft

(b). Touching these parts may damage them.

 

8
 

Examine the test pattern for adjustment. Determine
the straightest set of lines.
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9
 

Open the Top Cover and move the Angle Adjustment Lever
to match the number (or the square) of the straightest set
of lines.
If no single set of lines is perfectly straight, move the Angle
Adjustment Lever to a position between the numbers (or
between the number and the square) of the two sets of
lines that are least misaligned.

10
 

Close the Top Cover.
The Printhead is now straight, and adjustment is complete.

Troubleshooting Paper Abrasion and Blurry ImagesTroubleshooting Paper Abrasion and Blurry Images
The Printhead height setting affects printing quality.
Specifying a low Printhead height makes images clearer and enhances printing quality but may cause paper to rub
against the Printhead.
On the other hand, specifying a high Printhead height will prevent paper from rubbing against the Printhead but
may reduce the printing quality.

Important
• Paper rubbing against or becoming caught on the Printhead may jam or result in printed documents that are

soiled.

Note
• Raise or lower the printhead, depending on the nature of the problem.

 (See "Paper rubs against the Printhead.") ➔P.584
 (See "The edges of the paper are dirty.") ➔P.585
 (See "Image edges are blurred or white banding occurs.") ➔P.588

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.
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4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• When Head Height is set to Automatic, the setting value selec-

ted for the previous print job is displayed (to the right of Auto-
matic ) once you select the type of paper currently supplied.
However, the value is cleared when the printer is turned off or
the paper is replaced.

 

5 Press ▲ or ▼ to select Head Height, and then press the OK button.

6 Press ▲ or ▼ to select the desired setting value, and then press the OK button.

Note
• Using Automatic will ensure that the printer adjusts the Printhead height to the optimal level before print-

ing, accounting for the ambient temperature and humidity. When a setting other than Automatic is used,
that value will always be applied.

• Depending on the type of paper, some setting values may not be available.
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Adjusting the feed amountAdjusting the feed amount
Adjusting the Feed Amount ............................................................................................................................ 527

Selecting a Feed Amount Adjustment Method ........................................................................................... 527
Automatic Banding Adjustment ................................................................................................................. 528
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Fine-Tuning the Paper Feed Amount ......................................................................................................... 531
Adjusting Line Length ................................................................................................................................ 531

Adjusting the Vacuum Strength ...................................................................................................................... 533

Adjusting the Feed AmountAdjusting the Feed Amount
If printed documents are affected by the following problems, try adjusting the feed amount.

• Banding in different colors
• Line length is not accurate in the direction paper is fed

To adjust the feed amount, do the following, in this order.

1 Depending on the issue, adjust Adj. Priority to suit the particular type of paper.
 (See "Selecting a Feed Amount Adjustment Method.") ➔P.527

2 Execute Adj. Quality or Adjust Length, depending on the selection in Adj. Priority.
 (See "Automatic Banding Adjustment.") ➔P.528
 (See "Manual Banding Adjustment.") ➔P.529
 (See "Adjusting Line Length.") ➔P.531

3 After executing Adj. Quality, execute Adj. Fine Feed for further adjustment as needed.
 (See "Fine-Tuning the Paper Feed Amount.") ➔P.531

Selecting a Feed Amount Adjustment MethodSelecting a Feed Amount Adjustment Method
Methods of adjusting the amount paper is fed are set in Adj. Priority.
Adjust Adj. Priority to suit your particular printing application.

• Print Quality: Adjusts the feed amount to reduce banding across the sheet in printed documents.
Adj. Quality settings are applied. When Adj. Fine Feed is executed, the Adj. Fine Feed settings are applied
in addition to the Adj. Quality settings.

• Print Length: Adjusts the feed amount for better accuracy of lines in printed documents.
The settings of A:High or B:Standard/Draft in Adjust Length are applied.

• Automatic: Print Quality or Print Length is selected, depending on Print Priority as selected in the printer
driver at the time of printing.
Image or Office Document: Print Quality is selected.
Line Drawing/Text: Print Length is selected.

Note
• Either A:High or B:Standard/Draft in the Adjust Length menu is applied, depending on printer driver settings at

the time of printing.

• If you have selected Easy Settings in the printer driver, follow these steps to confirm the Print Priority setting.

• Windows: Click View Settings on the Main tab to display the View Settings dialog box.

• Mac OS: Click View set. on the Main pane to display the View set. dialog box.

Follow these steps to configure the settings.

1 Load the paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358
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2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adj. Priority, and then press the OK button.

7 Press ▲ or ▼ to select Automatic, Print Quality, or Print Length, and then press the OK button.

Automatic Banding AdjustmentAutomatic Banding Adjustment
If printed images are affected by banding in different colors across the sheet, execute Adj. Quality for automatic
adjustment of the paper feed amount.
There are two modes of automatic adjustment to correct banding: Auto(GenuinePpr) and Auto(OtherPaper). In
either mode, the printer prints and reads a test pattern for automatic adjustment of the feed amount.

• Auto(GenuinePpr)
Use this mode with paper identified in the Paper Reference Guide.
 (See "Types of Paper.") ➔P.328

• Auto(OtherPaper)
Use this mode with paper not in the Paper Reference Guide, or if Auto(GenuinePpr) does not eliminate
banding.
 (See "Types of Paper.") ➔P.328

Note
• Always check the Adj. Priority values before using Auto(GenuinePpr) or Auto(OtherPaper).

 (See "Selecting a Feed Amount Adjustment Method.") ➔P.527

• Adjustment is not possible with Auto(GenuinePpr) and Auto(OtherPaper) when using highly transparent media.
In this case, use Manual adjustment.
 (See "Manual Banding Adjustment.") ➔P.529

• If additional fine-tuning is necessary after Auto(GenuinePpr) and Auto(OtherPaper), execute Adj. Fine Feed.
 (See "Fine-Tuning the Paper Feed Amount.") ➔P.531

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
 (See "Adjusting Line Length.") ➔P.531

• This may take some time, depending on the type of paper.

• Use paper of the same type and size for adjustment as you will use for printing.

Items to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Auto(GenuinePpr) : One sheet of unused paper, A4/Letter size
Auto(OtherPaper) : Two sheets of unused paper, A4/Letter size (or one sheet when using A2)
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Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

Note
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be comple-

ted correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adj. Quality, and then press the OK button.

7 Press ▲ or ▼ to select Auto(GenuinePpr) or Auto(OtherPaper), and then press the OK button.
A test pattern is printed for adjustment.
Adjustment is now finished if you have printed on a roll or a sheet of A2 size or larger.

8 If you are printing on sheets smaller than A2 size for Auto(OtherPaper), a confirmation message is shown
on the Display Screen requesting you to continue printing.
Press the OK button and follow the instructions on the Display Screen.

Manual Banding AdjustmentManual Banding Adjustment
If printed images are affected by banding in different colors, execute Adj. Quality for adjustment of the paper feed
amount.
Use Manual adjustment with highly transparent media or other paper for which Auto(GenuinePpr) or Auto(Other-
Paper) cannot be used.
 (See "Automatic Banding Adjustment.") ➔P.528
Manual adjustment requires you to enter an adjustment value after a test pattern is printed.

Note
• Use paper of the same type and size for adjustment as you will use for printing.

• Always check the Adj. Priority values before using Manual adjustment.
 (See "Selecting a Feed Amount Adjustment Method.") ➔P.527

• If additional fine-tuning is necessary after Manual adjustment, use Adj. Fine Feed
 (See "Fine-Tuning the Paper Feed Amount.") ➔P.531

• Use Adjust Length to ensure that lines in CAD drawings are printed at exactly the right length.
 (See "Adjusting Line Length.") ➔P.531
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Paper to Prepare
When Using Rolls An unused roll at least 10 inches wide

When Using Sheets Two sheets of unused paper of at least A4/Letter size

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be comple-

ted correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adj. Quality, and then press the OK button.

7 Press ▲ or ▼ to select Manual, and then press the OK button.
Test pattern A is printed for manual adjustment.

Note
• When printing on sheets, follow the instructions on the Display Screen and remove the sheet.

8
 

Examine test pattern A for adjustment. Determine the
pattern in which banding is least noticeable.

Note
• If banding seems least noticeable in two patterns but you cannot decide which one is better, choose an

intermediate value.
For example, choose 11 if you cannot decide whether pattern 10 or 12 is better.
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9 Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.
Test pattern B is printed for adjustment.

Note
• If you printed test pattern A on a sheet, follow the instructions on the Display Screen and use another

sheet of the same type of paper.
Additionally, after test pattern B is printed, follow the instructions on the Display Screen and remove the
sheet.

10 Examine test pattern B for adjustment. Determine the pattern in which banding is least noticeable.

11 Press ▲ or ▼ to select the pattern number you have decided, and then press the OK button.
The adjustment value is now registered, and adjustment is complete.

Fine-Tuning the Paper Feed AmountFine-Tuning the Paper Feed Amount
If the contrast is uneven or banding in different colors appears at 50 mm (2.0 in) intervals in printed documents, try
executing Adj. Fine Feed during printing to fine-tune the feed amount.

Note
• The Adj. Fine Feed menu is only displayed during printing.

Additionally, it is displayed when you have selected Automatic or Print Quality in Adj. Priority in Feed Priority.
 (See "Menu Settings.") ➔P.416

• Always execute Adj. Quality before Adj. Fine Feed.
Once you execute Adj. Quality, the Adj. Fine Feed value will revert to 0.
 (See "Automatic Banding Adjustment.") ➔P.528
 (See "Manual Banding Adjustment.") ➔P.529

Perform adjustment as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Adj. Fine Feed, and then press the OK button.

4 Press ▲ or ▼ to select a setting value in the range -5 to 5, and then press the OK button.
At this time, if banding in dark colors appears, select a setting value in the range 1 to 5, and if banding in
light colors appears, select a setting value in the range -1 to -5.

Adjusting Line LengthAdjusting Line Length
To ensure that lines in CAD drawings are printed at exactly the right length, use Adjust Length to adjust the
amount that paper is advanced.
There are two options in Adjust Length : AdjustmentPrint and Change Settings.

• AdjustmentPrint
After a test pattern is printed, you will measure the discrepancy based on the results of printing.

• Change Settings
No test pattern is printed. Instead, you will measure a document already printed to determine the discrepancy.
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Additionally, two modes are available in both AdjustmentPrint and Change Settings : A:High or B:Standard/
Draft. Choose the mode that suits your particular printing application.

• A:High
This setting is applied when Highest or High is selected in Print Quality in the printer driver.

• B:Standard/Draft
This setting is applied when Standard or Fast is selected in Print Quality in the printer driver.

Note
• Always check the Adj. Priority values before using Adjust Length.  (See "Selecting a Feed Amount Adjustment

Method.") ➔P.527

• Use paper of the same type and size for adjustment as you will use for printing.

Paper to Prepare
When Using Rolls • An unused roll at least 10 inches wide

• High-precision ruler

When Using Sheets • One sheet of unused paper of at least A4/Letter size
• High-precision ruler

Perform adjustment as follows.

1 Load the paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

Important
• Always make sure the loaded paper matches the type of paper specified. Adjustment cannot be comple-

ted correctly unless the loaded paper matches the settings.

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Adjust Printer, and then press the OK button.

5 Press ▲ or ▼ to select Feed Priority, and then press the OK button.

6 Press ▲ or ▼ to select Adjust Length, and then press the OK button.

7
 

Press ▲ or ▼ to select AdjustmentPrint or Change Settings, and
then press the OK button.
When you select AdjustmentPrint, a test pattern is printed for you to
measure the scale and calculate the discrepancy. The scale bar prints
Millimeter in 50 mm increments and Inch in 1-inch increments.
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Note
• A test pattern is printed in black when you choose A:High or in magenta if you choose B:Standard/Draft.

• To cancel printing the test pattern for adjustment, hold down the Stop button. When "Stop printing?" is
displayed, press ▲ or ▼ to select Yes, and then press the OK button.

8 Press ▲ or ▼ to enter the amount of discrepancy, and then press the OK button.
If the scale is shorter than the actual size, use a positive setting value. If it is longer, use a negative value.
The feed amount can be adjusted in 0.02% increments.

Adjusting the Vacuum StrengthAdjusting the Vacuum Strength
When printing on heavyweight paper or paper that curls or wrinkles easily, if the Printhead rubs against paper, ad-
justing the level of suction against paper on the Platen may improve results.

Important
• Paper rubbing against or becoming caught on the Printhead may jam or result in printed documents that are

soiled.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Paper tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Paper Menu is displayed.

3 Press ▲ or ▼ to select Paper Details, and then press the OK button.

4 Press ▲ or ▼ to select the type of paper, and then press the OK button.

Note
• When VacuumStrngth is set to Automatic, the setting value se-

lected for the previous print job is displayed (to the right of Auto-
matic ) once you select the type of paper currently supplied.
However, the value is cleared when the printer is turned off or
the paper is replaced.

 

5 Press ▲ or ▼ to select VacuumStrngth, and then press the OK button.

6 Press ▲ or ▼ to select the desired setting value, and then press the OK button.
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Ink TanksInk Tanks
When purchasing, check the Model number.

Shape Colors Model number Ink Type Capacity
Matte black PFI-107MBK Pigment ink

130 ml (4.4 fl oz)

Black PFI-107BK

Dye ink

Cyan PFI-107C

Magenta PFI-107M

Yellow PFI-107Y

Shape Colors Model number Ink Type Capacity
Matte black PFI-207MBK Pigment ink

300 ml (10.2 fl oz)

Black PFI-207BK

Dye ink

Cyan PFI-207C

Magenta PFI-207M

Yellow PFI-207Y

Note
• For instructions on Ink Tank replacement, see "Replacing Ink Tanks." ➔P.536

Replacing Ink TanksReplacing Ink Tanks

Compatible ink tanks
For information on the compatible ink tanks for this printer, see "Ink Tanks." ➔P.536
Replacement ink tanks in 130 ml (4.4 fl oz) and 300 ml (10.2 fl oz) capacities are supported.

Note
• Depending on the color, you can also use ink tanks of different capacities.

Precautions when handling ink tanks
Take the following precautions when handling ink tanks.

Caution
• For safety, keep ink tanks out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.
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Important
• There may be ink around the ink supply section of ink tanks you removed. Handle ink tanks carefully during re-

placement. The ink may stain clothing.

• Do not install used ink tanks in another model of printer.
This will prevent correct ink level detection, which may damage the printer or cause other problems.

• We recommend using up an Ink Tank in the course of printing within six months after breaking the seal. Printing
quality may be affected if you use older ink tanks.

• Do not leave the printer without ink tanks installed for extended periods (a month or more). Residual ink may
become clogged inside the printer and affect printing quality.

Confirm the message
When the ink level becomes low, a message is displayed on the Display Screen.
According to the message, replace the ink tank or prepare a new ink tank.  (See "When to Replace Ink
Tanks.") ➔P.541

If a message requests you to replace an Ink Tank, press the OK button. In this case, you can skip the step Access
the menu for ink tank replacement. Follow the instructions in Remove the ink tanks.

Important
• Do not remove an Ink Tank during initialization immediately after turning on the printer, or during printhead clean-

ing. Ink may leak out.

Note
• Ink Tank replacement is possible even during printing, when print jobs are being canceled, or when paper is being

advanced.

Access the menu for Ink Tank replacement

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Ink tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Ink Menu is displayed.

3 Press ▲ or ▼ to select Rep. Ink Tank, and then press the OK button.
A message on the Display Screen requests you to open the Ink Tank Cover.
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Remove the Ink Tank

1
 

Open the Ink Tank Cover and check the ink lamps.
Ink lamps flash when there is little ink left.

2
 

Press the tip of the Ink Tank Lock Lever of the color for replace-
ment horizontally and pull the Ink Tank Lock Lever up to open it.

3
 

Hold the Ink Tank by the grips and remove it. Press the OK but-
ton.

Important
• Do not turn off the printer while the Ink Tank is removed.

It may cause the interior of the Ink Tank Cover to become soiled.

• If there is still ink in the Ink Tank you removed, store it with the ink
holes (a) facing up. Otherwise, ink may leak and cause stains. Put
the Ink Tank in a plastic bag and seal it.

 

Note
• Dispose of used ink tanks according to local regulations.
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Installing Ink Tanks

1
 

Before opening the pouch, gently agitate the Ink Tank once or
twice. Agitate the ink in the Ink Tank by slowly rotating the Ink
Tank upside-down and right side up repeatedly.

Important
• After installing an ink tank, do not remove and shake it. Doing so may cause the ink to leak out.

• If you do not agitate the Ink Tank, the ink may settle, which may affect printing quality.

2
 

Open the pouch and remove the Ink Tank.

Important
• Never touch the ink holes or electrical contacts. This may cause stains, damage the Ink Tank, and affect

printing quality.

3
 

Press the OK button and install the Ink Tank into the holder as
shown, with the ink holes facing down.

Important
• Ink tanks cannot be installed in the holder if the color or ori-

entation is incorrect.
If the Ink Tank does not fit in the holder, do not force it in.
Check the Ink Tank serial number, the Ink Color Label, the
color of the Ink Tank, and the orientation of the Ink Tank be-
fore reinstalling it.
Forcing the Ink Tank into the holder may damage the print-
er.
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4
 

Push the Ink Tank Lock Lever closed until it clicks into place.

Important
• Do not push the Ink Tank in by hand.

Forcing the Ink Tank into the holder may damage the print-
er.

• If a 130 ml (4.4 fl oz) ink tank is installed facing the wrong
direction, the rotating part of the Ink Tank Lock Lever come
out of place.
If this happens, open the Ink Tank Lock Lever to return it to
the proper position.

 

 

5
 

Make sure the Ink Lamp is lit in red.

Note
• If the Ink Lamp is not lit, reinstall the tank.

6
 

Close the Ink Tank Cover.
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Checking Ink Tank LevelsChecking Ink Tank Levels
On the Display Screen, you can check how much ink is left in the ink tanks.
To check remaining Ink Tank levels, access the Tab Selection screen on the Control Panel and press ◀ or ▶ to
select the Ink tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

• If an error has occurred and the Tab Selection screen cannot be displayed, display Ink Info as follows.

1. Press the OK button to display Printer Info.
2. Press the ▲ or ▼ button to select Ink Info.
3. Press the OK button.

The remaining ink levels shown on the Display Screen correspond to the inks identified by the Color Label on the
bottom of the Display Screen.
These symbols may be displayed above the ink level: ! if ink is low, × if no ink is left, and ? if you have deactivated
ink level detection.
The remaining ink level is indicated as shown below.

If the Display Screen indicates to replace the Ink Tank, replace the Ink Tank. If a message is displayed indicating to
check the remaining ink levels, or after tasks that consume a lot of ink such as large-format printing or head clean-
ing, check the remaining levels and replace Ink Tank as needed.  (See "Replacing Ink Tanks.") ➔P.536

When to Replace Ink TanksWhen to Replace Ink Tanks
Replace or prepare to replace ink tanks in the following situations.

If a message for checking the ink is shown on the Display Screen
When there is little ink left, the Message Lamp is lit and "Not much ink is left." is shown on the Display Screen.
You can continue to print, but prepare to replace the Ink Tank.  (See "Checking Ink Tank Levels.") ➔P.541
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Before print jobs and maintenance that consume a lot of ink
If little ink is left, there may not be enough for large-format printing, head cleaning, and maintenance, which require
a lot of ink. In this case, replace or prepare to replace the Ink Tank before maintenance.

If a message for ink replacement is shown on the Display Screen
When ink runs out, the Message Lamp flashes, a message regarding Ink Tank replacement is shown on the Dis-
play Screen, and printing is disabled. Replace the Ink Tank at this point.

Attach the Ink Tank Cover to the printerAttach the Ink Tank Cover to the printer
If too much force is applied to the Ink Tank Cover while it is open, Ink Tank Cover may become detached from the
printer.
If the Ink Tank Cover has become detached from the printer, attach it using the following procedure.

Note
• Although the attachment procedure describes the Ink Tank Cover on the right side of the printer, the Ink Tank Cover

on the left side can also be attached using the same procedure.

1
 

Rotate the Ink Tank Cover attachment part and store it in the printer.
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2
 

Move the Ink Tank Cover horizontally to align the po-
sition with the printer.

3
 

Rotate the Ink Tank Cover and place it on the printer.

4
 

Push down on the near side of the Ink Tank Cover from the top until
it clicks.

5
 

Open the Ink Tank Cover and check that it is attached to the print-
er.
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PrintheadsPrintheads
Printhead ........................................................................................................................................................544

Checking for Nozzle Clogging .........................................................................................................................544
Cleaning the Printhead ................................................................................................................................... 545
Replacing the Printhead ................................................................................................................................. 546

PrintheadPrinthead
When purchasing, check the Model number.

Shape Model number

PF-04

Note
• For instructions on replacing the Printhead, see "Replacing the Printhead." ➔P.546

Checking for Nozzle CloggingChecking for Nozzle Clogging
If printing is faint or affected by banding in different colors, make sure the Printhead nozzles are clear by printing a
test pattern to check the nozzles.

Note
• Nozzles are periodically checked to ensure they are clear. Configure the settings on the Control Panel menu in

Nozzle Check.  (See "Menu Settings.") ➔P.416

Paper to Prepare
When Using Rolls An unused roll at least 254.0 mm (10.00 in) wide

When Using Sheets One sheet of unused paper of at least A4/Letter size

1 Load paper.

• Attaching the Roll Holder to Rolls ➔P.338
• Loading Rolls in the Printer ➔P.341
• Loading Sheets in the Printer ➔P.358

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.
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4 Press ▲ or ▼ to select Test Print, and then press the OK button.

5 Press ▲ or ▼ to select Nozzle Check, and then press the OK button.
The printer now prints a test pattern for checking the nozzles.

6
 

Check the printing results.
If the horizontal lines are not faint or incomplete, the nozzles
are clear.

If some sections of the horizontal lines are faint or incomplete,
the nozzles for those colors are clogged.

If horizontal lines are faint or incomplete, follow the steps be-
low and check again for nozzle clogging.

1. Clean the Printhead.  (See "Cleaning the Printhead.") ➔P.545

2. Print a test pattern to check the nozzles.

Note
• If you repeat these steps several times but the horizontal lines are still faint or incomplete, the Printhead may have

reached the end of its useful life. Contact your Canon dealer for assistance.

Cleaning the PrintheadCleaning the Printhead
If printing is faint, cleaning the Printhead may improve results.
Choose one of two Printhead cleaning modes ( Head Cleaning A or Head Cleaning B ), depending on the prob-
lem to resolve.

• Head Cleaning A
Use this mode if printing is faint or contains foreign substances. This method of cleaning consumes the least
amount of ink.
It takes about three minutes to complete.

• Head Cleaning B
Use this mode if no ink is ejected at all, or if Head Cleaning A does not solve the problem.
It takes about three and a half minutes to complete.

Important
• Do not remove the Maintenance Cartridge or ink tanks during either Head Cleaning A or Head Cleaning B.

Ink may leak or an error may occur.

• If printing does not improve even if you execute Head Cleaning B, try repeating Head Cleaning B once or twice.
If this still does not improve printing, the Printhead may have reached the end of its useful life. Contact your Can-
on dealer for assistance.

Note
• By default, nozzles are checked at fixed intervals.

Configure the settings on the Control Panel menu in Nozzle Check.
 (See "Menu Settings.") ➔P.416

Perform cleaning as follows.

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.
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2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Head Cleaning, and then press the OK button.

5 Press ▲ or ▼ to select Head Cleaning A or Head Cleaning B, and then press the OK button.
Head cleaning is now executed.

6 Print a test pattern to check the nozzles, and determine whether cleaning has cleared the nozzles.  (See
"Checking for Nozzle Clogging.") ➔P.544

Replacing the PrintheadReplacing the Printhead

When to replace the Printhead
Replace the Printhead in the following situations.

• If the printing quality does not improve even after one or two cycles of Head Cleaning B from the printer
menu

• If the Display Screen indicates "Open top cover and replace the printhead."
• If your Canon dealer has advised you to replace the Printhead

Compatible printheads
For information on compatible printheads, see "Printhead." ➔P.544

Precautions when handling the Printhead
Take the following precautions when handling the Printhead.

Caution
• For safety, keep the Printhead out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

• Do not touch the Printhead immediately after printing. The Printhead becomes extremely hot, and there is a risk of
burns.

Important
• There may be ink around the nozzles of the Printhead you remove. Handle the Printhead carefully during re-

placement. The ink may stain clothing.

• Do not open the Printhead pouch until immediately before installation. After removing the Printhead from the
pouch, install it right away. If the Printhead is left after the pouch is opened, the nozzles may dry out, which may
affect printing quality.

Access the menu for Printhead replacement

Caution
• When replacing the Printhead immediately after printing, wait a few minutes before replacing it. The metal parts of

the Printhead become hot during printing, and there is a risk of burns from touching these parts.

Important
• Your hands may become dirty during Printhead replacement. Use the gloves provided with the new Printhead for

replacement.

Note
• Prepare a new Ink Tank when ink levels are low.

• When the remaining capacity of Maintenance cartridge is low, prepare a new Maintenance cartridge.
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1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Replace P.head, and then press the OK button.
Ink begins being drawn in. When it finishes, instructions are displayed on the Display Screen.
It takes about two minutes to complete.

Replace the Printhead

1
 

Open the Top Cover.
Instructions are now shown on the Display Screen regarding
Printhead replacement.

Important
• During Printhead replacement, do not move the Carriage from the position indicated. If you accidentally

move the Carriage, you will hear a warning tone, and Printhead replacement is no longer possible.
If you move the Carriage by mistake, close the Top Cover. The Carriage will be moved to the position as
indicated.
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2
 

If the Printhead Fixer Cover or Printhead Fixer Lever is
dirty, use a damp cloth that you have wrung out complete-
ly to wipe it clean.

Important
• Do not touch the Linear Scale (a) or Carriage Shaft

(b). Touching these parts may damage them.

 

3
 

Pull the Printhead Fixer Lever forward all the way to open it
completely.

 

 

Replacing the Printhead                                                                                                                                                                                         iPF785

                                                                                                                                                                                                                     User's Guide

  

M
aintenance and Consum

ables
Printheads

 548



4
 

Pull up the Printhead Fixer Cover to open it completely.

5
 

Remove the Printhead and press the OK button.

Important
• Never touch the metal contacts of the Carriage. Furthermore, do not allow any dirt or debris to become

adhered to the metal contacts of the Carriage. These may damage the printer.

Note
• Dispose of the used Printhead in accordance with local regulations.

6
 

Holding the new Printhead by the grips (a), remove it from
the pouch.

Important
• When handling the Printhead, always hold it by the grips (a). Never touch the nozzles (b) or metal con-

tacts (c). This may damage the Printhead and affect printing quality.

• Never touch the ink supply section (d). This may cause
printing problems.
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7
 

While firmly holding the Printhead you have removed, use
your other hand to remove the orange Protective Part (a).
Squeeze the grips (c) of Protective Part (b) and pull it down
to remove it.

Important
• The inside surface of the Protective Part (a) and Protective Part (b) is coated with ink to protect the

nozzles. Be careful not to touch these surfaces when removing the caps.

• The Printhead contains ink to protect the nozzles. We recommend removing Protective Part (b) as you
hold it over the Printhead package or safely out of the way to avoid spilling ink and staining your clothes
or the surrounding area. If ink accidentally spills, wipe off the ink with a dry cloth.

• If you need to put a Printhead somewhere temporarily before installation, do not keep the nozzles and
metal contacts facing down. If the nozzles or metal contacts are damaged, it may affect the printing
quality.

• Do not reattach the removed Protective Part. Dispose of these materials in accordance with local regula-
tions.

8
 

With the nozzles facing down and the metal contacts to-
ward the back, insert the Printhead into the Carriage. Care-
fully push the printhead firmly into the Carriage, ensuring
that the nozzles and metal contacts do not touch the car-
riage.

9
 

Pull the Printhead Fixer Cover down toward the front to
lock the Printhead in place.
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10
 

Push the Printhead Fixer Lever toward the back of the
printer until it clicks.

11
 

Close the Top Cover.
Ink now fills the system. It takes about seven minutes to
complete.

Important
• While ink is being filled, definitely do not remove the Ink Tank or Maintenance Cartridge. Ink may leak

out.

Note
• After Printhead has been replaced and filled with ink, Head Posi. Adj. ( Auto(Advanced) ) is performed if

you have selected Rep.P.head Print > On in the Control Panel menu.  (See "Menu Settings.") ➔P.416
In this case, follow the instructions on the Display Screen for Printhead adjustment.
If Rep.P.head Print is Off, perform Head Posi. Adj. ( Auto(Advanced) ) yourself.  (See "Automatic Ad-
justment to Straighten Lines and Colors.") ➔P.520
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Maintenance CartridgeMaintenance Cartridge
Maintenance Cartridge ................................................................................................................................... 552
Replacing the Maintenance Cartridge ............................................................................................................. 552
Checking the Remaining Maintenance Cartridge Capacity .............................................................................. 556

When to Replace the Maintenance Cartridge .................................................................................................. 556

Maintenance CartridgeMaintenance Cartridge
When purchasing, check the Model number.

Shape Model number

MC-10

Note
• For instructions on replacing the Maintenance Cartridge, see "Replacing the Maintenance Cartridge." ➔P.552

Replacing the Maintenance CartridgeReplacing the Maintenance Cartridge

Compatible maintenance cartridges
For information on compatible maintenance cartridges, see "Maintenance Cartridge." ➔P.552

Precautions when handling the Maintenance Cartridge
Take the following precautions when handling the Maintenance Cartridge.

Caution
• For safety, keep the Maintenance Cartridge out of the reach of children.
• If ink is accidentally ingested, contact a physician immediately.

Important
• Do not remove the Maintenance Cartridge except to replace it. Ink may leak out.

• Do not remove an Maintenance Cartridge during initialization immediately after turning on the printer, during
Printhead cleaning, while ink is being drawn out, or during initialization immediately after replacing the Mainte-
nance Cartridge.
The Maintenance Cartridge may become damaged or ink may leak out.

• To prevent ink from leaking from a used Maintenance Cartridge, avoid dropping the cartridge or storing it at an
angle. Otherwise, ink may leak and cause stains.

• Ink adheres to the top of the Maintenance Cartridge after it has been used. Handle the Maintenance Cartridge
carefully during replacement. The ink may stain clothing.

Confirm the message
When the Maintenance Cartridge is almost empty, a message is shown on the Display Screen. According to the
message, replace the Maintenance Cartridge or prepare a new Maintenance Cartridge.  (See "When to Replace
the Maintenance Cartridge.") ➔P.556
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If a message is displayed requesting Maintenance Cartridge replacement, you can skip the step Access the menu
for Maintenance Cartridge replacement. Follow the instructions in Replace the Maintenance Cartridge.

MaintCart,
Replace the

keeping it level.
cartridge full.

Maintenance

Access the menu for Maintenance Cartridge replacement

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Maintenance, and then press the OK button.

4 Press ▲ or ▼ to select Repl. maint cart, and then press the OK button.
A message on the Display Screen advises you to open the Maintenance Cartridge Cover.

Replace the Maintenance Cartridge

1
 

Open the box, remove the plastic bag and packaging
material, and take out the Maintenance Cartridge.

Important
• Never touch the metal contacts (a). This may damage the

Maintenance Cartridge.
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2
 

At this point, open the Maintenance Cartridge Cover.

3
 

Hold the used Maintenance Cartridge by the grip (a) with
one hand and put your other hand under the Mainte-
nance Cartridge to hold it firmly on the bottom, keeping it
level as you pull it out.

Important
• Used Maintenance Cartridges are heavy. Always grasp the cartridge firmly and keep the cartridge level

during removal and storage. If you drop a used Maintenance Cartridge or store it at an angle, ink may
leak and cause stains.

• The remaining Maintenance Cartridge capacity is recorded on each printer. Do not install a used Mainte-
nance Cartridge in another printer.

4
 

Keep the used Maintenance Cartridge level as you put
it in the plastic bag. Expel excess air from the plastic
bag and seal the zipper.
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5
 

Confirm the Maintenance Cartridge is right-side up, put
it in the box with the packaging material attached, and
store it so that it stays level.

Important
• Always put the used Maintenance Cartridge back in the box and store the box on a flat surface. Also,

seal the zipper thoroughly. Otherwise, ink may leak and cause stains.

Note
• Put the used Maintenance Cartridge in the plastic bag of the new cartridge, and dispose of it in accord-

ance with local regulations.

6
 

Keeping the new Maintenance Cartridge level, insert it all
the way in.
The printer now initializes the Maintenance Cartridge.

Important
• Do not remove the Maintenance Cartridge during initialization immediately after replacing the Mainte-

nance Cartridge. The Maintenance Cartridge may become damaged.

7
 

Close the Maintenance Cartridge Cover.

Note
• If you did not perform the operation in Access the menu for Maintenance Cartridge replacement, this

is the end of the procedure and you do not need to press the OK key in the next step.
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8
 

Press the OK button.

Checking the Remaining Maintenance Cartridge CapacityChecking the Remaining Maintenance Cartridge Capacity
The Maintenance Cartridge absorbs excess ink from borderless printing, printhead cleaning, and other processes.
You can confirm the remaining capacity of the Maintenance Cartridge by checking the Maintenance Cartridge ca-
pacity shown on the Display Screen.
To check remaining Maintenance Cartridge capacity, access the Tab Selection screen on the Control Panel and
press ◀ or ▶ to select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

If the Display Screen indicates to replace the Maintenance Cartridge, replace the Maintenance Cartridge. If a mes-
sage is displayed indicating to check the remaining capacity of the Maintenance Cartridge, or before tasks that de-
plete much of the capacity such as head cleaning or preparations to move the printer, check the remaining Mainte-
nance Cartridge capacity and prepare a new Maintenance Cartridge as needed.  (See "Replacing the Maintenance
Cartridge.") ➔P.552

When to Replace the Maintenance CartridgeWhen to Replace the Maintenance Cartridge
Replace or prepare to replace the Maintenance Cartridge in the following situations.

If a message for checking the Maintenance Cartridge is shown on the Display Screen
When the Maintenance Cartridge is almost full, the Message Lamp is lit and "The level is low" is shown on the
Display Screen. You can continue to print, but check the remaining Maintenance Cartridge capacity and prepare to
replace the Maintenance Cartridge with a new one.  (See "Checking the Remaining Maintenance Cartridge Ca-
pacity.") ➔P.556

When much of the Maintenance Cartridge capacity is depleted
Printhead cleaning, Printhead replacement, and preparations to transfer the printer deplete much of the Mainte-
nance Cartridge capacity. (In particular, preparing to move the printer depletes a lot of the capacity.)
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Check the remaining Maintenance Cartridge capacity before this maintenance and replace the Maintenance Car-
tridge if necessary.

If a message for the Maintenance Cartridge replacement is shown on the Display Screen
When the Maintenance Cartridge is full, the Message Lamp flashes and a message to replace the Maintenance
Cartridge is shown on the Display Screen. Printing is disabled, and you cannot replace the Printhead or transfer the
printer. Replace the Maintenance Cartridge with a new one.

MaintCart,
Replace the

keeping it level.
cartridge full.

Maintenance
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Cleaning the PrinterCleaning the Printer
Cleaning the Printer Exterior ........................................................................................................................... 558
Cleaning Inside the Top Cover ........................................................................................................................ 558

Cleaning the Printhead ................................................................................................................................... 545

Cleaning the Printer ExteriorCleaning the Printer Exterior
Clean the printer regularly to maintain better printing quality and help prevent problems.
To ensure a comfortable working environment, clean the printer exterior about once a month.

1 Turn the printer off.  (See "Turning the Printer On and Off.") ➔P.17

2 Unplug the power cord from the outlet.

Caution
• Always turn off the printer and unplug the power cord before cleaning or maintenance. Accidentally leav-

ing the printer on poses a risk of injury if you touch moving parts inside the printer.

3
 

Using a damp cloth that you have wrung out completely,
wipe the exterior surfaces of the printer. Dry the surfaces
with a dry cloth.

Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into con-

tact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend

cleaning the Ejection Guide even if it does not appear dirty, because it may actually be covered with
paper dust.
 (See "Cleaning Inside the Top Cover.") ➔P.558

4 Plug the power cord into the outlet.

Cleaning Inside the Top CoverCleaning Inside the Top Cover
Clean inside the Top Cover about once a month to maintain better printing quality and help prevent problems.
Also clean inside the Top Cover in the following situations to ensure optimal operation.

• If the printed surface or the underside of paper is dirty after printing
• After you have used up a roll
• After borderless printing
• After printing on small paper
• After printing on paper that generates a lot of cutting debris
• If you have replaced the roll
• After printing on paper that generates a lot of paper dust
• After printing on adhesive paper
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Important
• If the Platen inside the Top Cover becomes dirty, it may soil the underside of paper. We recommend cleaning the

Platen after borderless printing or printing on small paper.

• If the Ejection Guide is dirty, it may soil the edge of the paper when the paper is cut. We recommend cleaning the
Ejection Guide even if it does not appear dirty, because it may actually be covered with paper dust.

• Printing on adhesive paper may leave adhesive on the Platen, Paper Retainer, or other parts. To prevent paper
jams, we recommend cleaning inside the Top Cover after printing.

1
 

Open the Top Cover.

2
 

If paper dust has accumulated in the Vacuum holes
(a) on the Platen or in the Borderless Printing Ink
Grooves (b), use the Cleaning Brush (c), provided
with the printer, to wipe it away.

Note
• If the Cleaning Brush is dirty, rinse it in water.
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3
 

Using a damp cloth that you have wrung out completely,
wipe inside the Top Cover to clean it. Wipe away any ink
residue on the Platen as a whole (a), the Paper Retainer
(b), Borderless Printing Ink Grooves (c), and Ejection
Guide (d).

Warning
• Never use flammable solvents such as alcohol, benzene, or thinner. If these substances come into con-

tact with electrical components inside the printer, there is a risk of fire or electrical shock.

Important
• Do not use a dry cloth to wipe inside the Top Cover. This may create a static charge, which may attract

dust and affect the printing quality.

• Do not touch the Linear Scale (a) or Carriage Shaft
(b). This may stain your hands and damage the
printer.
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Note
• When cleaning between the Platen and Ejection

Guide, use a damp cloth that you have wrung out
completely to wipe over the Output Tray and along
grooves.

 

4
 

Close the Top Cover.
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Other MaintenanceOther Maintenance
Preparing to Transfer the Printer ..................................................................................................................... 562
Reinstalling the Printer .................................................................................................................................... 565

Updating the Firmware ................................................................................................................................... 568

Preparing to Transfer the PrinterPreparing to Transfer the Printer
To protect the internal parts in transit, always follow these steps before transferring the printer to a new location.
Refer to the Setup Guide for details on packing the printer and installing it after transfer.

Important
• Avoid tilting the printer excessively in transit. This may cause ink in the printer to leak and cause stains.

Note
• When you execute prepare to transfer, ink is drawn into the Maintenance Cartridge. Depending on the amount of

free space in the mounted Maintenance Cartridge, you may need to replace it with a new one at this time.
Note that replacement is not required if there is 80% or more free space.  (See "Checking the Remaining Mainte-
nance Cartridge Capacity.") ➔P.556

• Depending on the state of the printer, part replacement may be necessary when preparing to transfer the printer
(that is, when you execute the printer menu item to prepare for transfer).

Remove paper

1 Remove the paper.

• Rolls  (See "Removing the Roll from the Printer.") ➔P.345
• Sheets  (See "Removing Sheets.") ➔P.362

Access the Prep.MovePrinter menu

1 If a message instructing you to replace the Maintenance Cartridge is displayed on the Display Screen, re-
place the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") ➔P.552

2
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

3 Press the OK button.
The Set./Adj. Menu is displayed.

4 Press ▲ or ▼ to select Prep.MovePrinter, and then press the OK button.

5 Press ▲ or ▼ to select Standard or Limited, and then press the OK button.
Displays the confirmation screen.

Important
• If Limited is selected, do not transport in low temperature environments. The ink remaining in the printer

may freeze and damage the printer.
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6 Press ▲ or ▼ to select Yes (or Execute if Limited is selected), and then press the OK button.
Ink is now drawn into the Maintenance Cartridge.
Once preparations are finished, a message on the Display Screen requests you to open the Ink Tank Cov-
er.

Important
• Do not remove the Maintenance Cartridge except when the message for replacing it is displayed.

If you remove the Maintenance Cartridge while ink is being drawn out, the ink may leak out.

• If consumables must be replaced, the message "Consumables must be replaced. Call for service." is
shown on the Display Screen and preparation is not possible. If this message is displayed, press the OK
button and contact your Canon dealer for assistance.

Remove the Ink Tank

1
 

Open the Ink Tank Cover.

2
 

Pressing the tip of the Ink Tank Lock Lever horizontally, lift the Ink
Tank Lock Lever to release the lock.

3
 

Holding the ink tanks by the grips, remove them.

Important
• Store the ink tanks you removed with the ink holes (a) facing up.

Otherwise, ink may leak and cause stains.
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4
 

Repeat steps 2 and 3 to remove all ink tanks.

5
 

Push all ink tank lock levers closed until they click into place.

6
 

Close the Ink Tank Cover.
Ink is now drawn into the Maintenance Cartridge.

Important
• Do not remove the Maintenance Cartridge except when the message for replacing it is displayed.

If you remove the Maintenance Cartridge while ink is being drawn out, the ink may leak out.

7
 

When the processing is complete, "Completed! Turn Power
Off!!" is displayed. Press the Power button to turn the power off.

Pack the printer

1 Disconnect the power cord and interface cable.

Important
• Turn off the printer before you unplug it. It may damage the printer if you unplug it before it is off and

transfer it in that state. If you accidentally unplug the printer, plug it in again, reinstall the ink tanks, and
follow this procedure again.
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2
 

Tape down printer covers to secure them, in the re-
verse order of tape removal during installation.

3 Remove the Stand by reversing the installation procedure, when it was attached to the printer.

4 Disassemble and repackage the Stand by following the installation procedure in reverse.

5 Repack the Roll Holder, Holder Stopper, and printer in shipping materials, and then package them in a
shipping box.

Reinstalling the PrinterReinstalling the Printer
The basic workflow for reinstalling the printer is as follows.
For detailed instructions, see the Setup Guide.

Assemble the stand

1
 

Referring to the Printer Stand Setup Guide, assemble
the Stand.
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Caution
• The Stand must be assembled by at least two people on a flat surface. Attempting assembly by yourself

poses a risk of injury or bending the Stand.

• When assembling the Stand, lock all four of the casters. Attempting to move the stand when the casters
are not locked poses a risk of injury or damage to the location site.

• Before moving the assembled stand, lift the sup-
port rod to the position shown (a) and unlock all
four casters. Moving the stand with the support rod
lowered or the casters locked may cause injury or
damage the area of installation or basket cloth.

 

Install the printer

1
 

Mount the printer on the assembled Stand and tighten
the screws firmly.

Caution
• Moving the printer requires at least three people. Be careful to avoid back strain and other injuries.

• When moving the printer, firmly grasp the Carrying
Handles. The printer may be unsteady if you hold it
at other positions, which poses a risk of injury from
dropping the printer.

• When placing the printer on the Stand, lock all four of the casters of the Stand. Attempting to place the
printer on the Stand while the casters are not locked poses a risk of injury.
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2
 

Remove tape and packaging material attached to the
printer.

3
 

Connect the power cord to the Power Supply Connector
on the right side of the printer.

4 Plug the power cord into the outlet.

5
 

Press the power button to turn the printer on.
Instructions are displayed on the Display Screen.

6
 

Open the Ink Tank Cover and install the ink tanks.
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7
 

Load the Roll Media on the Roll Holder.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338

8
 

Load the Roll Media in the printer.
 (See "Loading Rolls in the Printer.") ➔P.341

9
 

Install the software.
Note that the driver installation procedure varies depend-
ing on the type of connection.

Important
• When the printer is connected to a network (via TCP/IP), the printer's IP address may be changed if you

reinstall the printer.
In this case, be sure to reconfigure the printer's IP address.

Updating the FirmwareUpdating the Firmware
Update the printer firmware to take advantage of new and improved printer functions.

Confirming the firmware version

1
 

On the Tab Selection screen of the Control Panel, press ◀ or ▶ to
select the Settings/Adj. tab ( ).

Note
• If the Tab Selection screen is not displayed, press the Menu button.

2 Press the OK button.
The Set./Adj. Menu is displayed.

3 Press ▲ or ▼ to select Printer Info, and then press the OK button.
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4 Press ▲ or ▼ to select System Info, and then press the OK button.
The firmware version is displayed.

Updating the Firmware
To obtain the latest firmware, visit the Canon website. If the firmware available online is newer than the installed
firmware, update the printer firmware. For details on downloading and updating the firmware, visit the Canon web-
site.
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Frequently Asked QuestionsFrequently Asked Questions
Frequently Asked QuestionsFrequently Asked Questions

This section presents frequently asked questions and answers. To view more detailed explanations, click the hyper-
links in the answer column.

Question Answer
I want to easily create
vertical or horizontal
banners.

You can print originals that are in landscape (or portrait) orientation automatically enlarged to fit the roll
width. This is an easy way to create vertical or horizontal banners.
 (See "Printing Vertical or Horizontal Banners (Large-Format Printing).") ➔P.88

Does this printer support
sub-ink tank system?

This printer supports sub-ink tank system.
Even if an ink tank becomes empty during printing, since a certain amount of ink always is stored in a
sub-ink tank, you can replace the ink tank while printing.
 (See "Replacing Ink Tanks.") ➔P.536

I want to know how to
configure roll cutting.

You can select the cutting method by the setting of the printer driver and the setting of the printer.
To cut rolls automatically after printing, set Cutting Mode of the printer to Automatic and Automatic
Cutting of the printer driver to Yes.
When using paper for which ink adhesion takes time or the print surface is easily scratched, we recom-
mend that you set the Cutting Mode setting of the printer to Eject.
 (See "Specifying the Cutting Method for Rolls.") ➔P.351
 (See "Cutting Roll Paper After Printing.") ➔P.137

I want to configure so
that the roll is cut auto-
matically after waiting for
the ink to dry.

In the printer driver, you can set the time for waiting until the ink dries.
Also, you can set likewise on the printer.
 (See "Specifying the Ink Drying Time for Rolls.") ➔P.350
 (See "Menu Structure.") ➔P.410

How do I print without
borders?

When printing on rolls, you can perform borderless printing by configuring the printer driver. (when print-
ing on cut sheets, you cannot perform borderless printing)
 (See "Borderless Printing on Paper of Equivalent Size.") ➔P.79
 (See "Borderless Printing by Resizing Originals to Fit the Roll Width.") ➔P.82
 (See "Borderless Printing at Actual Size.") ➔P.74

I want to know the paper
types that can be used in
this printer.

Concerning the paper that can be used in this printer, refer to the imagePROGRAF home page or the
Paper Reference Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

The paper type that I
want to print is not dis-
played on the Display
Screen.

When using newly released paper, paper information must be registered on the printer and the printer
driver. Download the new version of Media Information File from the imagePROGRAF website and in-
stall it.
 (See "Updating paper information.") ➔P.334

Can I perform duplex
printing?

This printer cannot perform duplex printing.
If you use the Folded Duplex function in the Free Layout of Windows software, you can print two pages
one-sided, fold them at the center and suspend them to substitute for duplex printing.
 (See "Prints using Folded Duplex (Windows).") ➔P.201

I want to perform en-
largement printing.

With the printer driver, you can specify the ratio matching the document with the paper size and width
and perform enlargement printing or reduction printing.
 (See "Resizing Originals to Match the Paper Size.") ➔P.60
 (See "Resizing Originals to Fit the Roll Width.") ➔P.62
 (See "Resizing Originals by Entering a Scaling Value.") ➔P.65
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Problems Regarding PaperProblems Regarding Paper
Clearing Jammed Roll Paper .......................................................................................................................... 573
Clearing a Jammed Sheet .............................................................................................................................. 576
Clearing Jammed Paper (Paper Feed Slot) ..................................................................................................... 578

Roll paper cannot be inserted into the Paper Feed Slot .................................................................................. 580
Cannot load sheets ........................................................................................................................................ 580

Paper is not cut neatly .................................................................................................................................... 580
Paper is not cut .............................................................................................................................................. 580

Depression on the leading edge is left ............................................................................................................ 581

The size of clear film cannot be detected ........................................................................................................ 581
Roll Paper is Continuously Ejected ................................................................................................................. 581

Clearing Jammed Roll PaperClearing Jammed Roll Paper
If paper from a roll becomes jammed, "Paper jam." is shown on the Display Screen of the Control Panel. Remove
the jammed paper as follows.

1
 

Positioning your hands as shown, open the Roll Cov-
er.

2
 

Cut the loaded roll paper with regular scissors or the
like.

Caution
• When cutting paper, be careful to avoid injury or damage to the printer.
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3
 

Push the Release Lever back.

4 Remove the jammed paper.

• If paper is jammed inside the Top Cover

1.  

Open the Top Cover and move the Carriage to
the left or right side manually, away from the
jam.

Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.

3.  

Close the Top Cover.
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Important
• Do not touch the Linear Scale (a) or Carriage Shaft

(b). This may stain your hands and damage the
printer.

 

• If paper from a roll is jammed by the Paper Feed Slot
Remove the jammed paper from the Paper Feed
Slot.
After removing the paper, make sure there are no
other scraps of paper in the printer.

• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no
other scraps of paper in the printer.
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5
 

Pull the Release Lever forward.

Clearing a Jammed SheetClearing a Jammed Sheet
If a sheet becomes jammed, "Paper jam." is shown on the Display Screen of the Control Panel. Remove the jam-
med paper as follows.

1
 

Push the Release Lever back.

2 Remove the jammed paper.

• If paper is jammed inside the Top Cover

1.  

Open the Top Cover and move the Carriage to
the left or right side manually, away from the
jam.
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Important
• Do not move the Carriage over jammed paper. This may damage the Printhead.

2. Clear any jammed paper from inside the Top Cover.
After removing the paper, make sure there are no other scraps of paper in the printer.

3.  

Close the Top Cover.

Important
• Do not touch the Linear Scale (a) or Carriage Shaft

(b). This may stain your hands and damage the
printer.

 

• If the paper is jammed by the Paper Feed Slot
Remove the jammed paper from the Paper Feed
Slot.
After removing the paper, make sure there are no
other scraps of paper in the printer.

 

 

iPF785                                                                                                                                                                                      Clearing a Jammed Sheet

User's Guide                                                                                                                                                                                                                     

  

Troubleshooting
Problem

s Regarding Paper

577  



• If the paper is jammed by the Ejection Guide
Remove the jammed paper from the Output Tray.
After removing the paper, make sure there are no
other scraps of paper in the printer.

3
 

Pull the Release Lever forward.

Clearing Jammed Paper (Paper Feed Slot)Clearing Jammed Paper (Paper Feed Slot)
Follow these steps to remove any scraps left in the Paper Feed Slot after you clear jammed sheets or roll paper.

1 Turn the printer off.  (See "Turning the Printer On and Off.") ➔P.17

2
 

Push the Release Lever back.
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3
 

Positioning your hands as shown, open the Roll Cov-
er.

4
 

Fold an A4 sheet lengthwise four times and insert it
through the gap of the Paper Feed Slot. Push the scrap
out toward the Platen.

5 Remove the scrap when it is pushed out onto the Platen.

6 If any scraps remain inside the paper feed slot, repeat steps 4 and 5.

7
 

Holding it at the positions indicated, close the Roll Cov-
er.
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8
 

Pull the Release Lever forward.

Roll paper cannot be inserted into the Paper Feed SlotRoll paper cannot be inserted into the Paper Feed Slot
Cause Corrective Action

The roll paper is warped. Straighten out curls and reload the roll.

Paper is jammed by the paper feed slot. Remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") ➔P.573
 (See "Clearing a Jammed Sheet.") ➔P.576

The paper source selection is incorrect. Press the Load button and select the paper source.

Cannot load sheetsCannot load sheets
Cause Corrective Action

The paper source selection is incorrect. Press the Load button and select the paper source.

Paper is not cut neatlyPaper is not cut neatly
Cause Corrective Action

The paper is bent or curled at the cut position. Straighten out any curling by the edges of the paper.

Paper rises by the ends of the cut position be-
fore it is cut.

Reload the paper correctly.

You are using paper that cannot be cut with the
Cutter Unit.

Specify Manual in Cutting Mode in the Control Panel menu and use scissors or
a cutting tool to cut the roll after printing.
 (See "Specifying the Cutting Method for Rolls.") ➔P.351

Cut Speed is not configured correctly in the
Control Panel menu.

Change the Cut Speed setting in the Control Panel menu.
 (See "Menu Structure.") ➔P.410

During cutting, printed documents fall out at an
angle.

In the Control Panel menu, set Cutting Mode to Eject. Hold documents after
printing, as they are cut.
 (See "Specifying the Cutting Method for Rolls.") ➔P.351

Paper is not cutPaper is not cut
Cause Corrective Action

In the printer driver, No or Print Cut Guideline is specified in
Automatic Cutting.

Specify Yes in Automatic Cutting in the printer driver.
 (See "Page Setup Sheet (Windows).") ➔P.161
 (See "Paper Detailed Settings Dialog Box (Mac OS).") ➔P.258

In the Control Panel menu, Cutting Mode is set to Eject or
Manual.

If the Cutting Mode is Eject, press the Cut button to cut the paper.
If the Cutting Mode is Manual, cut rolls with scissors or the like.
 (See "Specifying the Cutting Method for Rolls.") ➔P.351
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Depression on the leading edge is leftDepression on the leading edge is left
Cause Corrective Action

Keeping a roll in the printer for a long time
without printing on it may leave a depres-
sion on the leading edge.

When printing quality is most important, we recommend setting TrimEdge Reload to
On or Automatic so that the paper edge is automatically cut before printing.
 (See "Menu Structure.") ➔P.410

The size of clear film cannot be detectedThe size of clear film cannot be detected
Cause Corrective Action

The Platen is soiled with ink or other substances. Open the Top Cover and clean the entire Platen.
 (See "Cleaning Inside the Top Cover.") ➔P.558

Roll Paper is Continuously EjectedRoll Paper is Continuously Ejected
Cause Corrective Action

Although sheets are
selected as the paper
source, a roll was ad-
vanced.

After roll ejection stops, follow these steps to reload the roll.

1. Push the Release Lever back.
2. Open the Roll Cover.

3. Using both hands, rotate the Roll Holder toward the back to rewind the roll. At this time, ensure that
both ends of the roll are rewound evenly.

4. Pull the Release Lever forward.

5. Load the roll. At this time, be sure to press the Load button and select "Load Roll Paper".
 (See "Loading Rolls in the Printer.") ➔P.341
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Printing does not startPrinting does not start
The Data lamp on the Control Panel does not light up .................................................................................... 582
The printer does not respond even if print jobs are sent .................................................................................. 582

Ink Filling.. is displayed ................................................................................................................................... 582
The display screen indicates Agitating... ......................................................................................................... 582

The Data lamp on the Control Panel does not light upThe Data lamp on the Control Panel does not light up
Cause Corrective Action

The printer is not
on.

Make sure the power cord is securely plugged in, all the way. Press the Power button to turn on the printer.

The target printer
was not selected
when printing.

• In Windows, select the printer by clicking Select Printer or Printer in the printing dialog box and try printing
again.

• In Mac OS, open the dialog box of the printer driver, select the printer from the list of Printer, and try print-
ing again.

The print job is
paused.

• In Windows, restart the print job as follows.

1. Select the printer icon in the Printers and Faxes (or Printers ) window.
2. Clear Pause Printing in the File menu to restart the print job.

• In Mac OS, restart the print job as follows.

1. Click Print & Scan. (This is identified as Printers & Scanners or Print & Fax in other versions of Mac
OS.)

2. Select the printer, and then Resume Printer (or Resume ) in the Printers menu to restart the print job.

The printer does not respond even if print jobs are sentThe printer does not respond even if print jobs are sent
Cause Corrective Action

In the Control Panel menu, Pause Print is On. Set Pause Print to Off.
 (See "Pausing Printing.") ➔P.27

In the Control Panel menu, Use USB or Use Ether-
net is set to Off.

Set Use USB or Use Ethernet to On.
 (See "Menu Settings.") ➔P.416

You have selected Save in mail box in Output
Method on the printer.

Print the job saved on the printer's hard disk.
 (See "Printing Saved Jobs.") ➔P.490

Print jobs are pending. Manage the jobs on hold and print as needed.
 (See "Managing Pending Jobs (Printing or Deleting Jobs on
Hold).") ➔P.488

Ink Filling.. is displayedInk Filling.. is displayed
Cause Corrective Action

The printer was forced off during operation. Wait until the system has been filled with ink.

The display screen indicates Agitating...The display screen indicates Agitating...
Cause Corrective Action

Ink agitation is in progress. Please wait until ink agitation is finished.
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The printer stops during a print jobThe printer stops during a print job
An error message is shown on the Display Screen ......................................................................................... 583
The printer ejects blank, unprinted paper ........................................................................................................583

The printer stops when printing a HP-GL/2 job (the carriage stops moving) .................................................... 594

An error message is shown on the Display ScreenAn error message is shown on the Display Screen
Cause Corrective Action

The last portion of roll paper was used during a print job, and paper could
not be advanced because the trailing edge is taped to the roll.

Remove the used roll and insert a new roll.
 (See "Removing the Roll from the Printer.") ➔P.345
 (See "Removing the Roll Holder from Rolls.") ➔P.347
 (See "Loading and Printing on Rolls.") ➔P.18

The printer ejects blank, unprinted paperThe printer ejects blank, unprinted paper
Cause Corrective Action

The leading edge of the roll paper was cut to
straighten it.

The leading edge of rolls may be cut to straighten it if Trim Edge First is set to a
value other than Off in the Control Panel menu.
 (See "Cutting the Leading Edge of Roll Paper Automatically.") ➔P.355

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and make sure the Printhead is in good
condition for printing.
 (See "Checking for Nozzle Clogging.") ➔P.544

A print job was received from an incompatible
printer driver.

Use the correct imagePROGRAF printer driver for the printer and try printing again.

The printer has received print data that in-
cludes HP RTL commands when Auto Ro-
tate is On in the Control Panel menu.

In the Control Panel, set Auto Rotate to Off and print again.
 (See "Menu Settings.") ➔P.416

The printer is damaged. Contact your Canon dealer for assistance.
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Problems with the printing qualityProblems with the printing quality
Printing is faint ................................................................................................................................................ 584
Paper rubs against the Printhead ....................................................................................................................584
The edges of the paper are dirty ..................................................................................................................... 585
The surface of the paper is dirty ..................................................................................................................... 586
The back side of the paper is dirty .................................................................................................................. 586

Printed colors are inaccurate .......................................................................................................................... 586
Banding in different colors occurs ...................................................................................................................587
Colors in printed images are uneven ............................................................................................................... 587
Image edges are blurred or white banding occurs .......................................................................................... 588
The contrast becomes uneven during printing ................................................................................................ 588

The length of printed images is inaccurate in the feeding direction .................................................................. 588
Images are printed crooked ............................................................................................................................ 589
Documents are printed in monochrome ..........................................................................................................589

Line thickness is not uniform .......................................................................................................................... 589
Lines are misaligned ....................................................................................................................................... 589

Printing is faintPrinting is faint
Cause Corrective Action

You may be printing on the wrong
side of the paper.

Print on the printing surface.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") ➔P.544

Because the printer was left without
ink tanks installed for some time, ink
has become clogged in the ink supply
system.

After the ink tanks have been installed for 24 hours, run Head Cleaning B from the Control
Panel.
 (See "Cleaning the Printhead.") ➔P.545

Paper is jammed inside the Top Cov-
er.

Follow the steps below to remove the jammed piece of paper inside the Top Cover.

1. Open the Top Cover and make sure the Carriage is not over the Platen.

2. Remove any scraps of paper inside the Top Cover.
 (See "Clearing Jammed Roll Paper.") ➔P.573
 (See "Clearing a Jammed Sheet.") ➔P.576

3. Close the Top Cover.

The ink was not dry when paper was
cut.

Specify a longer drying period in the Control Panel menu, in Paper Details > Roll Drying-
Time.
 (See "Menu Settings.") ➔P.416

Printing may be faint if Print Quality
in Advanced Settings in the printer
driver is set to Standard or Fast.

In Advanced Settings of the printer driver, choose Highest or High in Print Quality.
Printing in Fast or Standard mode is faster and consumes less ink than in Highest or High
modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") ➔P.54

You are printing on paper that tends
to generate dust when cut.

In the Control Panel menu, set CutDustReduct. in Paper Details to On.
 (See "Reducing Dust from Cutting Rolls.") ➔P.356

Paper rubs against the PrintheadPaper rubs against the Printhead
Cause Corrective Action

The type of paper specified in the
printer driver does not match the type
loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded in the
printer.
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Cause Corrective Action
The type of paper specified in the
printer driver does not match the type
loaded in the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Paper has been loaded incorrectly,
causing it to wrinkle.

Reload the paper.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

The Printhead is set too low in the
Control Panel menu.

In the Control Panel menu, set Head Height to Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

You are printing on heavyweight pa-
per or paper that curls or wrinkles
easily after absorbing ink.

For paper-based media such as Heavyweight Coated Paper, set the VacuumStrngth to
Strong or Strongest in the Control Panel menu. If the paper still rubs against the printhead,
set the Head Height in the Control Panel menu to a higher value than the current setting.
 (See "Adjusting the Vacuum Strength.") ➔P.533
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

For film-based media such as Tracing Paper, set the VacuumStrngth to Standard, Strong
or Strongest in the Control Panel menu. If the paper still rubs against the printhead, set the
Head Height in the Control Panel menu to a higher value than the current setting.
 (See "Adjusting the Vacuum Strength.") ➔P.533
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

When printing on paper 0.1 mm (0.004 in) thick or less, choose a VacuumStrngth setting of
Weakest in the Control Panel menu. If rubbing still occurs, in the Control Panel menu, use a
higher Head Height setting.
 (See "Adjusting the Vacuum Strength.") ➔P.533
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

When you have loaded paper, the
paper you have loaded does not
match the type selected on the Con-
trol Panel.

Be sure to select the correct type of paper in the Control Panel menu when loading paper.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

The edges of the paper are dirtyThe edges of the paper are dirty
Cause Corrective Action

The Platen has become dirty after bor-
derless printing or printing on small pa-
per.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") ➔P.558

The type of paper as specified on the
printer does not match the type speci-
fied in the printer driver.

Make sure the same type of paper is specified on the printer as in the printer driver.
 (See "Changing the Type of Paper.") ➔P.343

Make sure the same paper type is specified in the printer driver as on the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

The paper is wrinkled or warped. Straighten out the wrinkles or curls and reload the paper. Do not use paper that has been
printed on previously.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

A cut line is printed because CutDus-
tReduct. is On in the Control Panel
menu to reduce cutting dust.

If this function is not needed, set CutDustReduct. to Off in the Control Panel menu.
 (See "Menu Settings.") ➔P.416

The Printhead is set too low in the
Control Panel menu.

In the Control Panel menu, set Head Height to Automatic.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

You are printing on heavyweight paper
or paper that curls or wrinkles easily af-
ter absorbing ink.

For paper-based media such as Heavyweight Coated Paper, set the VacuumStrngth to
Strong or Strongest in the Control Panel menu. If the paper still rubs against the print-
head, set the Head Height in the Control Panel menu to a higher value than the current
setting.
 (See "Adjusting the Vacuum Strength.") ➔P.533
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525
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Cause Corrective Action
You are printing on heavyweight paper
or paper that curls or wrinkles easily af-
ter absorbing ink.

For film-based media such as Tracing Paper, set the VacuumStrngth to Standard,
Strong or Strongest in the Control Panel menu. If the paper still rubs against the print-
head, set the Head Height in the Control Panel menu to a higher value than the current
setting.
 (See "Adjusting the Vacuum Strength.") ➔P.533
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

The Ejection Guide is soiled. Clean the Ejection Guide.
 (See "Cleaning the Printer Exterior.") ➔P.558

The surface of the paper is dirtyThe surface of the paper is dirty
Cause Corrective Action

The Paper Retainer is soiled. Clean the Paper Retainer.
 (See "Cleaning Inside the Top Cover.") ➔P.558

You are using a paper that does
not dry easily.

In the Control Panel menu, set Roll DryingTime to at least 1 min.
 (See "Menu Settings.") ➔P.416

When paper that does not dry easily is used for printing, it may curl during printing and touch the
Output Tray.
In this case, in the Control Panel menu, complete the settings for Dry time and Area in Scan
Wait Time.
However, note that printing will now take longer.
 (See "Menu Settings.") ➔P.416

The back side of the paper is dirtyThe back side of the paper is dirty
Cause Corrective Action

The Platen has become dirty after borderless print-
ing or printing on small paper.

Open the Top Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") ➔P.558

The Platen has become soiled because you have
set Width Detection to Off in the Control Panel
menu.

Set Width Detection to On in the Control Panel menu, and then open the Top
Cover and clean the Platen.
 (See "Cleaning Inside the Top Cover.") ➔P.558

Open the Top Cover and clean the Platen. After this, manually advance the roll
onto the Platen before printing.
 (See "Cleaning Inside the Top Cover.") ➔P.558
 (See "Feeding Roll Paper Manually.") ➔P.349

The Paper Retainer is soiled. Clean the Paper Retainer.
 (See "Cleaning Inside the Top Cover.") ➔P.558

Printed colors are inaccuratePrinted colors are inaccurate
Cause Corrective Action

Color adjustment has not been activated in the Ad-
vanced Settings of the printer driver.

In the Advanced Settings of the printer driver, access Color Settings in Col-
or Mode to adjust colors.
 (See "Main Sheet (Windows).") ➔P.150
 (See "Main Pane (Mac OS).") ➔P.254

Colors have not been adjusted on the computer or
monitor.

Refer to the computer and monitor documentation to adjust the colors.

Adjust the settings of the color management software, referring to the software
documentation as needed.

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") ➔P.544

Application Color Matching Priority is set to Off
in the Windows printer driver.

Click Special Settings in the Layout sheet of the printer driver, and set Ap-
plication Color Matching Priority to On in the dialog box that is displayed.
 (See "Layout Sheet (Windows).") ➔P.165
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Cause Corrective Action
Color may change slightly even on the same model
of printer if you use a different version of the firm-
ware or printer driver, or when you print under dif-
ferent settings or in a different printing environ-
ment.

Follow these steps to prepare the printing environment.

1. Use the same version of firmware or printer driver.
2. Specify the same value for all settings items.

Banding in different colors occursBanding in different colors occurs
Cause Corrective Action

The paper feed amount is out of adjust-
ment.

Adjust the feed amount.
 (See "Adjusting the Feed Amount.") ➔P.527

Printing does not proceed smoothly be-
cause print jobs are interrupted during
transmission.

Exit other applications and cancel other print jobs.

In the Control Panel menu, Adj. Priori-
ty is set to Print Length.

Setting Adj. Priority to Print Quality in the Control Panel menu and adjusting the feed
amount may improve results.
 (See "Adjusting the Feed Amount.") ➔P.527

The Printhead is out of alignment. Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520

The Printhead nozzles are clogged. Print a test pattern to check the nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") ➔P.544

Streaks may occur if you set the Print
Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer driver and
try printing again.
Printing in Fast or Standard mode is faster and consumes less ink than in Highest or
High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") ➔P.54

The type of paper specified in the print-
er driver does not match the type loa-
ded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Colors in printed images are unevenColors in printed images are uneven
Cause Corrective Action

Line Drawing/Text is selected when
printing images in many solid colors.

In Print Priority in the Advanced Settings of the printer driver, choose Image.

You are printing on paper that curls
easily.

Printed colors may appear uneven on the leading edge of paper that is susceptible to curl-
ing. Select a stronger level in VacuumStrngth in the Control Panel menu to increase suc-
tion against the paper, or specify a leading margin of 20 mm (0.79 in) or more.
 (See "Adjusting the Vacuum Strength.") ➔P.533

Printed colors may be uneven if you
set the Print Quality too low.

Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
Printing in Fast or Standard mode is faster and consumes less ink than in Highest or
High modes, but the printing quality is lower.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") ➔P.54

Color may be uneven between dark
and light image areas.

Select Unidirectional Printing in the Advanced Settings of the printer driver.

When borderless printing is used, the
edge of the paper is cut during printing.
Thus, ink density may be slightly un-
even at the leading edges.

Specify No in Automatic Cutting in the printer driver before printing. In this case, the pa-
per can be printed without borders on the left and right sides only. Cut the printed docu-
ment ejected from the printer, and then use scissors or a cutting tool to cut away the
edges on the top and bottom.

Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") ➔P.54

The Printhead is out of alignment. Adjust the Printhead alignment.
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Cause Corrective Action
The Printhead is out of alignment.  (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520

Allowing printed documents to dry on
top of each other may cause uneven
colors.

To avoid uneven colors, we recommend drying each sheet separately.

Density may be uneven if you use
Glossy Paper or Coated Paper.

In Advanced Settings of the printer driver, choose Highest or High in Print Quality.

The type of paper specified in the print-
er driver does not match the type loa-
ded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Scan Wait Time > Area in the Control
Panel menu is set to Leading edge.

When Scan Wait Time > Area is set to Leading edge, colors may be uneven 110–140
mm from the leading edge. (The position varies depending on the Print Quality setting.)
In this case, select Scan Wait Time > Area > Entire area.
However, note that printing will now take longer.
 (See "Menu Settings.") ➔P.416

Image edges are blurred or white banding occursImage edges are blurred or white banding occurs
Cause Corrective Action

The Platen suction is too strong. In the Control Panel menu, reduce the level of VacuumStrngth.
 (See "Adjusting the Vacuum Strength.") ➔P.533

Incorrect Printhead alignment value. In the Control Panel menu, set Head Height to a lower height.
 (See "Troubleshooting Paper Abrasion and Blurry Images.") ➔P.525

The type of paper specified in the print-
er driver does not match the type loa-
ded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

The contrast becomes uneven during printingThe contrast becomes uneven during printing
Cause Corrective Action

The paper feed amount is out of adjustment. Adjust the feed amount.
 (See "Adjusting the Feed Amount.") ➔P.527

The type of paper specified in the printer driv-
er does not match the type loaded in the
printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loa-
ded in the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

The length of printed images is inaccurate in the feeding directionThe length of printed images is inaccurate in the feeding direction
Cause Corrective Action

In the Control Panel menu, Adj. Priority is
set to Print Quality.

Set Adj. Priority to Print Length in the Control Panel menu, and then execute Adjust
Length.
 (See "Adjusting the Feed Amount.") ➔P.527
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Cause Corrective Action
The type of paper specified in the printer
driver does not match the type loaded in
the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded
in the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Images are printed crookedImages are printed crooked
Cause Corrective Action

In the Control Panel menu, Skew Check Lv. is set to Loose or Off. In the Control Panel menu, set Skew Check Lv. to Standard.

In the Control Panel menu, Width Detection is set to Off. Set Width Detection to On in the Control Panel menu.

Documents are printed in monochromeDocuments are printed in monochrome
Cause Corrective Action

In the Advanced Settings of the printer driver, Mon-
ochrome, Monochrome (BK ink), or Monochrome
Bitmap is specified in Color Mode.

In the Advanced Settings of the printer driver, specify Color in Color Mode
and try printing again.

The Printhead nozzles are clogged. Print a test pattern to check the color ink nozzles and see if they are clogged.
 (See "Checking for Nozzle Clogging.") ➔P.544

Line thickness is not uniformLine thickness is not uniform
Cause Corrective Action

In the Special Settings dialog box of
the Windows printer driver, Fast
Graphic Process is set to On.

Access the printer driver Properties dialog box from Print in the File menu of the source
application, and follow these steps to print.

1. Clear the option Open Preview When Print Job Starts on the Main sheet.
2. Clear the option Page Layout on the Layout sheet.

3. Click the Special Settings button in the Layout sheet, open the Special Settings dia-
log box, and set Fast Graphic Process to Off.

The type of paper specified in the
printer driver does not match the type
loaded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.

Lines are misalignedLines are misaligned
Cause Corrective Action

The Printhead alignment is not adjus-
ted.

Adjust the Printhead alignment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520
 (See "Manual Adjustment to Straighten Lines and Colors.") ➔P.521
 (See "Adjusting Line Misalignment.") ➔P.523

The type of paper specified in the print-
er driver does not match the type loa-
ded in the printer.

Load paper of the same type as you have specified in the printer driver.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

Make sure the same type of paper is specified in the printer driver as you have loaded in
the printer.

1. Press the Stop button and stop printing.
2. Change the type of paper in the printer driver and try printing again.
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Cannot print over a networkCannot print over a network
Cannot connect the printer to the network ..................................................................................................... 590

Cannot print over a TCP/IP network ............................................................................................................... 590
Cannot print over a Bonjour network .............................................................................................................. 590

Cannot connect the printer to the networkCannot connect the printer to the network
Cause Corrective Action

The Ethernet cable
is not connected
correctly to the
printer's Ethernet
port.

1. Make sure the printer is connected to the network with the correct Ethernet cable, and then turn the printer
on. For instructions on connecting the cable, refer to the Setup Guide.

2. Make sure the Link indicator is lit.
The bottom indicator is green if the printer is connected via 1000Base-T, while the top indicator is orange
if connected via 100Base-TX and the top indicator is green if connected via 10Base-T.
If the Link indicator is not lit, check the following points.

• Make sure the connection point is on.

• Make sure the end of the Ethernet cable is connected correctly.
Insert the Ethernet cable until it clicks and locks in place.

• Make sure there is no problem with the Ethernet cable.
If there is any problem, replace the Ethernet cable.

• Check the communication mode with the connection point.
Although the printer normally detects the communication mode and transmission rate of the communi-
cation point automatically (in auto negotiation mode), sometimes the communication point settings
cannot be detected. In this case, configure the connection method manually, specifying the communi-
cation mode in use.
 (See "Configuring the Communication Mode Manually.") ➔P.459

Cannot print over a TCP/IP networkCannot print over a TCP/IP network
Cause Corrective Action

The printer's IP address is not config-
ured correctly.

Make sure the printer's IP address is configured correctly.
 (See "Configuring the IP Address Using imagePROGRAF Device Setup Utility.") ➔P.461
 (See "Configuring the IP Address Using the Printer Control Panel.") ➔P.450

The printer's TCP/IP network settings
are not configured correctly.

Make sure the printer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer's TCP/IP Network Settings With RemoteUI.") ➔P.454

The computer you are trying to print
from is not configured correctly.

Make sure the computer's TCP/IP network settings are configured correctly.
 (See "Configuring the Printer Driver Destination (Windows).") ➔P.453
 (See "Configuring the Destination in TCP/IP Networks (Mac OS).") ➔P.457

Cannot print over a Bonjour networkCannot print over a Bonjour network
Cause Corrective Action

The computer you are trying to
print from is not configured cor-
rectly.

Make sure the computer is configured correctly.
 (See "Configuring the Destination for Bonjour Network (Mac OS).") ➔P.457

The computer and printer are not
on the same network.

Due to the nature of Bonjour, you cannot print if the printer is on another network behind a rout-
er. Make sure the computer and printer are on the same network. For information about net-
work settings, ask your network administrator.
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Installation problemsInstallation problems
The computer does not recognize the printer ................................................................................................. 591
Removing Installed Printer Drivers .................................................................................................................. 591

The computer does not recognize the printerThe computer does not recognize the printer
Cause Corrective Action

In the Control Panel menu, Use USB or Use Ethernet is set to Off. Set Use USB or Use Ethernet to On.
 (See "Menu Settings.") ➔P.416

Removing Installed Printer DriversRemoving Installed Printer Drivers
Follow these steps to remove installed printer drivers and utilities.

Removing printer drivers (Windows)
Remove the printer driver as follows.

Note
• The following procedure is for Windows 7. The method of removing printer drivers varies depending on the version

of Windows.

1 From the Windows start menu, select All Programs > Canon Printer Uninstaller > imagePROGRAF
Printer Driver Uninstaller to display the Delete Printer window.

2 Select the printer in the list and click Delete.

3 Click Yes after the Warning message is displayed.

4 Make sure that the printer has been removed from the list, and then click Exit.

Removing imagePROGRAF Status Monitor (Windows)
Remove imagePROGRAF Status Monitor as follows.

Note
• The following procedure is for Windows 7. The method of removing printer drivers varies depending on the version

of Windows.

1 Select Control Panel from the start menu.

2 Select Uninstall a program.

Note
• If the User Account Control dialog box is displayed, click Yes.

3 Select imagePROGRAF Status Monitor, and then click the Uninstall button.

Removing imagePROGRAF Device Setup Utility (Windows)
Remove imagePROGRAF Device Setup Utility as follows.

Note
• The following procedure is for Windows 7. The method of removing printer drivers varies depending on the version

of Windows.

1 Select Control Panel from the start menu.
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2 Select Uninstall a program.

Note
• If the User Account Control dialog box is displayed, click Yes.

3 Select imagePROGRAF Device Setup Utility, and then click the Uninstall button.
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HP-GL/2 problemsHP-GL/2 problems
With HP-GL/2, printing is misaligned .............................................................................................................. 593
Lines or images are missing in printed HP-GL/2 jobs. ..................................................................................... 593
Lines are printed too thick or thin in HP-GL/2 print jobs .................................................................................. 593
HP-GL/2 jobs are printed in monochrome (or color) ........................................................................................593
Printed colors of lines are inaccurate during HP-GL/2 printing ........................................................................ 594
HP-GL/2 jobs are printed 6 mm larger than specified ..................................................................................... 594
HP-GL/2 jobs are printed at maximum size, even if a standard size is specified .............................................. 594

HP-GL/2 printing takes a long time .................................................................................................................594
The printer stops when printing a HP-GL/2 job (the carriage stops moving) .................................................... 594

With HP-GL/2, printing is misalignedWith HP-GL/2, printing is misaligned
Cause Corrective Action

The plotter origin is incorrect. Check the printing commands.

Set Detect img size to Command priority or Detected size in the Control Panel
menu.
 (See "Menu Settings.") ➔P.416

The Margin setting in the Control Panel
menu is incorrect.

Adjust the Margin setting values in the Control Panel menu.
 (See "Menu Settings.") ➔P.416

Lines or images are missing in printed HP-GL/2 jobs.Lines or images are missing in printed HP-GL/2 jobs.
Cause Corrective Action

The memory is full. Check the size of the data in the print job.

An HP-GL/2 command not supported by this printer was
received.

Check the print job and settings.

The printer has received print data that includes HP RTL
commands when Auto Rotate is On in the Control Pan-
el menu.

In the Control Panel, set Auto Rotate to Off and print again.
 (See "Menu Settings.") ➔P.416

The plotter origin is incorrect. Set Detect img size to Command priority or Detected size in the Con-
trol Panel menu.
 (See "Menu Settings.") ➔P.416

Oversize in the Control Panel menu is set to Off. Set Oversize to On in the Control Panel menu.
 (See "Menu Settings.") ➔P.416

Lines are printed too thick or thin in HP-GL/2 print jobsLines are printed too thick or thin in HP-GL/2 print jobs
Cause Corrective Action

The Width setting in the Control Panel menu
is incorrect.

Change the Width setting configured in Pen no. of the Palette A or Palette B selec-
ted in the Control Panel menu.
 (See "Menu Settings.") ➔P.416

ThickenFineLines in the Control Panel
menu is set to Off.

If fine lines are printed faintly, setting ThickenFineLines to On will print the lines
more distinctly.
 (See "Menu Settings.") ➔P.416

The Ln wdth correct setting in the Control
Panel menu is incorrect.

Change the Ln wdth correct setting in the Control Panel menu.
 (See "Menu Settings.") ➔P.416

HP-GL/2 jobs are printed in monochrome (or color)HP-GL/2 jobs are printed in monochrome (or color)
Cause Corrective Action

The Color Mode setting in the
Control Panel menu is incor-
rect.

Check the Color Mode setting in the Control Panel menu.
 (See "Menu Settings.") ➔P.416
However, for optimal Printhead performance, the printer consumes trace amounts of color ink even
when Monochrome is selected as Color Mode.
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Printed colors of lines are inaccurate during HP-GL/2 printingPrinted colors of lines are inaccurate during HP-GL/2 printing
Cause Corrective Action

AdjustFaintLines is On in the Con-
trol Panel menu.

Setting AdjustFaintLines to Off in the Control Panel menu may help produce the expected
results. However, lines in some colors may appear broken.

HP-GL/2 jobs are printed 6 mm larger than specifiedHP-GL/2 jobs are printed 6 mm larger than specified
Cause Corrective Action

The page size of the HP-GL/2 print job, as created in the source application, is
incorrect.

In the Control Panel menu, set Oversize to Off.
 (See "Menu Settings.") ➔P.416

HP-GL/2 jobs are printed at maximum size, even if a standard size is specifiedHP-GL/2 jobs are printed at maximum size, even if a standard size is specified
Cause Corrective Action

The page size of the HP-GL/2 print job, as created in the
source application, is incorrect.

Set Detect img size to Command priority or Detected size in the
Control Panel menu.
 (See "Menu Settings.") ➔P.416

Set Conserve Paper to On in the Control Panel menu.
 (See "Menu Settings.") ➔P.416

HP-GL/2 printing takes a long timeHP-GL/2 printing takes a long time
Cause Corrective Action

Large print jobs with a lot of data take longer to print. Please wait a while until printing is finished.

A job was printed when Input Resolution in the Control
Panel menu was set to 600dpi.

In the Control Panel menu, set Input Resolution to 300dpi and print
again.
 (See "Menu Settings.") ➔P.416

The printer stops when printing a HP-GL/2 job (the carriage stops moving)The printer stops when printing a HP-GL/2 job (the carriage stops moving)
Cause Corrective Action

The printer is analyzing the print job. Please wait a while until printing is finished.

A job was printed when Input Resolution in the Control
Panel menu was set to 600dpi.

In the Control Panel menu, set Input Resolution to 300dpi and print
again.
 (See "Menu Settings.") ➔P.416
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Other problemsOther problems
The Ink Tank Cover has become detached from the printer ............................................................................ 595
The printer does not go on ............................................................................................................................. 595
The printer takes time to start up .................................................................................................................... 595

If the Printer Makes a Strange Sound ............................................................................................................. 596

Messages advising to check the maintenance cartridge are not cleared ......................................................... 596

The printer consumes a lot of ink .................................................................................................................... 596
Ink Level Detection ......................................................................................................................................... 596

The Ink Tank Cover has become detached from the printerThe Ink Tank Cover has become detached from the printer
Cause Corrective Action

The Ink Tank Cover became detached from the printer because too
much force was applied to the Ink Tank Cover.

Attach the Ink Tank Cover to the printer.
 (See "Attach the Ink Tank Cover to the printer.") ➔P.542

The printer does not go onThe printer does not go on
Cause Corrective Action

The printer is unplugged. Plug the power cord into the outlet, and then turn on the printer.

The specified voltage is not supplied. Check the voltage of the outlet and breaker.
 (See "Specifications.") ➔P.622

The printer takes time to start upThe printer takes time to start up
Cause Corrective Action

The printer may have shut down incorrectly last time. This may hap-
pen after power outages or if the printer is unplugged before it is
turned off.
In this case, the next time power is restored, the printer's hard disk is
checked, and startup may take some time.

Please wait a while, because it may take several minutes to
finish checking the hard disk.
If an error message is displayed after the hard disk check,
follow the instructions indicated to resolve the problem.
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If the Printer Makes a Strange SoundIf the Printer Makes a Strange Sound
Cause Corrective Action

The printer
makes a sound
during opera-
tion.

The following sounds do not indicate a problem with the printer.

• There is a sound of suction from the Platen
To prevent paper from rising, paper is held against the Platen by suction from Vacuum holes under it.

• There is a sound when a different size of paper is used and when the Carriage goes from side to side
When paper of a different size is used, a valve is automatically activated to switch the area for paper suction,
which may make a sound. This mechanism prevents suction from Vacuum holes where there is no paper.
In addition, ink is ejected in sync with the movement of the Carriage back and forth to ensure optimal ink flow.
At this time, the valve automatically switches the area for paper suction, which may make a sound.

• Roll paper makes a fluttering sound during printing
There may be a fluttering sound when large paper is advanced.

• If you suddenly hear the tone for cleaning operations
At regular intervals, for printer maintenance, cleaning operations will begin automatically, even if the printer is
in Sleep mode.

• If you suddenly hear the tone for ink agitation
At regular intervals, to ensure optimal printing quality, the ink is agitated automatically, even if the printer is in
Sleep mode.
The ink is also agitated automatically under the following conditions. Note that other operations are not possi-
ble while "Agitating..." is displayed on the control panel.

• After the printer is turned on

In other cases, contact your Canon dealer.

Messages advising to check the maintenance cartridge are not clearedMessages advising to check the maintenance cartridge are not cleared
Cause Corrective Action

The printer has not detected the new Mainte-
nance Cartridge that was used to replace the old
one.

Remove the new Maintenance Cartridge you have just installed and insert it
again firmly.
 (See "Replacing the Maintenance Cartridge.") ➔P.552

The printer consumes a lot of inkThe printer consumes a lot of ink
Cause Corrective Action

Many full-page color images are
printed.

In print jobs such as photos, images are filled with color. This consumes a lot of ink. This does
not indicate a problem with the printer.

Head Cleaning B in the Control
Panel menu is executed fre-
quently.

Head Cleaning B in the Control Panel menu consumes a lot of ink. This does not indicate a
problem with the printer. Unless the printer has been moved or stored for a long period or you
are troubleshooting Printhead problems, we recommend not performing Head Cleaning B, to
the extent possible.

You have just finished initial in-
stallation, when more ink is con-
sumed to fill the system.

After initial installation or at the first-time use after transfer, ink flows into the system between the
Ink Tank and Printhead.
Although the amount of remaining ink may drop as a result, it does not indicate a problem.

The Printhead nozzles are clog-
ged.

Check for nozzle clogging.
 (See "Checking for Nozzle Clogging.") ➔P.544

Ink Level DetectionInk Level Detection
Ink level detection will be deactivated if you load ink tanks once emptied.

Ink level detection
Ink tanks specified for this printer feature an ink level detection function to prevent the ink from running out during
printing, which prevents printer damage.  (See "Ink Tanks.") ➔P.536
This function will not work correctly if you use refill ink tanks. As a result, printing stops. Thus, before using refill ink
tanks, you must cancel the ink level detection.
Printing with the ink level detection canceled may lead to printer damage and printing problems. Canon Inc. is not
liable for any damage that may occur as a result of refilling ink.
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Important
• After ink level detection has been released, this function cannot be reactivated for currently loaded Ink Tank. To

use ink level detection again, replace the Ink Tank with new ones specified for use with the printer.

• Repeatedly removing and inserting an Ink Tank may damage the connection between the Ink Tank and the print-
er, which may cause ink leakage from the Ink Tank and damage the printer.

Releasing ink level detection

1
 

On the Display Screen, a message indicates that the ink level cannot
be detected. After checking the message, press the ▶ button.

2
 

Press ▲ or ▼ to select Information, and then press the OK button.

3
 

A confirmation message is shown on the Display Screen about re-
leasing ink level detection. After checking the message, press the ▶
button.

4
 

After checking the message, press the ▶ button.

5
 

Press ▲ or ▼ to select Yes, and then press the OK button.

6
 

Check the message and press the ▶ button.
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7
 

Check the message and press the ▶ button.

8
 

Press ▲ or ▼ to select Yes, and then press the OK button.

9
 

A confirmation message about updating ink information is shown on
the Display Screen. After checking the message, press the ▶ button.

10
 

Press ▲ or ▼ to select Yes, and then press the OK button.

Ink level detection is now released.
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Error MessagesError Messages
Borderless printng not possible. ..................................................................................................................... 609

Cannot adjust paper feed. .............................................................................................................................. 612
Cannot adjust printhead. ................................................................................................................................ 613
Cannot detect ink level correctly. Close tank cover. .........................................................................................610
Cannot detect papr ........................................................................................................................................ 608
Cannot recognize print head. ..........................................................................................................................613
Check if ink tank is set, and its color and direction. .........................................................................................611
Check printed document. ............................................................................................................................... 612
Close Ink Tank Cover ......................................................................................................................................610

Do not pull out ink tank. ..................................................................................................................................611

End of paper feed. ..........................................................................................................................................608
ERROR Exxx-xxxx (x represents a letter or number) ....................................................................................... 619
Error in cutter position. ................................................................................................................................... 620
Execute printhead cleaning. ............................................................................................................................614

File read error. ................................................................................................................................................ 616

GARO Wxxxx (x represents a number) ............................................................................................................619
GL2: W0502 The parameter is out of range. ................................................................................................... 618
GL2: W0504 This command is not supported. ............................................................................................... 618
GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904) ....................................................................... 618

Hard disk error. ............................................................................................................................................... 616
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ..................................................................... 619

Ink insufficient. ................................................................................................................................................ 610
Ink tank is empty. ........................................................................................................................................... 611
Insert the maintenance cartridge. ................................................................................................................... 615
Insufficient paper for job ................................................................................................................................. 605

Leading edge detection error. ......................................................................................................................... 608

Mail box full. Delete unwanted data ................................................................................................................ 616
Mail box full. Now printing without saving data. ...............................................................................................616
Mail box nearly full. ......................................................................................................................................... 616
Maint. cart. The level is low ............................................................................................................................. 615
Maintenance cartridge full. .............................................................................................................................. 615
Maintenance cartridge problem. ..................................................................................................................... 615
Maximum jobs stored. .................................................................................................................................... 616
MediaType Mismatch ......................................................................................................................................602
Multi-sensor error ........................................................................................................................................... 620

No ink left. ...................................................................................................................................................... 610
No Maintenance Cartridge capacity. ............................................................................................................... 615
Not much ink is left. ........................................................................................................................................ 611

Paper cutting failed. ........................................................................................................................................608
Paper is crooked. ........................................................................................................................................... 607
Paper jam .......................................................................................................................................................607
Paper mismatch ............................................................................................................................................. 602
Paper not aligned with right guide. ................................................................................................................. 607
Paper position not suitable for borderless printing. ......................................................................................... 609
Paper size not detected. .................................................................................................................................604
PaprWidth Mismatch ...................................................................................................................................... 604
Parts replacement time has passed. ............................................................................................................... 620
Prepare for parts replacement. ....................................................................................................................... 620
Printhead error ............................................................................................................................................... 613
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Regular printing is selected, but a roll is loaded. ............................................................................................. 606
Rel lever is in wrong position. ......................................................................................................................... 608
Remaining level of the ink cannot be correctly detected. Check ink tank. ........................................................610
Roll paper is not securely in contact with roll holder. ....................................................................................... 609
Roll printing is selected, but sheets are loaded. .............................................................................................. 605
Roll printing is selected. .................................................................................................................................. 605

Sheet printing is selected. ...............................................................................................................................606

The following ink tanks cannot be recognized. ................................................................................................611
The mail box is full. ......................................................................................................................................... 616
The paper is too small. ................................................................................................................................... 603
The paper is too small. ................................................................................................................................... 603
The roll is empty. ............................................................................................................................................ 606
This paper cannot be used. ............................................................................................................................ 605
This type of paper is not compatible with HP-GL/2. ........................................................................................ 618
Top cover is open. .......................................................................................................................................... 620

Unknown file. ..................................................................................................................................................620

Wrong ink tank. .............................................................................................................................................. 611
Wrong maintenance cartridge. ........................................................................................................................615
Wrong printhead. ............................................................................................................................................613
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Messages regarding paperMessages regarding paper
Paper mismatch ............................................................................................................................................. 602
MediaType Mismatch ......................................................................................................................................602
The paper is too small. ................................................................................................................................... 603
The paper is too small. ................................................................................................................................... 603
PaprWidth Mismatch ...................................................................................................................................... 604
Paper size not detected. .................................................................................................................................604
Insufficient paper for job ................................................................................................................................. 605
This paper cannot be used. ............................................................................................................................ 605

Roll printing is selected. .................................................................................................................................. 605
Roll printing is selected, but sheets are loaded. .............................................................................................. 605
The roll is empty. ............................................................................................................................................ 606

Sheet printing is selected. ...............................................................................................................................606
Regular printing is selected, but a roll is loaded. ............................................................................................. 606

Paper jam .......................................................................................................................................................607
Paper is crooked. ........................................................................................................................................... 607
Paper not aligned with right guide. ................................................................................................................. 607
Cannot detect papr ........................................................................................................................................ 608
Leading edge detection error. ......................................................................................................................... 608
Paper cutting failed. ........................................................................................................................................608
End of paper feed. ..........................................................................................................................................608
Rel lever is in wrong position. ......................................................................................................................... 608

Borderless printng not possible. ..................................................................................................................... 609
Paper position not suitable for borderless printing. ......................................................................................... 609

Roll paper is not securely in contact with roll holder. ....................................................................................... 609

Paper mismatchPaper mismatch
Cause Corrective Action

You tried to print a test pattern for printer adjust-
ment on several sheets, but sheets of different
types or sizes of paper were used.

When printing a test pattern for adjustment, use sheets of the same size and
type of paper, in the required quantity.
Press ▲ or ▼ to select Change Paper, press the OK button, and replace the
paper.
 (See "Loading and Printing on Sheets.") ➔P.21
The printer now starts printing the test pattern.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

MediaType MismatchMediaType Mismatch
Cause Corrective Action

When Detect Mismatch in the Control Panel
menu is set to Pause, the type of paper loaded
does not match the type specified in the printer
driver.

Follow these steps to ensure the paper type matches on the printer and in the
printer driver.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Change the paper type setting in the printer driver to the type loaded in the
printer and try printing again.

Follow these steps to ensure the paper type matches on the printer and in the
printer driver.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.

2. Replace the loaded paper with paper of the type and size you have specified
in the printer driver.
 (See "Loading and Printing on Rolls.") ➔P.18
 (See "Loading and Printing on Sheets.") ➔P.21
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Cause Corrective Action
When Detect Mismatch in the Control Panel
menu is set to Pause, the type of paper loaded
does not match the type specified in the printer
driver.

Press ▲ or ▼ to select Print, and then press the OK button to resume printing.
However, note that this error may cause paper jams and affect the printing quality.

When Detect Mismatch in the Control Panel
menu is set to Warning, the type of paper loa-
ded does not match the type specified in the
printer driver.

You can continue to print, but note that this error may cause paper jams or prob-
lems in the printing results.

The paper is too small.The paper is too small.
Cause Corrective Action

When Detect Mismatch in the Control Panel
menu is set to Pause, paper smaller than the
size specified in the printer driver is loaded.

Press ▲ or ▼ to select Print, and then press the OK button to resume printing.
However, note that this error may cause paper jams and affect the printing quality.

Adjust the paper size setting in the printer driver to match the size loaded in the
printer as follows.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Change the paper size setting in the printer driver to the size loaded in the print-
er and try printing again.

Replace the loaded paper with paper of a size that matches the size setting in the
printer driver as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button to stop
printing.

2. Replace the loaded paper to match the settings in the printer driver and try print-
ing again.
 (See "Loading and Printing on Rolls.") ➔P.18
 (See "Loading and Printing on Sheets.") ➔P.21

When Detect Mismatch in the Control Panel
menu is set to Warning, paper smaller than
the size specified in the printer driver is loa-
ded.

You can continue to print, but note that this error may cause problems in the print-
ing results.

The paper is too small.The paper is too small.

"Replace paper with A4/LTR (vertical) or larger"
Cause Corrective Action

The loaded paper is too small. Replace the paper with paper of A4/Letter (vertical) size or larger as follows.

1. Press ▲ or ▼ to select Change Paper, press the OK button, and remove the paper.
 (See "Removing Sheets.") ➔P.362

2. Switch to paper A4/Letter (vertical) or larger.
 (See "Loading and Printing on Sheets.") ➔P.21
The printer will resume printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

"Replace roll with 10 in. wide or larger roll."
Cause Corrective Action

The loaded paper is too small. Replace the roll with a roll 10 inches in width or larger as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") ➔P.345
 (See "Removing the Roll Holder from Rolls.") ➔P.347

2. Replace the roll with a roll 10 inches wide or larger.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338
 (See "Loading Rolls in the Printer.") ➔P.341
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Cause Corrective Action
The loaded paper is too small. The printer will resume printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

"Remove paper and check pap. size"
Cause Corrective Action

A sheet has come out of the printer during printing. 1. Press the Release Lever back and remove the paper.
2. Reload the sheet, aligning it with the guide on the right.
3. Pull the Release Lever forward.

4. If "Not finished printing. Finish printing remaining jobs?" is shown on
the Display Screen, press the OK button.
Printing will resume, starting from the page on which the error occurred.

 (See "Loading Sheets in the Printer.") ➔P.358

PaprWidth MismatchPaprWidth Mismatch
Cause Corrective Action

When Detect Mismatch in the Control Panel menu is
set to Pause or Hold Job, the width of the loaded roll
does not match the width specified in Fit Roll Paper
Width in the printer driver.

Press ▲ or ▼ to select Print, and then press the OK button to resume
printing.
However, note that this error may cause paper jams and affect the printing
quality.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Follow these steps to replace the roll to match the width specified in the
printer driver.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") ➔P.345
 (See "Removing the Roll Holder from Rolls.") ➔P.347

2. Replace with paper of the width configured in the printer driver.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338
 (See "Loading Rolls in the Printer.") ➔P.341
The printer now starts printing the print job.

Make sure the roll width selected in the dialog box displayed when you se-
lect Fit Roll Paper Width in the printer driver matches the width of the roll
loaded in the printer, and then try printing again.

Paper size not detected.Paper size not detected.
Cause Corrective Action

Paper has been loaded
askew, or warped paper
has been loaded.

Follow these steps to reload the roll.

1. Press the OK button and reload the paper.
 (See "Loading Rolls in the Printer.") ➔P.341

2. Pull the Release Lever forward.

3. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press
the OK button.
Printing will resume, starting from the page on which the error occurred.

If this error recurs after you reload the roll, remove the Roll Holder from the printer, push the roll firmly in
until it touches the Roll Holder flange, and reload the Roll Holder in the printer.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338

Follow these step to reload a sheet.

1. Push the Release Lever back.
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Cause Corrective Action
Paper has been loaded
askew, or warped paper
has been loaded.

2. Load the sheet, aligning it with the guide on the right.
 (See "Loading Sheets in the Printer.") ➔P.358

3. Pull the Release Lever forward.

4. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press
the OK button.
Printing will resume, starting from the page on which the error occurred.

Insufficient paper for jobInsufficient paper for job
Cause Corrective Action

The printer has received a print job longer than the amount of roll paper left when
ManageRemainRoll in the Control Panel menu is On.

Press ▲ or ▼ to select Print, and then press
the OK button to resume printing.
However, the roll paper may run out during the
print job and you may not be able to print all of
the document.

Press ▲ or ▼ to select Change Paper, and
then press the OK button to stop printing.
Either change the printer driver Paper Source
setting or the GL2 Settings > Paper Source
setting in the printer menu or replace the roll
with a roll that has enough paper for the print
job, and then try printing again.
 (See "Removing the Roll from the Print-
er.") ➔P.345
 (See "Loading Rolls in the Printer.") ➔P.341

Press ▲ or ▼ and select Stop Printing or
press the Stop button to stop printing.

This paper cannot be used.This paper cannot be used.
Cause Corrective Action

Paper smaller than the printer's minimum supported
size has been loaded.

Push the Release Lever back and load paper of the correct size.
 (See "Paper Sizes.") ➔P.328

Paper has been loaded that is too small to print the
test pattern for printhead adjustment or nozzle check-
ing.

Push the Release Lever back and load unused paper of A4 size or larger.
More than one sheet may be required depending on the adjustment.

Roll printing is selected.Roll printing is selected.
Cause Corrective Action

You have attempted to print on a roll,
but no roll is loaded.

Press ▲ or ▼ to select "Load Roll Paper", and then press the OK button. Load the roll,
and then print.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338
 (See "Loading Rolls in the Printer.") ➔P.341

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop printing.

Roll printing is selected, but sheets are loaded.Roll printing is selected, but sheets are loaded.
Cause Corrective Action

A print job for rolls was received when a
sheet is loaded.

Follow these steps to load and print on a roll.

1. Press ▲ or ▼ to select Eject Cut Sheet, press the OK button, and remove the sheet.
 (See "Removing Sheets.") ➔P.362

2. Load a new roll.
 (See "Loading Rolls in the Printer.") ➔P.341
The printer now starts printing the print job.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.
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The roll is empty.The roll is empty.
Cause Corrective Action

The roll is empty. Follow these steps to replace the used roll with a new roll of the same type and size.

1. Press the Release Lever back and remove the roll.
 (See "Removing the Roll from the Printer.") ➔P.345
 (See "Removing the Roll Holder from Rolls.") ➔P.347

2. Load the new roll.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338
 (See "Loading Rolls in the Printer.") ➔P.341

3. If no barcode was printed on the roll, specify the type of paper.
 (See "Changing the Type of Paper.") ➔P.343

4. When you have selected ManageRemainRoll > On in the control panel menu and a barcode is not printed
on the roll, also specify the paper length.
 (See "Specifying the Paper Length.") ➔P.345

5. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press the
OK button.
Printing will resume, starting from the page on which the error occurred.
If no message appears, printing will continue from the next page.

There is remaining
roll paper, but be-
cause it could not
be advanced, it
could not be detec-
ted.

The unused portion of the roll is heavy, and this is placing a burden on the printer. It may be helpful to change
the printing mode, which will change the paper feed timing.
Choose a higher level of Print Quality in the Advanced Settings of the printer driver.
 (See "Giving Priority to Particular Graphic Elements and Colors for Printing.") ➔P.54

Sheet printing is selected.Sheet printing is selected.
Cause Corrective Action

You have attempted to print on a sheet, but
no sheet is loaded.

Press ▲ or ▼ to select Load Paper, and then press the OK button. Load a sheet,
and then print.
 (See "Loading and Printing on Sheets.") ➔P.21

Press ▲ or ▼ and select Stop Printing or press the Stop button to stop printing.

Regular printing is selected, but a roll is loaded.Regular printing is selected, but a roll is loaded.
Cause Corrective Action

A print job for printing on
sheets was sent when a roll is
loaded.

1. Press ▲ or ▼ to select Remove Roll Paper, and then press the OK button to stop printing.

2. After removing the roll, load and print on a sheet of the type and size of paper you have speci-
fied in the printer driver.
 (See "Removing the Roll from the Printer.") ➔P.345
 (See "Loading and Printing on Sheets.") ➔P.21

Press ▲ or ▼ to select Stop Printing, and then press the OK button to stop printing.

The roll is empty.                                                                                                                                                                                                    iPF785

                                                                                                                                                                                                                     User's Guide

  

Error M
essage

M
essages regarding paper

 606



Paper jamPaper jam
Cause Corrective Action

A paper jam oc-
curred in the
printer during
printing.

For roll paper, cut the paper on the upper side of the {Paper Feed Slot.

1. Push the Release Lever back and remove the jammed paper.
 (See "Clearing Jammed Roll Paper.") ➔P.573
 (See "Clearing a Jammed Sheet.") ➔P.576

2. Load the paper.
 (See "Loading Rolls in the Printer.") ➔P.341
 (See "Loading Sheets in the Printer.") ➔P.358

3. Pull the Release Lever forward.

4. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen, press the OK
button.
Printing will resume, starting from the page on which the error occurred.

Paper is crooked.Paper is crooked.
Cause Corrective Action

Paper loaded crooked was detected when the paper was advanced. Follow these steps to reload the roll.

1. Push the Release Lever back.

2. Adjust the right edge of the roll to make it parallel to the
orange Paper Alignment Line.

3. Pull the Release Lever forward.

 (See "Loading Rolls in the Printer.") ➔P.341

If this error recurs after you reload the roll, remove the Roll
Holder from the printer, push the roll firmly in until it touches
the Roll Holder flange, and reload the Roll Holder in the print-
er.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338

Follow these step to reload a sheet.

1. Push the Release Lever back.
2. Pull out the sheet.
3. Pull the Release Lever forward.
4. Reload the sheet, aligning it with the guide on the right.

 (See "Loading Sheets in the Printer.") ➔P.358

Important
• To disable this message (if it is displayed repeatedly despite reloading paper, for example), choose Off or Loose

in the Skew Check Lv. setting of the printer menu. However, this may cause jams and printing problems because
paper may be askew when printed. Also, the Platen may become soiled, which may soil the back of the next
document when it is printed.

Paper not aligned with right guide.Paper not aligned with right guide.
Cause Corrective Action

When paper was loaded, it was not aligned with the guide on the right
side.

Follow these step to reload a sheet.

1. Push the Release Lever back.
2. Pull out the sheet.
3. Pull the Release Lever forward.
4. Reload the sheet, aligning it with the guide on the right.
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Cannot detect paprCannot detect papr
Cause Corrective Action

The printer could not detect the paper. Reload the paper as follows.

1. Remove the paper and press the OK button.

2. Reload the paper.
 (See "Loading Sheets in the Printer.") ➔P.358
 (See "Loading Rolls in the Printer.") ➔P.341

Leading edge detection error.Leading edge detection error.
Cause Corrective Action

The leading edge of the paper cannot be detected. Follow these step to reload a sheet.

1. Push the Release Lever back.

2. Reload the sheet straight, in the correct position.
 (See "Loading Sheets in the Printer.") ➔P.358

Paper cutting failed.Paper cutting failed.
Cause Corrective Action

There are sheets left on the
Ejection Guide.

1. Push the Release Lever back and remove the paper.
2. Load the paper.
3. Pull the Release Lever forward.

4. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on which the error occurred.

 (See "Loading Rolls in the Printer.") ➔P.341

There is a foreign object by
the Output Tray, obstructing
the Cutter Unit.

1. Lift the Top Cover and remove the foreign object.

2. If "Not finished printing. Finish printing remaining jobs?" is shown on the Display Screen,
press the OK button.
Printing will resume, starting from the page on which the error occurred.

You are not using the printer
under the recommended
environmental conditions for
the paper.

Use the printer only where the recommended environmental conditions for the paper are met. Note
that various environmental conditions are recommended for various types of paper. For details on the
recommended environmental conditions for paper, see Paper Reference Guide."
 (See "Displaying the Paper Reference Guide.") ➔P.331

You are using paper that is
not compatible with auto-
matic cutting.

1. Specify Manual as the cutting method and use scissors or a cutting tool to cut the roll.
 (See "Specifying the Cutting Method for Rolls.") ➔P.351
For information about paper that is compatible with automatic cutting, see the Paper Reference
Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

2. Push the Release Lever back and remove the paper.

In other cases, the Cutter
Unit may be damaged.

Contact your Canon dealer for assistance.

End of paper feed.End of paper feed.
Cause Corrective Action

Although an attempt was made to advance the paper manually, it reached the limit
position that can be advanced.

Canceling manual advancing.
 (See "Feeding Roll Paper Manually.") ➔P.349

Rel lever is in wrong position.Rel lever is in wrong position.
Cause Corrective Action

The Release Lever is pushed back. Pull the Release Lever forward.
Turn off the printer and wait a while before restoring power.
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Borderless printng not possible.Borderless printng not possible.
Cause Corrective Action

The print job received specifies a
type or width of paper that is not
compatible with borderless print-
ing.

Follow these steps to change the settings of the print job to enable borderless printing.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Make sure the correct printer driver for the printer is selected and try printing again.
For information on types of paper compatible with borderless printing, refer to the Paper
Reference Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

Press ▲ or ▼ to select Print With Border, and then press the OK button to continue printing.
The document will be printed with a border.

The loaded paper is a size not
compatible with borderless print-
ing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Replace the paper with paper compatible for borderless printing as follows.

1. Press ▲ or ▼ to select Change Paper, and then press the OK button.
 (See "Removing the Roll from the Printer.") ➔P.345
 (See "Removing the Roll Holder from Rolls.") ➔P.347

2. Replace the paper with paper compatible for borderless printing.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338
 (See "Loading Rolls in the Printer.") ➔P.341
The printer now starts printing the print job.
For information on types of paper compatible with borderless printing, refer to the Paper
Reference Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

Press ▲ or ▼ to select Print With Border, and then press the OK button to continue printing.
The document will be printed with a border.

Because paper expands or con-
tracts depending on the environ-
ment of use, it may become nar-
rower or wider than the supported
width for borderless printing.

Use each type of paper only where the recommended environmental conditions are met. For
details on environmental conditions for various paper, see the Paper Reference Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

Paper position not suitable for borderless printing.Paper position not suitable for borderless printing.
Cause Corrective Action

Because paper expands or con-
tracts depending on the environ-
ment of use, it may become nar-
rower or wider than the suppor-
ted width for borderless printing.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.
Use each type of paper only where the recommended environmental conditions are met. For de-
tails on environmental conditions for various paper, see the Paper Reference Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

The paper is loaded askew. Press ▲ or ▼ to select Fix Paper Position and straighten the paper so that the edges are be-
tween the ink grooves for borderless printing.
Insert the roll firmly until it touches the flange of the Roll Holder.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338

Press ▲ or ▼ to select Print With Border, and then press the OK button to continue printing.
The document will be printed with a border.

Press ▲ or ▼ to select Stop Printing, and then press the OK button.

Roll paper is not securely in contact with roll holder.Roll paper is not securely in contact with roll holder.
Cause Corrective Action

When the roll was loaded, the roll was not inserted firmly all
the way on the Roll Holder.

Follow these steps to reload the roll.

1. Press the OK button and remove the roll holder from the printer.

2. Insert the roll firmly on the Roll Holder until it touches the flange.
 (See "Attaching the Roll Holder to Rolls.") ➔P.338

3. Load the Roll Holder in the printer.
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Messages regarding inkMessages regarding ink
Ink insufficient. ................................................................................................................................................ 610
No ink left. ...................................................................................................................................................... 610
Remaining level of the ink cannot be correctly detected. Check ink tank. ........................................................610
Cannot detect ink level correctly. Close tank cover. .........................................................................................610

Close Ink Tank Cover ......................................................................................................................................610
Ink tank is empty. ........................................................................................................................................... 611
Not much ink is left. ........................................................................................................................................ 611
Check if ink tank is set, and its color and direction. .........................................................................................611
The following ink tanks cannot be recognized. ................................................................................................611
Wrong ink tank. .............................................................................................................................................. 611
Do not pull out ink tank. ..................................................................................................................................611

Ink insufficient.Ink insufficient.
Cause Corrective Action

The ink level is low, so you cannot print, clean the Printhead, or
do other operations that require ink.
There is not enough ink of the color with × displayed above the
remaining ink indicator.

Press ▲ or ▼ to select Rep. Ink Tank, and then press the OK
button. Replace the Ink Tank that is low with a new Ink Tank.
 (See "Replacing Ink Tanks.") ➔P.536

Press ▲ or ▼ to select Continue to print, and then press the
OK button to resume printing. However, note that this error may
affect the printing quality.

Press the OK button, open the Ink Tank Cover, and replace the
Ink Tank for the color that does not have enough ink.
 (See "Replacing Ink Tanks.") ➔P.536

No ink left.No ink left.
Cause Corrective Action

There is no ink left.
There are no ink colors with × displayed above the
remaining ink indicator.

Press the OK button, open the Ink Tank Cover, and replace the Ink Tank for the
color that is out of ink.
 (See "Replacing Ink Tanks.") ➔P.536

Remaining level of the ink cannot be correctly detected. Check ink tank.Remaining level of the ink cannot be correctly detected. Check ink tank.
Cause Corrective Action

Ink level detection cannot work correctly
if you use refill ink tanks.

The refill ink tank can no longer be used. See the section Ink level detection and take
the appropriate action.  (See "Ink Level Detection.") ➔P.596

Cannot detect ink level correctly. Close tank cover.Cannot detect ink level correctly. Close tank cover.
Cause Corrective Action

The remaining ink level could not be correctly detected. Close the Ink Tank Cover.
The buzzer stops sounding.
Next, "No ink left." is displayed and see "No ink left.." ➔P.610

Close Ink Tank CoverClose Ink Tank Cover
Cause Corrective Action

The Ink Tank Cover is open. Close the Ink Tank Cover.
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Ink tank is empty.Ink tank is empty.
Cause Corrective Action

There is no ink left in an ink tank.
There are no ink colors with × displayed above the remaining ink indi-
cator in the Ink tab top screen.
 (See "Checking Ink Tank Levels.") ➔P.541

Open the Ink Tank Cover, and replace the Ink Tank for the
color that is out of ink.
 (See "Replacing Ink Tanks.") ➔P.536

Not much ink is left.Not much ink is left.
Cause Corrective Action

Not much ink is left. Prepare a new Ink Tank.
We recommend replacing the Ink Tank with a new Ink Tank at this point if you plan to print large-format or
high-quantity jobs.

Check if ink tank is set, and its color and direction.Check if ink tank is set, and its color and direction.
Cause Corrective Action

There is no Ink Tank of the indicated color in the printer. Load the Ink Tank.
 (See "Replacing Ink Tanks.") ➔P.536

There is a problem with the Ink Tank. Replace it with a new Ink Tank.
 (See "Replacing Ink Tanks.") ➔P.536

The following ink tanks cannot be recognized.The following ink tanks cannot be recognized.
Cause Corrective Action

An Ink Tank that is incompatible with the printer is loaded. Load an Ink Tank that is compatible with the printer.
 (See "Replacing Ink Tanks.") ➔P.536

Wrong ink tank.Wrong ink tank.
Cause Corrective Action

The Ink Tank in the printer is incompatible. Load an Ink Tank specified for use with the printer.
 (See "Replacing Ink Tanks.") ➔P.536

Do not pull out ink tank.Do not pull out ink tank.
Cause Corrective Action

The Ink Tank was removed using an
incorrect procedure.

Install the Ink Tank that was removed.
The buzzer stops sounding.
Next, replace the Ink Tank using the procedure on the Display Screen in the Control Panel.
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Messages regarding printing or adjustmentMessages regarding printing or adjustment
Cannot adjust printhead. ................................................................................................................................ 613

Borderless printng not possible. ..................................................................................................................... 609

Cannot adjust paper feed. .............................................................................................................................. 612
Check printed document. ............................................................................................................................... 612

Cannot adjust paper feed.Cannot adjust paper feed.
Cause Corrective Action

The Printhead nozzles are clogged. Execute Adj. Quality again, as follows.

1. Press the OK button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") ➔P.544

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") ➔P.545

4. Execute Adj. Quality again.
 (See "Automatic Banding Adjustment.") ➔P.528

Highly transparent film is loaded that cannot be
used for automatic feed amount adjustment.

Press the OK button to clear the error, and then adjust the feed amount manually.
 (See "Manual Banding Adjustment.") ➔P.529

Check printed document.Check printed document.
Cause Corrective Action

The Printhead nozzles are becoming clogged. If printing is faint, clean the Printhead.
 (See "Cleaning the Printhead.") ➔P.545
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Messages regarding printheadsMessages regarding printheads
Cannot adjust printhead. ................................................................................................................................ 613

Wrong printhead. ............................................................................................................................................613
Printhead error ............................................................................................................................................... 613
Cannot recognize print head. ..........................................................................................................................613
Execute printhead cleaning. ............................................................................................................................614

Cannot adjust printhead.Cannot adjust printhead.
Cause Corrective Action

The Printhead nozzles are
clogged.

Execute Head Posi. Adj. again, as follows.

1. Press the OK button to clear the error.

2. Print a test pattern to check the nozzles.
 (See "Checking for Nozzle Clogging.") ➔P.544

3. Clean the Printhead if the nozzles are clogged.
 (See "Cleaning the Printhead.") ➔P.545

4. Execute Head Posi. Adj. again.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520

The Printhead cannot be
aligned; highly transparent film
is loaded.

Press the OK button to clear the error.
We recommend using a type of paper that you often use, other than film, for Printhead adjustment.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520

The Printhead is installed
crooked.

Straighten the Printhead as follows, and then execute Head Posi. Adj. again.

1. Press the OK button to clear the error.

2. Use Head Inc. Adj. to adjust the angle of inclination of the Printhead.
 (See "Adjusting Line Misalignment.") ➔P.523

3. Execute Head Posi. Adj. again.
 (See "Automatic Adjustment to Straighten Lines and Colors.") ➔P.520

Wrong printhead.Wrong printhead.
Cause Corrective Action

An incompatible Printhead has been installed. Open the Top Cover and replace the Printhead with a new one.
 (See "Replacing the Printhead.") ➔P.546

Printhead errorPrinthead error
Cause Corrective Action

There is a problem with the Printhead. Open the Top Cover and replace the Printhead with a new one.
 (See "Replacing the Printhead.") ➔P.546

Cannot recognize print head.Cannot recognize print head.
Cause Corrective Action

No Printhead is installed. Follow these steps to install the Printhead.

1. Open the Top Cover.

2. Install the Printhead.
 (See "Replacing the Printhead.") ➔P.546

The Printhead cannot be recognized because it is not installed correctly. Follow these steps to reinstall the Printhead.

1. Open the Top Cover.

2. Reinstall the Printhead.
 (See "Replacing the Printhead.") ➔P.546
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Execute printhead cleaning.Execute printhead cleaning.
Cause Corrective Action

The Printhead noz-
zles are clogged.

Follow these steps to clean the Printhead.

1. Stop printing by pressing ▲ or ▼ to select Stop Printing.

2. Clean the Printhead.
 (See "Cleaning the Printhead.") ➔P.545

If the message is still displayed when printing, replace the Printhead.
 (See "Replacing the Printhead.") ➔P.546

Press ▲ or ▼ to select Print, and then press the OK button to resume printing. However, note that this error
may affect the printing quality.
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Messages regarding the maintenance cartridgeMessages regarding the maintenance cartridge
Insert the maintenance cartridge. ................................................................................................................... 615
Wrong maintenance cartridge. ........................................................................................................................615

Maint. cart. The level is low ............................................................................................................................. 615
No Maintenance Cartridge capacity. ............................................................................................................... 615
Maintenance cartridge full. .............................................................................................................................. 615
Maintenance cartridge problem. ..................................................................................................................... 615

Insert the maintenance cartridge.Insert the maintenance cartridge.
Cause Corrective Action

The Maintenance Cartridge is not installed. Install the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") ➔P.552

Wrong maintenance cartridge.Wrong maintenance cartridge.
Cause Corrective Action

A Maintenance Cartridge for a different model of printer is in-
stalled.

Replace it with the Maintenance Cartridge for your particular model.
 (See "Maintenance Cartridge.") ➔P.552

Maint. cart. The level is lowMaint. cart. The level is low
Cause Corrective Action

The Maintenance Cartridge is al-
most full.

You can continue to print, but prepare a new Maintenance Cartridge to use when the message
for replacement is displayed.

No Maintenance Cartridge capacity.No Maintenance Cartridge capacity.
Cause Corrective Action

The Maintenance Cartridge cannot absorb
enough ink for Printhead cleaning or other oper-
ation.

After confirming that the printer has stopped operating, replace the Maintenance
Cartridge.
 (See "Replacing the Maintenance Cartridge.") ➔P.552

Maintenance cartridge full.Maintenance cartridge full.
Cause Corrective Action

The Maintenance Cartridge is full. After confirming that the printer has stopped operating, replace the Maintenance Cartridge.
 (See "Replacing the Maintenance Cartridge.") ➔P.552

Maintenance cartridge problem.Maintenance cartridge problem.
Cause Corrective Action

An incompatible or used Maintenance Cartridge has
been installed.

Install an unused Maintenance Cartridge specified for use with the printer.
 (See "Replacing the Maintenance Cartridge.") ➔P.552
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Messages regarding the hard diskMessages regarding the hard disk
Hard disk error. ............................................................................................................................................... 616
File read error. ................................................................................................................................................ 616

The mail box is full. ......................................................................................................................................... 616
Mail box full. Now printing without saving data. ...............................................................................................616
Mail box nearly full. ......................................................................................................................................... 616

Maximum jobs stored. .................................................................................................................................... 616
Mail box full. Delete unwanted data ................................................................................................................ 616

Hard disk error.Hard disk error.
Cause Corrective Action

The format of the printer's hard
disk is invalid.

Press the OK button to start reformatting the hard disk. When formatting is finished, data on the
printer hard disk is erased and the printer automatically restarts.

File read error.File read error.
Cause Corrective Action

Files on the printer's hard disk have become
corrupted.

Restart the printer. Only the corrupted files will be deleted, and the printer will restart.

The mail box is full.The mail box is full.
Cause Corrective Action

There is no more space on the printer's hard disk. Press the Stop button and stop printing.

Delete print jobs from the queue.
 (See "Managing the Job Queue (Deleting or Preempting Other Jobs).") ➔P.486

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") ➔P.494

Mail box full. Now printing without saving data.Mail box full. Now printing without saving data.
Cause Corrective Action

No more space is available on the printer's hard disk, so jobs are now printed
without saving them. (Print jobs can no longer be saved on the hard disk.)

After printing, this message is cleared.

Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") ➔P.494

Mail box nearly full.Mail box nearly full.
Cause Corrective Action

The free hard disk space left for Personal Boxes in the printer's hard disk does
not have more than 1 GB, combined.

Delete unneeded jobs stored in Personal Boxes.
 (See "Deleting Saved Jobs.") ➔P.494

Maximum jobs stored.Maximum jobs stored.
Cause Corrective Action

100 jobs are stored in the personal box. Delete unneeded jobs stored in personal boxes.
 (See "Deleting Saved Jobs.") ➔P.494

Mail box full. Delete unwanted dataMail box full. Delete unwanted data
Cause Corrective Action

100 jobs are stored in the Personal Box. Press the Stop button and stop printing.

Delete print jobs from the queue.
 (See "Managing the Job Queue (Deleting or Preempting Other Jobs).") ➔P.486

Delete unneeded jobs stored in personal boxes.
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Cause Corrective Action
100 jobs are stored in the Personal Box.  (See "Deleting Saved Jobs.") ➔P.494
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Messages regarding HP-GL/2Messages regarding HP-GL/2
This type of paper is not compatible with HP-GL/2. ........................................................................................ 618

GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904) ....................................................................... 618
GL2: W0502 The parameter is out of range. ................................................................................................... 618
GL2: W0504 This command is not supported. ............................................................................................... 618

This type of paper is not compatible with HP-GL/2.This type of paper is not compatible with HP-GL/2.
Cause Corrective Action

The printer has received a HP-GL/2
print job that cannot be printed on the
paper that has been advanced.

Follow these steps to replace the type of paper in the printer.

1. Press ▲ or ▼ to select Stop Printing, and then press the OK button.

2. Replace the paper with a type compatible with HP-GL/2. For details on paper compati-
ble with HP-GL/2, refer to the Paper Reference Guide.
 (See "Displaying the Paper Reference Guide.") ➔P.331

Press ▲ or ▼ to select Print, and then press the OK button to resume printing. However,
note that this error may cause paper jams and affect the printing quality.

GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904)GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904)
Cause Corrective Action

The printer memory is
full.

Because the entire print job could not be received, the printer may not be able to print the entire original.
Check the printing results.

In the Control Panel menu, setting On-the-Fly to On may enable printing. However, check the printing
results because the image may be incomplete in some cases.

GL2: W0502 The parameter is out of range.GL2: W0502 The parameter is out of range.
Cause Corrective Action

A parameter specified in a HP-GL/2 command is out of the suppor-
ted range.

Check the print job.

If you have specified ProcessingOption > Warning > On in
the Control Panel menu, set it to Off instead.

GL2: W0504 This command is not supported.GL2: W0504 This command is not supported.
Cause Corrective Action

The printer has received an unsupported HP-GL/2 com-
mand.

Check the print job.

If you have specified ProcessingOption > Warning > On in the
Control Panel menu, set it to Off instead.

This type of paper is not compatible with HP-GL/2.                                                                                                                                                 iPF785
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Other MessagesOther Messages
GARO Wxxxx (x represents a number) ............................................................................................................619
ERROR Exxx-xxxx (x represents a letter or number) ....................................................................................... 619
Hardware error. xxxxxxxx-xxxx (x represents a letter or number) ..................................................................... 619

Top cover is open. .......................................................................................................................................... 620

Prepare for parts replacement. ....................................................................................................................... 620
Parts replacement time has passed. ............................................................................................................... 620

Unknown file. ..................................................................................................................................................620
Multi-sensor error ........................................................................................................................................... 620

Error in cutter position. ................................................................................................................................... 620

GARO Wxxxx (x represents a number)GARO Wxxxx (x represents a number)
Cause Corrective Action

There is a problem with the print job. Try printing again, using the correct printer driver.

It is also possible to continue printing in this state.
However, you may not be able to obtain the desired printing results.

ERROR Exxx-xxxx (x represents a letter or number)ERROR Exxx-xxxx (x represents a letter or number)
Cause Corrective Action

An error requiring service may have occurred. Write down the error code and message, turn off the printer, and contact your Can-
on dealer for assistance.

Hardware error. xxxxxxxx-xxxx (x represents a letter or number)Hardware error. xxxxxxxx-xxxx (x represents a letter or number)
Cause Corrective Action

The last portion of roll paper was used during a print job. The paper
was not advanced because the trailing edge is taped to the roll.

Turn off the printer and remove the roll from the printer before
restoring power.

Fastening tape or the Belt Stopper has not been removed inside
the Top Cover.

Turn off the printer, open the Top Cover and remove the tape
or the Belt Stopper before restoring power.

An error requiring service may have occurred. Turn off the printer and wait at least three seconds before re-
storing the power.
If the message is displayed again, write down the error code
and message, turn off the printer, and contact your Canon
dealer for assistance.

Hardware error. 03130031-2F7x (x is 0, 1, or 2)
Cause Corrective Action

The ink tank is not
installed correctly.

Turn off the power, remove and then reinstall all of the ink tanks, and then turn on the power.
If the same message is displayed again, write down the error code and message, turn off the printer, and
contact your Canon dealer for assistance.  (See "Replacing Ink Tanks.") ➔P.536
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Top cover is open.Top cover is open.
Cause Corrective Action

The printer has detected that the Top Cover is
open.

Open the Top Cover fully, remove any foreign objects, and close the Top Cover
again.

If the error occurs again, close the Top Cover, turn off the printer, and wait a while
before restoring power.

Prepare for parts replacement.Prepare for parts replacement.
Cause Corrective Action

It is almost time to replace consumables for
which service is required.

If "Parts replacement time has passed." is displayed, you can continue to use the
printer for some time.
Contact your Canon dealer for assistance.

Parts replacement time has passed.Parts replacement time has passed.
Cause Corrective Action

It is past the recommended time to replace consumables for which service is required. Contact your Canon dealer for assistance.

Unknown file.Unknown file.
Cause Corrective Action

Data sent to keep the printer up to date (such as pa-
per information) is in the wrong format.

Check the data. Turn off the printer and wait a while before restoring power,
and then resend the data.

You have uploaded firmware for a different model. Check the firmware version. Turn off the printer and wait a while before re-
storing power, and then resend the firmware.

If the message is displayed again, contact your Canon dealer for assistance.

Multi-sensor errorMulti-sensor error
Cause Corrective Action

Direct sunlight or strong lighting may be shining on
the printer and causing the sensor to malfunction.

Take steps to ensure the printer is not used when exposed to direct sunlight
or strong lighting.

The performance of a sensor inside the printer may
be impaired.

Turn off the printer and wait at least three seconds before restoring the pow-
er.
If the message is displayed again, contact your Canon dealer for assistance.

Error in cutter position.Error in cutter position.
Cause Corrective Action

The Cutter Unit stops in the middle of cutting. 1. Push the Release Lever back and remove the paper.
2. Pull the Release Lever forward.
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Printer SpecificationsPrinter Specifications
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SpecificationsSpecifications

Important
• The following values may vary depending on the operating environment.

Printer

Power supply 100–240 V AC (50/60 Hz)

Power consumption During operation 140 W max.

Sleep mode 5 W max.

Off 0.5 W max. (*1)

Operating noise (*2) Sound pressure level During operation Approx. 48 dB (A)

Standby 35 dB (A) max.

Audio power level (during operation) Approx. 6.5 bels

Operating environment Temperature 15–30°C (59–86°F)

Humidity 10–80%, non-condensing

Dimensions (W × D × H) Printer and Stand (When the
Output Stacker is used)

Extended position A 1,304×887×1,062 mm
(51.3×34.9×41.8 in)

Extended position B 1,304×1,100×1,062 mm
(51.3×43.3×41.8 in)

Weight Main unit and Stand(including
Roll Holder. Does not include
Printhead and Ink Tank.)

Approx. 68.1 kg (150.1 lb)

Space for installation (W × D
× H)

Printer and Stand 1,704×1,700×1,362 mm (67.1×66.9×53.6 in)

Related standards International Energy Star Program, Law on Promoting Green Purchasing/GPN (Japan), Eco
Mark (Japan), RoHS

  *1: The printer uses a trace amount of power even when turned off. To stop all power consumption, turn off the printer and
unplug the power cord.

  *2: Calculation based on ISO 7779. Operating conditions: On the Main sheet of the printer driver, Media Type > Plain Paper,
Advanced Settings > Print Priority > Line Drawing/Text, and Print Quality > Standard.

Printing performance

Print method Bubblejet

Maximum resolution 2400 dpi horizontally (*1) × 1200 dpi vertically

Printhead PF-04

Number of nozzles MBK: 5120; Others: 2560 each color

  *1: Prints with a minimum 1/2400 inch dot pitch between ink droplets.

Memory and hard disk

Memory 32 GB (256 MB physical memory)

Hard disk capacity 320 GB

Personal mail boxes (Permanent storage
area)

180 GB

Print job storage capacity Common Box 100 jobs

Specifications                                                                                                                                                                                                        iPF785
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Print job storage capacity Personal Boxes 100 jobs

Interface

USB Format Internal port

Mode Full-speed (12 Mbps), high-speed (480 Mbps), bulk transfer

Connector Series B (4-pin)

Ethernet Format Internal port

Specification IEEE 802.3 10Base-T,
IEEE 802.3u 100Base-TX/Auto-Negotiation,
IEEE 802.3ab 1000Base-T/Auto-Negotiation,
IEEE 802.3x Full Duplex
IEEE 802.3az EEE

Protocols SNMP (supports Canon-MIB), HTTP, TCP/IP (IPv4/IPv6)

Ink
For information on the ink the printer supports, see "Ink Tanks." ➔P.536

Paper
For information on the types of paper the printer supports, refer to the Paper Reference Guide.  (See "Displaying
the Paper Reference Guide.") ➔P.331

Paper width For information on the paper widths the printer supports, see "Paper Sizes." ➔P.328

Minimum paper length Rolls 203.2 mm (8.0 in)

Sheets 279.4 mm (11.0 in)

Maximum printable length (*1) Rolls 18 m (19.7 yd)

Sheets 1,600 mm (63.0 in)

Thickness Rolls 0.07–0.8 mm (0.0028–0.031 in)

Sheets 0.07–0.8 mm (0.0028–0.031 in)

Roll maximum outer diameter 150 mm (6 in) or shorter

Supported paper core inner diameter 2 inches / 3 inches

Print area For details, see "Print Area." ➔P.623

  *1: Varies depending on the operating system or application.

Roll Holder Set Roll Holder Set RH2-33

Print AreaPrint Area
A margin required by the printer is added with respect to the size of paper loaded in the printer. Except in border-
less printing, the actual printing area corresponds to the paper size minus the space for this margin.

Note
• Printable Area: The area that can be printed.
• There is no margin (that is, a margin of 0 mm) during borderless printing on rolls.
• Recommended Print Area: We recommend printing within this area.

• To print so that your original matches the print area exactly, use an oversized paper size that includes the required
margin.  (See "Printing on Oversize Paper.") ➔P.70

 
Margins of Printable Area Margins of Recommended Print Area

Top Edge Bottom Edge Sides Top Edge Bottom Edge Sides
Sheets 3 mm (0.12 in) 23 mm (0.91 in) 3 mm (0.12 in) 20 mm (0.79 in) 23 mm (0.91 in) 5 mm (0.20 in)

Rolls 0/3 mm (0/0.12 in) 0/3 mm (0/0.12 in) 0/3 mm (0/0.12 in) 20 mm (0.79 in) 5 mm (0.20 in) 5 mm (0.20 in)
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Sheets

• Printable Area
a margin of 3 mm (0.12 in) on top, 23 mm (0.91 in) on bottom, and 3 mm (0.12 in) on left and right sides is
required.

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 23 mm (0.91 in) on bottom, and 5 mm (0.20 in) on left and right sides is
required.

Rolls

• Printable Area
A margin of 3 mm (0.12 in) on all sides is required. During borderless printing, the margin on all sides is 0 mm.
For information on paper compatible with borderless printing, see the Paper Reference Guide.  (See "Types
of Paper.") ➔P.328

• Recommended Print Area
A margin of 20 mm (0.79 in) on top, 5 mm (0.20 in) on bottom, and 5 mm (0.20 in) on left and right sides is
required.
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Safety PrecautionsSafety Precautions
Safety Precautions ......................................................................................................................................... 626
Legal Notices ................................................................................................................................................. 628

Safety PrecautionsSafety Precautions
Follow the warnings and precautions below to use the printer safely. Do not perform any operations or procedures
other than as described in this manual. Doing so may result in unexpected accidents and can cause a fire or elec-
trical shocks.

Printer location

Warning
• Do not set up the printer in any location exposed to alcohol, thinner, or other volatile liquids. If these substances

come into contact with electrical components inside the printer, there is a risk of fire or electrical shock.

Caution
• Never install the printer on an unstable or vibrating surface. If it falls over, this could cause personal injury.

• Never set up the printer in a location that is exposed to high humidity or large amounts of dust, or exposed to
direct sunlight, high temperature, or open flame. This could cause a fire or electrical shock. Use the printer loca-
tion in an environment where temperature and humidity are within the ranges of 15 °C to 30 °C (59 °F to 86 °F)
and 10 to 80% RH (with no condensation).

• Never place the printer on a heavy wool or shag carpet. The fibers may enter the printer and cause a fire.

• Keep the area around the power outlet clear of items so that you can disconnect the power cable immediately if
the printer starts operating abnormally. In the event of a printer malfunction, remove the power cable from the
outlet as soon as possible to prevent fire and electrical shocks.

• Do not install the printer near sources of strong electromagnetic fields, whether equipment that generates such
fields or places where such fields occur. This could damage the printer or cause malfunction.

Power Supply

Warning
• Never handle the power cable with wet hands. Doing so may cause electrical shock.

• Insert the power cable securely and completely into the power source. If the power cable is not inserted complete-
ly, this could cause a fire or electrical shock.

• Do not use any power cable other than the one provided. This could cause a fire or electrical shock. Never use the
power cable with any other electrical device.

• Never cut the power cable or attempt to modify it, and never stretch it or bend it forcefully. Never place a heavy
object on the power cable. Damaged sections of the power cable could cause a short circuit and may cause a fire
or electrical shock.

• Never connect the power cable to a power strip or any power source shared by other electrical devices. This could
cause a fire or electrical shock.

• Never knot the power cable or wrap it around itself. This could cause a fire or electrical shock.

• Periodically disconnect the power cable and use a dry cloth to wipe away dust that has collected on the plug and
the area around the power outlet. Leaving the power cable plugged in and not cleaned for a long period, especial-
ly in an area subject to dust, oil, and humidity, could cause the insulation material to deteriorate and lead to a fire.

Caution
• Always grip the plug to remove the power cable from the power outlet. Pulling on the power cable could damage

the cable and lead to a fire or electrical shock.

• Never use an extension cord. This could cause a fire or electrical shock.

• Never use any power source other than 100–120 / 220–240 V AC. This could cause a fire or electrical shock. The
printer operating conditions are described below. Use the printer under the following conditions.
Power supply voltage: 100–120 / 220–240 V AC
Power supply frequency: 50/60 Hz
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In an Emergency

Warning
• If the printer emits smoke or strange odors, continuing to use the printer may cause a fire or electrical shock.

Switch the printer off immediately and remove the power plug from the power outlet. Contact your Canon dealer or
support center.

Cleaning the Printer

Warning
• For cleaning, use a cloth dampened in water. Never use flammable solvents such as alcohol, benzene, or thinner.

If these substances come into contact with electrical components inside the printer, there is a risk of fire or electri-
cal shock.

Caution
• Always disconnect the power cable from the outlet before cleaning the printer. If the printer is switched on acci-

dentally, moving parts inside the printer may cause personal injuries.

Pacemakers

Warning
• This printer generates a low-level magnetic field. Anyone wearing a pacemaker who experiences discomfort while

working around the printer should leave the area. Consult a physician before continuing to work around the printer.

Moving the Printer

Caution
• Moving the printer requires at least three people, holding it on both sides and from behind. Be careful to avoid

back strain and other injuries.

• When moving the printer, firmly grasp the Carrying Handles under each side and in back. The printer may be
unsteady if you hold it at other positions, which poses a risk of injury from dropping the printer.

Printhead, Ink Tanks, and Maintenance Cartridge

Caution
• Always store consumables in a safe location out of the reach of small children. If a child licks or ingests ink acci-

dentally, seek medical assistance immediately.

• If ink accidentally gets in your eyes, immediately rinse with water.
If ink gets on your skin, immediately clean it off with soap and water.
If irritation persists in your eyes or on your skin, contact a physician immediately.

• Avoid dropping or shaking printheads, ink tanks, and maintenance cartridges. Spilled ink can stain clothing and
the work area.

• Never touch the electrical contacts of the Printhead after printing. The contacts become extremely hot and can
cause minor burns.
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Other

Warning
• Never disassemble the printer or attempt repairs. There are high voltage parts inside the printer that can cause a

fire or electrical shock.

• Never use flammable sprays around the printer. The gas of flammable sprays can cause a fire or electrical shock,
if it contacts high voltage points inside the printer.

• Never touch the cutting edge of Cutter Unit (a). This could cause personal injury.

Caution
• Never insert your hand into the printer while it is printing. Moving parts inside the printer can cause injuries.

• Never place anything on the printer such as small metal objects (paper clips, staples), liquids, any type of liquid
container that contains flammable liquids (alcohol, benzene, etc.). If such objects fall into the printer, this could
cause a fire or electrical shock.

• To prevent a fire hazard or dangerous electric shock, if a foreign object falls into or a liquid spills into the printer,
press the Power button immediately to switch the printer off, unplug the printer power cable from the outlet, and
then contact your Canon dealer or support center. If you continue to use the printer, this could cause a fire or
electrical shock.

Important
• Connect the interface cable correctly. To avoid damage, before connection make sure that the shape of the cable

connector matches the connection point on the printer.

• During printing, turn on the ventilation system in the room.

• We recommend ensuring ample space for installation.

Legal NoticesLegal Notices

FCC Regulations (U.S.A)

Canon Large Format Printer iPF785

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.
 

Note: This equipment has been tested and found to comply with the limits for class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
in a residential installation.
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accord-
ance with the instructions, may cause harmful interference to radio communications.However, there is no guaran-
tee that interference will not occur in a particular installation. If this equipment does cause harmful interference to
radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

 

Use of shielded cable is required to comply with Class B limits in Subpart B of Part 15 of FCC Rules.
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Do not make any changes or modifications to the equipment unless otherwise specified in the manual.
If such changes or modifications should be made, you could be required to stop operation of the equipment.
Canon U.S.A. Inc.
One Canon Park Melville, NY 11747 , U.S.A.
Tel No. 1-800-652-2666

For CA, USA Only
Included battery contains Perchlorate Material - special handling may apply.
See http://www.dtsc.ca.gov/hazardouswaste/perchlorate/ for detail.

Trademarks

• Canon, the Canon logo, and imagePROGRAF are trademarks or registered trademarks of CANON INC.

• Microsoft is a registered trademark of Microsoft Corporation.

• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other countries.

• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other coun-
tries.

• Excel, Internet Explorer and PowerPoint are registered trademarks or trademarks of Microsoft Corporation in
the U.S. and/or other countries.

• Mac, Mac OS, Bonjour, Safari and OS X are trademarks of Apple Inc., registered in the U.S. and other coun-
tries.

• Adobe RGB, a trademark of Adobe Systems Incorporated, is color space proposed by Adobe Systems Incor-
porated.

Copyright

• Unauthorized reproduction of this user manual in whole or part is prohibited.

Legal Notice

• It is illegal to reproduce currency, bills, negotiable securities and other documents prohibited by law. Reproduc-
tion of such items may be subject to criminal prosecution.

• It is illegal to reproduce legal certificates, licenses, travel tickets, and certain public and private documents pro-
hibited from reproduction by law. Reproduction of such items may be subject to criminal prosecution.

• Please note that intellectual property protected by copyright may not be reproduced without the express per-
mission of the copyright holder except for personal or household use under limited circumstances.
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Manuals for this printerManuals for this printer
This printer has the following manuals.

Name Contents Medium
Setup Guide Instructions for unpacking and setting up the printer, and for in-

stalling the software and electronic manuals.
Printed Manuals

Quick Guide Contains information such as a guide to exchanging paper, Ink
Tank, and Printhead, and cautions for using the product safely.

Basic Guide Descriptions of basic printer operations. Electronic manuals

User's Guide Detailed instructions for using the printer.

Paper Reference Guide This guide describes about the types and specifications of the
available media on the printer.

Setup Guide Quick Guide Basic Guide User's Guide Paper Reference Guide

About This User ManualAbout This User Manual
• Symbols

The following symbols are used in this user manual to indicate safety information and explanations on restric-
tions or precautions in use.

Warning Indicates warning items for which operating error poses a risk of death or serious injury. To ensure safe
use, always follow these warnings.

Caution Indicates caution items for which operating error poses a risk of injury. To ensure safe use, always follow
these cautions.

Important Indicates important information and restrictions that definitely are to be followed during operation. Be sure
to read this information to prevent troubles, malfunctions, or damage to equipment or property by operating
errors.

Note Indicates helpful reference information and supplemental information on particular topics.

• Button names and user interface elements
Key and button names on the control panel and user interface elements in software (such as menus and but-
tons) are indicated as follows in this user manual.

Control panel buttons Example: Press the OK button.

Control panel messages Example: Head Cleaning is displayed.

Software interface items
(menus and buttons)

Example: Click OK.

Keyboard keys Example: Press the Tab key.
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• Cross-reference
Other pages or manuals that provide related information are indicated as follows in this user manual.

Cross-reference in the same user manual Example: see "Menu Structure." ➔P.410
Click the link to jump to the corresponding page.

Cross-reference in related manuals Example: Refer to the Paper Reference Guide.

Other cross-reference Example: See the printer driver help.

• Figures and software screens
• Figures in this user manual may be different from the actual appearance of the printer in some cases.

• Screens depicted in this user manual for the printer driver or other software may be different from the ac-
tual screens because of subsequent updates.

• May we request
• The information in this user manual is subject to change without notice.

• We strive to ensure accuracy of information in this user manual, but if you notice errors or omissions, con-
tact support center.
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Disposal of the productDisposal of the product
WEEE DirectiveWEEE Directive

Only for European Union and EEA (Norway, Iceland and Liechtenstein)
These symbols indicate that this product is not to be disposed of with your household waste, according to the
WEEE Directive (2012/19/EU), the Battery Directive (2006/66/EC) and/or national legislation implementing those
Directives.
If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Directive, this indi-
cates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) is present in this battery or accumulator at a
concentration above an applicable threshold specified in the Battery Directive.
This product should be handed over to a designated collection point, e.g., on an authorized one-for-one basis when
you buy a new similar product or to an authorized collection site for recycling waste electrical and electronic equip-
ment (EEE) and batteries and accumulators. Improper handling of this type of waste could have a possible impact
on the environment and human health due to potentially hazardous substances that are generally associated with
EEE. Your cooperation in the correct disposal of this product will contribute to the effective usage of natural resour-
ces.
For more information about the recycling of this product, please contact your local city office, waste authority, ap-
proved scheme or your household waste disposal service or visit ➔ www.canon-europe.com/weee , or
➔ www.canon-europe.com/battery .

Nur für Europäische Union und EWR (Norwegen, Island und Liechtenstein)
Diese Symbole weisen darauf hin, dass dieses Produkt gemäß WEEE-Richtlinie (2012/19/EU; Richtlinie über Elek-
tro- und Elektronik-Altgeräte), Batterien-Richtlinie (2006/66/EG) und nationalen Gesetzen zur Umsetzung dieser
Richtlinien nicht über den Hausmüll entsorgt werden darf.
Falls sich unter dem oben abgebildeten Symbol ein chemisches Symbol befindet, bedeutet dies gemäß der Batter-
ien-Richtlinie, dass in dieser Batterie oder diesem Akkumulator ein Schwermetall (Hg = Quecksilber, Cd = Cadmi-
um, Pb = Blei) in einer Konzentration vorhanden ist, die über einem in der Batterien-Richtlinie angegebenen Grenz-
wert liegt.
Dieses Produkt muss bei einer dafür vorgesehenen Sammelstelle abgegeben werden. Dies kann z. B. durch Rück-
gabe beim Kauf eines neuen ähnlichen Produkts oder durch Abgabe bei einer autorisierten Sammelstelle für die
Wiederaufbereitung von Elektro- und Elektronik-Altgeräten sowie Batterien und Akkumulatoren geschehen. Der un-
sachgemäße Umgang mit Altgeräten kann aufgrund potenziell gefährlicher Stoffe, die generell mit Elektro- und
Elektronik-Altgeräten in Verbindung stehen, negative Auswirkungen auf die Umwelt und die menschliche Gesund-
heit haben.
Durch Ihre Mitarbeit bei der umweltgerechten Entsorgung dieses Produkts tragen Sie zu einer effektiven Nutzung
natürlicher Ressourcen bei.
Um weitere Informationen über die Wiederverwertung dieses Produkts zu erhalten, wenden Sie sich an Ihre Stadt-
verwaltung, den öffentlich-rechtlichen Entsorgungsträger, eine autorisierte Stelle für die Entsorgung von Elektro-
und Elektronik-Altgeräten oder Ihr örtliches Entsorgungsunternehmen oder besuchen Sie
➔ www.canon-europe.com/weee , oder ➔ www.canon-europe.com/battery .

Union Européenne, Norvège, Islande et Liechtenstein uniquement.
Ces symboles indiquent que ce produit ne doit pas être mis au rebut avec les ordures ménagères, comme le spéci-
fient la Directive européenne DEEE (2012/19/UE), la Directive européenne relative à l'élimination des piles et des
accumulateurs usagés (2006/66/CE) et les lois en vigueur dans votre pays appliquant ces directives.
Si un symbole de toxicité chimique est imprimé sous le symbole illustré ci-dessus conformément à la Directive rela-
tive aux piles et aux accumulateurs, il indique la présence d'un métal lourd (Hg = mercure, Cd = cadmium, Pb =
plomb) dans la pile ou l'accumulateur à une concentration supérieure au seuil applicable spécifié par la Directive.

WEEE Directive                                                                                                                                                                                                      iPF785

                                                                                                                                                                                                                     User's Guide

  

Appendix
Disposal of the product

 632

http://www.canon-europe.com/weee
http://www.canon-europe.com/battery
http://www.canon-europe.com/weee
http://www.canon-europe.com/battery


Ce produit doit être confié au distributeur à chaque fois que vous achetez un produit neuf similaire, ou à un point
de collecte mis en place par les collectivités locales pour le recyclage des Déchets des Équipements Électriques et
Électroniques (DEEE). Le traitement inapproprié de ce type de déchet risque d'avoir des répercussions sur l'envir-
onnement et la santé humaine, du fait de la présence de substances potentiellement dangereuses généralement
associées aux équipements électriques et électroniques.
Votre entière coopération dans le cadre de la mise au rebut correcte de ce produit favorisera une meilleure utilisa-
tion des ressources naturelles.
Pour plus d'informations sur le recyclage de ce produit, contactez vos services municipaux, votre éco-organisme
ou les autorités locales compétentes, ou consultez le site ➔ www.canon-europe.com/weee , ou
➔ www.canon-europe.com/battery .

Uitsluitend bestemd voor de Europese Unie en EER (Noorwegen, IJsland en Liechtenstein)
Met deze symbolen wordt aangegeven dat dit product in overeenstemming met de AEEA-richtlijn (2012/19/EU), de
richtlijn 2006/66/EG betreffende batterijen en accu's en/of de plaatselijk geldende wetgeving waarin deze richtlijnen
zijn geïmplementeerd, niet bij het normale huisvuil mag worden weggegooid.
Indien onder het hierboven getoonde symbool een chemisch symbool gedrukt staat, geeft dit in overeenstemming
met de richtlijn betreffende batterijen en accu's aan dat deze batterij of accu een zwaar metaal bevat (Hg = kwik,
Cd = cadmium, Pb = lood) waarvan de concentratie de toepasselijke drempelwaarde in overeenstemming met de
genoemde richtlijn overschrijdt.
Dit product dient te worden ingeleverd bij een hiervoor aangewezen inzamelpunt, bijv. door dit in te leveren bij een
hiertoe erkend verkooppunt bij aankoop van een gelijksoortig product, of bij een officiële inzameldienst voor de re-
cycling van elektrische en elektronische apparatuur (EEA) en batterijen en accu's. Door de potentieel gevaarlijke
stoffen die gewoonlijk gepaard gaan met EEA, kan onjuiste verwerking van dit type afval mogelijk nadelige gevol-
gen hebben voor het milieu en de menselijke gezondheid. Uw medewerking bij het op juiste wijze weggooien van
dit product draagt bij tot effectief gebruik van natuurlijke hulpbronnen.
Voor verdere informatie over recycling van dit product kunt u contact opnemen met uw plaatselijke gemeente, af-
valdienst, officiële dienst voor klein chemisch afval of afvalstortplaats, of kunt u terecht op
➔ www.canon-europe.com/weee , of ➔ www.canon-europe.com/battery .

Sólo para la Unión Europea y el Área Económica Europea (Noruega, Islandia y Liechtenstein)
Estos iconos indican que este producto no debe desecharse con los residuos domésticos de acuerdo con la Direc-
tiva sobre RAEE (2012/19/UE) y la Directiva sobre Pilas y Acumuladores (2006/66/CE) y/o la legislación nacional.
Si aparece un símbolo químico bajo este icono, de acuerdo con la Directiva sobre Pilas y Acumuladores, significa
que la pila o el acumulador contiene metales pesados (Hg = Mercurio, Cd = Cadmio, Pb = Plomo) en una concen-
tración superior al límite especificado en dicha directiva.
Este producto deberá entregarse en un punto de recogida designado, por ejemplo, entregándolo en el lugar de
venta al adquirir un producto nuevo similar o en un centro autorizado para la recogida de residuos de aparatos
eléctricos y electrónicos (RAEE), baterías y acumuladores. La gestión incorrecta de este tipo de residuos puede
afectar al medio ambiente y a la salud humana debido a las sustancias potencialmente nocivas que suelen conten-
er estos aparatos.
Su cooperación en la correcta eliminación de este producto contribuirá al correcto aprovechamiento de los recur-
sos naturales.
Los usuarios tienen derecho a devolver pilas, acumuladores o baterías usados sin coste alguno. El precio de venta
de pilas, acumuladores y baterías incluye el coste de la gestión medioambiental de su desecho, y no es necesario
mostrar la cuantía de dicho coste en la información y la factura suministradas a los usuarios finales.
Si desea más información sobre el reciclado de este producto, póngase en contacto con su municipio, el servicio o
el organismo encargado de la gestión de residuos domésticos o visite ➔ www.canon-europe.com/weee , o
➔ www.canon-europe.com/battery .

Solo per Unione Europea e SEE (Norvegia, Islanda e Liechtenstein)
Questi simboli indicano che il prodotto non può essere smaltito con i rifiuti domestici, ai sensi della Direttiva RAEE
(2012/19/UE), della Direttiva sulle Batterie (2006/66/CE) e/o delle leggi nazionali che attuano tali Direttive.
Se sotto il simbolo indicato sopra è riportato un simbolo chimico, in osservanza della Direttiva sulle batterie, tale
simbolo indica la presenza di un metallo pesante (Hg = Mercurio, Cd = Cadmio, Pb = Piombo) nella batteria o
nell'accumulatore con un livello di concentrazione superiore a una soglia applicabile specificata nella Direttiva sulle
batterie.
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Il prodotto deve essere conferito a un punto di raccolta designato, ad esempio il rivenditore in caso di acquisto di
un nuovo prodotto simile oppure un centro di raccolta autorizzato per il riciclaggio di rifiuti di apparecchiature elettri-
che ed elettroniche (RAEE) nonché di batterie e accumulatori. Un trattamento improprio di questo tipo di rifiuti può
avere conseguenze negative sull'ambiente e sulla salute umana a causa delle sostanze potenzialmente nocive sol-
itamente contenute in tali rifiuti.
La collaborazione dell'utente per il corretto smaltimento di questo prodotto contribuirà a un utilizzo efficace delle
risorse naturali ed eviterà di incorrere in sanzioni amministrative ai sensi dell'art. 255 e successivi del Decreto Leg-
islativo n. 152/06.
Per ulteriori informazioni sul riciclaggio di questo prodotto, contattare le autorità locali, l'ente responsabile della rac-
colta dei rifiuti, un rivenditore autorizzato o il servizio di raccolta dei rifiuti domestici, oppure visitare il sito
➔ www.canon-europe.com/weee , o ➔ www.canon-europe.com/battery .

Apenas para a União Europeia e AEE (Noruega, Islândia e Liechtenstein)
Estes símbolos indicam que este produto não deve ser eliminado juntamente com o seu lixo doméstico, segundo a
Diretiva REEE de 2012/19/UE, a Diretiva de Baterias (2006/66/CE) e/ou a sua legislação nacional que transponha
estas Diretivas.
Se houver um símbolo químico impresso como mostrado abaixo, de acordo com a Diretiva de Baterias, isto indica
que um metal pesado (Hg = Mercúrio, Cd = Cádmio, Pb = Chumbo) está presente nesta pilha ou acumulador, nu-
ma concentração acima de um limite aplicável especificado na Diretiva.
Este produto deve ser entregue num ponto de recolha designado, por exemplo num local autorizado de troca
quando compra um equipamento novo idêntico, ou num local de recolha autorizado para reciclar equipamento elé-
trico e eletrónico (EEE) em fim de vida, bem como pilhas e baterias. O tratamento inadequado deste tipo de resí-
duos pode ter um impacto negativo no ambiente e na saúde humana, devido a substâncias potencialmente perigo-
sas que estão associadas com equipamentos do tipo EEE.
A sua cooperação no tratamento correto deste produto irá contribuir para a utilização mais eficaz dos recursos na-
turais.
Para obter mais informações acerca de como reciclar este produto, por favor contacte as suas autoridades locais
responsáveis pela matéria, serviço de recolha aprovado para pilhas e baterias ou serviço de recolha de resíduos
sólidos domésticos da sua municipalidade, ou visite ➔ www.canon-europe.com/weee , ou
➔ www.canon-europe.com/battery .

Gælder kun i Europæiske Union og EØS (Norge, Island og Liechtenstein)
Disse symboler betyder, at produktet ikke må bortskaffes sammen med dagrenovation i henhold til WEEE-direktivet
(2012/19/EU), batteridirektivet (2006/66/EF) og/eller den lokale lovgivning, som disse direktiver er gennemført i.
Hvis der i overensstemmelse med batteridirektivet er trykt et kemisk symbol under det symbol, der er vist ovenfor,
betyder det, at batteriet eller akkumulatoren indeholder tungmetaller (Hg = kviksølv, Cd = cadmium, Pb = bly) i en
koncentration, som ligger over de grænseværdier, der er beskrevet i batteridirektivet.
Produktet skal afleveres på et godkendt indsamlingssted, f.eks. i overensstemmelse med en godkendt én-til-én-
procedure, når du indkøber et nyt tilsvarende produkt, eller på et godkendt indsamlingssted for elektronikaffald
samt for batterier og akkumulatorer. Forkert håndtering af denne type affald kan medføre negative konsekvenser
for miljøet og menneskers helbred på grund af de potentielt sundhedsskadelige stoffer, der generelt kan forefindes i
elektrisk og elektronisk udstyr.
Når du foretager korrekt bortskaffelse af produktet, bidrager du til effektiv brug af naturressourcerne. Kontakt din
kommune, den lokale affaldsmyndighed, det lokale affaldsanlæg, eller besøg ➔ www.canon-europe.com/weee , el-
ler ➔ www.canon-europe.com/battery  for at få flere oplysninger om genbrug af dette produkt.

Μόνο για την Ευρωπαϊκή Ένωση και τον ΕΟΧ (Νορβηγία, Ισλανδία και Λιχτενστάιν)
Αυτά τα σύμβολα υποδεικνύουν ότι αυτό το προϊόν δεν πρέπει να απορρίπτεται μαζί με τα οικιακά απορρίμματα,
σύμφωνα με την Οδηγία για τα Απόβλητα Ηλεκτρικού και Ηλεκτρονικού Εξοπλισμού (ΑΗΗΕ) (2012/19/ΕΕ), την
Οδηγία για τις Ηλεκτρικές Στήλες (2006/66/ΕΚ) ή/και την εθνική νομοθεσία που εφαρμόζει τις Οδηγίες εκείνες.
Εάν κάποιο χημικό σύμβολο είναι τυπωμένο κάτω από το σύμβολο που φαίνεται παραπάνω, σύμφωνα με την
Οδηγία για τις Ηλεκτρικές Στήλες, υποδηλώνει ότι κάποιο βαρύ μέταλλο (Hg = Υδράργυρος, Cd = Κάδμιο, Pb =
Μόλυβδος) υπάρχει στην μπαταρία ή τον συσσωρευτή σε συγκέντρωση μεγαλύτερη από το ισχύον επίπεδο που
καθορίζεται στην Οδηγία για τις Ηλεκτρικές Στήλες.
Αυτό το προϊόν πρέπει να παραδίδεται σε καθορισμένο σημείο συλλογής, π.χ. σε μια εξουσιοδοτημένη βάση
ανταλλαγής όταν αγοράζετε ένα νέο παρόμοιο προϊόν ή σε μια εξουσιοδοτημένη θέση συλλογής για την
ανακύκλωση των αποβλήτων ηλεκτρικού και ηλεκτρονικού εξοπλισμού (ΗΗE) και των ηλεκτρικών στηλών και
συσσωρευτών. Ο ακατάλληλος χειρισμός αυτού του τύπου αποβλήτων μπορεί να έχει αρνητικό αντίκτυπο στο
περιβάλλον και την υγεία του ανθρώπου, λόγω δυνητικά επικίνδυνων ουσιών που γενικά συνδέονται με τον ΗΗΕ.
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Η συνεργασία σας για τη σωστή απόρριψη αυτού του προϊόντος θα συμβάλει στην αποτελεσματική χρήση των
φυσικών πόρων.
Για περισσότερες πληροφορίες σχετικά με ανακύκλωση αυτού του προϊόντος, επικοινωνήστε με το τοπικό γραφείο
της πόλης σας, την υπηρεσία απορριμμάτων, το εγκεκριμένο σχήμα ή την υπηρεσία απόρριψης οικιακών
αποβλήτων ή επισκεφθείτε τη διεύθυνση ➔ www.canon-europe.com/weee  ή ➔ www.canon-europe.com/battery .

Gjelder kun den europeiske union og EØS (Norge, Island og Liechtenstein)
Disse symbolene indikerer at dette produktet ikke skal kastes sammen med husholdningsavfall, i henhold til
WEEE-direktivet (2012/19/EU), batteridirektivet (2006/66/EF) og/eller nasjonal lov som har implementert disse dir-
ektivene.
Hvis et kjemisk symbol vises under symbolet vist ovenfor, i samsvar med batteridirektivet, indikerer dette at et tung-
metall (Hg = kvikksølv, Cd = kadmium, Pb = bly) finnes i batteriet eller akkumulatoren i en konsentrasjon over en
gjeldende øvre grense som er spesifisert i batteridirektivet.
Produktet må leveres til et dertil egnet innsamlingspunkt, det vil si på en autorisert en-til-en-basis når en kjøper et
nytt lignende produkt, eller til et autorisert innsamlingssted for resirkulering av avfall fra elektrisk og elektronisk ut-
styr (EE‑utstyr) og batterier og akkumulatorer. Feil håndtering av denne typen avfall kan være miljø- og helseska-
delig på grunn av potensielt skadelige stoffer som ofte brukes i EE‑utstyr.
Din innsats for korrekt avhending av produktet vil bidra til effektiv bruk av naturressurser.
Du kan få mer informasjon om resirkulering av dette produktet ved å kontakte lokale myndigheter, avfallsadminis-
trasjonen, et godkjent program eller husholdningens renovasjonsselskap, eller gå til
➔ www.canon-europe.com/weee , eller ➔ www.canon-europe.com/battery .

Vain Euroopan unionin sekä ETA:n (Norja, Islanti ja Liechtenstein) alueelle.
Nämä tunnukset osoittavat, että sähkö- ja elektroniikkalaiteromua koskeva direktiivi (SER-direktiivi, 2012/19/EU),
paristoista ja akuista annettu direktiivi (2006/66/EY) sekä kansallinen lainsäädäntö kieltävät tuotteen hävittämisen
talousjätteen mukana.
Jos yllä olevan symbolin alapuolelle on paristodirektiivin mukaisesti painettu kemiallisen aineen tunnus, kyseinen
paristo tai akku sisältää raskasmetalleja (Hg = elohopea, Cd = kadmium, Pb = lyijy) enemmän kuin paristodirektiivin
salliman määrän.
Tuote on vietävä asianmukaiseen keräyspisteeseen, esimerkiksi kodinkoneliikkeeseen uutta vastaavaa tuotetta os-
tettaessa tai viralliseen sähkö- ja elektroniikkalaiteromun tai paristojen ja akkujen keräyspisteeseen. Sähkö- ja elek-
troniikkalaiteromun virheellinen käsittely voi vahingoittaa ympäristöä ja ihmisten terveyttä, koska laitteet saattavat
sisältää ympäristölle ja terveydelle haitallisia aineita. Tuotteen asianmukainen hävittäminen säästää myös luonnon-
varoja.
Jos haluat lisätietoja tämän tuotteen kierrätyksestä, ota yhteys kunnan jätehuoltoviranomaisiin tai käyttämääsi jäte-
huoltoyhtiöön tai käy osoitteessa ➔ www.canon-europe.com/weee , tai ➔ www.canon-europe.com/battery .

Endast för Europeiska unionen och EES (Norge, Island och Liechtenstein)
De här symbolerna visar att produkten inte får sorteras och slängas som hushållsavfall enligt WEEE-direktivet
(2012/19/EU), batteridirektivet (2006/66/EG) och/eller nationell lagstiftning som implementerar dessa direktiv.
Om en kemisk symbol förekommer under ovanstående symbol innebär detta enligt Batteridirektivet att en tungme-
tall (Hg = Kvicksilver, Cd = Kadmium, Pb = Bly) förekommer i batteriet eller ackumulatorn med en koncentration
som överstiger tillämplig gräns som anges i Batteridirektivet.
Produkten ska lämnas in på en avsedd insamlingsplats, t.ex. på en återvinningsstation auktoriserad att hantera
elektrisk och elektronisk utrustning (EE-utrustning) samt batterier och ackumulatorer eller hos handlare som är auk-
toriserade att byta in varor då nya, motsvarande köps (en mot en). Olämplig hantering av avfall av den här typen
kan ha negativ inverkan på miljön och människors hälsa på grund av de potentiellt farliga ämnen som kan återfin-
nas i elektrisk och elektronisk utrustning.
Din medverkan till en korrekt avfallshantering av produkten bidrar till effektiv användning av naturresurserna.
Om du vill ha mer information om var du kan lämna in den här produkten, kontakta ditt lokala kommunkontor, ber-
örd myndighet eller företag för avfallshantering eller se ➔ www.canon-europe.com/weee , eller
➔ www.canon-europe.com/battery .

Pouze Evropská unie a EHP (Norsko, Island a Lichtenštejnsko)
Tento symbol znamená, že podle směrnice OEEZ (2012/19/EU), směrnice o bateriích (2006/66/ES) a/nebo podle
vnitrostátních právních prováděcích předpisů k těmto směrnicím nemá být tento výrobek likvidován s odpadem z
domácností.
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Je-li v souladu s požadavky směrnice o bateriích vytištěna pod výše uvedeným symbolem chemická značka, udá-
vá, že tato baterie nebo akumulátor obsahuje těžké kovy (Hg = rtuť, Cd = kadmium, Pb = olovo) v koncentraci vyš-
ší, než je příslušná hodnota předepsaná směrnicí.
Tento výrobek má být vrácen do určeného sběrného místa, např. v rámci autorizovaného systému odběru jednoho
výrobku za jeden nově prodaný podobný výrobek, nebo do autorizovaného sběrného místa pro recyklaci odpad-
ních elektrických a elektronických zařízení (OEEZ), baterií a akumulátorů. Nevhodné nakládání s tímto druhem od-
padu by mohlo mít negativní dopad na životní prostředí a lidské zdraví, protože elektrická a elektronická zařízení
zpravidla obsahují potenciálně nebezpečné látky. Vaše spolupráce na správné likvidaci tohoto výrobku napomůže
efektivnímu využívání přírodních zdrojů.
Chcete-li získat podrobné informace týkající se recyklace tohoto výrobku, obraťte se prosím na místní úřad, orgán
pro nakládání s odpady, schválený systém nakládání s odpady či společnost zajišťující likvidaci domovního odpa-
du, nebo navštivte webové stránky ➔ www.canon-europe.com/weee  nebo ➔ www.canon-europe.com/battery .

Csak az Európai Unió és az EGT (Norvégia, Izland és Liechtenstein) országaiban
Ezek a szimbólumok azt jelzik, hogy a termék hulladékkezelése a háztartási hulladéktól különválasztva, az elektro-
mos és elektronikus berendezések hulladékairól (WEEE) szóló (2012/19/EU) irányelvnek és az elemekről és akku-
mulátorokról, valamint a hulladék elemekről és akkumulátorokról szóló (2006/66/EK) irányelvnek megfelelően és/
vagy ezen irányelveknek megfelelő helyi előírások szerint történik.
Amennyiben a fent feltüntetett szimbólum alatt egy vegyjel is szerepel, az elemekről és akkumulátorokról szóló irá-
nyelvben foglaltak értelmében ez azt jelzi, hogy az elem vagy az akkumulátor az irányelvben meghatározott határ-
értéknél nagyobb mennyiségben tartalmaz nehézfémet (Hg = higany, Cd = kadmium, Pb = ólom).
E terméket az arra kijelölt gyűjtőhelyre kell juttatni – pl. hasonló termék vásárlásakor a régi becserélésére vonatko-
zó hivatalos program keretében, vagy az elektromos és elektronikus berendezések (EEE) hulladékainak gyűjté-
sére, valamint a hulladék elemek és hulladék akkumulátorok gyűjtésére kijelölt hivatalos gyűjtőhelyre. Az ilyen jelle-
gű hulladékok nem előírásszerű kezelése az elektromos és elektronikus berendezésekhez (EEE) általánosan
kapcsolható potenciálisan veszélyes anyagok révén hatással lehet a környezetre és az egészségre.
E termék megfelelő leselejtezésével Ön is hozzájárul a természeti források hatékony használatához.
A termék újrahasznosítását illetően informálódjon a helyi polgármesteri hivatalnál, a helyi közterület-fenntartó válla-
latnál, a hivatalos hulladéklerakó telephelyen vagy a háztartási hulladék begyűjtését végző szolgáltatónál, illetve
látogasson el a ➔ www.canon-europe.com/weee , vagy ➔ www.canon-europe.com/battery  internetes oldalra.

Tylko dla krajów Unii Europejskiej oraz EOG (Norwegia, Islandia i Liechtenstein)
Te symbole oznaczają, że produktu nie należy wyrzucać razem z odpadami gospodarstwa domowego, zgodnie z
dyrektywą WEEE w sprawie zużytego sprzętu elektrycznego i elektronicznego (2012/19/UE) lub dyrektywą w spra-
wie baterii (2006/66/WE) bądź przepisami krajowymi wdrażającymi te dyrektywy.
Jeśli pod powyższym symbolem znajduje się symbol chemiczny, zgodnie z dyrektywą w sprawie baterii oznacza to,
że bateria lub akumulator zawiera metal ciężki (Hg = rtęć, Cd = kadm, Pb = ołów) w stężeniu przekraczającym od-
powiedni poziom określony w dyrektywie w sprawie baterii.
Użytkownicy baterii i akumulatorów mają obowiązek korzystać z dostępnego programu zwrotu, recyklingu i utyli-
zacji baterii oraz akumulatorów.
Niewłaściwe postępowanie z tego typu odpadami może mieć wpływ na środowisko i zdrowie ludzi ze względu na
substancje potencjalnie niebezpieczne, związane ze zużytym sprzętem elektrycznym i elektronicznym.
Państwa współpraca w zakresie właściwej utylizacji tego produktu przyczyni się do efektywnego wykorzystania za-
sobów naturalnych.
W celu uzyskania informacji o sposobie recyklingu tego produktu prosimy o kontakt z właściwym urzędem miejskim
lub zakładem gospodarki komunalnej bądź zapraszamy na stronę ➔ www.canon-europe.com/weee , lub
➔ www.canon-europe.com/battery .

Platí len pre štáty Európskej únie a EHP (Nórsko, Island a Lichtenštajnsko)
Tieto symboly označujú, že podľa Smernice o odpade z elektrických a elektronických zariadení (OEEZ)
2012/19/EÚ, Smernice o batériách (2006/66/ES) a podľa platnej legislatívy Slovenskej republiky sa tento produkt
nesmie likvidovať spolu s komunálnym odpadom.
Ak je chemická značka vytlačená pod vyššie uvedeným symbolom, znamená to, že táto batéria alebo akumulátor
obsahuje ťažký kov (Hg = ortuť, Cd = kadmium, Pb = olovo) v koncentrácii vyššej, ako je príslušná povolená hod-
nota stanovená v Smernici o batériách.
Produkt je potrebné odovzdať do určenej zberne, napr. prostredníctvom výmeny za kúpu nového podobného pro-
duktu, alebo na autorizované zberné miesto, ktoré spracúva odpad z elektrických a elektronických zariadení (EEZ),
batérií a akumulátorov. Nesprávna manipulácia s takýmto typom odpadu môže mať negatívny vplyv na životné
prostredie a ľudské zdravie, pretože elektrické a elektronické zariadenia obsahujú potenciálne nebezpečné látky.
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Spoluprácou na správnej likvidácii tohto produktu prispejete k účinnému využívaniu prírodných zdrojov.
Ďalšie informácie o recyklácii tohto produktu získate od miestneho úradu, úradu životného prostredia, zo schvále-
ného plánu OEEZ alebo od spoločnosti, ktorá zaisťuje likvidáciu komunálneho odpadu. Viac informácií nájdete aj
na webovej stránke: ➔ www.canon-europe.com/weee , alebo ➔ www.canon-europe.com/battery .

Üksnes Euroopa Liit ja EMP (Norra, Island ja Liechtenstein)
Antud sümbolid viitavad sellele, et vastavalt elektri- ja elektroonikaseadmete jäätmeid käsitlevale direktiivile
(2012/19/EL), patareisid ja akusid ning patarei- ja akujäätmeid käsitlevale direktiivile (2006/66/EÜ) ja/või nimetatud
direktiive rakendavatele riiklikele õigusaktidele ei või seda toodet koos olmejäätmetega ära visata.
Kui keemiline sümbol on trükitud eespool toodud sümboli alla, siis tähendab see, et antud patareis või akus leiduva
raskemetalli (Hg = elavhõbe, Cd = kaadmium, Pb = plii) kontsentratsioonitase on kõrgem kui patareisid ja akusid
ning patarei- ja akujäätmeid käsitlevas direktiivis sätestatud piirmäär.
Antud tootest tekkinud jäätmed tuleb anda vastavasse kogumispunkti, nt müügipunkti, mis on volitatud üks ühe
vastu vahetama, kui ostate uue sarnase toote, või vastavasse elektri- ja lektroonikaseadmete jäätmete ning patar-
eide ja akude ümbertöötlemiseks mõeldud kogumispunkti. Antud liiki jäätmete vale käitlemine võib kahjustada
keskkonda ja inimeste tervist elektri- ja elektroonikajäätmetes tavaliselt leiduvate potentsiaalselt ohtlike ainete tõttu.
Antud tootest tekkinud jäätmete nõuetekohase kõrvaldamisega aitate kasutada loodusvarasid efektiivselt.
Täiendava teabe saamiseks elektri- ja elektroonikaseadmetest tekkinud jäätmete ning patarei- ja akujäätmete ta-
gastamise ja ümbertöötlemise kohta võtke ühendust kohaliku omavalitsusega, asjakohase valitsusasutusega, asja-
kohase tootjavastutusorganisatsiooniga või olmejäätmete käitlejaga. Lisateavet leitate ka Interneti-leheküljelt
➔ www.canon-europe.com/weee  või ➔ www.canon-europe.com/battery .

Tikai Eiropas Savienībai un EEZ (Norvēģijai, Islandei un Lihtenšteinai)
Šie simboli norāda, ka atbilstoši ES Direktīvai (2012/19/ES) par elektrisko un elektronisko iekārtu atkritumiem
(EEIA), Direktīvai (2006/66/EK) par baterijām un akumulatoriem, un akumulatoru atkritumiem, ar ko atceļ Direktīvu
91/157/EEK, un vietējiem tiesību aktiem šo izstrādājumu nedrīkst izmest kopā ar sadzīves atkritumiem.
Ja zem iepriekš norādītā simbola ir uzdrukāts ķīmiskais simbols, saskaņā ar direktīvu par baterijām un akumulator-
iem tas nozīmē, ka šīs baterijas vai akumulatori satur smagos metālus (Hg = dzīvsudrabs, Cd = kadmijs, Pb =
svins) un to koncentrācijas līmenis pārsniedz direktīvā par baterijām un akumulatoriem minēto piemērojamo slieks-
ni.
Šis izstrādājums ir jānodod piemērotā savākšanas vietā, piemēram, apstiprinātā veikalā, kur iegādājaties līdzīgu
jaunu produktu un atstājat veco, vai apstiprinātā vietā izlietotu elektrisko un elektronisko iekārtu un bateriju un aku-
mulatoru pārstrādei. Nepareiza šāda veida atkritumu apsaimniekošana var apdraudēt vidi un cilvēka veselību tādu
iespējami bīstamu vielu dēļ, kas parasti ir elektriskajās un elektroniskajās iekārtās.
Jūsu atbalsts pareizā šāda veida atkritumu apsaimniekošanā sekmēs efektīvu dabas resursu izmantošanu.
Lai saņemtu pilnīgāku informāciju par šāda veida izstrādājumu nodošanu otrreizējai pārstrādei, sazinieties ar vietē-
jo pašvaldību, atkritumu savākšanas atbildīgo dienestu, pilnvaroto organizāciju vai iestādi, kas veic sadzīves atkri-
tumu apsaimniekošanu, vai apmeklējiet tīmekļa vietni ➔ www.canon-europe.com/weee , vai
➔ www.canon-europe.com/battery .

Tik Europos Sąjungai ir EEE (Norvegijai, Islandijai ir Lichtenšteinui)
Šie simboliai reiškia, kad šio gaminio negalima išmesti į buitines atliekas, kaip reikalaujama WEEE Direktyvoje
(2012/19/ES) ir Baterijų direktyvoje (2006/66/EB) ir (ar) jūsų šalies nacionaliniuose įstatymuose, kuriais šios Direk-
tyvos yra įgyvendinamos.
Jeigu cheminio ženklo simbolis yra nurodytas žemiau šio ženklo, tai reiškia, kad vadovaujantis Baterijų direktyvą,
baterijų ar akumuliatorių sudėtyje yra sunkiųjų metalų (Hg = gyvsidabrio, Cd = kadmio, Pb = švino), kurių koncen-
tracija viršija Baterijų direktyvoje nurodytas leistinas ribas.
Šį gaminį reikia pristatyti į specialųjį surinkimo punktą, pavyzdžiui, mainais, kai jūs perkate naują panašų gaminį,
arba į specialiąją surinkimo vietą, kurioje perdirbamos elektrinės ir elektroninės įrangos atliekos bei naudotos bater-
ijos ir akumuliatoriai. Dėl netinkamo šio tipo atliekų tvarkymo gali nukentėti aplinka ir iškilti grėsmė žmogaus sveika-
tai dėl galimai kenksmingų medžiagų, iš esmės susijusių su elektrine ir elektronine įranga.
Bendradarbiaudami ir teisingai utilizuodami šiuos gaminius, jūs padėsite efektyviai naudoti gamtinius išteklius.
Daugiau informacijos apie gaminio perdirbimą jums gali suteikti vietinis biuras, atliekų tvarkymo bendrovė, sertifi-
kuoti organai ar buitinių atliekų surinkimo įmonės. Taip pat siūloma apsilankyti interneto svetainėje
➔ www.canon-europe.com/weee , arba ➔ www.canon-europe.com/battery .

Samo za Evropsko unijo in EGP (Norveška, Islandija in Lihtenštajn)
Ti simboli pomenijo, da tega izdelka skladno z Direktivo OEEO (2012/19/EU), Direktivo 2006/66/ES in/ali nacional-
no zakonodajo, ki uvaja ti direktivi, ne smete odlagati z nesortiranimi gospodinjskimi odpadki.
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Če je pod zgoraj prikazanim simbolom natisnjen kemijski simbol, to v skladu z Direktivo pomeni, da je v tej bateriji
ali akumulatorju prisotna težka kovina (Hg = živo srebro, Cd = kadmij, Pb = svinec), in sicer v koncentraciji, ki je
nad relevantno mejno vrednostjo, določeno v Direktivi.
Ta izdelek je potrebno odnesti na izbrano zbirno mesto, t. j. pooblaščeno trgovino, kjer ob nakupu novega (podob-
nega) izdelka vrnete starega, ali na pooblaščeno zbirno mesto za ponovno uporabo odpadne električne in elek-
tronske opreme (EEO) ter baterij in akumulatorjev. Neustrezno ravnanje s to vrsto odpadkov lahko negativno vpliva
na okolje in človeško zdravje zaradi potencialno nevarnih snovi, ki so pogosto povezane z EEO.
Vaše sodelovanje pri pravilnem odlaganju tega izdelka predstavlja pomemben prispevek k smotrni izrabi naravnih
virov.
Za več informacij o ponovni uporabi tega izdelka se obrnite na lokalen mestni urad, pristojno službo za odpadke,
predstavnika pooblaščenega programa za obdelavo odpadkov ali na lokalno komunalo. Lahko pa tudi obiščete na-
šo spletno stran ➔ www.canon-europe.com/weee , ali ➔ www.canon-europe.com/battery .

Само за Европейския съюз и ЕИП (Норвегия, Исландия и Лихтенщайн)
Тези символи показват, че този продукт не трябва да се изхвърля заедно с битовите отпадъци съгласно
Директивата за ИУЕЕО (2012/19/ЕC), Директивата за батерии (2006/66/ЕО) и/или Вашето национално
законодателство, прилагащо тези Директиви.
Ако под показания горе символ е отпечатан символ за химически елемент, съгласно разпоредбите на
Директивата за батерии, този втори символ означава наличието на тежък метал (Hg = живак, Cd = кадмий,
Pb = олово) в батерията или акумулатора в концентрация над указаната граница за съответния елемент в
Директивата.
Този продукт трябва да бъде предаден в предназначен за целта пункт за събиране, например на база
размяна, когато купувате нов подобен продукт, или в одобрен събирателен пункт за рециклиране на излязло
от употреба електрическо и електронно оборудване (ИУЕЕО), батерии и акумулатори. Неправилното
третиране на този тип отпадъци може да доведе до евентуални отрицателни последствия за околната среда
и човешкото здраве поради потенциално опасните вещества, които обикновено са свързани с ЕЕО.
В същото време Вашето съдействие за правилното изхвърляне на този продукт ще допринесе за
ефективното използване на природните ресурси.
За повече информация относно това къде можете да предадете за рециклиране на този продукт, моля
свържете се с Вашите местни власти, с органа, отговорен за отпадъците, с одобрената система за ИУЕЕО
или с Вашата местна служба за битови отпадъци, или посетете ➔ www.canon-europe.com/weee , или
➔ www.canon-europe.com/battery .

Doar pentru Uniunea Europeană şi EEA (Norvegia, Islanda şi Liechtenstein)
Aceste simboluri indică faptul că acest produs nu trebuie aruncat împreună cu deşeurile menajere, în conformitate
cu Directiva DEEE (2012/19/UE), Directiva referitoare la baterii (2006/66/CE) şi/sau legile dvs. naţionale ce imple-
mentează aceste Directive.
Dacă un simbol chimic este imprimat sub simbolul de mai sus, în conformitate cu Directiva referitoare la baterii,
acest simbol indică prezenţa în baterie sau acumulator a unui metal greu (Hg = Mercur, Cd = Cadmiu, Pb = Plumb)
într-o concentraţie mai mare decât pragul admis specificat în Directiva referitoare la baterii.
Acest produs trebuie înmânat punctului de colectare adecvat, ex: printr-un schimb autorizat unu la unu atunci când
cumpăraţi un produs nou similar sau la un loc de colectare autorizat pentru reciclarea reziduurilor de echipament
electric şi electronic (EEE) şi baterii şi acumulatori. Administrarea neadecvată a acestui tip de deşeuri, ar putea
avea un impact asupra mediului şi asupra sănătăţii umane datorită substanţelor cu potenţial de risc care sunt în
general asociate cu EEE.
Cooperarea dvs. în direcţia reciclării corecte a acestui produs va contribui la o utilizare eficientă a resurselor natu-
rale.
Pentru mai multe informaţii despre reciclarea acestui produs, vă rugăm să contactaţi biroul dvs. local, autorităţile
responsabile cu deşeurile, schema aprobată sau serviciul dvs. responsabil cu deşeurile menajere sau vizitaţi-ne la
➔ www.canon-europe.com/weee , sau ➔ www.canon-europe.com/battery .

Samo za Europsku uniju i EEA (Norveška, Island i Lihtenštajn)
Oznaka pokazuje da se ovaj proizvod ne smije odlagati s komunalnim i ostalim vrstama otpada, u skladu s direkti-
vom WEEE (2012/19/EC), Direktivom o baterijama (2006/66/EC) i Pravilnikom o gospodarenju otpadnim baterija-
ma i akumulatorima te Pravilnikom o gospodarenju otpadnim električnim i elektroničkim uređajima i opremom.
Ako je ispod prethodno prikazane oznake otisnut kemijski simbol, u skladu s Direktivom o baterijama, to znači da
se u ovoj bateriji ili akumulatoru nalazi teški metal (Hg = živa, Cd = kadmij, Pb = olovo) i da je njegova koncentraci-
ja iznad razine propisane u Direktivi o baterijama.
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Ovaj bi proizvod trebalo predati ovlašenom skupljaču EE otpada ili prodavatelju koji je dužan preuzeti otpadni
proizvod po sistemu jedan za jedan, ukoliko isti odgovara vrsti te je obavljao primarne funkcije kao i isporučena EE
oprema. Otpadne baterije i akumulatori predaju se ovlaštenom skupljaču otpadnih baterija ili akumulatora ili proda-
vatelju bez naknade i obveze kupnje za krajnjeg korisnika. Neodgovarajuće rukovanje ovom vrstom otpada može
utjecati na okoliš i ljudsko zdravlje zbog potencijalno opasnih supstanci koje se najčešće nalaze na takvim mjesti-
ma.
Vaša suradnja u pravilnom zbrinjavanju ovog proizvoda pridonijet će djelotvornom iskorištavanju prirodnih resursa.
Dodatne informacije o recikliranju ovog proizvoda zatražite od svog lokalnog gradskog ureda, službe za zbrinja-
vanje otpada, odobrenog programa ili komunalne službe za uklanjanje otpada ili pak na stranicama
➔ www.canon-europe.com/weee  ili ➔ www.canon-europe.com/battery .

Només per a la Unió Europea i a l’Espai Econòmic Europeu (Noruega, Islàndia i Liechtenstein)
Aquests símbols indican que aquest producte no s’ha de llençar amb les escombraries de la llar, d’acord amb la
RAEE (2012/19/UE), la Directiva relativa a piles i acumuladors (2006/66/CE) i la legislació nacional que implementi
aquestes directives.
Si al costat d’aquest símbol hi apareix imprès un símbol químic, segons especifica la Directiva relativa a piles i
acumuladors, significa que la bateria o l’acumulador conté un metall pesant (Hg = mercuri, Cd = cadmi, Pb = plom)
en una concentració superior al límit aplicable especificat en la Directiva.
Aquest producte s’hauria de lliurar en un dels punts de recollida designats, com per exemple, intercanviant un per
un en comprar un producte similar o lliurant-lo en un lloc de recollida autoritzat per al reciclatge de residus d’apar-
ells elèctrics i electrònics (RAEE) i piles i acumuladors. La manipulació inadequada d’aquest tipus de residus po-
dria tenir un impacte negatiu en l’entorn i en la salut humana, a causa de les substàncies potencialment perilloses
que normalment estan associades a l'RAEE.
La vostra cooperació a l’hora de rebutjar correctament aquest producte contribuirà a la utilització efectiva dels re-
cursos naturals.
Els usuaris tenen dret a retornar les bateries o els acumuladors usats sense cap càrrec. El preu de venda de les
bateries i els acumuladors inclou el cost de la gestió ambiental dels residus i no es necessari mostrar l’import
d’aquest cost en aquest fullet o en la factura que es lliuri a l’usuari final.
Per a més informació sobre el reciclatge d’aquest producte, contacteu amb l’oficina municipal, les autoritats encar-
regades dels residus, el pla de residus homologat o el servei de recollida d’escombraries domèstiques de la vostra
localitat o visiteu ➔ www.canon-europe.com/weee , o ➔ www.canon-europe.com/battery .

Korisnici u Srbiji
Ovaj simbol označava da ovaj proizvod ne sme da se odlaže sa ostalim kućnim otpadom, u skladu sa WEEE Direk-
tivom (2012/19/EU), Direktivom o baterijama (2006/66/EC) i nacionalnim zakonima.
Ukoliko je ispod gore navedenog simbola odštampan hemijski simbol, u skladu sa Direktivom o baterijama, ovaj
simbol označava da su u ovoj bateriji ili akumulatoru prisutni teški metali (Hg – živa, Cd – kadmijum, Pb - olovo) u
koncentracijama koje premašuju prihvatljivi prag naveden u Direktivi o baterijama.
Ovaj proizvod treba predati određenom centru za prikupljanje, npr. po principu „jedan-za-jedan“ kada kupujete sli-
čan novi proizvod, ili ovlašćenom centru za prikupljanje za reciklažu istrošene električne i elektronske opreme
(EEE), baterija i akumulatora. Nepravilno rukovanje ovom vrstom otpada može imati negativne posledice po život-
nu sredinu i ljudsko zdravlje usled potencijalno opasnih materijala koji se uglavnom vezuju za EEE.
Vaša saradnja na ispravnom odlaganju ovog proizvoda će doprineti efikasnom korišćenju prirodnih resursa.
Više informacija o tome kako možete da reciklirate ovaj proizvod potražite od lokalnih gradskih vlasti, komunalne
službe, odobrenog plana reciklaže ili servisa za odlaganje kućnog otpada, ili posetite stranicu
➔ www.canon-europe.com/weee , ili ➔ www.canon-europe.com/battery .
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	The printer stops when printing a HP-GL/2 job (the carriage stops moving)

	Other problems
	The Ink Tank Cover has become detached from the printer
	The printer does not go on
	The printer takes time to start up
	If the Printer Makes a Strange Sound
	Messages advising to check the maintenance cartridge are not cleared
	The printer consumes a lot of ink
	Ink Level Detection
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	Roll printing is selected, but sheets are loaded.
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	Paper is crooked.
	Paper not aligned with right guide.
	Cannot detect papr
	Leading edge detection error.
	Paper cutting failed.
	End of paper feed.
	Rel lever is in wrong position.
	Borderless printng not possible.
	Paper position not suitable for borderless printing.
	Roll paper is not securely in contact with roll holder.
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	Ink insufficient.
	No ink left.
	Remaining level of the ink cannot be correctly detected. Check ink tank.
	Cannot detect ink level correctly. Close tank cover.
	Close Ink Tank Cover
	Ink tank is empty.
	Not much ink is left.
	Check if ink tank is set, and its color and direction.
	The following ink tanks cannot be recognized.
	Wrong ink tank.
	Do not pull out ink tank.
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	Cannot adjust paper feed.
	Check printed document.
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	Cannot adjust printhead.
	Wrong printhead.
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	Cannot recognize print head.
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	Insert the maintenance cartridge.
	Wrong maintenance cartridge.
	Maint. cart. The level is low
	No Maintenance Cartridge capacity.
	Maintenance cartridge full.
	Maintenance cartridge problem.
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	Hard disk error.
	File read error.
	The mail box is full.
	Mail box full. Now printing without saving data.
	Mail box nearly full.
	Maximum jobs stored.
	Mail box full. Delete unwanted data

	Messages regarding HP-GL/2
	This type of paper is not compatible with HP-GL/2.
	GL2: Wxxxx The memory is full. (xxxx is 0501, 0903, or 0904)
	GL2: W0502 The parameter is out of range.
	GL2: W0504 This command is not supported.

	Other Messages
	GARO Wxxxx (x represents a number)
	ERROR Exxx-xxxx (x represents a letter or number)
	Hardware error. xxxxxxxx-xxxx (x represents a letter or number)
	Top cover is open.
	Prepare for parts replacement.
	Parts replacement time has passed.
	Unknown file.
	Multi-sensor error
	Error in cutter position.
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